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Getting Started

About CW Evolve

CW Evolve is a powerful and customizable web platform which can be configured to offer different

experiences for different audiences within your organization.

Using Evolve you can share information from your CW repository across your organization - but only the data
you want to share.

Depending on your configuration and the roles you set for your users, people can either read the data, follow

it to keep up to date, comment on it, or even edit it directly.

System Architecture
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Key Concepts

To help understand Evolve and the instructions in this guide, this page lists the key concepts you'll run into

when working with Evolve.

Sites

Evolve deployments are called Sites - that is a collection of custom web pages based on data from a CW

Model. In Evolve, these web pages are called Index Pages and Object Pages.

You can deploy your Site in two ways: as a Static Site, or a Dynamic Site - or both, if you have a Dynamic

license.

You can create as many Sites as you like but only one per Model.

See URLs, file paths and directory structures to understand the URLs used to access your Sites.

Top-level /IS Site

The top-level IIS Site is only used when Dynamic Sites have been deployed and lists all the Sites the logged

on user has permission to view. Users can choose a Site to view and then that Site is displayed.

Evolve Static

A Static Evolve Site is a read-only deployment which displays data from your repository taken at a fixed

point in time. It is therefore not live data and does not allow anyone viewing the web pages to edit it.
Static Sites do not support user login and therefore do not support access control or social features such as

Comments, Questionnaires and Favorites.

Evolve Dynamic

A Dynamic Evolve Site shows live data from the CW repository and allows people viewing the data to edit it -

assuming you have configured it that way and the users have sufficient permissions to do so.

Using Evolve's social features, a Dynamic Site enables Followers to read the data, create a custom

homepage and set favorite pages, while Contributors can additionally edit data and participate in the review

and approval workflow.
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Index Pages

Index Pages are the top-level pages in your Site. They are the pages that the main Menu navigation links to

and they are generally the starting point for users browsing your Site.

Index Pages essentially display lists or representations of objects which can be expanded on by supporting

Object Pages which show more information about the object in question.
There are three types of Index Page:

1. Object listing pages, such as lists, tables, or boxes.

2. Graphical pages, such as dashboards and charts.

3. Diagram pages, showing CW Modeler diagrams or visualization diagrams.

Object Pages

An Object Page is used to present the details of an object instance - you select an object on an Index
Page, and the Object Page displays its properties. You must have an Object Page configured for each type of
object you want to see the details of in your Evolve Site.

Views

An Object Page can be configured to offer more than one View of the object being observed. If you
make more than one Object Page for an Object Type, these pages will be offered as Views to the user. The

links to the different Views are displayed as sections in the page's left-hand navigation panel.

Layouts and Behaviors

There are many ways you can display your data in Evolve web pages. The basic display options for Index
Pages and Object Pages are simple lists or property groups. You can however use a wide variety of layouts
and behaviors to extend on these basic display options to include elements such as Pie Charts, Bubble
Charts, Cost/Benefit Charts, Bar Charts, Maps, Roadmaps and Tables.

Evolve Designer

Evolve Designer is the desktop application you use to create, configure and manage your Evolve Sites. It is

installed on the web server machine which hosts your Evolve Site.
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Diagram Designer

Diagram Designer is the desktop application you use to create and configure Diagram Visualizations. It is

installed on the web server machine which hosts your Evolve Site.

Roles

Roles are used to group users for the purpose of control Site access and capabilities.

You use Roles to control visibility to your Site pages, as well as whether those users are Social or

Contributing users - so who is a read-only user and who can also edit data.

In addition, Roles are used in Evolve Workflow to determine which users must review and approve other

users' edits to data.

Deployment

A Deployment is the location of your published Evolve Site running on a web server. Once you create and

configure your Site, you deploy it to the web server so other people can access it.

Workflow

Workflow is a component of Evolve which provides some useful workflow processes based on creating,

editing and deleting data, as well as reviewing content.

Glossary

The terms mentioned above are only some of the concepts you'll come across when working with Evolve.

For a full list of the common concepts and terms, please use the Glossary in the left-hand pane.
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Meta Model Considerations

Your model's meta model is a consideration for Evolve for the following reasons:
1. When you create an Evolve Site, certain changes are made to your model's meta model

2. Certain Evolve features, such as graphs, dashboards or features on Object Pages, can only be used if

your objects have specific corresponding Property Types or Association Types

3. If you change your meta model - such as by creating new Object Types, Property Types or
Association Types, then you must use the Update Meta Model feature in Evolve Designer to

ensure Evolve is aware of the changes.

Throughout this documentation, when meta model changes are required or are enforced, the topic is

highlighted in the following way:

This feature requires specific Property Types or Association Types for the Objects in question —
and therefore may require changes to your meta model.
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Displaying Diagrams in Evolve Sites

This page explains how to display diagrams in your Evolve web pages.

There are two types of diagram that can be displayed in Evolve web pages:

1. CW Modeler diagrams - any diagram created in CW Modeler in your model.
2. Visualization diagrams - auto-generated diagrams created using Diagram Designer.

Both of these types of diagram can be displayed in either Index Pages or Object Pages.

When a diagram is displayed in a page, the objects on it are clickable - but you must have Object Pages for

each of the Object Types otherwise the user will see an error.

On CW Modeler diagrams you can also configure Diagram Popouts to display the data behind objects on

your diagrams in a pop-out panel on the diagram page itself.

Q In order to display a diagram in Evolve, your model must contain a Template Diagram with the
/| same Rule and Category as the one you want to show.

Note: There must be just one template for each Rule/Category combination.

If you try to display a diagram that does not have a corresponding Template Diagram, Evolve will

not be able to show it.

What do you want to do?

Display a CW Modeler diagram in your Site

Display a Visualization diagram in your Site
Display object data with a Diagram Pop-out

Display a diagram on the home page of your Static Site
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Users, Roles and Access Rights

Evolve Web Platform 2020.0.1 and below:
Users, Roles and Access Rights are only relevant to Dynamic Sites.

Static sites are open to everyone to see who has access to the URL, and as the data is fixed and
read-only permissions are irrelevant.

If your Site configuration includes Access Rights and Roles, but you want to publish a Static
version of the Site, then those elements are ignored in the generation.

Evolve Web Platform 2020.0.2 and above:

Whilst the Roles and Access Rights for the generated content are still operated at generation
time, the gate to access to the site can now be controlled by Evolve Web Platform. This means
that, when Static Authentication is turned on, users must be given ‘Static’ access, at a minimum

to be able to access the site.

If Static Authentication is turned off, Evolve Web Platform will still be required to check the usage

mode, but will then pass through any requests for data, without further authentication.
In order to view an access controlled Evolve Site, a User must log in with a valid Username and Password (or
be given permission through Active Directory or SAML2 group acess). There are three types of User:

e Static Users - who can access a pre-generated static site. (If Static Authentication is turned off,

anyone with access to the webserver will be admitted).

e Social Users - who only have read-only access to data, but can use all the Social features of Evolve,
so they can Rate objects, set Favorites, collaborate using Comments and Questionnaires, and can

Share pages with other Users

e Contributors - who can do all of the above, but can additionally Edit data as well, and can be

involved in Workflow tasks.

e Diagrammers - who have the same rights as Contributors but can additionally edit and create

Diagrams using eModeler.

All Evolve Sites can have Static and Social Users, however a special license is required to have Contributors

- and the license also controls how many Contributors you can have.

Web Modeler, for example, is a licensed application. Additional licenses are required on a per user basis in

order to use Web Modeler on your Evolve Site.
Controlling who can see what?
There are two factors that determine which content a User can see in an Evolve Site:

e Roles - determine which Site pages a User can view
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o CW Suite Access Rights - determine which objects a User can see, and whether they
can create, read, edit or delete those objects.

NOTE: With Active Directory or SAMLZ2 Authentication and a large number of users, it is likely that

only Roles are used.

Roles

Roles are used to determine which pages within the Site a User is able to view. That means the Menus and
links in the interface are updated to remove all links to pages that the Role determines the User should not

be able to see.
If a page has no Roles assigned to it, then all users in any Role can view it.

As an Evolve Administrator you can create as many Roles as you like, assign Users to those Roles, and then

specify exactly which pages a Role is able to view.

If a User is in more than one Role, Evolve looks at all relevant Roles to see if the User is able to view the
page.
Roles are also used with Evolve Workflow to specify who must approve changes made to data by other
users.

For details on Roles and assigning Users to Roles, see: Working with Roles.

CW Suite Access Rights

While the type of User you are (Social User or Contributor) specifies whatyou can do in Evolve, and Roles
control which pages you can see, CW Suite Access Rights and Extended Access Controls are used to

determine what capabilities a User has with specific objects at a granular level.

CW Suite Access Rights can be used to make a User Read-Only, control which Models they can see, and

what they can do with certain types of objects, like ones that are Frozen.

Extended Access Controls can be used to specify whether a User can Create, Read, Update or Delete

objects based on either their Object Type or Category.

CW Suite Access Rights and Extended Access Controls are the final level of access control within Evolve.
Even though a User might be a Contributor, and they can view a Table listing some Processes, they may not
be able to edit all of the Processes listed. They may not even see all the Processes - and another User may

see a different list of Processes.

For full details on CW Suite Access Rights and Extended Access Controls, please refer to the CW Suite

documentation.
Active Directory or SAML2 Authentication

You can configure an Evolve Dynamic Site to automatically authenticate users based on Active Directory or
SAML2 group membership.
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Users authenticated in this way only have to browse to the Evolve URL and they are automatically signed in,

without having to enter a username and password.

As an Evolve Administrator, you can state that Users in a specific Active Directory group should be Static
Users, Social Users, Contributors or Diagrammers and you can assign them to an Evolve Role, and a CW

Group.
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Running Evolve Designer

Evolve Designer is the application used to create, configure and manage Evolve Sites.

‘-( In order to run Evolve Designer you must log in with a CW user that has System Manager
. rights.
In addition, certain functions performed by Evolve Designer require that the application is run

with administrator privileges on your machine.

How to access and run Evolve Designer

For Dynamic Sites, or Static Sites that are directly published to a web server machine running Microsoft

Internet Information Services (IIS), Evolve Designer must run on the web server itself.
We recommend that you do the following two steps to access and run Evolve Designer:

1. Create a Desktop shortcut for Evolve Designer.

2. Configure the shortcut to force the application to run with administrator privileges.

What do you want to do?

Create a Desktop shortcut for Evolve Designer

To create a Desktop Shortcut for Evolve Designer:
1. Right-click on your Desktop background and select New > Shortcut
The Create Shortcut wizard opens
2. Click the Browse button to navigate to and select evolveDesigner.exe
The normal installation path is C:¥Casewise¥evolve¥Site¥bin¥evolveDesigner.exe

3. Click Next
4. Enter a name for the shortcut
5. Click Finish.

The shortcut is created.
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Configure Evolve Designer to run with administrator privileges

To configure Evolve Designer to run with administrator privileges:

1.

2.

Right-click the Desktop shortcut and select Properties
Click Advanced

The Advanced Properties dialog opens

3. Select the Run as administrator check box
4. Click OK

The Advanced Properties dialog closes

. Click OK

The shortcut Properties dialog closes.

Now, when you click the Evolve Designer shortcut on your Desktop, the program will run with

administrator privileges.
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Product Licensing

As of the 2020.1.1 release of erwin Evolve Suite / Web Platform, licensing is migrating to the standard Quest
Inc. license system. During the migration, there will be a grace period, whereby existing customers can
continue to use their existing Casewise licenses. Quest do not intend to force customers onto the new
licensing and will work with them to ensure a successful migration.

Ifyou are considering upgrading to 2022, you should not be concerned with the new
\_ ' licensing system, as its usage is optional at the moment.

Activating your Quest License

The process for activating an erwin Evolve license is:

1. Support will provide you with one or more license files per Server machine that requires licensing.

For example:

[E

license.dlv

2. Having installed the software, copy this file to your server's desktop.

3. Double click on the file. You will be presented with a warning:

User Account Contrel

Do you want to allow this app to make
changes to your device?

>
ﬂ' Registry Editor

Verified publisher: Microsoft Windows

Show more details

Yes

4. Click Yes to allow the tool to change the registry.
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License file was imported successfully, To make the licenses in
this file available please log in.

5. The software now has the purchased licenses activated on the server. To verify this, load the License
Manager.

Open erwin Evolve suite - Start Here.

erwin | cwsuite

MODEL ANAGE

/ Modeler Maodel Explorer
t Explorer
Matrix

Automadeler

License Manager

Reports information about the state of licenses on the current system, allows
youto request new licenses, and to configure licenses in a multi-user
environment,

Forinomaion weweincon Q) ) @) @

6. Click License Manager, and login.

7. License Manager will show the license code, and various other attributes.

B License Manager O X
File Records Licenses Help
License Name Producet Version Type License ID Expiry Date
Multi-User database erwin Evolve Suite CM200%.1 Client ClrmégsmadgZ2rmégsm3rmdgsmérade2 Does not expir
erwin Evolve Suite erwin Evolve Suite CM2009,1 Client Clrmégsmadg22rmagsmirmagsmérade Does rot expir
Evolve Web Platform Server erwin Evolve Web Platform CM2009.1 Client Cirmdgsmgdg22rmdgem3rmdgsmdrade? Does not expir
Evolve Web Platform Contributors (1) erwin Evolve Web Platform CM200%.1 Client Clrm4gsmadgZ2rmégsm3rmdgsmérade2 Does not expir
Evolve Web Platform Contributors (1) erwin Evolve Web Platform CM2005.1 Client ClrmégsmadaZZrmiasm3rmdgsmérade2 Does not expir
Evolve Web Platform Offline Generation erwin Evolve Web Platform CM2009.1 Client Clrmdgsmadg22rmaqem3rmdgsmarade? Does mot expir
Evolve Web Platform erwin Evolve Web Platform CM2009.1 Client Clrmdgsmgdg22rmdgsm3rmdgsmarade2 Does not expir
Aute Diagram Designer erwin Evolve Web Platform CM200%.1 Client Clrm4gsmadgZ2rmégsm3rmdgsmérade2 Does not expir
Evolve Web Platform Social Follower (Unlimited Users) erwin Evolve Web Platform CM200%.1 Client Clrm4gsmadgZ2rmdgsm3rmdgsmaradel Does not expir
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Returning your erwin License

If you need to move the license from one server to another, you must contact support, who
will assist with the migration.
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URLs, File Paths and Directory
Structures

This page explains how the URLs, file paths and directory structures work in Evolve.

Evolve Site URLs

There are three different URLs you can use to access Evolve, depending on how your deployment is

configured.
Accessing the main Evolve I/S Site
The main Evolve 11S Site is only accessible if you use Evolve Dynamic Sites. If you use only
Evolve Static, then this site is still created, but does not display anything.
When you install Evolve and Configure the Server, it creates a top-level Evolve IIS Site.

The Site is used to provide the Evolve login dialog, as well as to show the page displaying the list of Model

Sites that are available.

The site can be accessed using the following URL:

http://<server-name>/<evolve-11S-site-name>/
where <server-name> is the name of your web server machine, and <evolve-11S-site-
name> is the name you specified in the Server Configuration application.

Depending on which authentication method your Evolve server is configured to use, when you access the
Evolve IIS Site you log on and are then shown a list of all the Dynamic Model Sites you have access to. You

can click any of the Model Site links to visit that Site.
Accessing a Dynamic Site
Dynamic Sites are published at the following URL:

http://<server-name>/<evolve-11S-site-name>/sites/<site-url-name>/

Accessing a Static Site

Static Sites are published at the following URL:

http://<server-name>/<evolve-I1S-site-name>/statics/<site-url-name>/
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File paths and directory structures

This section explains the folder structure used by Evolve on the web server machine. The names used are

the default names for a typical configuration.

The Evolve files are typically found at C:¥Casewise¥Evolve

Within this directory, the following directories exist:

Folder

Description

Data

This folder contains all the necessary site-specific files created when you publish a Site.

Includes the following sub directories:

The Common folder contains all resources that are shared across all Dynamic Sites

Commo in Evolve, such as translated text and Site logos.

n
Logos for Model Sites listed on the top-level Evolve Site are also stored here.

The Sites folder contains a folder for each of the Dynamic Sites that are published.

Sites Each of these directories is named according to the Site ID in the deployment

settings for the Site, and contains the css, js, images and webdesigner sub

directories.

Stati The Statics folder contains a folder for each of the Static Sites that are published,
atics
which in turn contain all the published files and resources for the Site.

Site

Contains all the application files required for Evolve to run.

Also is the home of the custom folder used to store customizations such as js, css, themes and

images.

Log files.

Conten
t

This folder will only exist if you have had a previous version of Evolve on the machine.

Static

This folder will only exist if you have had a previous version of Evolve on the machine and had a
Static Site published.

Accessing object pages directly by the URL

There are two ways to access content directly in Evolve using URLs.

The Standard URL

Using the 'Share' button:

O
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Will allow a user to share a page with another user. It is also possible to gain the same behaviour by copying
the address bar URL from your browser and sharing this with other users. These URLs are model and site
dependent. This means that they will only work for a given site, generated by a given model. This is because
the identifier for the object is an ID that is local to the model. This is normal, and in almost all cases, is

exactly what is required.

A sample of a Standard URL:

localhost/evolve/sites/voxdnoev/index.html#/cwtype=single&cwview=process&lang=en&cwi
d=1767

Where: cwid=1767 is the local ID for an object.

The UUID URL [Evolve 2016.1.1 and above]

A UUID based URL differs in the way that it identifies objects in Evolve. A UUID URL is still site dependent,
in that the first part of the URL identifies the Evolve web site, however the latter part can be used with any
site that supports the given object type, and has an object with the matching UUID. This means that objects
which have been copied, or transfered by XML (or other means) from one model to another, will still be

considered to be the same object.

A sample of a UUID URL:

localhost/evolve/sites/voxdnoev/index.html#/cwtype=single&cwview=process&lang=en&cw
uuid= f0a9ed615e7b11e48273a08869a4da20

Where: f0a9ed615e7b11e48273a08869a4da20 is the UUID of the object.

How does this work?

When you access a URL using the cwuuid, Evolve will do a lookup in the model and redirect the page to the

matching cwid.

If both cwid and cwuuid are supplied in the URL, Evolve will ignore the cwuuid parameter.

Why might UUID based URLs be useful?

Take an example where you are running a master model in English, and take copies of this model to
translate into French. You want to add the ability to reference the translated object from the English object.
However, the IDs of the objects within the French model, may differ from those in the English model. It is

therefore not possible to create a simple reference.

In this instance it is possible to use the UUID based URL. You can simply take the site portion of the French
URL, and add the Object UUID from the English URL, and you have a new URL that can jump from French to
English.
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NB: To find the UUID of an object, either display this in your Evolve site design, or if you are developing a
custom view, look to the JSON data structure that is returned by the Evolve server.
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Creating your First Evolve Site

If you are new to Evolve, once you have familiarized yourself with the Key Concepts, Metamodel
Considerations and how to Run Evolve Designer, you can use the following pages to help you get your first
Site up and running.

Once you have completed these tasks, you should have a simple working Site containing all the fundamental
elements. Only once you have done this do we recommend that you go on to try different options.

1. Configure your server

2. Create a Site

3. Create a basic Index Page displaying a simple list of objects

4. Create a simple Object Page

5. Create a Menu to link to your Index Page

6. Publish your Site

7.0nce you have published your Site and tested that it works, you can go on to explore
how to extend your Site by creating more adventurous pages using the information in
the Layouts and Behaviors section.

\ | Important factors to remember when extending your site

As you go on to add more content to your site, remember these important factors:
e You must create an Object Page for each type of object you want to view.

e Your CW model must contain a Template Diagram with the same Category and
Rule combination for every Diagram you want to display in Evolve.
This must be one template only for each Category and Rule - if you have multiple
templates then Evolve will report an error.
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Creating Sites and Pages

Create a Site

Before you can create a Site, you must ensure you have completed the configuration of your
Evolve Server.

See Configure your Server for details.
These instructions explain how to set up a basic, empty Site, and then how to configure the deployment
settings so that it can be published.

Once the Site is created, you should follow the instructions in the rest of the help to learn how to create Index
Pages, Object Pages and a Menu.

An Evolve Site is explicitly linked to one CW Model. You can create one Site in each Model in your repository.

Creating a Site makes changes to your Model's meta model, resulting in new Object
Types and Associations being added to the Model.

If you are using Evolve for the first time and want to experiment with creating a Site, we
recommend that you create a copy of an existing Model and use that as the basis of

your Site.

Step 1 - Create a Site in your Model

To create a Site in your Model:
1.  Run Evolve Designer
2. Select the Model you want to create a Site in
The page updates to show Sites in your Model.

If your Model is not listed, you must enable it to support having an Evolve Site. To enable your
Model:

i. Click the plus (+) icon in the top-right of the dialog.
A pop-up menu listing all the models in your repository is displayed.

ii. From the pop-up, select the Model you want to use for your Site
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Your Model's meta model is updated with the new Object Types and Association Types required

for Evolve. This process may take a few moments.

Once the Model is updated, an icon representing the Model is displayed in the Evolve Designer

window.
3. On the Sites page, click the (+) icon in the top-right of the dialog.
The New Site dialog is displayed.
4. Enter a Name for your Site in the Site Name field

5. Click Create.
Step 2 - Configure the Site settings

To configure the Site settings:
1. In Evolve Designer click the top Site node.

2. Review the following settings:

Setting Description

Site

Language Choose the language of the Site if you want to override the global Evolve setting.
Select 'None' (default), 'Comma’ or 'Space' to specify which number separator is used
when displaying numbers on your Evolve Site.

Number For example:

Separator None - 1000 or 1000000
Comma - 1,000 or 1,000,000
Space - 1 000 or 1 000 000

Less Theme Choose the theme of the Site if you want to override the global Evolve setting.
Static Sites only.

Export Use this option if you are publishing your Site in Static mode and you are showing

Diagram Diagrams created in CW Modeler using the CW Modeler Diagram behavior.

Images You can leave this option unselected if you are not displaying diagrams or are only
using the Vector (HTML5) behavior to prevent images of diagrams being generated
when you publish your Site - a process which can take some time.
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See the Evolve Configuration Reference for details on the full list of settings.

3. Select the Deployments > [server name] > Model node (showing the Scriptname of the Model

your Site is in).
The settings are shown in the right-hand pane

4.  Complete the following fields:

Setting Description

Specify the name of this Model Site as it appears in the URL, such as
http://<server-name>/<evolve-11S-site-name>/[sites|statics]/<site-url-

name>/

Site URL Name ) )
Ensure that the name is all lower-case and has no spaces or special characters.

To change the Site URL Name for an existing Site, see: Change the URL Name
of your Site.

Site Display | Enter the name of your site. This is only displayed on the top-level Evolve Sites
Name page.

Dynamic Deployments Only

This control now replaces the single mapping per license type, allowing a much

greater level of control of groups.
The control is used for both Active Directory and SAML2 configurations.

AD Group - is used to specify the name of the Active Directory group you want
to use for this configuration. It is also used for the name of the "Outgoing Claim
AD Mapping Type" in a SAML2 configuration.

If a user is a member of this AD Group or Claim, then they will assume the
permissions indicated on this row of the table. If a user is a member of multiple
Groups or Claims, then they will receive the aggregate of the permissions, with
the exception of CW User Type, which will be promoted to the highest license

type they are allowed.

Dynamic Deployments Only - this can be one of "Social", "Contributor",

"Diagrammer".

AD Default | Dynamic Deployments Only
Social Role | Only used if the Evolve Authentication Method is set to Active Directory.

Name Specify the default Role you want newly created Evolve Social users to be given.
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Dynamic Deployments Only

AD Default i o . . .

. Only used if the Evolve Authentication Method is set to Active Directory.
Contributor
Role Name Specify the default Role you want newly created Evolve Contributor users to be

given.

Display Model | Applies to Dynamic Sites only.

in Evolve
Use this option to specify if this Model Site is available or disabled in Evolve.

See the Evolve Configuration Reference for details on the full list of settings.
5. Save the Site.
The settings are complete.
Step 3 - Publish your Site
Now the Site and IIS are configured, you must publish your site so that all the required files are generated and
placed in the correct location on the web server.
To publish your Site:
In Evolve Designer, click Dynamic Site or Static Site in the Publish area on the Home menu.
All the Site's files are generated in the correct location for the web server to host them.

The status area at the bottom of Evolve Designer updates as the various processes involved in

publishing are performed. Once the operation is complete, it reports 'Site generated in ....".

These instructions are for publishing your Site for the first time - there are different publishing
options for when you are editing a Site that has already been published. See Publishing your
Site for full details.

Accessing a Dynamic Site

You can access a Dynamic Site at the following URL:

http://<server-name=>/<evolve-11S-site-name>/sites/<site-id>/

Accessing a Static Site

You can access a Static Site at the following URL:
http://<server-name>/<evolve-11S-site-name>/statics/<site-id>/
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Layouts and Behaviors Explained

Evolve offers many different possibilities for how you want the information in your Index Pages and Object
Pages to be displayed.

These display options are controlled by Layouts and Behaviors.

Layouts control the physical structure of the web page, whereas Behaviors control how the data is
displayed inside the Layout. Some Behaviors can only work with certain Layouts. Additionally, some Layouts
and Behaviors can only be used on Index Pages, while others can only be used on Object Pages. However,
some can be used on both.

Use the table below to see all the page display options available in Evolve, then follow the links to find out

how to create them in your own Site.

There are a number of different options for how you want to display the properties of objects
on Object Pages. For full details on these display options see:

Working with Property Groups and Property Group Layouts

Page Display Options

. Editable .
Type Example Description R Used in
The Simple List is the default Layout
for all new Index Pages and displays
o . Index
= objects in a simple bulleted list.
. . Pages
Slmple List On Object Pages this layout is used to | No .
. Object
show related objects, such P
as Associations or Diagrams the ages
object appears on.
An Accordion is an Object List where
each object reference is clickable and
can be expanded to show further
L information about the object - either
Accordion .| PrOperties of the object, or associations. | No Index
e Pages
When you use an Accordion, you can
nest other Layouts and Behaviors inside
it, such as another list of Associated
Objects.
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Table
(Complex)

A Table (Complex) behavior displays
objects and properties in table format.
You can choose which properties to
display as columns, and you can include

associations.

Users can sort the list by clicking
column headings, and they can
optionally edit objects directly in the
Table itself.

Yes

Index

Pages
Object
Pages

Table
(Simple)

The Table (Simple) layout creates a
basic table for displaying lists of data,
with the ability to open the Object Page

for a listed item.

No

Index

Pages
Object
Pages

Simple
Matrix

A Simple Matrix creates a table which
displays Associated Objects for the
object in question, and shows which
other similar objects these Associated

Objects are associated to.

For example, you could show which Risk
objects your Process is associated with,
and which other Processes are

associated with those Risks.

No

Object
Pages

Tabs
based on
Lookup
Values

This list-type display organizes your
objects into groups based on the value
of Lookup properties (drop-downs such
as Category).

Vertical tabs on the left side of the page
are used to represent the values, while
the objects themselves in each tab are
displayed in simple lists.

Option

You can optionally include an Overview
Chart which creates an 'Overview' tab
displaying a Pie Chart showing the

proportion of each value.

No

Index

Pages
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The Pie Chart based on Lookup
Values display creates a chart for a

specified Object Type showing the

Ple Chart percentage of objects with values from
based on one Lookup (drop-down) property. No Index
Lookup o Pages
The chart is identical to the
Values optional Overview Chart offered by
the Tabs based on Lookup
Values display.
A Recursive Pie Chart allows you to
show a top-level chart which sums the
values of properties of associated Index
Recursive . objects (or Intersection Objects), and No Pages
Pie Chart then allows users to click those items to Object
view a second chart showing all the Pages
objects associated to the selected
object.
Index
A Roadmap is a type of Gantt Chart that Pages
Roadmap enables you to show a number of [ No .
objects and their start and end dates. Object
Pages
A Lifecycle Roadmap is a type of Gantt
Chart that enables you toshow a
Lifecycle __'———__;—_ number of objects, displaying their No Index
Roadmap ___——: overall time frame, as well as Pages
highlighting in different colors any
number of phases of their lifecycle.
A Cost/Benefit Chart enables you
to compare properties you class
Cost - as Costs in your organization against
Benefit _ properties you class as Benefits. No :;fe;
Chart . The result is a chart that allows you to &
evaluate your expenditure in terms of
business importance.
Simple Bar Th? Simple Bar Chart behavior displays Index
Chart a simple bar chart on your Index Page, | No Pages

listing a maximum of 20 objects on
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the yaxis and referencing a

simple number property on the x axis.

On your Index Page, the Multi-Axis Bar

Multi-Axis Chart behavior displays a simple bar N Index
o
Bar Chart chart which compares the values of two Pages
properties of the objects referenced.
Simple Bubble Charts allow you
. e to compare objects of the same type,
Simple _
. : by analyzing three levels of data and Index
Bubble :: . , , No
ch + using the values to affect the size and Pages
art position of the representations on the
chart.
Cluster Bubble Charts are similar
Cluster — to Simple Bubble Charts, except they i
ndex
Bubble . allow you to visualize the properties of | No 5
ages
Chart an Associated Object (directly or &
indirectly), or an Intersection Object.
The Visual Identity layout is used to
show a list of objects with visual
indicators to represent some of their
properties.
Index
. The layout displays each object as a
Visual Pages
. rectangle, and then at the bottom of | No
Identity . Object
each shape you can show icons
P
to represent the values of one or more ages
properties of your object.
The Visual Identity layout requires
a Custom Site deployment.
The External Picture layout can be
used to display an image, stored on the Index
External m H Evolve server, which is referenced as a Pages
. : . No
Picture I:"J property of an object. Object
The External Picture layout requires Pages
a Custom Site deployment.
The Image Layout is used to display an Index
Image _ ge Layo! | No
image for an object that is referenced Pages
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using a Single-Line Object
Text or URL Property. Pages
It is used on its own, not together with
other properties, so suits larger images
more.
Vector Maps enable you to highlight Index
countries or places on a map so that Pages
Vector Map : No ,
the user can click through to see more Object
detailed information about that area. Pages
The Radar Layoutis used to display
and compare three or more properties of ind
ndex
an Object, or many Objects, in one
Pages
Radar chart. No
. . . Object
It is used on its own, not together with
) ) ) Pages
other properties, so suits larger images
more.
Index
. Pages
View Box Layout reserved for internal Evolve use. | No
Object
Pages
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Working with Index Pages

Index Pages Explained

Index Pages are the top-level pages in your Site. They are generally the starting point for users browsing your

Site. For navigation purposes, in order to view an Index Page it must be linked to a Menu.

Index Pages essentially display lists or representations of objects which can be expanded on by supporting

Object Pages which show more information about the object in question.

So users typically find objects they are interested in on Index Pages and follow links to Object Pages providing

more detail.

Index Pages are generally tied to a specific Object Type, but you can have multiple Index Pages per Object
Type.

There are three types of Index Page:

1. Object listing pages, such as lists, grids, and accordions
2. Graphical pages, such as bar charts, maps, pie charts and roadmaps

3. Diagram pages, showing CW Modeler diagrams or visualization diagrams.

What do you want to do?

Create an Object List Index Page

Create an Empty Index Page

Create a Diagram Index Page

Create a Graphical Index Page

Use Tabs to organize content on an Index Page
Create Multiple Index Pages for an Object Type

Extend display options with Layouts and Behaviors
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Create an Object List Index Page

The instructions on this page detail how to create a basic Index Page which displays a simple list of objects.

This is the default display setting for all new Index Pages.

Basic Object List Index Pages only display the Name of the objects listed within them.

While these instructions describe how to create a basic Object List page, Evolve offers many
different options for how you want to display content in your pages.

To find out more about these different display options and how to configure them, see \Working

with Page Layouts and Behaviors.

Creating a basic Object List Index Page is a two-step process. Follow the steps below.

Step 1 - Create the page

To create a new Index Page:
1. In Evolve Designer, expand the Site node.
2. Right-click the Index Pages node.
3. Select Add Index Page for Object Type.
4. Scroll through the pop-up list to select an Object Type to base the Index Page on

The new Index Page is created and is placed at the bottom of the list of Index Pages in the tree. It is

given a default name of index_<object-type-name>.
If you close and reopen Evolve Designer, then the new page will be listed alphabetically.
Step 2 - Specify the page properties

Once you have made an Index Page you should configure its properties.

To specify the page properties:
1. Select the node for the Index Page
The right-hand panel shows the properties for the page

2. Edit the page's properties:

o Use Page Name to specify the name of the page as it appears in the URL.

Please note you can only use lower case letters with no spaces.
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() The Page Name must be unique, but generally you can leave it as the default. The only time you
will need to edit the Page Name is if you have more than one Index Page per Object Type.
See Creating Multiple Index Pages for an Object Type for more information.

If you change the Page Name and you already have a Menu linking to the page, you must

also change the Menu Link as it is not updated automatically.

o Use Page Display Name to set the name of the page as it appears in Evolve web pages, in

Menus.

o Page Title is not available for index pages.

o Use Add Page Filter to specify if you want the filter control available on the page - so a user

can filter the displayed list of objects.

o Use Has Image to specify the image and styling to be used when the page appears in a

menu.

Selecting Has Image enables the following properties:

3. Save your Site.

Use the Custom Image drop-down list to select an icon to be displayed
alongside the Page Display Name in the published web pages. These icons are

part of the Theme applied to your Site.

If you chose a Custom Image, use Apply Color Transformation to specify the

color transformation to the icon

If you chose to Apply Color Transformation, select the color to use from

the Color Transformation drop-down list

To apply a hover effect to the icon, use the Apply hover effect to the
image check box.

The Index Page's properties are saved.

( }:) Remember that to view your page you must have a Menu which links to it.

See Create and Edit a Menu for more details.

Related Topics

Use Page Queries and Filters to display just the objects you want

Use Tabs to present your data
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Use a Custom Display String to show more than just the object Name

Display your data using different Layouts and Behaviors
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Create an Empty Index Page

The instructions on this page detail how to create an empty Index Page that is not linked to any Object Type.

You might want to do this if you are creating some of the more complex page types, such as Cluster Bubble

Charts and so on.

Once you have created the page, you can then add an Object Type node, a Tab Controller, or both, depending

on what the behavior you plan to use requires.
What do you want to do?

Create an empty Index Page

To create an emply Index Page:
1. Right-click on the Index Pages node and choose Add Index Page.
A new Index Page node is added to the bottom of the list of Index Pages

2. Select the new Index Page node and edit its settings accordingly, particularly Page Name and Page
Display Name
o Use Page Name to specify the name of the page as it appears in the URL.

The page Name must be unique and can only contain lower case letters, numbers, dashes and

underscores, with no spaces.

If the Page Name is not unique, or it contains illegal characters, you will see an error when you try

to Save the Site.

o Use Page Display Name to set the name of the page as it appears in Evolve web pages,
such as for its title or in Menus.

3. Save your Site.

Remember that to view your page you must have a Menu which links to it.

See Create and Edit a Menu for more details.
Add an Object Type node to an empty Index Page

To add an Object Type node to an empty Index Page:
1. Right click the Index Page node and choose New Object List > [object-type]

Where [object-type] is the name of the Object Type you want to add.
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An Object Type node is added to the Index Page.

2. Save your Site.

Add a Tab Controller to an empty Index Page

To add a Tab Controller to an empty Index Page:
1. Right-click on the Index Page node and choose New Tabs Controller
A new Tabs node is added.

2. Save your Site.

Related Topics

Use Page Queries and Filters to display just the objects you want
Use Tabs to present your data
Use a Custom Display String to show more than just the object Name

Display your data using different Layouts and Behaviors
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Create a Diagram Index Page

A Diagram Index Page is used to display either a single CW Modeler diagram, or a Visualization diagram.

Shapes in the diagram are clickable, linking through to the relevant Object Pages for the Object Type selected.

—~
( ‘;, || In order to display diagrams in Evolve Sites, you must ensure you have a template diagram in your

model which has the same Rule and Category as the diagram you want to display.

If you do not have an equivalent template diagram, the diagram will not be able to be displayed.

What do you want to do?

Display a CW Modeler Diagram on an Index Page.

= S .
() These instructions assume you know how to Create a basic Object List Index Page.
NG/

To display a CW Modeler Diagram on an Index Page:

1. Create a new Index Page for the Object Type 'Diagram'.
2. On the 'Diagram' node, use the Filter Properties area to specify exactly which diagram you want to

show.
We recommend you use the ID property as the reference and specify the ID of the diagram you want.

Remember that any properties you reference in the Filter Properties area should also be selected in
the Selected Properties area.

3. Right-click the Layout node and choose Switch Layout > CW > Diagram.

4. Right-click the Layout node and choose Add Behaviors > CW Modeler Diagram.

5. On the CW Modeler Diagram node, use the Full Screen setting to specify that the diagram is displayed
in full-screen mode.

6. Save your Site.

7N
( " )| If you plan to publish your Site as a Static Site, you must ensure you use the Export Diagram

\

Images option on the Site node settings toensure images of your diagrams are generated.
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Create a Graphical Index Page

There are several different display options for graphical Index Pages, including:

Pie Charts (including Pie Charts based on Lookup Values and Recursive Pie Charts).
Bubble Charts.

Bar Charts - Simple (Limited) and Multi-Access.

Roadmaps - Basic and Lifecycle.

Cost-Benefit Chart.

Vector Maps for displaying locations.

Each of these different types of Graphical Index Pages start out as basic Index Pages.
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Create Multiple Index Pages for an Object
Type

While Index Pages are typically linked to a specific Object Type, you are not restricted to having just one page

per type.

Evolve allows you to create as many Index Pages as you want for any given Object Type.

You might do this to have different Index Pages for different Categories of an Object Type, or to display only

those objects associated with another object.
You can then use Sub-Menus to link to link to the different Index Pages you have.
If you do want to use more than one Index Page for an Object Type, there is one important factor you must
be aware of:
The Page Name of an Index Page must be unique.

When you create additional Index Pages for an Object Type, the default Page Name is always the
same -index-[object type name], such as index-process.

You must ensure that you give a unique name to each page to avoid any conflicts.

When editing the Page Name, you can only use lower case
letters, numbers, dashes and underscores, with no spaces.
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Working with Object Pages

Object Pages Explained

An Object Page is used to present the details of an Object Instance - a web user selects the object on an
Index Page or Diagram, and the Object Page displays its properties.

You must have an Object Page configured for each type of Object you want to see the details of in your Evolve
Site.

You can organize the information presented in an Object Page into Tabs, and you can present different views

of the data using Object Page Views.

In addition to just an object's properties, Object Pages can be used to display Diagrams - both Visualization

Diagrams and standard Diagrams that relate to the object - as well as Associated Objects in Lists or Tables.

What do you want to do?

Create a new Object Page
Create an Object from a Grid
Present your data using Tabs

Offer different perspectives with Object Page Views
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Create an Object Page

An Object Page is used to present the details of an Object Instance - a web user selects the object on an

Index Page or Diagram, and the Object Page displays its properties.

You must have an Object Page configured for each type of Object you want to see the details of in your Evolve

Site.

You can create more than one Object Page per Object Type. Additional Object Pages you create
for an Object Type are displayed as Views.

For more information about creating multiple Object Pages as Views, see: Object Page Views.

Important: You can only display an individual Property Type, or an Association Type, once on an

Object Page, including across Tabs.

Creating a basic Object Page is a multi-step process. Please follow the steps below.

Step 1 - Create the Page

To create an Object Page:

1. In Evolve Designer, expand the Site node.

2. Right-click the Object Pages node.

3. Select Add Object Page for Object Type.

4. Scroll through the pop-up list to select the Object Type the Object Page represents

The new Object Page is created and is placed at the bottom of the list of Object Pages in the tree. It is

given a default name of <object-type-name>.
If you close and reopen Evolve Designer, then the new page will be listed alphabetically.
Step 2 - Specify the page properties

Once you have made an Object Page you should configure its properties.

To specify the page properties:
1. Select the node for the Object Page.
The right-hand panel shows the properties for the page.

2. Edit the page's properties:
o Use Page Name to specify the name of the page as it appears in the tree in Evolve

Designer. Please note you can only use lower case letters with no spaces.
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=
( \j, We recommend you do not change the Page Name, unless you are creating an additional Object

Page for the Object Type to act as a View - in which case you must give it a unique name to avoid

a conflict.

Use Page Display Name to set the name of the page as it appears in Evolve web pages,

o
such as in the menu of Views.

o Use Page Title to set the name of the page as it appears in Evolve web pages, as the title of
the Page. Introduced in version 2018, it has possible to use a Custom Display String, to
format the Title.

Evolve Designer (Test > TEST) - v2018.0.00

bject Page PageType
Add Page Fite

Customazed Page

3. Save your Site.
The Object Page's properties are configured and saved.

You have now created an Object Page, but it will not yet display any content.
Step 3 - Show some content
The instructions here explain how to insert a simple Property Group displaying the basic
properties from the '‘General’ Pane of the object. Object Pages can display much more than this
simple element.

You can also use Tabs to display more content on Object Pages, including Object Lists for

Associated Objects, rather like you would on an Index Page.

The simplest way to display some content is to show some properties of the Object being viewed.

You do this by inserting a Property Group.

To insert a simple Property Group:

1. Expand the node for the Object Page
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2. Right-click the Object Type Name node, for example 'Process’, and choose New Property Group >
From CM Panel > General

A 'General' node is added beneath the Object Type Name node.
3. Save your Site.

The Object Page is saved.

To read more about Property Groups and how to use them, see Working with Property Groups.
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Creating Objects from an Object Grid Using
Object Pages (4.0.2 onwards)

You can new create objects in an Object Grid by utilising an existing Create Object page.

7o do this:

1. Check the Add Object box
2. Check the Use Object Page For Add box
3. In the Create Object Page Name, select the Object Page from which you wish to generate additional

objects.
Layouts Options [cwWebDesignerTreeNodeBehaviourKendoGrid] - Table (Complex)
ERSE ~
= ™ Mode Name Table (Complex)
B-4) Index Pages
- | ] index_applications Add Object
= o Application -
B E Layout Empty Use Object Page For Add
i gl Teble (Complex) Create Object Page Name licat
O Application - Organisation () application
D index_applications_gridwithtab Edit Object
D index_applications_inlinegrid_with_association
D index_applications_inlinegrid_without_association EditMade Popup
D index_cw_views Delete Object
- | ] index_diagrams
D index_diagramsa. Unlink Object
]
- | ] index_entities
[ index locations Intersection Object Grid
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Object Page Views

Just as you can have Multiple Index Pages for one Object Type, you can also have multiple Object Pages for
an Object Type.

When you have more than one Object Page for an Object Type, it is called a View.

You can use Views to offer a different perspective on the object in focus, perhaps showing a different set of

properties to the default page, or show the object in context, based on its relationships to other objects.

When a user views an Object Page, the default page is the one which has a Page Name matching the Object
Type name, such as 'process' for the Process Object Type. Any other pages, or Views, are displayed as links

in a menu above the page title, so the user can click them to view the pages.
Creating Object Page Views

To create an Object Page View, simply create a new Object Page for your Object Type - in exactly the same
way you would for any Object Page.

However, you must make sure your new Object Page has a unique Page Name - you cannot for example

have two Object Pages titled 'process’, so you should rename the new one so that it is different.

In every other respect, creating an Object Page View is the same as creating a standard Object Page.
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Working with Menus

Create and Edit a Menu

The Menu appears on the left-hand side of your Evolve web pages and links to pages you have created in

your Site.

However, you must add the links in the menu yourself, giving you full control over how they are displayed

and in what order the menu items appear.
You can add menu links to the following items:
e Index Pages.
e Create Object pages (Dynamic Sites only) - Object Pages that allow users to create new objects.

e Administration Pages (Dynamic Sites only) - either for viewing administration data such as Roles,
Questionnaires and so on, or as Create Object pages to allow users to create new objects of these

types.

=
(0 || To use a Create Object page in your Dynamic Site, you must have created an Object Page or

NS

Object Page View in advance, and you must make sure that the Object Page is configured using
Property Groups to display all the properties that the user must enter - including
all mandatory properties.

Menu levels

The Menu in Evolve is structured so that there are top-level menu items each with one or more sub-menu
items.

Top-level menu items cannot be configured to link to individual pages, only sub-menu items can link to

actual pages. Therefore you should think of the top-level menu items more as groups of sub-menu links.

You can also add sub-menu groups, which contain sub-menu links. In fact, you can create multiple levels of

nested menus using this method.

What do you want to do?

Add a new top-level menu item

To add a new top-level menu item:
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1. In Evolve Designer's Layout pane, right-click the Menu node.
2. From the pop-up menu, choose Add Menu Link.

A new node titled 'Menu Link' is created beneath the Menu node.

3. Select the new Menu Link node
4. Enter a title for the Menu Link using the Node Name field

This is the name of the top-level menu item as it appears in the web pages.

Set an icon for a menu item

To add icons to display next to menu items:

1. In Evolve Designer's Layout pane, click the Menu node to display the menu links within it
2. Select the Menu Item you wish to set an icon for

3. Select the Icon Library, IconColor and Icon for the menu item.

4. Save your Site.

Custom Icons can ONLY be added to Index Pages and Object Pages, but not top level menu

items.

Add a link to an Evolve page

You can add menu links to Index Pages and Object Create pages which allow users to create
new objects.

You add a menu link to a page by creating a new sub-menu item for an existing top-level menu

item or sub-menu group item.

To add a menu link to an Evolve page:

1. Right-click the menu node you want to add the menu link to.
2. Add your link:

o To add alink to an Index Page, choose Add Index Page Link > Custom Pages > and
select the Index Page you want the sub-menu item to link to.

o To add alink to a Create Object page to allow a user to create an Object in your
model, choose Add Create Object Page > Custom Pages > and select the Object Page
you want to link to.

A new sub-node is created representing the sub-menu jtem that will appear in that menu
group.
3. Select the new sub-node.
4. Use the Node Name field to enter the name of the sub-menu item as it will appear in the web pages.
5. Save your Site.
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Add a sub-menu group node

Sub-menu group nodes are used to create multiple menu levels. You can add one to a top-level
menu, or to any existing menu item. Like top-level menu items, sub-menu group nodes do not

link to a page, instead they are used to contain or group one or more sub-menu links.

To add a sub-menu group node:

1. In Evolve Designer's Layout pane, expand the Menu node.
2. Right-click the menu item you want to add the sub-menu group to.

3. From the pop-up menu, choose Add Menu Link

A new node titled 'Menu Link' is created beneath the selected node

4. Select the new Menu Link node.
5. Enter a title for the Menu Link using the Node Name field.

This is the name of the menu item as it appears in the web pages.

You can now add sub-menu links to this new node.

Add a link to an Evolve Administration Page

You can add menu links to built-in pages to view administration data, such as Roles,

Questionnaires and so on, as well as to Object Create pages which allow users to create new
Objects.

You add a menu link to a page by creating a new sub-menu item for an existing top-level menu

item or sub-menu group item.

To add a menu link to an Evolve Administration Page:

1. Right-click the menu node you want to add the menu link to.
2. Add your link:

o To add a link to an Administration Index Page, choose Add Index Page Link > Standard
Pages > and select the Administration Page you want the sub-menu item to link to.

o To add a link to an Administration Create Object page to allow a user to create an
administration object, such as a Role or Question, choose Add Create Object Page >

Standard Pages >and select the page you want to link to.

A new sub-node is created representing the sub-menu item that will appear in that menu

group.

3. Select the new sub-node.
4. Use the Node Name field to enter the name of the sub-menu item as it will appear in the web pages.

5. Save your Site.

erwin Evolve — User Help Guide |
Creating Sites and Pages |



Change the order of the top-level menu

The order of the top-level menu can be changed by selecting and dragging the top-level menu nodes and

dropping them on main Menu node.

When you drag a node and drop it to the main Menu node, that node is then placed at the bottom of the list.
To create the order you want, drag and drop the top-level menu nodes until the tree is ordered accordingly.
Change the order of sub-menu items

The order of the sub-menu items can be changed by selecting and dragging the sub-menu nodes and

dropping them on parent top-level menu node.

When you drag a sub-menu node and drop it to the top-level menu node, that node is then placed at the
bottom of the list.

To create the order you want, drag and drop the sub-menu nodes until the tree is ordered accordingly.

Delete a top-level menu or sub-menu item

To delete a top-level menu or sub-menu item:

1. In Evolve Designer's Layout pane, expand the Menu node.
2. Select the top-level menu node or sub-menu node you want to delete.
3. Right-click and choose Delete.

The item is deleted. If you deleted a top-level menu node, all its sub-menu items are also deleted.
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Publishing

Publish your Site

Evolve offers different options for publ ishing a Site. Use the table below to determine which option to use at

any given time.

You can also publish your site via batch command or scheduled task. To find out more about

batch publishing, see Command Line Publishing.

Menu: Home

Function Description
Dynamic Use when you publish your Dynamic Site for the first time, or when you want to do a full re-
Site publish - including all of the other options detailed below.

L Use when you publish your Static Site for the first time, or when you want to do a full re-
Static Site

publish - including all of the other options detailed below.

Menu: Dynamic Deployment / Static Deployment

The following functions are duplicated on the Dynamic Deployment and Static Deployment menus, as they

perform the same function and are different only in the respect of whether you are publishing a Dynamic or

Static Site.
Function Description
Use this option if you show Diagrams in your Site and have edited any of the Templates
they are based on.
Diagram Note: Only the Diagram Templates are updated during this operation - changes to Site
Templates pages are not published.
Note: Web Modeler Diagram Templates will be kept up to date automatically, there is
no need to use this option when you make changes to templates in Evolve Suite.
Use this option if you have changed the Site's Theme or any of the icons used for the
Theme & Menu or Pages - this includes adding new Pages that have custom images.
Pictures Note: Only the theme and pictures are updated during this operation - changes to Site
pages are not published.
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Use this option to publish just the Site pages without updating Diagram Templates,

Deploy Site )

Theme and Pictures.

Use this option to Save the Site, then publish just the Site pages without updating
Save & Diagram Templates, Theme and Pictures.
Deploy Site It is likely you will use this option most of the time when creating and configuring

your Site.
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Command Line Publishing

You can if you wish publish your Site using a Command Line operation - which you could use to create a

scheduled task, or batch command.
You might want to do this if you have a Static Site and want to ensure your users are viewing the latest data
in your Model - so you could re-publish the Site daily or weekly.
To create a batch command for Command Line publishing:
1. In Evolve Designer, right-click the Model node for your Deployment and choose Add Batch Node.
A Batch Node is added below the Model node.
2. Select the Batch Node and configure the settings as follows:
i Use Node Name to change the name of the Batch Node
ii. Use Connection to select the CW repository you want to publish from
By default the Connection you are using while logged in to Evolve Designer is selected
iii. Use CW User Name to enter the name of the CW User you want to generate your Site as

iv. Use CW User Password to enter the password for the above User, ensuring you click
the Encrypt button

3. Save the Site
4. Right-click the Batch Node and choose 'Copy batch script into clipboard

The command is copied to the clipboard for you to paste where you need it.

You can now open a Command Prompt and paste the command into it, paste it into a batch file, or

paste it into a Scheduled Task configuration.
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Use Tabs to Present your Data

Tabs are used as a way of grouping and controlling the way you present different information in your Index

Pages and Object Pages.

For example, on an Object Page, you might have a Tab showing the General properties of an object, then
use another Tab to show a list of Associated Objects, or Diagrams that the object appears on.

On an Index Page you might want to display some charts and a Table, offering different views of the same

information.

By using Tabs you can include much more information than the basic object list or object details, but all

content on the page must be displayed on a Tab.

,//‘ 3
t’\ ! \) Please note that having multiple Tabs each referencing different Object Types could impact the

performance of your page, so we recommend being careful about not overloading the page with

content.

What do you want to do?

Add Tabs to an Object Page

a\ .
[ U )| These instructions assume you do not yet have any Tabs, but you do have a clean Object Page
=5
~ | node, with an Object Type node already set to an Object Type, and a Layout set to Object Page.

To add Tabs to an Object Page:
1. Under the Object Page node, right-click the Object Type node and choose New Tab Controller.
A new Tab node is added to the tree.

2. Select the Tab node and use the Side drop-down to choose whether you want the tabs to be
displayed Horizontally or Vertically in your page.
3. Right-click the Tab node and choose New Tab

A new Tab titled 'Tab' is added to the tree
4. Select the 'Tabo' node and edit the Tab Name to what you want to be displayed in the web page.
Repeat steps 3 to 4 to add multiple Tabs to your page.

5. Save your Site.
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Add content to a Tab on an Object Page
Once you have one or more Tabs, you can choose what content to display in them. Within a Tab you can

display Property Groups, or Associated Objects displayed as a list, Table, or other layout option.

When you add new content, you use the Tab itself as the parent node.

See Working with Property Groups to find out how to add Property Groups to a Tab.
See Working with Layouts and Behaviors to find out the different display options within Object Pages.

Add Tabs to an Index Page

You cannot add Tabs to an Index Page that already includes content - you must either Delete the
existing content first, or create a new Index Page.

If you want to add Tabs to an Index Page, the Tab node must be the top-level node for that page in Evolve

Designer.

There are two ways to achieve this:

1. Create a new Index Page, but instead of using the Add Index Page for Object Type option, use Add
Index Page

2. Use an existing Index Page, but Delete the Object Type node and everything below it - do this by
right-clicking the Object Type node and choosing Delete. All previous content will be lost if you do
this.

The instructions below assume you have a clean Index Page node with no other nodes
beneath it.

To add Tabs to an Index Page:
1. Right click the Index Page node and choose New Tabs Controller.
A Tabs node is added below the Index Page node.

2. Select the Tabs node and use the Side drop-down to specify whether you want the Tabs to be
displayed Horizontally or Vertically on the page.
3. Right-click the Tabs node and choose New Tab.

A new Tab node is added.

4. Select the Tab node and use the Tab Name field to specify the name of the Tab as you would like it
too be displayed in the web page.
5. Right-click the Tab node and choose New Object List > [object-type]

An Object Type node and a Layout node are created.
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6. Save your Site.

You can now configure the content in the same way as you would for a normal Index Page without
Tabs.

Add content to a Tab on an Index Page
Once you have a Tab on an Index Page, you must create an Object Type node for the Tab - until you have an
Object Type node you cannot add any content.
To do this:

1. Right-click the Tab node and choose New Object List > [object-type]

An Object Type node and a Layout node are created.

Once you do have an Object Type node, you can add content just as you would for any Index Page.
See Working with Layouts and Behaviors for instructions on adding the different content types.

Add a new Tab to an existing Tabs Controller

To add a new Tab to an existing Tabs Controller:
1. Right-click on the Tabs node and choose New Tab
A new Tab is added to the bottom of the list of Tabs.
Change the order of Tabs in your page

You can change the order of Tabs in your page by dragging and dropping Tabs to the parent Tab node.
When you do this, the Tab you moved is placed at the bottom of the list. By dragging and dropping Tabs in

the same order you want them to appear on the page, you can make the tree show them in the correct order.

Delete a Tab

To Delete a Tab:
1. Right-click the Tab you want to delete and choose Delete.
A confirmation dialog is displayed.
2. Click Yes.

The Tab is deleted.
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Use Custom Display Strings

On certain page layouts and behaviors you can now build a custom string to display the properties of your

objects or associated objects.

So, instead of just showing the Name of an object, you can build a string mixing one or more property values

of the object with some standard text.

For example, if you are listing Application objects, and they have a number property titled ‘Cost’, you could
specify a custom string to display the Application Name, followed by the Cost — such as ‘Application 1 -
$500'.

You can even show some meta data, such as the Object Type Name or Pluralname, or lookup
abbreviation.

And, if you have a Custom Site which is configured to support Visual Indicators, you can display them
within a Custom Display String.

A simple syntax means it's easy to build the custom strings, using curly brackets {} to display property

values and all other text being displayed as it is.
You can use custom property strings with the following layouts and behaviors:
e Accordions - including when nested
e Simple Lists
e Tables — when listing Associated Objects in a column
e List Boxes
e External Picture layout

e Visual Identity layout.

The page filter/search does not work with custom display strings and can only filter based on

Name.

URL property types are displayed as plain text with no hyperlink.

What do you want to do?

To create a Custom Display String

To create a custom display string:
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1. Select the Object Type or Association Type node you want to create the string for

2. Ensure all the properties you want to include in your string are selected in the Selected Properties
area

3. Select the Layout node for your page

4. Enter your custom string in the Custom Display String field, for example '{name}: ({type})' to display
the object's Name, followed by a colon and its Category in brackets.

Use the following syntax rules:

o Use curly brackets {} to surround Property Type scriptnames, for example {name}

o Scriptnames must be entered in lower case

o All other characters not included in curly brackets {} will be displayed as plain text

o Use {cwobjecttype} to display the Object Type Name, for example, 'Process'

o Use {cwobjecttypes} to display the Object Type Pluralname, for example, 'Processes'

o Use '_abbreviation' after a lookup scriptname to display the Abbreviation for the drop down value, for
example {type_abbreviation}

o Use'_id' after a lookup scriptname to display the ID for the drop down value, for example {type_id}.

If you leave the Custom Display String field blank, your layout or behavior will default to
displaying the Name.

If you enter incorrect syntax, it will be rendered as text in the web page.

5. Save your Site.
Use Visual Indicators inside a Custom Display String

If you have a Custom Site which is configured to support the use of Visual Indicators, you can display
them directly in a Custom Display String.

To do this, simply insert the reference in the custom string using the following syntax:

{<property-type-scriptname>_image_mapping}

For example:
{type_image_mapping} or {validated_image_mapping}

Remember to ensure the properties you reference here are also selected in the Selected

Properties area for the parent node.

The image will be displayed within the string alongside any other properties you reference.
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Static Pages in a Dynamic Site usoz2

What does this mean?

A Dynamic Site offers a read, write access to your model, which means that content is generated as it is
requested by users. This generation, whilst highly efficient, can be slow when large volumes of data are
requested. Often pages which have large amounts of information, do not contain data which changes often.
Such pages could therefore be pre-generated, saving much server time, and make the user's experience
much more desirable.

The disadvantages to this method of generation are that the content is not modified until the page is
regenerated. Also the page is not access controlled by Roles, so is available to all users.

None the less, this is often a tradeoff worth making for complex pages.
How to make a page Static?

1. Define a page in your site as usual.
2. From the page settings, tick the checkbox, 'Display as Static Page'

3. You will be warned that new content will not appear in the site, until the static page is regenerated.

Layouts Options [cwWebDesignerTreeNodePage] - application
2-(0) Object Pages L)

T : Page Name |app|ication

=] ﬁ] application

= O Application Page Display Name |Appncamn

i == .

Layout Object Page

i E v ! g Page Title |

B Tabs

' g5 Properties PageT

i &= Froperti age lype single

i +-- s Associations |

i Add Pae Filt: I

i w1 e Delivered QoS _=m 1eer

i Warning X

i - Diagrams F—
- da Test . . . .

Enabling this option on an object page will prevent those

e 'j] attribute | objects from being editable. Adding a new object is possible E
H but the static site needs to be generated again for it to be

3} ':]] businessrule visible on the site, L
':l] cw_user_favorites

{[] datastore 9 E
T Hﬂ diagram ‘ I [} Application

& ﬁ] document -
& j] entity Object Page Order |°
e Aj] eventresult T
‘%I —j] flow Display As Static Page
a7 indicator

2 P teaafalia A

Fig. Set a page to contain static content

4. To generate (and regenerate) content for this page, right click on the page in tree
5. Choose the option 'Generate Content - Static Mode Only'
6. The page will be regenerated.

OR allow your end users to regenerate the page themselves with ‘'in-page refresh’
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In-Page Static Content Refresh

Allow Users to Refresh Static Pages in a Dynamic Site [2018.1.0+]

What does this mean?

As the name suggests, a Static Page is generated at a point in time, and then made available. Its content
does not change. Why would you want a static page?

Sometimes a page is made static because it is a baseline, other times it is static to improve load
performance, as it changes less frequently.

If the page is static for performance, it might be nice to allow a user to refresh the page themselves. So
Evolve offers an In-Page refresh button.

Enabling In-page Refresh

1. First configure the page to be static

2. You will now be able to access the 'Allow refresh' options; "Disabled", "Everyone" or Roles... that exist

in your site.
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3. Choosing "Disabled", which is default, will ensure that no-one can refresh the page from the site.
Choosing "Everyone", will enable the refresh button for all users of the site.

Choosing a specific Role, will enable the refresh button for users who are members of that Role.

Each static page has a "Last generated" time stamp, to indicate when it was last refreshed. A user can then
press the regenerate button and have the server make the refresh.
Once refreshed, the page will reload with the updated content. This content will be available for all users

who subsequently visit the page.

° - Appracante Back OG0 ) AZEREBIALEL 3 Actielly Manitaeing

ke ssmenne sore 20 (@) EPE) @@

Apploation ~

Fig. Refresh static content, end user view

Help me choose an option

e When a page is a baseline, it may be most appropriate to disable the ability for end users to refresh
the content. This means the site administrator would be required to use Evolve Designer to
regenerate the content when a new version is released. Often this is done with a batch run,
overnight, or on another trigger. However, it may be that the page could change throughout the day,
and you'd like an administrator to control when this happens. Going to Evolve Designer each time,
can be time consuming, so choosing a Role that your Administrators are a member of, will ensure

only they can refresh the page from within the site.

e Perhaps the page is owned by a particular department, and they like to make changes behind the
scenes, and then publish them. Again using the Role restriction will ensure only the owners can

update the page.

e In some environments the flexibility of allowing Everyone to refresh pages, is fine. If someone visits a
page, and would like to see the most up-to-date details, they can tap refresh and everyone will now

see the latest and greatest, when they visit.
Caveats

In 2018.1.0 this feature updates ALL object pages of the same type, and not just the page you are viewing.
While this could be useful, it was not intended. We plan to reduce the scope in subsequent releases, to just

the page you are viewing.
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Also, it is not possible to make a page both static AND editable. So the page would need to be duplicated in
Evolve Designer, with one page static, and one page dynamic. The dynamic page would be made available,
only to roles who are contributors. In this way a contributor would see the page twice. If they were to edit,
the editable version and save the changes, these changes would not be seen on the static page, until that
page was also refreshed.

This feature is in an early adopter stage, and we welcome comments and suggestions for improvement.
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Data Layout Options

Working with List (Simple)

The List (Simple) layout is the most basic display option for showing a list of objects.
It is the default Layout for all new Index Pages and displays objects in a simple bulleted list.

When used on an Object Page, a Simple List shows related objects, such as Associations or Diagrams the
object appears on.

What do you want to do?

Use the List (Simple) layout on an Index Page:
You can use a Simple List in more than one way on an Index Page.
To use as the main element of the page or Tab to list the objects returned:

Ensure the Layout node beneath the parent node is set to Layout List (Simple). No other controls, layouts
or behaviors are required.

To use inside an Accordion to list Associated Objects:

Ensure the Layout node beneath the Association node is set to Layout List (Simple).

Read more about Working with Accordions.

Use the List (Simple) layout on an Object Page

The Simple List layout can only be used on an Object Page to show objects that are related to the object
which is in focus.

You must therefore have an Association node in your Object Page before you can use it.
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You can add an Association node at the top-level of the page - with an Object Page Layout, or inside a
Tab, where the top-level node in the Tab is an Association node.

To use a Simple List to display your Associated Objects:
Ensure the Layout node immediately beneath the Association node is set to Layout List (Simple).

Display a title above your list

To display a title above your list, wherever you use it:

1. Select the Layout List (Simple) node you want to have a title
2. Enter the title you want to use in the Node Name field
3. Select the Display Title check box.
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Working with Accordions

This page describes how to create an Accordion within one of your Evolve Site.

Accordions are used on Index Pages to display a list of objects, and then for each object a set of related
information, such as the object's properties, its associations, which diagrams it appears on, and so on.

Accordions are usually configured to contain other layouts and behaviors inside them, which are exposed

when the user expands the node.

[y
[

I

You can also nest Accordions inside other Accordions, typically for listing Associated Objects.

What do you want to do?

Display a top-level Accordion in an Index Page

@ These instructions assume that you have already created a basic Object List Index Page which
displays the list of objects you want to appear in your Accordion.

To display a top-level Accordion in an Index Page:

1. Expand the node for the Index Page you want to add an Accordion to

2. Expand the Object Type node with the name of the Object Type, for example 'Process'

You should have a node representing the default layout ‘Layout List (Simple)’. If not. right-click the
layout node and select Switch Layout > CW > List (Simple)

3. Right-click the node 'Layout List (Simple)' and select Add Behaviors > Navigation > Accordion
A new sub-node is created under the layout node, titled 'Accordion’
4. Specify the settings for the Accordion

o Remove accordion header if empty is only relevant if you are displaying another Accordion,
nested inside this one, so this setting can be ignored if you only have one level.

If you do plan to have another Accordion nested inside this one, such as to list some

Associated Objects, you can switch off this check-box to specify that you want the top-level
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Accordion item to be omitted from the displayed list if it does not have any Associated

Objects.

o Use Collapse by default to specify whether the Accordion is presented in a collapsed or

expanded state when viewed.
5. Save your Site.
The changes are saved.
Display data inside an Accordion

Once you have an Accordion, you need to specify what you want to be displayed inside it when a user

expands the node for each object.

You do this by adding one or more Property Groups to the parent node for the Accordion - this is usually
the Object Type node for a top-level Accordion, or the Association Type node if the Accordion is nested.

For a full explanation of using Property Groups, see: Working with Property Groups.

The instructions below detail how to add a generic Property Group.
1. Right-click the parent node for the Accordion and select New Property Group> Empty Group
The Property Group node is added.

2. In the Property Group's properties, choose the Layout you want and use the Selected
Properties area to choose which properties to display
3. Save your Site

The changes are saved.

Display an Accordion nested inside another Accordion

These instructions assume that you have already created an Object List Index Page which
includes a top-level Accordion displaying a list of objects, and that these objects have Associated

Objects.

To display an Accordion nested inside another Accordion:

1. Expand the node for the Index Page you want to add a nested Accordion to
2. Expand the Object Type node with the name of the Object Type, for example 'Process’

You should have a node representing the default layout 'Layout List (Simple)’, under which you
should find the top-level Accordion.

3. Right-click the Object Type node and select New Association > [Object Type] > [Association

Type] to create an Association node
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If you already have a node representing the Association Type you want to use with your nested

Accordion, skip this step

. Expand the Association node
5. Right-click the Layout List (Simple) node and choose Add Behaviors > Navigation > Accordion

The new Accordion node is created.
. Specify the settings for the Accordion
o lgnore Remove accordion header if empty as it cannot be used at this level.

o Use Collapse by default to specify whether the accordion is presented in a collapsed or

expanded state when viewed.
. Save your Site.

The changes are saved.
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Working with Tables (Simple)

A Table (Simple) layout displays data in a simple tabular format. You can choose which columns you want
to be displayed, representing properties of the objects, or Associated Objects, and you can link to the Object

Page for the objects it shows.

Options Name Category Image
’; Automodeler Application productsfam.png
’; Casewise Modeler Application productsfcm.png
’; Gallery Application products/gallery.png
P; Matrix Application products/matrix.png
’; Model Explorer Application products/me.png
’; Object Explorer Application productsfoe.png
’; Simulator Application products/sim.png

However, unlike the Table (Complex) behavior, you cannot edit content in a Simple Table.

Why and how should you use one?

Use a Simple Table when you want to show more details for lists of objects than the other behaviors allow,

but you are not interested in sorting the columns or editing the displayed data.
Where and when can you use one?

Use the table below to see where you can use a Simple Table:

Editabl
Page Type | Parent node Tabs Number on page

e

] ) 1 - the Table must be the only element on
Index Page | Object Type node Yes - optional No
the page
Object Association Type Yes - 1 N
0

Page node mandatory

What do you want to do?

Insert a Table (Simple) into your Index or Object Page

To insert a Simple Table into your page:

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages
2. Switch the Layout node beneath the parent node to Table (Simple)

To do this: Right-click the Layout node and choose Switch Layout > CW > Table (Simple)
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3. Right-click the parent node and choose to add a New Property Group > Empty Group or From
CM Panel.

This node is the parent node of the 'Layout Table (Simple)' node. For full details on Property Groups,
see Working with Property Groups.

4. Select the Property Group and use the Selected Properties area to choose all the properties you

want to be represented as columns in the Table

Add as many Property Groups as you want if you want complete control over the ordering of your

columns.
5. Save and Publish your Site.
Show Associated Objects in a Simple Table

You can configure your Table to include one or more columns displaying Associated Objects.

To add a column showing Associated Objects:

1. Right-click the parent node - Object Type node for Index Pages, Association Type node for Object
Pages - and select
New Association > [Object Type] > [Association Type] to create an Association node

A new node representing the Association Type is created at the bottom of the /ist.
2. Save and Publish your Site.

The Associated Objects column is displayed as the last column in your table.
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Working with Tables (Complex)

A Table (Complex) behavior displays data in a gird format. It has columns that can be sorted or filtered, and
optionally you can specify that users can edit the data presented in the Table, either inline, directly in the
cells, or by using a pop-up window.

You can use Tables on Index Pages and Object Pages to display properties of Objects and Associated
Objects, and on Object Pages only, you

can also show properties of Intersection Objects.

Editing content in a Table

A Table is the only display option that enables you to edit data in an Index Page.

When you edit data in a Table you can edit the object's properties and associations (if you have associations
displayed).
You can choose whether to edit data inline or using a pop-up dialog. You must use a pop-up if you want to

edit associations.
You can also allow users to create new objects on a Table page, by using the Add Object setting.
Why and how should you use one?

Use a Table when you want to show more details for lists of objects than the other behaviors allow - and if

you want users to be able to edit the data.
Where and when can you use one?

Use the table below to see where you can use a Table:

Editabl
Page Type | Parent node Tabs Number on page
e
) ) 1 - the Table must be the only element on
Index Page | Object Type node Yes - optional Yes
the page
Object Association Type Yes -
1 Yes
Page node mandatory
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What do you want to do?

Insert a Table (Complex) into your Index or Object Page

To insert a Table into your page:

sy '
t\/ " || When you use a Table in an Index Page it must be used on its own - that is it cannot be
| contained within an Accordion or other page display type.

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages
- and use the Filter Properties area to apply any filtering
2. Switch the Layout node beneath the parent node to Empty

To do this: Right-click the Layout node and choose Switch Layout > CW > Empty

w

. Right-click the Layout node and choose Add Behaviours > Tables > Table (Complex)
A new node is added below the Layout node, titled 'Table (Complex)’
4. Select the new Table (Complex) node
The Table's settings are displayed
5. Edit the Table's settings:
o Use Add Object to place an Add Object button on the page so users can create new objects

o Use Edit Mode to specify if you want the objects listed to be editable, and whether you
prefer inline editing in the Table or to use a pop-up window

Leave Edit Mode unset if you do not want to allow editing.

a0

( )| If you show a multi-line text property, such as Description, in your table, and the content includes
S HTML formatting, users will not be able to edit the content via the table.

-

e\
[ 1 )| Object Pages do not support pop-up editing, only inline editing /s supported.
A
o Use Intersection Object Grid if you want to be able to display the value of an Intersection
Object
See Display data from an Intersection Object in a Table (below) for further details.

6. Right-click the parent node and choose to add a New Property Group > Empty Group or From
CM Panel
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This node is the parent node of the 'Layout Empty' node referenced in step 3. For full details on

Property Groups, see Working with Property Groups.

7. Select the Property Group and use the Selected Properties area to choose all the properties you want

to be represented as columns in the Table
Leave the Layout setting as 'table’.
8. Save your Site.
The changes are saved.
Include a Table column showing Associated Objects
You can configure your Table to include one or more columns displaying Associated Objects.
When you display Associated Objects in a Table, they can only be displayed as a simple List, showing just

the Name of the Associated Object.

Associations can only be edited in a Table if you set the Table to have an Edit Mode of 'Pop-up'.

To add a column showing Associated Objects:

1. Right-click the parent node - Object Type node for Index Pages, Association Type node for Object

Pages - and select
New Association > [Object Type] > [Association Type] to create an Association node

A new node representing the Association Type is created at the bottom of the list. By default it is

given a List (Simple) layout - which is the only layout you can use.

2. If your Table is editable, or you plan to make it editable, you must choose which properties of the
Associated Objects to display on the pop-up edit dialog by adding a Property Group to the
Association node and selecting the properties to display, as nothing is displayed by default:

i. Right-click on the Association node and choose New Property Group >Empty
Group or From CM Panel > [Pane Name]

ii. Use the Selected Properties area to choose which properties to display in the edit dialog
For full details on Property Groups, see Working with Property Groups.
3. Save your Site.
The changes are saved.
Display data from an Intersection Object in a Table
You can configure a Table, based on an Association Type, to display data from an Intersection Object.

A Table configured in this way will only show the Name of the Associated Object and then any properties of

the Intersection Object you choose.
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You can only display Intersection Object data in a Table when the Table is used on an Object

Page.

To do this:

1. Follow the instructions above to create a Table for your Index or Object Page, basing it on an

Association Type node
Your tree should look like this: Association Type node > Layout Empty > Table (Complex)

You do not need to add a Property Group to control which properties of the Associated Objects are

displayed, as Name is displayed by defaullt.
2. Right-click the Association Type node and choose New Intersection Object
A new node is added for the Intersection Object and it is given a List (Simple) layout by default

3. Right-click the Association Type node and choose New Property Group >Empty Group or From
CM Panel > [Pane Name]
4. Use the Selected Properties area to choose which Property Types are shown in the Table

Each property you select is shown in a separate column in the Table.

5. Save your Site.

Your Table is configured. When the page is viewed, you should see a Table showing the Name of
Associated Objects in the first column, followed by the

properties of the Intersection Objects in the following columns.
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Working with a Simple Matrix

The Simple Matrix requires that you have an Association Type defined between the two Object
Types you want to show.
A Simple Matrix can only be used on an Object Page, where one object is therefore the focus.

It creates a table which shows Associated Objects for the object in question as column headings, and then

within the cells shows other objects that are also associated to those Associated Objects.

For example, if your Object Page was focused on a Process, you could use the Simple Matrix to show which
Risk objects your Process is associated to, and then beneath each Risk also show which other Processes

are also associated to those Risks.

When you use a Simple Matrix, the first level of Associated Objects are listed as columns in
the table - consequently the more you show, the wider the table will be.
We therefore recommend that you restrict the number of Associated Objects displayed in

the Matrix or it may become unusable.

To display a Simple Matrix in your Object Page:

These instructions assume that you are adding your Simple Matrix to a Tab on an existing Object

Page, and that the new Tab node already exists.
1. Right-click the Tab you want to add the Simple Matrix to, and choose New Association > [object-
type] > [association-type]
This is to choose the Association Type you want to use to populate the column headings
An Association Type node is added.
2. Expand the Association Type node and switch the Layout to Empty.
To do this: Right-click the Layout and choose Switch Layout > CW > Empty

3. Right-click the Layout Empty node and choose Add Behaviors > Matrix > Matrix (Simple)
4. Right-click the Association Type node created at step 1 and choose New Association > [object-
type] > [association-type]

This is to choose the Association Type you want to use to find out which other objects are associated

to each Associated Object returned by the parent node.
An Association Type node is added.

5. Save your Site.
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Please ensure you use unique Object Group IDs for the Association Type nodes.

If you have IDs which are the same as ones you have used elsewhere, you will see an error
reported when attempting to Deploy the Site.
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Working with an Advanced Matrix

The Advanced Matrix is used to display associations between two Object Types, and can be

used on either anIndex Page or an Object Page.

To display an Advanced Matrix in an Index Page:

1. AnIndex Page can be added for an Object Type. In this example an Application has been added;

Layouts
=] fpﬁ' OnlineHelp
& ﬁ_} Index Pages
E [ index_applications_technologies_matrix
= O Application
| 558 Layout Empty
. EI.;' Matrix (Advanced)
] O Application - Technology ()
=8 Layout Empty
&' Reason for Involvement
58 Layout Empty
B O Technology
58 Layout Empty

Options [cwWebDesignerTreeNodeObjectNodeObjectType] - Application

Node Name

|App|ication

Object Type Application

Object Group ID |application_1;r:l3438029

SortOn

Name
Sort Reverse O
' Include Objects Only If '
Have Associations
I Selected Properties CAverage Rating
[Ocategory

2. Arelated Object Type can also be added to the same Index Page. In this example a Technology has

been added;
Layouts
=& ¥ OnlineHelp
— @ Index Pages
=] index_applications_technologies_matrix
&) Application
g 58 Layout Empty
% Matrix (Advanced)
O Application - Technology ()
8 Layout Empty
= ‘& Reason for Involvement
58 Layout Empty
ogy
iS5 Layout Empty

3. The first object type should have its Layout switched to Casewise > Empty, to allow a Matrix >

Options [cwWebDesignerTreeNodeObjectNodeObjectType] - Technology

Node Name Technology
Object Type —
ObjectGroupID | fyecnnology_37255636
SortOn . e v
Sort Reverse .
O

| Include Objects Only If |

Have Associations
Selected Properties O Availability End Date

~[JAvailability Start Date

Matrix (Advanced) Behaviour to be added. The second object type should have its Layout

switched to Casewise > Empty, to prevent a list of these objects from being output.

The first object type will be the Row of the matrix, the second object type will be the Column.
4. The first object type should identify the relationship to be represented in the Matrix. A New
Association allows the relationship to the second object type to be selected. In this example

the Application — Technology () has been selected;
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5.  The Association should identify its Intersection Object Type. In this example it is a Reason for

Involvement;

Layouts
=] @ OnlineHelp
@l @ Index Pages
| B || index_applications_technologies_matrix
fl O Application
| =58 Layout Empty
2 Matrix (Advanced)
1= CO Application - Technology ()
58 Layout Empty
=] :‘
58 Layout Empty
e-{) Technology
| E Layout Empty

Options [cwWebDesignerTreeNodeObjectNodelntersectionObjectType] - Reason for

Involvement
Node Name |Reason for Involvement
Object Type | .R e t -

ObjectGroup ID |reason_for_invnlven'rent_1y,7096993

[ Application Id

6. The Matrix (Advanced) behavior can now have its Intersection Properties added, and the Row
Object Group ID and Column Object Group ID updated from the Application and Technology

object types;
Layouts
e @ OnlineHelp
=2 @ Index Pages
| 5[] index_applications_technologies_matrix
aO Application

58 Layout Empty

Bl 4 Reason for Involvement

5 58 Layout Empty
&) Technology
8 Layout Empty
# | | index_data_stores_list
| ®- || index_it_portfolios_list
|_| G_) Object Pages
- &[] application
=l O Application
£ Layout Object Page
55 General
% Description
B8 Details

® @ datastore

String {FUNCTIONSYNONY M.

SortOn I B
Sort Reverse |
O
[ Include Objects Only If ' O
Have Associations
Selected Properties O Allow Automatic Deletion ~

Options [CwWebDesignerTreeNodeBehaviourMatrxTable] - Matrx (Advanced)

| Column Object Group

Node Name Matrix (Advanced)
Matrix Type Matrix On Intersection |
Full Screen | O
Allow Editof | -
Intersection
Intersection [
Properties Add/Remove Properties
Property Disolay Grow

Automatically | &
Generate Custom

Custom Display String | e\ NcTIONSYNONYM]

Row Object Group ID |applicaticn_:7:3438¢:9

. [technology_37255636

Intersection Node ID |reason_for_involvemenL:3;.;ogﬁgga

By default, the matrix cell will contain the {namej of the Intersection instance as its Display
String, until Intersection Properties are added. In this example the Reason for Involvement
has had its Name property added, which Automatically Generates the Custom Display

established.

The Intersection Node ID /s automatically updated when the Intersection Object Type is
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The Published Example Advanced Matrix:

Both Application and Technology object types have been restricted to Include Objects Only If
they Have Associations. This will reduce the size of the matrix, and consequently the time it

will take to refresh.

e Objects with Associations Only

SRV_APP SRV_BDD Desktop #

Application - Technology Matrix, _UK02 4 _UKO3 IT Archite Jj

Activity Monitoring

Application Portfolio Manage
r i

Business Object

Casewise Suite

Dashboard

ERwin Data Modeler

Finance Suite

SRV_APP SRV_WEB
VM_UsSO Nl |

SRV_BDD

_UKO2

It might also prove useful to Add a Page Filter to enable the size of the matrix to be reduced.

An active filter is likely to reduce the time to generate the matrix.
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® AFiltered Page

« D OO®

SRV_APP SRV_BDD SRV_BDD SRV_APP SRV_BDD SRV_APP
_uko2 & _uko3z 8 _ukoz2 8 _uko1 8 _uko1 8 _VM_UKOJ

Application - Technology Matrixgdlj

Activity Monitoring ]

Application Portfolio Manage
r

Business Object

Casewise Suite

ERwin Data Modeler

Finance Suite

HR Access

The Row and Column objects could be filtered to reduce the number of rows or columns. For
example, the Applications could be filtered to only include those with a Category = ERP;

® Filtering Objects

& om Filter Properties (AND) I Property Operation Vaioe
=58 Layout Empty [Category = ~[erp -
&% Matnx (Advanced) | | |

A matrix with too many rows and columns could take an unacceptable amount of time to generate.

Displaying Intersection Properties:

In the example output above, the Custom Display String for each cell has been set to the Name of the
Intersection object. None of the Reason for Involvement associations have been given a name, as a

consequence the shaded cell contains no detail. The following example has the Number of Resources

displayed in each cell:
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® |ntersection Property

& || index_applications_technologies_matrix [ Intersection Properties
& O Application Add/Remove Properties
=58 Layout Empty Property Dusplay Value Group
e L

= (9 Application - Technology ()
8 Layout Empty

B & Reason for Invelvement

EH Layout Empty | Automatically Generate Custorn |

2 O Technology | Display String _E

£ Layout Empty Custom Display String {NUMBERINVOLVEDUSED}

® Number of Resources

- - SRV_APP_UK SRV_BDD_UK SRV_APP_UK SRV_BDD_UK SRV_APP_V
Application - Technology Matrixgll 02 B 03 3 01 3 01 B M_UKol B

Business Object

Casewise Suite

Finance Suite

HR Access

To display an Advanced Matrix in an Object Page:

The Advanced Matrix on an Object Page is similar to one created for an Index Page, but like the
Simple Matrix on an Object Page, the focus is on a single object.

1. An Object Page can be added for an Object Type. In this example a Process is to be added.

2. This object type should identify a relationship to the objects to be represented in the matrix rows. A
New Association is added under the object type. In this example a
Process - Application () is to be added.

3. The related object type should have its Layout switched to Casewise > Empty, to allow a Matrix >
Matrix (Advanced) Behaviour to be added.

4, The first related object type should now identify the relationship to be represented in the
Matrix. A New Association allows the relationship to a second related object type to be
selected. In this example the Application — Technology () is to be selected.

5. The Association should identify its Intersection Object Type. In this example it is to be a Reason
for Involvement.

6. The Matrix (Advanced) behavior can then have its Intersection Properties added, and the Row
Object Group ID and Column Object Group ID updated from theProcess — Application ()
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and Application - Technology () nodes;

Layouts Options [CwWebDesignerTreeh B srMatrixTable] - Matrix (Advanced)
=] OnlineHelp £ I T
& - Node Name Matrix (Advanced) =
=] @ Index Pages | | |
@ || index_applications Matrix Type [MatrcOn Intersection w
@ || index_applications_technologies_matrix :
N - Full Screen
@- [ index_processes O
@[ index_technologies Allow Edit of ntersection |
&-(C) Object Pages
G| application | Intersection Properties 1
1 ‘j] Add/Remove Properties
a8 __T] process
=] o Process Property DisplayValve  Grouo
53 Layout Object Page »
ﬁ Property Group
= T,] process_matrix
&) Process
58 Layout Object Page Automatically Generate =
=] (,9 Process - Application () | CustomDisplay String |
58 Layout Empty Custom Display 5tring | [reUNCTIONSYNONYM)
"

BE
= é) Application - Technalogy ()
ﬁLﬂ\’Wf List (Simple) | Column Object Group ID
B “& Reason for Involvement

8 Layout List (Simple)

Row Object Group ID |applucawn_:l>9:tg_uBB6vnu

|te:hnobgy_;og:9_1261533860

Intersection Node ID [rﬂson_ror_invo!umm_;: 28200612

The need to reduce the size of the Object Page matrix is less likely, as only the objects related
to the selected object, and their related objects will be included in the matrix.

The Published Example Advanced Matrix:

® An Application to Technology matrix for a selected Process;

SRV_BDD_ Desktop # SRV_WEB SRV_BDD_ SRV_APP_ SRV_APP_

Application - Technology Matrixgll 0 | IT Archite [ _NYOT 4 Uso1 | FR_Prod VM_UKOT,

Business Object

Casewise Suite

ComptaPlus

Dashboard

Editing Intersection Properties:

In the example output above, the Custom Display String for each cell has been set to the Name of the
Intersection object. None of the Reason for Involvement associations have been given a name, as a
consequence the shaded cell contains no detail. It is possible to Edit the Intersection Properties, by clicking
on the Edit button above the matrix;

® Editing the Name of an Intersection.
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Application - Technology Matrix SRV_BDD_UK03 Desktop # IT Architect

storedin| X @ 2]
8

Business Object

This is opticnal and for de
Casewise Suite Oo

o)
ComptaPlus % S
Dashboard % %
< I >

It is possible to create new relationships by clicking on the link "icon, or to delete existing

relationships by clicking on the bin'icon.
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Working with Tabs based on Lookup
Values

Tabs based on Lookup Values is a list-based display that organizes your objects into groups based on the
value of 'Lookup' (drop-down) properties such as Category.

Vertical tabs on the left side of the page are used to represent the values, while the objects themselves in

each tab are displayed in simple lists.
Objects listed using this display type cannot be edited directly.

You can optionally include an Overview Chart which creates an 'Overview' tab displaying a Pie Chart
showing the proportion of each value. The Overview Chart is identical to the chart displayed when using

the Pie Chart based on Lookup Value behavior.

The Tabs based on Lookup Values display requires that you have drop-down properties in your
model. It will work with the default drop-down Category, as well as any user-defined drop-

down properties in your model.

To create an Index Page using Tabs based on Lookup Values:

1. Create a New Index Page with a List (Simple) layout

2. On the Object Type node, ensure you select 'Category' in the Selected Properties area

3. Right-click the Layout List (Simple) node and choose Add Behaviors > Navigation > Tabs on
Lookup Values

A Tabs on Lookup Values node is added below the Layout node.

4. Select the Tabs on Lookup Values node and enter the Scriptname of the drop-down property you
want to refer to in the Filter Lookup field

You can find the Scriptname in Model Explorer's Design View. The scriptname for the default

Category drop-downs on objects is always 'TYPE'
5. Use the following optional settings:

o Use Overview Chart to specify that you want the first tab to be an Overview tab showing a

Pie Chart summarizing the distribution of the values
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o Use Not Display Undefined to specify that the page should not include or display any
objects that has a value of 'Undefined".

6. Save your Site.

7N

) | Remember to add a Menu item for your new page.
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Filtering Data

Page Queries and Filters

This page explains how to use page queries and filters so that your pages only display objects that match
certain conditions that you specify.

By default Index Pages, and Association Type nodes on Object Pages, list all the instances of the Object
Type you specified - for example all Processes in your model.

However, you can create association queries and conditional filters which result in only a restricted list. For
example, you might want an Index Page which shows a list of Processes, but you only want to see Processes

of a certain Category, or that are associated to another object.

These queries and conditional filters can be applied to most Index Pages, as well as most Object Pages
which use Association Type nodes to display Associated Objects.

There are two types of conditional filters that can be applied to the results to form a query:

1. Filters based on object properties

2. Filters based on associations.
Filter Operators

Text-string filters and select-list filters can be combined in a formula using filter operators. This allows for

greater versatility when filtering objects.

The filter operators and their functions are listed below:

Operato . L.
Function Description

r

= equals Matches to any values that are equal to the inputted value.

= does not equal Matches to any values that are not equal to the inputted value.

> is greater than Matches to any values that are greater than the inputted value.

< is less than Matches to any values that are less than the inputted value.
is greater than or .

>= It Matches to any values that are equal to or greater than the inputted value.
equal to
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is less than or .
<= It Matches to any values that are equal to or less than the inputted value.
equal to

N i< withi Matches to any values that are one of the inputted list of values. Operates
is within
with List, Text and Numeric values.

Filter based on object properties

Filters based on object properties can be applied to any Layout or Behaviour on any Index

Page or Association Type node on an Object Page.
These filters restrict the results based on one or more properties of the objects to be displayed.

You can add multiple property filters, which combine to form a single query where each condition must be

met for the object to be included in the results, so for example:

Display all Processes where:
Category = ‘X'
AND Validated = 'TRUE'

While individual conditions are joined with the AND operator in your complete filter query, when you add a
condition referencing a Drop-down, ID or Single Line Text property, you can specify multiple values which
are treated as OR within that particular condition. So, for example, you could create a filter query like:

Display all Processes where
Category = X'OR 'Y OR 'Z'
AND Validated = 'TRUE'

IMPORTANT: You can only use OR conditions with the following standard property
types: Name, Category, UUID, ID. User-defined property types are not supported:

In addition, you can only use one OR condition in a filter set.

NOTE: The OR operator is shown as 'IN"in the Evolve Designer interface.

Add a property-based filter

Filters based on association

IMPORTANT: You can only use a filter based on association when you are not already using an

Association Type node for any other purpose in your Index or Object Page.
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In addition to property based filters, you can restrict the list of objects displayed on a page by way of
association. This could be by association to any object of a specified type, or to a specific object or objects

of a specified type.

For example, you could create a filter like:

Display all Processes where Category = X'

AND Process Is Associated To any Location.

You could extend the filter to reference a specific associated object, such as:

Display all Processes where Category ="'Y’
AND Process Is Associated To Location 7.

You can even extend these basic examples to add multiple nested association conditions to filter the
results by way of indirect association. For example:

Display all Processes where Process Is Associated To any Location

AND where Location Is Associated To Organization 'UK"

Finally, you can of course add property-based filters to any association filter, enabling you to create

sophisticated page queries such as:

Display all Applications where Date for Review > 'date’
AND Application Is Associated To an Organization
where Organization Category = 'X' OR'Y"

AND Organization Is Associated To the Location 'US'

When filtering results by association on an Object Page, remember that the parent node will

always be an Association, so the list you are filtering is a list of associated objects.

On an Object Page it is not possible to present a list of objects indirectly associated to the object
that is the subject of the page. It is only possible to list objects that are indirectly associated to
objects that are associated to the subject.

Add a filter based on association

Filters Properties

The following properties can be used to configure a filter:

Name Notes

Average Rating
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Category

Created By

Format: DD/MM/YYYY HH:MM:SS E.g.: 22/12/2015
14:34:42

Creation Date

Format: DD/MM/YYYYHH:MM:SS E.g.: 22/12/2015
14:34:42

Date Validated

Display Name

Freeze Level

Id

Name

Owner

Template

Total Comment

Unique

Identifier

Updated By

Updated Date

Format: DD/YY/MMMM HH:MM:SS E.g.: 22/12/2015
14:34:42

Validated
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Property Groups

Working with Property Groups

Property Groups are page elements that display the properties of the object in question. They are used
on Index Pages, such as within an Accordion, or Table, or in Object Pages.

There are two ways you can enter Property Groups into your pages:

1. By using the Empty Group option
2. By using the From CM Panel option.

The Empty Group option creates one group within the page and then you can choose which of the object's
properties to display within it - nothing is selected for you by default

The From CM Panel option allows you to choose a group based on one of the Panes in the object's
properties, such as General, and automatically selects all the properties within that Pane to be displayed in
the group.

( '; | | When inserting a Property Group, we recommend you only display a small number of properties in

any particular group -
your page will look much better if you restrict the number of properties in each one.

Property Group Layouts

When you insert a Property Group there is a Layout setting which determines how the content within the
group is displayed.

Certain layouts only work with certain types of properties. Please use the Property Group Layout Table to

see which layout to use when.

Property Groups and Tables

The Property Group feature is also used when configuring a Table to specify which properties you want to
be displayed as columns in the Table. The details for using Property Groups in this way are included in the

instructions for creating a Table. See Working with Tables for further information.

What do you want to do?

Insert a Property Group on an Object Page
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If you use Tabs on your Object Page you can only insert a Property Group beneath a Tab node.

If you do not use Tabs, you can insert the Property Group beneath the main Object Type node.

To insert a Property Group on an Object Page:

1. Expand the node for the Object Page you want to add the Property Group to

2. Right-click the node (Tab or Object Type) you want to add the Property Group to and choose
New Property Group > Empty Group, or New Property Group > From CM Panel > [Group
Name]

See the beginning of this page for explanations of each option.
3. Configure the Property Group settings:

o Use Property Group Name to specify the name of the group as it is displayed in the web
page.

o The Identifier setting holds a unique identifier for the Property Group. You should have no

reason to change this setting.
o Use Layout to specify which layout to apply to your Property Group.

See Property Group Layouts for explanations of each layout type.

o Use Selected Properties to specify all the properties that will be displayed in the Property
Group.

Remember, we recommend only using a small number of properties in any one group.

4. Save your Site.

The Index Page's properties are saved.

Insert a Property Group inside an Index Page Accordion

To insert a Property Group inside an Index Page Accordion:

1. Expand the node for the Index Page you want to add the Property Group to

2. Right-click the node that is two steps above the Accordion you want the Property Group to be
displayed in and choose
New Property Group > Empty Group, or New Property Group > From CM Panel > [Group
Name]

See the beginning of this page for explanations of each option

3. Configure the Property Group settings:
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o Use Property Group Name to specify the name of the group as it is displayed in the web
page.

o The ldentifier setting holds a unique identifier for the Property Group. You should have no
reason to change this setting.

o Use Layout to specify which layout to apply to your Property Group.

See Property Group Layouts for explanations of each layout type.

o Use Selected Properties to specify all the properties that will be displayed in the Property
Group.

Remember, we recommend only using a small number of properties in any one group.

4. Save your Site.

The Index Page's properties are saved.
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Property Group Layouts

When you use Property Groups to display object properties within your Site Pages, you must choose

a Layout to apply to the group.

The layout controls how the properties are displayed, but some layouts are only to be used with certain

types of property.

The table below details each layout and in which case it should be used:

Layout Description Used for
This is the default layout which can be used with any type of | Any type of property,
table property. Properties are displayed in a tabbed format with except multi-line text
property name > property value. fields.
The FlatList layout is especially useful on Diagram Popouts Any type of property -
FlatList as it can be used to combine multiple properties, including | especially on Diagram
multi-line texts, in one simple 'flat' layout. Popouts
This layout is especially for multi-line text properties, such
as 'Description’. It is better at presenting potentially longer
Multi-li fiel
memotext pieces of text than the standard table. ulti-line text fields
with plain text content.
The use of Enhanced Multi-line Text Control will enable the
use of rich text formatting for HTML content.
This layout is has been deprecated in version 3.0 and
htmlbox , n/a
replaced with the Memotext Layout (above).
This layout allows users to proceed without selecting any
helptext properties. The Property Group Name can then be used to Displaying help text
display help text
) ) Number fields where the
The gauge layout displays a visual gauge on a scale of 0 to )
] ] value is between 0 and
100. The pointer represents the value of the property. This ) )
gauge . . . ) 100. Text fields which
type of layout is especially useful for displaying percentages | . .
] ) include just a number
in a visual way. .
will also work.
The embedURL layout creates a frame within your page that
embedURL can open and display the target of a URL property - as long URL property types only.
as it is properly formatted and starts with 'http://'. Therefore,
if you have a URL property which contains a link to your
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corporate website, you can display the web site within the

frame in your object page.

If you want to use this layout in your Property Group, you can

only use the group to reference one property.

Note: In order for URLs to work in this way, the URL property
on your object must be on its own Pane. See the CW Suite

help for positioning Property Types on Panes.

Note 2: You cannot edit the URL Property using the
embedURL layout. To make a URL property editable in
Evolve you must expose the property on another part of the
Object Page.

[Note 3:] If you reference a PDF document, ensure that if

your users are accessing your Site using Internet
Explorer that they have a PDF reader plugin installed.

The image layout is used to display properties that are image

Image property types

the same central point.

image files, and result in the image being displayed in the web only.

page. Images are not commonly used as properties.

The imageFromURL layout is used to display an image for an

object which uses a Single-Line Text or URL Property Type URL or Single-Line Text
imageFromUR to store an HTTP reference to an image file. properties used to store
L HTTP references to an

If you want to use the imageFromURL layout in your Property image file.

Group, you can only use it to reference one property.

The radar layout is used to create a chart that displays three
radar or more Object properties on different axes which start from | Number fields

Property Group Name

The property group name is displayed in the title bar of the property group. In the case of options such
as 'embeddedURL' or 'imagefromURL' the default title is the full URL.

Since Evolve 2016.1.1 the ability to use a 'Custom Display String' means it is now possible to use any text,

or property variables in this display.

For example: The default use of an embeddedURL may look like this:
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Name

Details

Responsibilities (RACI)

Process Claim

Process Claim

com/evolve/v201 docs/Evolvs lease-Notes.pdf

Casewise Evolve Release Notes

Process Flow

Published

Drafts

WHAT'S NEW IN EVOLVE 2016.1.1

Jenny Hylton

90060

However the URL is seldom a useful attribute. So using the 'Custom Display String' to display some simple

text, and optionally a variable (e.g. Name), it is possible to adjust the configuration like this:

Home | Dynamic Deployment  Static Deployment

H| & &

IO,

Save Dynamic Site Static Site Update Meta Model  Show/Hide Object Types Online Help
Design Publish Adrministration Help
Layouts Options [cwWebDesignerTreeNodePropertiesGroup] - Documentation

&

ﬁ] database
f:ﬁ] diagram
:ﬁ] entity

@ eventresult
ﬂ organization

&

&

=
&g Details
58 General
58 Description
£ e
) é) Business Area
-4 Responsibilities (RACI)

@@ Data Management

) Template Nodes

Eioperty GroupName |Documentat|on

Identifier |propertyGl’OUP_117971774

Custom Disply Sting |Document link for "{Name}"

Layout \inbe JURL

Selected Properties M General

+[OName
~[JAlternate Name
~[category
[implementation
-MDocumentation
‘[IDecomposition Number
[Description
[JObjective
[OSpecification
[JFrequency/Growth
[OcCosts
Throughput
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Data Visualizations

Visualizing Data in Evolve

There are a number of ways you can use Evolve to visualize the data in your model.

e Use Diagram Designer visualizations

e Use dedicated behaviors like Pie Charts, Bubble Charts, Bar Charts, Roadmaps, Cost-Benefit
Charts and Vector Maps

e Use Visual Indicators

These features each offer different ways of allowing you to present your data in a visual way, from giving

high-level dashboard views, to exposing the details behind individual objects.
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Working with Pie Charts based on
Lookup Values

Pie Chart based on Lookup Values gives you a percentage view of the number of objects of a specified

Object Type that are set to the different values for a specified Lookup (drop-down) property, such

as Category.

It creates the same pie chart as the one displayed on the optional Overview Chart created by the Tabs

based on Lookup Values behavior.

To create an Index Page using Pie Chart based on Lookup Values:

1. Create a new Index Page

2. Right-click the Layout node and choose Switch Layout > CW > Empty

3.

4. Right-click the Layout Empty node and choose Add Behaviors > Pie Charts > Pie Chart (On

On the Object Type node, ensure you select 'Category' in the Selected Properties area

Lookup Value)

A Pie Chart (On Lookup Value) node is added below the Layout node.

. Select the Pie Chart (On Lookup Values) node and enter the Scriptname of the drop-down property

you want to refer to in the Group By field

You can find the Scriptname in Model Explorer's Design View. The Scriptname for the default

Category drop-downs on objects is always 'type’. Scriptnames must always be entered in lower case.

. Save your Site.

Remember to add a Menu item for your new page.
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Working with Recursive Pie Charts

Unlike the standard Pie Chart based on Lookup Value which shows you the break-up of objects based on a
drop-down property, the Recursive Pie Chart allows you to show a top-level chart which sums the values
of properties of Associated Objects (or Intersection Objects), and then allows users to click those items to

view a second chart showing all the objects associated to the selected object.

You can include multiple levels of associations in one chart, so users can drill down from one to another.

Step 1 Step 2 Step 3

r

The Recursive Pie Chart requires at least one Association Type to work, as well as a Whole
Number or Decimal Number property on the Associated Object - or Intersection Object.

Why and how should you use one?

You should use a Recursive Pie Chart when you want to get an overview of some underlying data by way
of an Association. Think of it as a visual representation of the sum of a numeric property on associated
objects.

For example, you have some Technology objects, each with a Cost property, and in your
model, Technologies are associated to Organization objects which are used to represent Departments in

your business.

In this example you could use the Recursive Pie Chart to show Technology Cost per Department. The chart
is configured to show Organization objects - but the size of each piece is based on the total

(summed) Cost of the Technology objects associated to each one.

While the above example examines one level of association, you can extend this basic functionality to
include more steps, by adding additional Association Types, allowing you to visualize the data of objects
Indirectly Associated to the higher-level objects. The result is to have more click-through pie charts, one
focusing on a different Object Type in the chain.

For example, if your Organization owns a number of different companies, your data could consist of:

e Company objects used to define companies in the group

e Country objects used to define countries where you have offices
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e Department objects used to define departments within the company

¢ Technology objects used to define server machines.
The Technology objects have a Cost property to specify the running costs per year for each machine.

Your model has Association Types linking these Object Types together - in the following path: Company >
Country > Department > Technology

You could then use a Recursive Pie Chart to show the summed costs of server machines (Technologies)
per Company, then after clicking through by Country, and then by Department, in one interactive chart.

See Use multiple Association Types to visualize Indirect Associations below for details.

You can sum properties of the Intersection Object instead of the Associated Object if you

wish.

Where and when can you use one?

Use the table below to see where you can use a Recursive Pie Chart:

Number on Editabl
Page Type | Parent node Tabs

page e
Index Page | Object Type node Yes - optional 1 or more No
Object Association Type Yes -

1 or more No
Page node mandatory

What would you like to do?

Add a Recursive Pie Chart to your page

These instructions lead you to create a basic Recursive Pie Chart, which results in a pie chart
showing instances of the first object, sized by the sum of a property of the associated objects,
then a second pie chart users can drill down to which shows instances of the associated

objects for just one of the top-level objects.

By following these instructions you could create the Organization to Technology (Cost) example

described above.

The parent node mentioned in the instructions is the Object Type node for an Index Page -
optionally within a Tab - or is the Association Type node within a Tab on an Object Page.

1. Select the parent node - Object Type node for Index Pages, Association Type node for Object Pages
- and use the Filter Properties area to apply any filtering
2. Switch the Layout node beneath the parent node to Empty

erwin Evolve — User Help Guide
Data Visualizations



To do this: Right-click the Layout node and choose Switch Layout > CW > Empty

3. Add the Recursive Pie Chart behavior to the Layout node

To do this: Right-click the Layout node and choose Add Behaviors > Pie Charts > Pie Chart

(Recursive)
A Pie Chart (Recursive) node is added

4. Add an Association to the parent node - choosing the Associated Object Type which has the property

you want to sum

To do this: Right-click the parent node and choose New Association > [object-type] >

[association-type]
A new Association Type node is added

5. Select the Association Type node and in the Selected Properties area, tick the property you want to

sum on the chart
6. Select the Pie Chart (Recursive) node and configure the following settings:

o Use the Node Name to set the name of the node as it appears in the tree - you only need to

edit this if you are using multiple Recursive Pie Charts

o Use Leaf Object Type Scriptname to specify the Scriptname of the Associated Object Type

- for example, 'technology'
o Always use lower case when referring to Scriptnames

o Use Property Scriptname to Sum to enter the Scriptname of the property on the Associated

Object you want to sum
o Use the Where is the Property to sum drop-down to choose whether you want to sum a

property of the Associated Object, or a property of the Intersection Object

See the separate instructions below for more details on using the Intersection Object.

o Use Property Unit to specify the text to be displayed on the chart for the sum value

o Use Intersection Object Type Scriptname to specify the Scriptname of the Associated

Object Type
Use the same Scriptname as for the Leaf Object Type Scriptname
7. Save your Site.
Use a property of the Intersection Object for the sum

You can configure your Recursive Pie Chart to sum the values of Intersection Objects rather than values of

the Associated Objects themselves.
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Just as with values for Associated Objects, the properties must be Whole Number or Decimal
Number.

The instructions for creating a Recursive Pie Chart in this way is exactly the same as for
referencing an Associated Object, with the following exceptions:
1. Set the Where is the Property to sum drop-down to 'On the intersection before'

2. Use Property Scriptname to Sum to enter the Scriptname of the property on the Intersection Object

you want to sum
3. Use Intersection Object Type Scriptname to specify the Scriptname of the Intersection Object Type.

Use multiple Association Types to visualize Indirect Associations

If you want to add more steps in your Recursive Pie Chart using multiple levels of
associations, you should follow the points below:

e Nest additional Association Type nodes beneath each other - add the next Association Type by right-

clicking on the Association Type node you want to nest beneath
e On the Recursive Pie Chart node the settings should reference the object at the end of the chain - in

the example case, the Technology.
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Working with Roadmap Gantt Charts

Roadmaps require two Date/Time properties on your object to store the Start and End date of
each item you want to display.

A Roadmap is a type of Gantt Chart that enables you to show a number of objects and their start and end
dates.

For example, you could have a Project object, which has Start Date and End Date properties. On your
Roadmap you could show all the Projects associated to a specific Department and what their start dates

and end dates are, viewing any overlaps or gaps.

You can optionally display Categories like a menu in the web page which allows users to filter the list

dynamically when viewing the page.

You can use Roadmaps as the main element on Index Pages, or beneath an Association Type node on
Object Pages.

What do you want to do?

Create a new Roadmap Gantt Chart for your page

7

These instructions assume that you have already created your page, including
any filtering you may want so that only the objects you want displayed are shown.

To create a new Roadmap Gantt Chart for your page:
1. Ensure the Layout node for your element is set to Empty
For an Index Page the Layout node is the one directly under the Object Type node.
For an Object Page the Layout node is the one directly under the Association Type node
2. Right-click the Layout node and choose Add Behaviors > Gantt Charts > Gantt Chart (Roadmap)
A Gantt Chart (Roadmap) node is added below the Layout node

3. Select the Gantt Chart (Roadmap) node and set the properties

A~
/

Use lower case to enter Scriptnames.
i Use the Start Date field to enter the Scriptname of the property used to store the start date

ii. Use the End Date field to enter the Scriptname of the property used to store the end date
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iii. Use the Filter Lookup Property field to enter the Scriptname of a drop-down property that
you want displayed like a menu in the web page so that users can click to filter the displayed

list of objects in the Roadmap

4. Select the Object Type node and use the Selected Properties area to select all the properties you
referenced at step 3 - that is the Start Date and End Date properties, as well as the Category.
5. Save your Site.

The Site is saved and the Roadmap Gantt Chart is created.
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Working with Lifecycle Roadmaps

A Lifecycle Roadmap is a type of Gantt chart that enables you to show a number of objects, displaying their
overall time frame, as well as highlighting in different colors the phases involved in their lifecycle.

You can display any number of phases in your lifecycle.

When you use a Lifecycle Roadmap you can also show the names of each of the phases in a color-coded

legend so users can understand the chart.
You can use Lifecycle Roadmaps as the main element on Index Pages only.

Lifecycle Roadmaps require that you have a total of Date/Time properties on your object to
represent the Start dates of each phase in the cycle,

and an additional Data/Time property is required to store the End date of the final phase.
Why and how should you use one?

Use a Lifecycle Roadmap when you want to view the lifespan of an object, such as a Project, but you also

want to see the breakdown of phases within the overall timeframe.

For example, you could have a Technology object representing a server, which has four lifecycle

phases: Development, Testing, Active, and Retirement. Each stage has a

corresponding Date/Time property to represent the start date of the phase, and the final phase also has a
corresponding end date property.

Where and when can you use one?

Use the table below to see where you can use a Recursive Pie Chart:

Number on Editabl
Page Type | Parent node Tabs
page e
Index Page | Object Type node Yes - optional 1 No
Object Association Type Yes - ) N
0
Page node mandatory
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What do you want to do?

Create a new Lifecycle Roadmap for your page

/
{

{ || These instructions assume that you have already created your page, including

any filtering you may want so that only the objects you want displayed are shown.

To create a new Lifecycle Roadmap for your page:

1. Use the Selected Properties area on your Object Type node to select all the properties you want to
reference on the roadmap

2. Ensure the Layout node for your element is set to Empty

For an Index Page the Layout node is the one directly under the Object Type node.

For an Object Page the Layout node is the one directly under the Association Type node
3. Right-click the Layout node and choose Add Behaviors > Roadmap Lifecycle

A Roadmap Lifecycle node is added below the Layout node

4. Select the Roadmap Lifecycle node and set the properties

(Y ) Use lower case to enter Scriptnames.
NS4

i Use the Dates field to enter a comma-separated list representing the start dates of all the

phases in your roadmap, as well as the end date of the final phase

Enter the Scriptnames of the start date properties for each of the phases in the lifecycle,
followed by the Scriptname of the end date property of the final phase

For example: astart bstart,cstart dstart dend

ii. In the Steps field enter the names of each of the four phases as you want them to be

displayed in the web page, separating them with a comma
Example: 'Development, Testing,Active, Retirement’
5. Save your Site.

The Site is saved and the Lifecycle Roadmap is created.
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Working with Cost/Benefit Charts

A Cost/Benefit Chart enables allows you to compare properties you class as Costs in your organization

against properties you class as Benefits.

(e -

bl Lo il | | |

ik

The result is a type of color-coded bar chart which highlights the costs and benefits, as well as

a calculated cost/benefit value.

There is no limit to the number of cost and benefit properties you use, but obviously the more you do use,

the more unusable the chart will become.

Cost/Benefit Charts require that you have Whole Number or Decimal Number properties for
your Costs, and either Whole Number, Decimal Number of Drop-down properties for your

benefits.

Ifyou do use Drop-down properties for benefits, these should include a number, such as:

1-Low
2 - Medium
3 - High

You can have multiple costs and multiple benefits on one chart.

Why and how should you use one?

An example of using a Cost/Benefit Chart might be to show the business benefit of expenditure on

software applications.

A number property could be used to store the actual monetary cost of the application in your organization,

while a drop-down could be used to assign the importance of the application to the business - from 1 to 10.

Using the chart, you would then be able to get an overview as to whether you were spending a lot of money

on applications that have little business value.
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Where and when can you use one?

Use the table below to see where you can use a Cost/Benefit Chart:

Page Editabl
Parent node Tabs Number on page
Type e
1
Index Object Type Yes -

The Chart must be the top-most item on the No
page

What do you want to do?

Create a new Cost/Benefit Chart

Page node optional

To create a new Cost/Benefit Chart for your page:

1. Ensure the Layout node for your element is set to Empty
2. Right-click the Layout node and choose Add Behaviors > Other Charts > Cost - Benefit Chart

A Cost-Benefit Chart node is added below the Layout node.
3. Select the Cost-Benefit Chart node and set the properties.
i In the Costs area, select the properties you want to use as costs on the chart.
ii. In the Benefits area, select the properties you want to use as benefits on the chart.

jii. Use the Multiplier field to enter the multiplier number for equalizing calculations.

T

\ . | Costs tend to have higher values than those you assign to determine benefits such as business
N

importance. For example a cost might be 10,000, but the business importance might be 3 -
High.

The Multiplier can be used to set a value to multiply the benefits by so they can be brought
into line with the costs for comparison.

4. Right-click the Object Type node and choose to add a New Property Group

Use New Property Group > Empty Group or From CM Panel depending on your preference.

See Working with Property Groups for more details on Property Groups.

5. Select the Property Group and use the Selected Properties area to choose all the cost and benefit
properties you want to reference on the chart

6. Save your Site.

The Site is saved and the Cost/Benefit Chart is created.
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Working with Vector Maps

Vector Maps require that you have a specific Single Line Text property on your object which is
used to store a country code value, or a latitude/longitude value. The map will not work without

one of these codes.

Vector Maps enable you to highlight countries or places on a map so that the user can click through to see
more detailed information about that area.

You can use them on an Index Page, or on an Object Page to show locations that are associated to the

main object.

It works by using a single object in your model to represent an area on the map - either a country, or a
place within a country - that area is highlighted and is clickable so that a supporting Object Page can be
used to show additional information.

Example

Use Location objects to highlight each country where your organization has an office, and
then use an Object Page for the Location to show detailed information about each one, such
as which Functions (associated) are performed there.

There are two types of map available, each with several different built-in maps available:

+ Worldwide maps (used to show countries): World, Europe
o Country maps (used to show places): Belgium, France, India, Italy, Netherlands, Philippines, South
Africa, United Kingdom, United States.

If you want to view another map not currently on the list, please review this list of available
maps, then raise a request with your Account Manager or with the erwin Support Team.
Highlighting countries on Worldwide maps

When using Worldwide maps, you must have a user-defined property on the object to store the country
code. This must be a Single-Line Text property.

The country code is a two-letter code which adheres to the ISO 3166-1 standard, such as GB, US, FR. Read
more about ISO 3166 here, or here on Wikipedia.

Highlighting places on Country maps

When using Country maps, you must have a user-defined property on the object to store the latitude and
longitude reference for the place you want to show. This must be a Single-Line Textproperty.

The format for the value is '[latitude],[longitude]' - such as 48.856614,2.352222 for Paris.
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[ U )| Latitude values can be either North (N) or South (S), while Longitude values are either East (E)
or West (W).

When entering these values in Evolve, please use a plus sign '+'instead of N and E, and use
a minus sign -'instead of S and W.

What do you want to do?

Create a new Vector Map for your page

v
| ' || These instructions assume that you have already created your page, including

\
any filtering you may want so that only the objects you want displayed are shown.

To create a new Vector Map for your page:
1. Ensure the Layout node for your element is set to List (Simple)
For an Index Page the Layout node is the one directly under the Object Type node.
For an Object Page the Layout node is the one directly under the Association Type node
2. Right-click the Layout node and choose Add Behaviors > Maps > World Map (jVectorMap)
A World Map (jVectorMap) node is added below the Layout node
3. Select the World Map (jVectorMap) node and set the properties:
i Use the Map drop-down to select the map you want to use

ii. If you are using a Country Map to show places in a country, use the Lat Lang field to enter
the Scriptname of the Property Type used to store the latitude/longitude value

iii. If you are using a Worldwide Map to show countries, use the 1SO Code field to enter
the Scriptname of the Property Type used to store the ISO value

Always use lower case for Scriptnames.

4. Save your Site.

The Site is saved and the map is created.
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Working with Bar Charts (Simple)

The Simple Bar Chart behavior requires that you have a specific Whole Number or Decimal
Number property on your object which is used to store the value you want displayed on the

chart.
The Simple Bar Chart behavior displays a simple bar chart on your Index Page, listing objects on the yaxis
and referencing number properties on the x axis.

You can specify the maximum number of objects to display.

To create a Simple Bar Chart display on your Index Page:

1. Ensure the Layout node for your element is set to Layout (Empty)
2. Right-click the Layout node and choose Add Behaviors >Bar Charts > Bar Chart (Simple)

A Bar Chart (Simple) node is added below the Layout node.
3. Select the Bar Chart (Simple) node and set the properties:
i Use the Node Name field to set the title of the chart as it is displayed in the web page.
ii. Use the Unit field to enter the name of the unit that is displayed on the x axis.

jii. Use the Limit Number field to enter the maximum number of objects to display in the chart.

The name displayed on the legend at the top of the bar chart is taken from the Name of
the Property Type you are using on the x axis.
4. Right-click the Object Type node and choose New Property Group > Empty Group

An Empty Property Group is added below the Object Type node

5. Select the Property Group and in the Selected Properties area, select the property you want to base
the bar chart on

6. Save your Site.

The Site is saved and the bar chart is created.
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Working with Multi-Axis Bar Charts

The Multi-Axis Bar Chart behavior requires that you have a two specific Whole
Number or Decimal Number properties on your object which are used to store the values you

want displayed on the chart.
The Multi-Axis Bar Chart behavior displays a simple bar chart on your Index Page, which compares the
values of two properties of the objects referenced.

The chart has two scales, one for each property shown.

To create a Multi-Axis Bar Chart on your Index Page:
Make sure you use the Filter Properties controls on the Object Type node to ensure you filter
the list of displayed objects so that not too many are returned.
Always use lower case to enter Scriptnames.
1. On the Object Type node, in the Selected Properties area, select the two properties you want to be
referenced on the chart

2. Ensure the Layout node for your element is set to List (Empty)
3. Right-click the Layout node and choose Add Behaviors > Bar Charts > Bar Chart (Multi-Axis)

A Bar Chart (Multi-Axis) node is added below the Layout node
4. Select the Bar Chart (Multi-Axis) node and set the properties:
i Use the Node Name field to set the title of the chart as it is displayed in the web page.

ii. Use the Value Axis-1 field to enter the Scriptname of the first property you want to be
displayed.

jii. Use the Value Axis-2 field to enter the Scriptname of the second property you want to be
displayed.

iv. Use the Axis-1 Unit field to enter the name of the unit that is displayed for the first property.

V. Use the Axis-2 Unit field to enter the name of the unit that is displayed for
the second property.

The name displayed on the legend at the top of the bar chart is taken from the Name of
the Property Types you are referencing.
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Vi. Use the Direction drop-down to choose whether you want the chart to be
displayed horizontally or vertically

vil. Use the Legends Min/Max/Step field to specify the scale of each axis, setting the low end
of the scale, the top end of the scale and the interval value - using for format
low:high:int,low:high:int

For example 0:100:10,0:500:100 means that Axis 1 starts at zero and ends at 100 with steps
of 10 units, while Axis 2 starts at zero, ends at 500 and has steps of 100.

viii. Use the Hide Empty Data check box to specify that the chart should not display any objects
where the two properties referenced have no value

5. Save your Site.

The Site is saved and the chart is created.
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Working with Simple Bubble Charts

A Simple Bubble Charts allow you to compare objects of the same type, by analyzing three levels of

data and using the values to affect the size and position of the representations on the chart.
[ e ]

One value is used to position the bubble on the X-axis, another value is used to position the bubble on the

Y-axis, while the size of the bubble is based on the third property.

With its accompanying Data Quality Chart, it also enables you to see where your data is incomplete, by

highlighting objects that do not have values set for the properties you are referencing.

If you want to use a Bubble Chart that visualizes data from associated or indirectly associated objects,
see Working with Cluster Bubble Charts.

The Simple Bubble Chart requires three properties to compare - and these must all be
either Whole Number or Decimal Number properties - or they can be Drop-Down properties
where the Abbreviation contains a number.

Why and how should you use one?

You should use a Simple Bubble Chart when you want to visualize a comparison between objects based on

three properties.
A typical example would be to have some Application objects with three useful properties:

1. Cost - a Whole Number property to represent the monetary cost of the application

2. Business Alignment - a Drop-Down property ranging from '0 - Unknown' to '5 - Very High', which
represents how important the application is to the business

3. IT Alignment - a Drop-Down property with the same range as Business Alignment, which represents

how well aligned the application is to your current IT infrastructure, support and competencies

In this example the IT Alignment is used as the X-axis, the Business Alignment is the Y-axis, and
the size of each bubble is based on the Cost.

Where and when can you use one?

Use the table below to see where you can use a Simple Bubble Chart:

erwin Evolve — User Help Guide |
Data Visualizations |


https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/visualizations/bubble-simple.png

Page Parent Editabl
Tabs Number on page
Type node e

Index Object Type | The chart must be in a Tab, but The Bubble Chart must be the

Page node there can only be one Tab only item on the page

What would you like to do?

Add a Simple Bubble Chart to your page

No

[ 1 )| These instructions assume you have an Index Page node, containing a Tab
Controller with one Tab that includes an Object Type node.

The result will be an Index Page including two Tabs, one which you created and named
yourself and that holds the Bubble Chart, and the second which is automatically created and is
used for the Data Quality Chart.

1. Select the Object Type node and ensure all the properties you want to reference are selected in
the Selected Properties area

2. If you want to filter the list of objects displayed, use the Filter Properties area to apply any filtering

3. Switch the Layout node beneath the Object Type node to Empty

To do this: Right-click the Layout node and choose Switch Layout > CW > Empty
4. Add the Bubble Chart (Simple) behavior to the Layout node

To do this: Right-click the Layout node and choose Add Behaviors > Bubble Charts > Bubble Chart
(Simple)

A Dashboard Bubble Chart node is added
5. Select the Bubble Chart (Simple) node and configure the following settings:
o Use the Node Name to set the title of the chart as it appears in the web page

o Use Circle to specify the Scriptname of the property you want to use to affect the size of the
bubble

Always use lower case when referring to Scriptnames
o Use X to enter the Scriptname of the property you want to use on the X-axis
o UseY to enter the Scriptname of the property you want to use on the Y-axis

o Use the three Data Quality settings to choose whether the corresponding properties are

Drop-Downs (Lookups) or number properties

Choose 'Lookup_Abbreviation_Not_o'if the property is a Drop-Down
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Choose 'Not_Equal_To_o'if the property is a number
o Use Circle Unit to specify the text to be displayed on the chart for the bubble size value

o Use X Unit to specify the text to be displayed on the X-axis - leave blank to use the Property
Type Name

o Use Y Unit to specify the text to be displayed on the Y-axis - leave blank to use the Property
Type Name

o Use Circle Intersection Object Type to specify the Scriptname of the Object Type used on
the Object Type node

6. Save your Site.
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Working with Cluster Bubble Charts

Cluster Bubble Charts are similar to Simple Bubble Charts, except they allow you to visualize the
properties of an Associated Object (directly or indirectly), or an Intersection Object.

You can analyze three levels of data of the Associated Objects, using the values to affect the size and

position of the representations on the chart.

One value is used to position the bubble on the X-axis, another value is used to position the bubble on the

Y-axis, while the size of the bubble is based on the third property.

The way the Cluster Bubble Chart evaluates Associated or Indirectly Associated Objects is very similar to the
way Recursive Pie Charts work, however, instead of creating one chart that you can drill down through,

it creates a number of Tabs, one for each of the items in the top-level Object List, and then creates a
Bubble Chart on each one.

The Cluster Bubble Chart does not display a Data Quality Chart like the Simple Bubble Chart does.
The Cluster Bubble Chart requires at least one Association Type to exist - plus three
properties on the Associated Object to compare.

These properties must all be either Whole Number or Decimal Number properties - or they can
be Drop-Down properties where the Abbreviation contains a number.

Why and how should you use one?

You should use a Cluster Bubble Chart when you want to visualize a comparison between objects based on

three properties - but you want to take a higher-level view by using one or more associations.

A typical example would be like the example for Simple Bubble Charts, to have some Application objects

with three useful properties:

1. Cost - a Whole Number property to represent the monetary cost of the application

2. Business Alignment - a Drop-Down property ranging from '0 - Unknown' to '5 - Very High', which
represents how important the application is to the business

3. IT Alignment - a Drop-Down property with the same range as Business Alignment, which represents
how well aligned the application is to your current IT infrastructure, support and competencies
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In this example the IT Alignment is used as the X-axis, the Business Alignment is the Y-axis, and the size of

each bubble is based on the Cost.

However, where this differs from the Simple Bubble Chart is that instead of having one chart showing all
the objects, your Applications are associated to different Location objects and you want to see a chart for

each Location showing only the Applications associated to it.

The result is a Tab for each Location object and then a Bubble Chart for each showing just its associated

Applications.

While this example shows one level of association, you could make your chart use several, such as Location

> Organization > Application, or more.
Where and when can you use one?

Use the table below to see where you can use a Cluster Bubble Chart:

Page Editabl
Parent node | Tabs Number on page
Type e
Index Object Type | You must have an empty Tab The Bubble Chart must be the N
0
Page node Controller on the page only item on the page

What would you like to do?

Add a Cluster Bubble Chart to your page

1. Create a new empty Index Page with an empty Tab Controller and an Object Type, both added to the

Index Page node, in that order
See Create an Empty Index Page for instructions

2. Select the Object Type node and use the Filter Properties area to apply any filtering
3. Switch the Layout node beneath the Object Type node to Empty

To do this: Right-click the Layout node and choose Switch Layout > CW > Empty
4. Add the Bubble Chart (Cluster) behavior to the Layout node

To do this: Right-click the Layout node and choose Add Behaviors > Bubble Charts > Bubble Chart
(Cluster).

A Bubble Chart (Cluster) node is added.
5. Add an Association node to the Object Type node

To do this: Right-click the Object Type node and choose New Association > [object-type] >

[association-type]
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A new Association Type node is added.
If your chart examines indirectly associated objects, add all the additional Association Types
required, nesting them beneath each other

The last Association node you add is for the Object Type you want the bubbles on the chart to

represent.

6. Select the Bubble Chart (Cluster) node and configure the following settings:
o Use the Node Name to set the title of the chart as it appears in the web page

o Use Circle to specify the Scriptname of the property you want to use to affect the size of the
bubble

This should be from the Associated Object - or, if you are referencing an Indirect

Association, from the last Associated Object in the path.

Always use lower case when referring to Scriptnames.

o Use X to enter the Scriptname of the property you want to use on the X-axis.
o UseY to enter the Scriptname of the property you want to use on the Y-axis.

o Use the three Data Quality settings to choose whether the corresponding properties are

Drop-Downs (Lookups) or number properties.
Choose 'Lookup_Abbreviation_Not o' if the property is a Drop-Down
Choose 'Not_Equal To_o'if the property is a number
o Use Circle Unit to specify the text to be displayed on the chart for the bubble size value

o Use X Unit to specify the text to be displayed on the X-axis - leave blank to use the Property
Type Name

o Use Y Unit to specify the text to be displayed on the Y-axis - leave blank to use the Property
Type Name

o Use Circle Intersection Object Type to specify the Scriptname of the Associated Object
Type

7. Save your Site.
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Working with Radar Layout

A Radar layout is used to create a chart that displays three or more* Object properties on different axes
which start from the same central point.

A simple Radar chart uses one line to display the different properties of a single object (a Property Group).

The Radar layout can also overlay multiple lines into a single chart to display the various properties of

an Object List. Each line is used to represent a different Object.
With the Radar layout, you can use one chart to visually consolidate multiple values of a single object, or

multiple values of many objects, against one another.

(Y) *We recommend that 3-10 properties or values are used per Object for clarity purposes.
NS

Why and how should you use one?

Use the Radar layout when you want to visually compare the different properties of a single object, or of

many objects, against each other.

You can use radar layout list in an index page or a single page. To do this, add an index page (or add a “New

Association” for single pages).

Next, add a properties group and under “Selected Properties”, tick the properties that you wish to display in

the radar layout. Please note that only integer properties (i.e numbers) can be represented in radar layout.
Where and when can you use one?

Use the table below to see where you can use the Radar Layout:

Number on Editabl
Page Type | Parent node Tabs

page e
Index Page | Object Type node Yes - optional Any No
Object Association Type Yes -

Any No
Page node mandatory

What do you want to do?

Use a Radar Layout

To create a Radar layout for the properties of a single object:
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This is either the Object Type Node on an Index Page or an Association Type Node on an Object Page.

Selection is only applicable for integer Properties as Radar Layout requires that only integer
values are used to create charts. Decimal numbers are permitted, however.

1. In Evolve Designer, locate the Parent Node that you want your Radar Layout to be applied to.
2. From the Layout drop-down menu, select Radar.

3. In the Selected Properties area of the Parent Node, select all the properties that you want to display

in the Radar.
4. Save and Publish your Site.

5. Navigate to the appropriate Object or Index Page on your Site, and the Radar chart will be displayed.

To create a Radar layout for the properties of many objects:
This is either the Object Type Node on an Index Page or an Association Type Node on an Object Page.
Choose Switch Layout > CW > Radar.

1. In Evolve Designer, locate the Parent Node that you want your Radar Layout to be applied to.
2. Right-click beneath the Parent Node Layout to change the Layout to Radar:

3. In the Selected Properties area of the Parent Node, select all the properties that you want to display

in the Radar.
4. Save and Publish your Site.

5. Navigate to the appropriate Object or Index Page on your Site, and the Radar chart will be displayed.
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Working with the Visual Identity
Layout

The Visual Identity layout is used to show a list of objects with Visual Indicators to represent some of their
properties, rather like you can with Shape Regions in CW Modeler.

The layout displays each object as a rectangle, and then at the bottom of each shape you can show icons

to represent the values of one or more properties of your object.

It means you can build a dashboard-like page for a set of objects, highlighting important data about each
one, for example, showing a red circle if an object has a Business Risk of '3 - High' or a green circle if it has

a Business Risk of 'l - Low', and so on.

@ As for all Visual Indicators, the Visual Identity layout only supports lookup (drop-down) and check
box (true or false) properties of your objects.

In order to use the Visual Identity layout you must have configured a Custom Site to support the
use of Visual Indicators.

Why and how should you use one?

Use the Visual Identity layout when you want to create a dashboard-like view of a set of objects or

associated objects, highlighting some of the important data about the objects displayed.

For example you could use the layout to provide an overview of the state of a set of Server objects, using the

indicators to show high-level data about each server.
Where and when can you use one?

Use the table below to see where you can use the Visual Identity layout:

Editabl
Page Type | Parent node Tabs Number on page

e

) ) One, or one per
Index Page | Object Type node Yes - optional Tab No
a
Object Association Type Yes -
One per Tab No

Page node mandatory

Use the Visual Identity layout
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These instructions assume you have already configured your Custom Site to support the use of
Visual Indicators for the Object Types and Property Types you want to reference.

To use the Visual Identity layout:

1. In Evolve Designer, locate the parent node you want your Visual Identity layout to be applied to
This is either the Object Type node on an Index Page or an Association Type node on an Object
Page

2. In the Selected Properties area of the parent node, select all the properties you want to use as
visual indicators

3. Switch the Layout of the node to Visual Identity
Right-click the layout beneath the parent node and choose Switch Layout > CW > Visual Identity

4. Select the Layout Visual Identity node

5. In the Properties List field, enter the Scriptname of the Property Type you want to be used as an
indicator
You can reference multiple Property Types by entering the Scriptnames of each, separated using
comas

6. Save and Publish your Site.
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Working with Visual Indicators

Visual Indicators are small icons or images that are displayed to represent the values of properties of your
objects, rather like you can with Shape Regions in CW Modeler.

It means you could use a series of colored discs to represent Categories of an object, or tick and cross icons

to show whether a value is true or false.
They can be used with the Visual Identity layout, and with Custom Display Strings.

In order to use Visual Indicators though, you must deploy your site as a Custom Site, as the images
you want to use as your indicators must be stored on the Evolve server and deployed with your Site when

you publish it.

Visual Indicators can only work with lookup (drop-down) and boolean (true or
false) properties of your objects.
Configure your Custom Site to support the use of Visual Indicators

To use Visual Indicators on your Site, you must place image files in the correct location in a Custom Site

folder, and make sure they have the correct file names.
Folders

For each Object Type you want to use a Visual Indicator with, create a directory with the name as the

Scriptname of the Object Type in your Custom Site 'images' folder.

For example

<your-custom-site-folder>/images/image_mappings/application
<your-custom-site-folder>/images/image_mappings/process

Inside each Object Type folder, you must create additional folders for each Property Type you want to use as

an indicator, again named according to the Scriptname of the Property Type

For example
<your-custom-site-folder>/images/image_mappings/application/validated
<your-custom-site-folder>/images/image_mappings/application/type

Files
In each Property Type folder, you should place image files for each of the possible values that can be set.

Files should be named as follows:
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e Use 'true' or 'false' for boolean Property Types

e Use the Abbreviation for lookup (drop-down) Property Types.

If you want to show an indicator for the 'Undefined' value for a lookup, create an image named
'undefined..

Evolve supports PNG, JPEG and GIF for the images, but as images look best when they use a transparent

background, we recommend using PNG files.

In the Site the images are re-sized to be displayed at 16x16 pixels, so we recommend creating square
images that will not be skewed when re-sized. For optimization reasons, we recommend creating images

that are already 16x16 pixels.
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Working with External Pictures

An External Picture layout is used to show a picture for each object in a list, and works by using a property
on your objects to reference images on the Evolve server.

B oMoz
.

It is similar to the Image layout, except it is much better suited to displaying smaller images.

For example, you could have a number of 'Product' objects, each one with a 'logo' property. If you upload an
image for each product to your Evolve server, you can enter the image name in the 'logo' property for each
product, and using the External Picture layout, display that logo on an Index Page or Object Page (if listing
Associated Objects).

In order to use the External Picture layout, you must have a Property Type on your object which
can be used to store the image file reference. This must be a Single-Line Textproperty.
Note the scriptname of this Property Type.

The External Picture layout also requires you publish your Site as a Custom Site, and image files

must be uploaded to your Evolve server.

Why and how should you use one?
Use the External Picture layout when you want to display an image for each object in a list.
Where and when can you use one?

Use the table below to see where you can use an External Picture:

Number on Editabl
Page Type | Parent node Tabs

page e
Index Page | Object Type node Yes - optional Any No
Object Association Type Yes -

Any No
Page node mandatory
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What do you want to do?

Use an External Picture layout

To use the External Picture layout:

1. Ensure you have a Single-Line Text Property Type on your Object Type where you can enter the
image name. If you do not have one, use CW Suite to create a new one.

For example, create a new Property Type titled 'logo'.

If you create the Property Type while Evolve Designer is open, you will have to close Evolve
Designer and re-open it in order for it to recognize the new meta data.
2. Upload all the image files you want to use to the 'images' folder, or a sub-folder within it, in

your custom Site folder
All standard web image formats are supported.

3. For each of the objects you want to use an image with, enter the image file name in the new property
field.

What you enter here must be the full path to the image file, with the root being the images’ folder in
Yyour custom Site folder. Therefore, if you uploaded your images directly into the images’ folder, you
can simply enter the image file name. However, if you created a sub-folder there, you should

enter: <sub-folder-name>,/<image-file-name>, such as 'logos/myimage.png"
4. In Evolve Designer, locate the parent node you want your External Picture page to sit beneath
This is either the Object Type node on an Index Page or an Association Type node on an Object Page

5. In the Selected Properties setting for the parent node, ensure you select the new Property Type
which stores the image reference

6. Right-click the layout beneath the parent node and choose Switch Layout > CW > External Picture

7. In the Layout ID setting for the External Picture layout node, enter the scriptname of the Property
Type which stores the image reference.

8. Save and Publish your Site.

SN
( /' Please remember that now you are using a custom Site you must select that custom Site in

the Deployment node settings for your Site.
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Working with the Image Layout

An Image layout is used to show a picture to represent each object in a list, and works by using a property

on your objects to reference an image file on a web server.
It is similar to the External Picture layout, except it is much better suited to displaying large images.

Users visiting your page can choose to navigate to the Object Page for that object, or can view the image in

fullscreen mode.

If one or more of the objects returned by the list do not have a value for the image URL property, that object

is omitted from the displayed list.
To display the same image as a property of your object in an Object Page, use the imageFromURL Property
Group layout.
In order to use the Image layout, you must have a Property Type on your object which can be
used to store the image file reference. This must be a Single-Line Text or URL property.
Note the scriptname of this Property Type.
The path to the file must be a full URL, such as:
http://www.mysite.com/images/myimage.png

The following image formats are supported: PNG, JPEG, GIF.

Why and how should you use one?

Use the Image layout when you want to display a large image for each object in a list, whether that's a list of

objects on an Index Page, or a list of Associated Objects on an Object Page.
Where and when can you use one?

Use the table below to see where you can use the Image layout:

Editabl
Page Type | Parent node Tabs Number on page o
. . One, or one per
Index Page | Object Type node Yes - optional Tab No
Object Association Type Yes -
One per Tab No
Page node mandatory

What do you want to do?
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Use an Image layout

These instructions assume you have already created the Property Type to store the reference,
have populated the property for some of the objects, and have images stored in the locations

you reference.

To use the Image layout:

1. In Evolve Designer, locate the parent node you want your Image layout to be applied to
This is either the Object Type node on an Index Page or an Association Type node on an Object
Page
2. Switch the Layout of the page to Image
Right-click the layout beneath the parent node and choose Switch Layout > CW > Image
3. Enter the scriptname of the Property Type you are using to store the image file reference in
the Image URL Property Scriptname setting.
4. Save and Publish your Site.

The Custom Display String feature does not work with the Image layout.
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Working with View Box Layout

The View Box layout is a display function used internally by Evolve. This option is reserved and is not

intended for customer use.

What do you want to do?

Select an Alternative Layout
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Working with the Custom URL
Layout [2018.0.2+]

The Custom URL layout is a display function used to display a URL property as a hyperlink, with a custom
display string for the caption.

1. Create a property group, and select a single property to display in that group.

2. Use the Custom Display String to define the text to display to represent the link.

3. Select the Layout 'URL'

4. When the property is displayed in the page, it will now show the Custom Display String, but have the

original URL.
Layouts Options [cwWebDesignerTreeNodePropertiesGroup] - General
g ‘@ Object Pages ~ Property Group Name |
[ : General
= Fﬁ] application
Identifier

- o Application

- jﬁ] attribute

t)

] rﬁ] businessrule

]:ﬁ] cw_user_favorites Layout URL
t]

(- jj] datastore

IprOpEﬂmaUP_2134759443

Custom Display String |Open Documentl

el

=

Fig. URL Property

& jj] diagram Display Full Width 0
& ']j] document
L Selected Properties =.
=% O Document & General
-8 Layout Object P [ Sitame
~~50 Layout Object Page LOCate
| = ; gory
S Tabs [Local Link - Deliverable
- @8 Properties ~[OLocal Link - Template
i -E8 General FWeb Link - Deliverable
53 Description - Dng !.lnk - Deliverable2
i 7 @ [JDescription
(= b Associations -
. @-[JStatus
o Project & [Version
- jr]] entity
0

Related Topics

Select an Alternative Layout
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Working with Text Editor

The Text Editor incorporates an HTML content editor to provide rich text formatting options for multi-line
descriptive fields. The Text Editor option is only available for the Memotext Property Type with the
Enhanced Multi-line Text Control setting enabled on the Property Type Page.

Use of Memotext without the Enhanced setting, will provide either a read only HTML text field, or an
editable plain text field, dependent on the content stored in the property. For example in Object Explorer, if
the content is edited in Text mode, it is possible to edit the related non-enhanced Memotext field on your
Site. Should the text be converted to and edited as HTML content in Object Explorer, it will no longer be

available to edit on your Site, even when edit mode is selected:

Application properties: Activity Monitoring

General | Description | Detals  HTML h:mﬂd‘!hlﬁlimlwl

Convert To HTML  Revert to HTHL

MemoText | Text Mode - Editable

Memotext (non enhanced)

MemoTexd : Text Mode - Ediable

Asgociation o I
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Application properties: Activity Monitoring

B Eba. - Paragrapt = . A i B f Ul

MemoText : HTML Maode - READ ONLY

Memotext (non enhanced)

MemoText : HTML Mode - READ ONLY

Assodiations oK I

With Text Editor all content is defined as HTML by default, and so is always available to edit on your Site.
Text Editor also provides additional formatting options (commonly associated with word processors) for

enhanced content editing:

Application properties: Activity Monitoring - a Description

Gerersl Descroton | Detis | MM | Access fightz | Status | verson |
Edi ~ insed~ View~ Formal »  Table »  Todls =

Edt = Inset~  Wiew =~  Format ~ Tabk = Took -

® o |Pusgupn - AnsiBisck < 149t AR~ |f|E # b |Pamagraph ~ FonlFamiy - FonlSkes - A v Al v f B

B @ B JUSYx S~ErTEEE==E # L . R
XhEmBITUSX x S"E~"EEFFIAE G I

Manage and monitor the operatlanal activities of the

enterprise . - P

’ Manage and monitor the operational activities of the

enterprise

LEY -] Waids: §

= w ] e | e | L] Words: ¢

Additionally, the Text Editor can be used to:

e Enter HTML code directly (including hyperlinks and images)
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e Print the contents of a multi-line text field
e Copy and paste formatted text and HTML code to and from other applications, such as Microsoft
Word.

Content pasted will have the formatting simplified to match the capabilities of the Editor. Styles
such as Headings will be mapped to equivalent HTML styles.

The Text Editor uses an open source TinyMCE program and can be found in the following
location: Bin>WebDesigner>/S>External_async>TinyMCE

*TinyMCE is a platform independent web-based Javascript HTML WYSIWYG editor control and
/s released as open software under the LGPL license. It is sourced from www.tinymce.com and

is used in many popular web applications.

What Do You Want To Do?

Enable Enhanced Multi-line Text Editor for Internet Explorer

If using Windows Internet Explorer as your web browser, it will be necessary to enable a font setting on your
server in order to use the Enhanced Multi-line Text Editor.

To enable Enhanced Multi-line Text Editor for Internet Explorer:
A second settings box will display.

Enhance Multi-line Text Editor will now be enabled for use with Internet Explorer.

This change to your settings will not take effect until Internet Explorer is restarted.

. From your Control Panel, open up the Internet Options settings.

. Select the Security Tab.

. Click on the Local Intranet icon to open up your local Intranet settings.

. In the 'Security level for this zone' box, click on the Custom Level button.
. Scroll down to the 'Font Downloads' section and select the Enable setting.
. Click on the OK button to close the settings box.

~N O o B~ W N -

. Click Apply, then OK on the Internet Options page to apply the change.
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Enable Enhanced Multi-line Text Editing

To enable the Text Editor:
1. Open CW Suite Model Explorer and click on the Design tab.

2. Select a Model and Object Type. Double click on the Object to reveal its properties (Model > Object Type
> Properties).

File Edit View Action Tools Help

=l SR . = QEHE-BHEA
0 Models A T Name |
B850 Casewise Framevaork Examgl = Average Ratng
I: Ii“ EAFnum:Iah:n Sample Mod IZ Calegony
— - E Code
— . __.-_ Contact
Properlies - ﬂmmalnn Eu&mgs Ful _'—_:_ E:::;’f;!rﬂ
i - Association DataStare Ag = Ciestion Date
— i s Aszociation DataStore Te _—r
Panes | |~ Association Flow Apphcs
[ e Associstion Flow Apphicsl
" i i-ugw Associstion Flow Entity -
. bl Asvaciation Indicator Pios 2=
Associsliong [l Aszocistion 1T Pertiolio & 2 Entesprise Standard
| -8 Associalion IT Portiolio 1T | 2= Freeze Level
(g Aszociation ITPortfoko Er A2 GoLive Date

For help with creating new Object Types and associated Properties, see Object Pages Explained

The properties dialog for that Property Type will display:
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Property Type properties: Description -

eneral

Name:®

Pescriton
Serpt Name:™

[pESCRIPTION
Diata Type:

[ e st =1
krr Maximasm Mumber Of Characters

I Enhanced Multi-line Text Control

™ Confirmed fortranslstion
™ Read Oaly
T Mandstory

Asgociations I ITI Cancel I Helg L

3. Ensure that Multi-line Textis selected as the Data Type before selecting the Enhanced Multi-line Text

Control option.

Property Type properes: Description Duita Typa:
e

G | peserptn | e | St | vessen |
dzmr Mazi masm Number Of Charsders

m. l ¥ Enhanced Muliidine Test Control I
| ] [ Confiemad for transistion
e [ Fead Guly

%Y Mmimes hewbar 0 Charactars [T Mandatery

Selecting the Enhanced Multi-line Text Control check box will prompt a caution dialog box to display. After

reading the message, click on the OK button.
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Enhanced Multi-line Text Control
Selecting this cption enables the Enhenced Multi-ine Test Control for
Qk this Property Type.

Any exsting data entered using this Property Type could be displayed
Efferently after this change has been made.

We therefore recommend that you reveew il previously entered data
before making any updates using the Enhanced Mudti-line Text Control,

You can always switch back to usng the standard control by
wreelecting this option,

The Enhanced Multi-line Text Control check box will be ticked and the Text Editor will now be available for
use with this Object property in both CW Suite Desktop products and your Evolve Site.

Data Type:
|""IJ|.I-|I'E RExt j

Lrp - Maximum Mumber Of Charactars

I [¥ Enhanced Multi-line Tast Contral |

[T Caonfirmed fortranslation
[~ Read Only
[ Mandatary

4, Click on the OK button.

5. Open Evolve Designer and select the check box of the modified Object Property type:

Wed ® & O

Dtices EaNEOsoore T et aowltpchelmectTrce] - Agpicaton
S Bomn It
Ooyect Type
et Oy O
P
ot b

ekon Ot Ordy f Have Alsocsore

e e Py

R e

e

Licecss Tyoe
Marurarce Aecmsiiny

Msrmrarce (o
Ea

6. Publish the changes to your Site. See Publish your Site.

7. Open the Evolve Site and locate the desired Application Object to view its related Property Types.
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MemoText : HTML Mode - Read Only

8. Click on the Edit button at the top of the Object Page to switch into Edit mode and the Text Editor will
open up as part of the newly configured Property Type.

w(8]z] =)

The text of that Property Type can now be edited with enhanced formatted options using the Text Editor.
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The Text Editor will not function under two Object Property Types simultaneously. We
recommend that the Text Editor is assigned to one Property Type per page.
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Memotext vs Table Layout
It is possible for the Text Editor to display in a constricted state. This occurs when its Layout

property is set to display in a Table view.

DresCripion

Edi = Inseri = Wiew = Fomal «

Table = Took =

L)

Farageaph = [Font Family = Fonl Sizes L
ATHE~ F B

XKbe BB T Y S xR
E-ETEEEFEFEE @ 5L

DS ripdicn )
Manage and monitor the

operational activities of the
enterprise

p Wity 3

For optimal editing functionality, we therefore recommend that Memotext is selected as the

default Layout for the Text Editor in Evolve Design.

Descriptan

Edl = Inied= Visy+  Fomal+ Table = Took =

h o Faagagh - FonlFamly = FentSows = A~ W - & @

Frpaty g Hare —
] -
i e XLl BI/USxx S"E-EEFFFE # L
[ o — i . i .
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s Frowim = L
enterprise
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1
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L

B

[ Wionde §

Grid Mode

In Grid Mode, it is not possible to edit text placed within a text field. Any text previously
entered in CW Modeler will display as read only, even when Edit mode is enabled.
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Save and Send Changes for Approval

To save and commit any changes made using the Text Editor:

1. Make any desired changes to the text of a Property Type then click on the Save button (located in the
top right-hand corner).

<|8]o)e]

A third panel will open up on screen, displaying a summary of the new changes made using the Text Editor.

Uipdate Summary |T1
Prapeiy Cranges

Dsscrighon
Haden [

The Update Summary area presents a summary of the changes made using the Text Editor to the User.
Clicking on the Show Originalinstruction will reveal the original state of the modified text.

Update Summary E] Update Summary @
Property Changes

Pmpert}[ Cha”ges Description

Description

. I'.hl'l.':l]ﬂ and monitor the operational activiies of the nn1ernrl=e|
Show Oniginal

Hide: Original

Click on the Hide Original instruction to once more remove the original unaltered text from view.

2. If happy with the changes made, click on the Submit button to send on the changes for approval.

Review and Approval Notifications

If Workflow has been enabled for your site, when a text field has been altered using the Text Editor and a
user desires to save the changes made, the designated Approver is sent a 'Pending Changes' notification
email. Any changes made will not be implemented until authorized by the Approver. The Approver will
receive an email stating: 'This property contains HTML content. Please review this change in Evolve'. -
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prompting them to access Evolve and assess the detail of all HTML changes made. This content is not
included within the email as email systems will often display this incorrectly and cause confusion for the

user.

See Working with Tasks

erwin Evolve — User Help Guide
Data Visualizations



Displaying Diagrams

Display a CW Modeler Diagram

Any diagram in your model created in CW Modeler can be displayed in your Evolve Site.

You can display diagrams on any Object Page where the focus is the Diagram Object Type, or on Object
Pages where the focus is a different Object Type, but a Tab is used to display diagrams the object appears
on or details.

You can also display diagrams on Index Pages where one or more diagrams are returned. For performance
and usability reasons it may not be appropriate to display multiple diagrams on one Index Page, however you

could easily use the page filters so that only one diagram is returned in the results.

The default method for displaying CW Modeler diagrams is to use the CW Modeler Diagram behavior, but

you can experiment with a newer behavior - Vector (HTML5) - which provides improved quality and scaling.
Display a CW Modeler diagram

These instructions detail how to display a CW Modeler diagram on an Object Page for the
Diagram Object Type.

You can of course show Visualization diagrams in other places, such as below an Association
node in a Tab on an Object Page, or below an Object Type node on an Index Page.

To display a CW Modeler diagram:

1. In Evolve Designer, expand the Object Type node
2. Right-click the Layout node and select Switch Layout > CW > Diagram

A Layout Diagram node is added.
3. Right-click the Layout Diagram node and select Add Behaviors > CW > CW Modeler Diagram
The CW Modeler Diagram node is added.
4. Select the CW Modeler Diagram node and edit its properties:
o Use Full Screen to specify if the diagram should be shown in full-screen mode.

o Use the Diagram Popouts area to specify any Diagram Popouts you want to configure for

this page.

5. Save and Publish your Site.
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Display a Visualization Diagram

This page explains how to display Diagram Designer Visualization diagrams in your Evolve Site.

Visualization diagrams are typically used to visually-represent an object and its relationships to other
objects, allowing you to see a specific object in context.

However, rather than being a fixed diagram created in CW Modeler, they are automatically generated at the

time of viewing.

Visualization diagrams are created as 'layouts' in Diagram Designer. The layout defines which Object Type is
the focus of the diagram, which other Object Types and Associations should be shown, and how the diagram

should be organized, but it does not specify which object instances should be shown.

In Evolve, you can configure a page to show a diagram generated from one of these layouts, resulting in a

dynamically-generated view of an object in context.

You most commonly display Visualization diagrams on Object Pages, where you want a visual

representation of the subject of the Object Page. However you can also display them on Index Pages.

This Help does not explain how to create Diagram Designer layouts.

Evolve only supports Diagram Designer layouts which have one object instance as the focus.

Display a Visualization diagram on your web page

These instructions detail how to display a Visualization diagram in a new Tab on an Object
Page.

You can of course show Visualization diagrams in other places, such as below an Association

node in a Tab on an Object Page, or below an Object Type node on an Index Page.

To display a Visualization diagram on your web page:

1. In Evolve Designer, expand the Object Page node where you want your diagram to be displayed
2. Right-click the Tab node and select Add Layout > CW > Diagram

The Layout Diagram node /s added.

3. Right-click the Layout Diagram node and select Add Behaviors > Diagram > Visualization
(Automatic Diagram)

The Visualization (Automatic Diagram) node is added.

4. Select the Visualization (Automatic Diagram) node and edit the settings:
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Use Diagram Design Name to select the Diagram Designer layout you want to use on this page. Only
layouts focused on the same Object Type as the Object Page are listed.

Use Display Mode to choose how you want the diagram to be displayed, either constraining it by

diagram height, or displayed in full-screen mode.

5. Save and Publish your Site.

Related Topics

Create a Visualization / Automatic Diagram
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Display Object Data with Diagram
Pop-outs

This page explains how to create and use Diagram Pop-outs to display the data behind objects that appear

on diagrams.

‘ You can use Diagram Pop-outs with all display Layouts in Evolve.

See Layouts and Behaviors Explained for a full list of supported Layouts.

Diagram Pop-outs are used to display information about objects that appear on a diagram.

When a user clicks on an object on a diagram in the Site, a pop-out panel showing the object's details is

displayed on the right of the browser window.

Diagram Pop-outs are completely customizable, so you can choose exactly what data you want to show for
any given object, and you can even display different pop-outs depending on the Category of the object.

Pop-outs are constructed in a similar way to Object Pages, although you cannot use Tabs, but as such they
can include properties of the object, lists of associated objects, as well as some visualizations. Behaviors

are not supported in Diagram Pop-outs.

Like Object Pages, Diagram Pop-outs are Object Type specific, so you must create a pop-out for each
type of object you want to view the details of.

There are two steps to getting Diagram Pop-outs working on your Site:

1. Create a Diagram Pop-out

2. Configure a page to use a Diagram Pop-out.

—~
(U )| Ifyour Site was created in Evolve 2.2 or earlier, you must enable Diagram Popouts in Evolve

\
N

Designer before you can create any.

To do this:

i Open your Site in Evolve Designer
ii.  Right-click the Site node and select Add Diagram Popout Node

The Diagram Popouts node is added to the bottom of the Site tree.

What do you want to do?

Create a Diagram Pop-out
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To create a Diagram Pop-out:

1. In Evolve Designer, right-click the Diagram Popouts node and select Add Object Page for Object
Type > [object type]

A node is added for the Object Type you selected
2. Configure your pop-out to display some object data and/or associations

You configure the pop-out to display data in a similar way to how you build an Object Page,
using Property Groups and Associations. However, there is one important difference to an Object
Page - you cannot use Tabs.

You can use multiple Property Groups, and you can use multiple Associations.

See here for information on using Property Groups

The Property Group Layout FlatList ' particularly useful on Diagram Pop-outs, as it combines multiple

properties in a simple display format.

3. See here for working with layouts and behaviors for Associations

4. When you have completed the configuration of your pop-out, Save it.

In order for your pop-out to display on a diagram page, you must configure the page to use it.

Configure a page to use a Diagram Pop-out
Even if you have created a Diagram Pop-out, you must configure individual pages in your Site to use it.
You can display a Diagram Pop-out on any Object Page or Index Page which is configured to display a
diagram.
To configure a page to use a Diagram Pop-out:
1. On your page, select the diagram behavior node you want the pop-out to work with
The CW Modeler Diagram, Vector (HTML5), or Visualization (Automatic Diagram) node

2. Use the Diagram Popouts area to choose the pop-outs you want to use for different Object Types

that appear on the diagram

Use different rows to specity different pop-outs for different Object Types or Categories of the same

Object Type.

i Use the Object Type drop-down to select the Object Type you want a pop-out for
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ii. Use the Category drop-down to select the Category of the Object Type you want the pop-
out for - or leave the Category as 'UndefinedValue' if you want your pop-out to apply to all
instances of the selected Object Type

iii. Use the Diagram Popout drop-down to select the specific pop-out you want to use for the

Object Type and Category combination you have chosen
3. Save and Publish your Site.
Create Category-specific Diagram Pop-outs
You can show different pop-outs for different Categories of the same Object Type.

To do this, create multiple pop-outs for one Object Type, then, when configuring your page to use the pop-

outs, choose different pop-outs for different Categories of objects.

If you want to have just one Category of Object Type showing a different pop-out to the others, create a
generic pop-out and set it to 'UndefinedValue' on the diagram page, then specify the Category pop-out just

for that specific Category.
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Display a Diagram on the Home Page
of your Static Site

If you publish your Site as a Static Site, you can create a special home page which displays a CW Modeler

diagram.

This feature does not work with Dynamic Sites.

To display a diagram on your Static Site home page:

1. Create a new Diagram Index Page
2. Enter 'home' as the Page Name
3. Ensure your page filter is configured so that only one diagram is selected

For example: 'ID = 12’
4. Save and Publish your Site.
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Displaying Vector (HTML5) for
Displaying Diagrams

This page explains how to display CW Modeler diagrams in Vector (HTML5) format in your Evolve Site.

Vector (HTML5) diagrams introduce a new method for displaying CW Modeler diagrams, bringing increased

load performance, better picture quality and perfect scaling.

Use the Vector (HTML5) Diagram display
To use the Vector (HTML5) Diagram display:

If you want to compare the appearance of the Vector (HTMLS5) version of your diagram and the

original CW Modeler version, you can display both versions in your page. To do this, each
diagram must be displayed in a different Tab. Ensure that you enter a specific Layout ID for

each.

This is a useful way to provide us with feedback about the differences you experience.

1. Open one of your existing Diagram pages.

2. Add a new behavior to the Layout Diagram node you want to change, ensuring you choose the Vector
(HTML5) option.

3. Delete the existing CW Modeler Diagram node.

Support for diagram elements

The Vector (HTML5) diagram behavior supports all diagram elements typically available to CW Modeler

diagrams, except for the following:
The following elements are NOT supported:
e Association Type Regions
The following elements are PARTIALLY-supported:

e Version Control (all items except for the Detailed Object section)

e Free Text (only Free Texts referenced on the palette)
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[ 1) IMPORTANT

Vector (HTML5) Diagrams will not correctly display any diagram element where the formatting of
the element is applied directly on the canvas.

Only formatting applied to items on the New Objects Palette of the corresponding template
diagram are displayed correctly.

Diagram Shapes

There is partial support for available for the following diagram shapes:

Jo o DDDCDE‘

EIEIC D OoQIoCed Dl
CHOUOOOOOO®®®
oA oOdUanNV O
{5 [ [0 (o] (o [ (] (o] [
FHHENOO0OIE a0
oo C O

RED = NotSupported

Supported with differences to the original CW Modeler

BLUE = diagram.

VAT
( ||| Please note that due to the rendering limitations of Internet Explorer 9 and 10, using shapes with a

dashed outline may prevent the diagram from rendering properly.

Lines and Connectors

All lines and Connectors are supported.
Shape Regions

The following table shows the support for shape regions:
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Region Level

Label

Association Type

Property Value

Property Value (Custom)

Property Visualization using Reference
property

Property Visualization using Palette value

Explosion with rule and category

Property gauge using a reference property

Property gauge using Palette

Property Gauge as date range

Explosion

Explosion with rule

Navigation

(1)

\_* /| Ayellow triangular ( ! ) Warning icon will display next to the action buttons in the top right hand

corner when:

e |If there is misalignment between the Template Palette and the Diagram Palette. However,
the icon will not display if the misaligned objects in the palette use names that have
previously been accepted for aligned objects, even if their settings have been changed.

e A diagram uses unfinished or missing connectors. Close and reopen the diagram in

Corporate Modeler . If the Warning icon remains, this is likely due to another issue.

® Missing Shapes create a Broken Layer. Close and reopen the diagram in Corporate Modeler

. If the Warning icon remains, this is likely due to another issue.
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Please be aware that certain fonts are not supported by all browsers. When using the HTML5S
Canvas, some fonts will therefore be substituted for alternative styles, depending on your
browser type.

Publishing Static Sites

If you only use the Vector (HTML5) behavior to display diagrams in your Static Site, you can tell Evolve to no

longer generate image files of the diagrams in your repository when you publish the Site.

Generating diagram image files is often the most time-consuming part of publishing a Static Site and they
are not needed for the Vector (HTML5) behavior, so choosing not to export them can significantly speed up

publication.

Use the Export Diagram Images option on the Site node settings to disable diagram image generation.
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Editing Business Process Diagrams

Please check with your Administrator that firstly, your Server and Internet Browser meet the
necessary system requirements to use BP modeler. Secondly, check with your Administrator

that the eModeler feature is enabled.

BP modeler is used to both edit and create Process Diagrams online, using predefined Dynamic Templates

and Themes.

Save & Publish

TitIeéBar Help Toggle

r Exit Editor
b Rent a Movie (Process Capture) ADMIN

Name Rent a Movie (Process Cap

Tithe Rent a Movie (Process Cap

Undo / Redo Buttons I R

Zoom Controls e Eve

-—— Canvas Area—~ Editor Menus ——

7 Draft Status APREAEEE
v Draft Saved ACTIONS

The different features within the Editor are detailed below:

Title Bar Displays the Diagram Draft and related Rent & Movie {Procass Capture)

Template Names

Zoom In, Reset Scaling, Zoom Out and Full +
Zoom Screen. #
Controls Click and move the 'Radar' view to zoom -
around the diagram. .

erwin Evolve — User Help Guide
Displaying Diagrams



Canvas
Controls

Undo, Redo, Save & Publish, Help and Exit
Edit Mode.

Editor Menus

Home to the different BP Modeler

Panes: Diagram, Appearance, and Actions.

Canvas Area

T

<—— Canvas Area >
Process Diagram will display. l

The area where the edited/created

Navigation

BP modeler contro

Is that can be used when editing a diagram.

Click Summary
Mode Click Behavior
Type
. Displays the Context pane for that Shape/Connector in the Menu pane (edit properties,
Single ;
Standar connect another Shape, add/remove Swimlane).
pens the Properties sub-menu and enables the Name and Title fields for entering or
d Double (0] he P i b d bles the N d Title fields f i
editing the Shape/Connector's name.

Keyboard Shortcut Summary

Keyboard Behavior
Shortcut
Ctrl+ + Zoom In
Ctrl+ - Zoom Out
Esc Deselect all shapes
Ctrl+Z Undo the last change
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Keyboard Behavior
Shortcut
Ctrl+Y Redo the last change
Ent Save Diagram/Shape/Connector changes when editing
nter
properties
Delete Deletes selected Shape(s)/Connector(s)

BP modeler is a licensed application. In order to use it, additional licenses are required on a
per user basis.

Drafting & Publishing

When BP modeler is enabled for an Object Type, 2 menus are created; a drafts menu and a published

menu.

Drafts Menu

The Drafts menu displays all the current drafts for the specified object type. Drafts can be viewed in Tile

view, or Full view. Hovering over the draft will reveal the draft controls:

Process Diagram

These controls allow you to view, edit, delete or open the diagram in the Object page.

Published Menu
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Process A
Tile Full )

Tab0

Process?2

=t

Process Diagram

Process

Published

The Published menu displays all the published diagrams for the specified object type. Drafts can be viewed

in Tile view, or Full view. Hovering over the draft will reveal the diagram controls:

Process Diagram

These controls allow you to view, edit or open the diagram in the Object page.

Creating New Diagrams

In the top-right of the Drafts and Published pages there is an icon that can be clicked to create a new

diagram:

There are currently no diagrams published for this object.

Get started here.
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Duplicating Diagrams

To duplicate diagrams, edit an existing diagram and navigate to the Actions menu:

ACTIONS

& w & &

Clicking the first icon will result in a duplicate of the current draft being created.

What do you want to do next?

Enable BP modeler

BP Modeler is not enabled by default.

To Enable BP modeler:

The Server Configuration Dialog will open.
BP modeler will be enabled for use on your Site.

1. Open Evolve Designer and select the Evolve Designer Models launcher dialog, click on the Server
Configuration button:

Dle@@e®

2. Open the Features tab and check the Enable BP modeler check box.

| Server | Authentication |Wu:rrkﬂu:rw Features

[l

Enable Diagrarm Editor

3. With the function enabled, Open the Dynamic Deployment tab and click the Save button to commit
the changes to your Site.
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Adding BP modeler Pages to Object Types

If you already have eModeler enabled (from version 3.1 or lower) for an Object Type you will

need to remove or delete the eModeler nodes prior to completing these steps.

In Evolve Designer, right click on Object Pages and hover over Add BP modeler Page for Object Type to
expand the list of Object Types. Simply click an object type and Evolve will automatically add the pages to
view BP modeler drafts and published diagrams.

Home | Dynamic Deployment  Static Deployment
" @ | @ oS @
b=t @ ) o &
Seve Oyramic Ste Suatic Sae Undate Mets Model Shew/Hide Object Types Deztoy Buiin Ste. Criine Help
Asrinittration
Layouts Options [cwWedDesgner TreeNodePagesSe
£ 5
24 Ste Node Name
o (1) sncex Pages
L) AddObject Page For Objact Type
,LL‘ AdSObject Page e N
P ASdeodguPage o ObjecTyt bl Appiation
‘35 ~ Generate Object Pages Contents - Stats Moda Only Business Rule
’j'}_ o Expand Data Store
[l Cotspse Document
#-(1l dagram Entty
11 document EvertiResutt
) ermey Extemal Entty
1) eventresuit Flow.
ﬁﬂow Framawork Help
- T Portfolo
| M indicator Indicatec
1 tportfolo
-~ lssve
1 location Vicisen
1 network Network
T organization Organization
|1 process. Picture
Tl project T —
JP’WI.(L’WM Product
T requrement Project
-‘,'Jm“ Requurement
D sarvice Role
: Serve
i serecacatilog Service Catwiog
T techrotogy Techaitogy

'*' Temgiate Nodes
S e v

Once your configuration is complete, publish your Evolve site as usual.

Configuring a dynamic template to support BP modeler

You should already have a Process diagram template configured in CW Modeler that offers the
shapes you would like to use in your Process diagram palette.

Launch Evolve and login as a System Manager and you will now have an Administration menu, under
which you will see Dynamic Template Editor.
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€% Administration

Create a New Diagram from an Existing Template

To Create a New Diagram from An Existing Template:

A sub-menu for that process will open, listing three options to select from:

The Process Flow page will open.

The BP modeler canvas will open and you can begin to create your new Process Diagram.

1. Open Evolve and click on the Processes tab.
2. Click on the All Processes option to display a list of all available processes.

3. From the list displayed, select the Process that you wish to build a Diagram for.
o Process
o Process Flow
o Properties

4. Click on the Process Flow option.
5. Click on the Create a new diagram based on the template [Template Name] link at the top of the

screen.
Create a Basic Linear Process Diagram

A basic Process Diagram will capture three simple steps: The Eventthat triggers the process,
an Activity or Decision, and a Result.
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To Start Your Basic Process Diagram:
See Create a New Diagram from an Existing Template.
The Shape will be transferred to the Canvas Area.

The description will be added to the Shape:

EXTERNAL EVENT

Process Trigger
PROPERTIES (Event)

Process Trigger (Evem)|

The Next Shapes available for selection will then display in the Shape Menu Pane:

SHAPES

The second Shape will be transferred to the Canvas Area and connect to the existing Event Shape:

Process Trigger
(Event)

¥

The Next Shapes available for selection will then display in the Shape Menu Pane:
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SHAPES

Externsl Result

Internsl Result

This final Shape will be transferred to the Canvas Area and connect to the existing Activity/Decision Shape:

Process Trigger " Activity / Decision
(Event) >

Your basic Process Diagram is now ready to be saved.

See Saving your Work in eModeler.

1.

Open eModeler and select the appropriate Process from which to create the new Diagram.

2. In the Shape Menu Pane, click on the appropriate Event Shape.

3. Add a description or title to the Shape by entering details into the Name field in the Properties Menu

Pane.

. Click on the green circle containing a tick, the Validate your Changes button, displayed beneath.

Alternatively, press the Enter button on your keyboard.

5. Select the next Activity/Decision Shape by clicking on it.
6. Add a description or title to the Shape and save it.

7.
8
9

Select the available Result Shape by clicking on it.

. Add a description or title to the Shape and save it.

. Save your Diagram.

Saving your Work in eModeler

To Save a Draft

Drafts save automatically as they are edited, so you will never have to worry about accidentally closing the

browser and losing all of your changes.

To Do Menu Pane
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There is a fourth, hidden, menu pane called To Do, which only appears if there are any aspects of your
Diagram requiring action. The To Do menu will list these actions and the Shapes relating to these tasks will
be highlighted by a red border. Users will be prevented from saving your work until these actions are

addressed.

(O setName property on Shape

(O Set Name property on Shape ® Y

Once the actions have been completed, you will be able to successfully save your work.

1. Select a Task from the list to be taken to the relevant aspect of the Diagram requiring action.

Add Descriptions and Properties to a Shape

To Add a Description or Property to a Shape:

As soon as new information is added to the fields, a green circle containing a tick, the Validate your

Changes button, displays beneath.

PROCESS

A

"Process Trigger

Name Process Trigger (Event)

Internal Result >
<
\ C

Procsss <Eana| Result

¥
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eModeler supports all diagram elements typically available to CW Modeler diagrams, except for
the following Property Types:

e Date Range
o Distribution Properties
o The use of Memotext in HTMLS

For a full list of the existing Regions supported, see: Shape Regions.

1. Click on the Diagram tab to select the required Shape and add it to the Diagram.

2. In the Properties section of the Diagram tab, enter the desired information into the Name and Title
fields.

3. Click on the Validate your Changes button to save your new description to the Shape.

Create a Connection between Shapes: Add Alternative Branches (Simple)

There are three ways to create a connection between two shapes. Each method is described below.

To Create a Connection Between Two Shapes, Either:
The Shape will be highlighted by a solid border to indicate that it has been selected.
A Connector linking the Shape to your mouse pointer will appear.

The linked Connector follows the mouse pointer. The Connector will turn red when encountering Shapes

that cannot be connected to, and green with those Shapes that it can.
The Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Select the first shape by clicking on it.
2. Click on a Connector from the Shapes Menu pane.
3. Move your mouse pointer to the Shape you would like to connect to (target Shape).

4. Click on the Canvas to end Shape selection.
OR
The Shape will be highlighted by a dashed border to indicate that it has been selected.
A Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Click and hold (long-click) on the first Shape to select it.
2. Double-click on the target Shape.

OR
A Connector will link the two Shapes, indicating that a connection between the two has been made.

1. Hold down the Shift key and click on the first Shape to select it.
2. Double-click on the target Shape.
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For Shapes that are not rectangular in nature, Connectors will connect to the Shape's
boundary, and not directly to the Shape itself.

Create a Connection between Shapes: Add Alternative Branches (Multiple)

There are three ways to create connections between multiple Shapes. Each method is described below.

To Create a Connection Between Multiple Shapes:

The Shape will be highlighted by a solid line to indicate that it has been selected.

Each additional Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.
Connectors will link the Shapes, indicating that connections have been made between them.

1. Select the first shape by clicking on it.
2. Hold down the Shift key and click on the next shape.

3. Double-click on the final target Shape to end the multiple selection.
OR:
The border of the Shape will be highlighted with a dashed border to indicate that it was been selected.
Each additional Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.
Connectors will link the Shapes, indicating that connections have been made between them.

1. Select the first shape by clicking and holding on it (long-click).
2. Click on the extra Shapes required.

3. Double-click on the final target Shape to end the multiple selection.
OR:
Each Shape will be highlighted with a dashed border to indicate Multiple Selection Mode.
Connectors will link the Shapes, indicating that connections have been made between them.

1. Press and hold down the Shift key.
2. Click and drag your pointer over the area containing the Shapes to be selected.
3. Once you are happy with the Shapes selected, release the Shift key stop dragging across the area.

4. Double-click on the final target Shape to end the multiple selection.

For Shapes that are not rectangular in nature, Connectors will connect to the Shape's
boundary, and not directly to the Shape itsel.
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Delete Shapes from the Diagram

To Delete a Single Shape or Connector from your Diagram:

The Clear Shape icon will display:
The Shape or Connector is deleted.
1. Select the Shape or Connector.
2. Click on the Clear Shape icon
To Delete Multiple Shapes or Connectors from your Diagram:
The Clear Shape icon will display.
The Shape or Connector is deleted.
1. Select the necessary Shapes or Connectors.
2. Click on the Clear Shape icon.
To Delete a Swimlane from your Diagram.:
The Swimlane will be deleted but the Shape[s] attached to it will remain.

1. Select the Swimlane and proceed to delete as with a Shape or Connector.

Assign Swimlane Elements to your Process

It is possible to group or assign various aspects of your diagram to a particular Swimlane element. Assigning
Shapes to a Swimlane can provide clarification about which organizational roles or functions are responsible

for which parts the process being captured in your diagram.

To Assign a Shape/s] to a Swimlane:

1. Click on the required Shape[s] that you would like to assign.

2. In the Selection Menu Pane, a Swimlane Sub-menu pane will appear. The sub-menu will use the
same title as the element placed inside the Swimlane category in the Diagram Template Editor. In
the example below, the Swimlane element is 'Organization’.

3. You will be prompted to either search for or create a the new group to assign the Shapes to:

ORGANIZATION

Search or Create
The previously selected Shapes will be assigned to the new group.

1. Select (or create) the desired group.
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To Change the Name of a Group,/Swimlane Element:

A solid border will appear around the element Shape (Organization grouping).
The Swimlane (Organization) sub-menu will appear in the Editor Menus area.
The new description will be added to your Shape.

1. Select the Swimlane element by clicking on it.

2. Enter the new element name into the properties field provided.

3. Click on the green Validate your Changes button to save your new description to the Shape.
Alternatively, press the Enter key on your keyboard.

Operations Team

'H_Q#G_ .

et : ‘Mext Shape C.
Goods itemized, ORGANIZATION Goods HEE:iIEd.
stock updated slock updaled

Operations Team| b 4
ext Mext Shape D
Goods di ‘I i ape [
ed Operations Team d

To Remove a Swimlane from your Diagram:

A solid border will appear around the element Shape (Organization grouping).
The Swimlane (Organization) sub-menu will appear in the Editor Menus area.
The Swimlane element is removed from your Diagram.

1. Select the Swimlane element by clicking on it.
2. Click on the Clear Shape icon located in the in the Properties section of the pane:

]

Change the Appearance of your Diagram

When creating your Diagram, it is possible to adjust the both the orientation of the Diagram and the Theme

used.
To Open the Appearance Options:

The Appearance Menu options will display:
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APPEARANCE

Dev 2 2

1. Open your Diagram Draft and click on the Appearance Menu Pane.
2. Select the appropriate option.

To Change the Orientation of your Diagram:

Process Trigger | Activity / Decision

Fa T

Y

Alternatively;

Process Trigger j"*.k

(Event) b
.-'f
¥
.
h Activity / Decision
- L

)
/

The Diagram will change orientation accordingly.

1. Open the Appearance Menu Pane.

2. Click on the Left to Right icon to display your Process Diagram from left to right across the screen:
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3. Click on the Top to Bottom icon to display your Process Diagram from the top to the bottom of the

screen:

To Change the Theme Used by your Diagram:

A list of Themes available for selection will display in the Theme sub-menu.

Dev 1 é
Dev 2 &

1. Open the Appearance Menu Pane.

2. Select your chosen Theme by clicking on the relevant pane:

Exit eModeler

To Exit the Application:

The screen returns to the previous Process Summary page.

1. Click on the Close Edit Mode icon at the top of the screen:

] - ? x
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Using Web Modeler

Overview of Web Modeler - Editing
Diagrams Online

Please check with your Administrator that firstly, your Server and Internet Browser meet the
necessary system requirements to use Web modeler. Secondly, check with your Administrator

that the Web Modeler feature is enabled.
Web modeler is used to both edit and create any Evolve Diagram online.
f New Draft Diagram

Fu?a*a\ /EE

- Diagram Draft Diagram

Shape Palette \ Title Manager <
Diagram
Operations i ]
;e\tiil;‘('.:al::; :\L:_‘(jl / =
Shape Tools o
and
Service Catalog  Existing Diagram Settings @
-Level 3 Service Diagram
—
Surface
itur T Pro
Diagram
Palette
A tion A n
: [ Zoom Controls
Al tion A n
[ 100% — ——@—— 4+ & Q

The different features within the Editor are detailed below:
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Editable title for the diagram, this
Diagram Title differs from the diagram name, Click to rename the title
which must be unique

Zoom % - Click to choose presets

Zoom in and out - [+] and [-]

Zoom Slider

Radar button

Click and move the 'Radar' view to

Zoom Controls

zoom around the diagram. .

All can be collapsed to a single 150% — —+@— + ¢ Q

maghnifier button.

Shape Palette

The Shape Palette contains all the

shapes that can be used on the Service Catalog Service Catalo
diagram. - LE'.-'E ] - LE!‘E' .L-l
Drag and drop the shapes from the
alette onto the diagram surface
Shape Palette P &

Service Catalog Existing
Note that lines / connectors are - Lavel 3 Service
drawn from the (+) buttons around
the sides of a selected shape.

Future Service Process

erwin Evolve — User Help Guide
Using Web Modeler




Tools

Shape and Diagram

Home to the different Web Modeler
Panes: Properties, To Do, Settings
and Styles.

5 Process i

% Undefined -

a Undefined v
Undefined -

Save

Canvas Area

The area where the edited/created

Process Diagram will display.

T

“+—— Canvas Area —*

l

Navigation

Web modeler controls that can be used when editing a diagram.

Click Summary
Mode Click Behavior
Type
Standar ) Selects a shape and updates the "Shapes and Diagram Tools" pane for that
Single . .
d Shape/Connector, if the pane is open.
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Mode Click Behavior
Type

Opens the "Shapes and Diagram Tools" pane, if it is closed, and navigates to the

Name and Properties tab. For easy access to the object details.

Double

Keyboard Shortcut Summary

Keyboard Behavior
Shortcut
Ctrl+ + Zoom In
Ctrl+ - Zoom Out
Esc Deselect all shapes
Deletes or Clears the selected
Delete
Shape(s)/Connector(s)

Web modeler is a licensed application. In order to use it, additional licenses are required on a
per user basis.
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Enable Web Modeler

This page explains how to enable web modeler step by step

Steps to Configure Evolve Web Platform:

1. Logon to Evolve Designer.
2. Go to the Features tab

o Enable Diagramming — Choose Web Modeler from the drop-down list.

o Check the Enable Swimlane Diagramming.

Home
O © @
b= Y
Save Configure IIS Install IS Features Update Admin Model
la
Server  Authentication Workflow Features Security
Enable Diagramming IWebMDdeIer
Enable Swimlane Diagramming (beta)
Enable advanced matrix
M
Enable Web Rest AP|
O
Web Modeler API URL r

3. Click on Save.

4. Then click on the Configure IIS button to configure Evolve Web Platform.
Steps to Setup Global Search:
In Evolve Designer:

1. Select the model you wish to work with, e.g. Sample Model and then click on Site.
2. If your meta-model is out of date you may need to update it. If so, click on Update Meta Model &
Themes.
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Home = Dynamic Deployment  Static Deployment

=y g ® | &

Update Meta M - .
Save Dynamic Site Static Site "jc_:,M taMoce Show/Hide Chject Types Online Help
& Themes
Design | Publish Admjhistration He=lp
Layouts Options
@49 Site

3. Click on Show/Hide Object Types to show the hidden object types. You will need this in the later
steps when you enable a user as a Diagrammer.

4. Under the Layouts tab, expand the nodes of Site, Deployments. Select the deployment node of
your device.

5. Scroll down to the bottom and check the Enable Global Search. Global search is required to enable

the Web Modeler to find pre-existing objects in your model. This is needed where you wish to add
them to your diagrams.

Home | Dynamic Deployment  Static Deployment

H & & & &K @

Save Dynamic Site Static Site UpdetevM&!e Model Show/Hide Object Types Online Help
& Themes
Design Publish Administration Help
Layouts Options [cwWebDesignerTreeNodeDeploymentModel] - EASAMP14
=] S_? Sife A | Property lype
® \l/ Index Pages Validation Workflow Validated
FP By Property Type
() Object Pages [
¥ :(') g 9 Enable Task Delegation

Template Nodes

& Menu
& Deployments e
? 3 Jp-pc ‘ Enable Discussions
=] E, desktop-pa3visc

é EASAMP14 Enable Favourites

@ O Diagram Popouts

Enable Social Features

Enable Ratings

Enable Global Search

Ul o ©l ©

6. A popup appears which says populate the Object Revision History with data for current records.
Click OK.
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ByProperty lype i
Enable Task Delegation ‘ .

Enable Social Feg Enable Global Search x

Enable Discussi| Enabling Global Search will populate the Object Revisi

data for the current moﬁ;

History with

Enable Favourt This may take some time.

Enable Rating

[Cox ]| concen

Enable Global Search

[
7. Then click on Dynamic Site to republish the site.

Steps to Configure the CW User as a Diagrammer:

1. Go to erwin Evolve Suite, then click on Object Explorer.
2. Expand your Model, e.g. EA Foundation — Sample Model.
3. Scroll down and click on CW User.

SELECTEDMODEL  SELECTED OBJECT TYPE

©eolyea

HOME

£A Founcation - Sampls Mode! - eran Evolve Object Explorer

TOOLS

HELP MOCEL CEECT LIST

—
=

/' Containg Text

Find Cbyject|

New  SalsctAl  Expert Oisplayed
- Objects Chbpects -

Frd

| Fiter Wihie Typing

% 5

Fiter  Column

Objects  Chocser

Fiiter

Obyacts

I tv,»ec!s 'CW User

User Name

£ Catecory

Creation Date

Updated Date

Unigue [densfer

Model

« Cbject Count =~

|~ %48 EA Foundation - Sample Model
S erwin Evolve Suite Disgrams
77 Matrix Diagrams

+ g Cbjext Types 50

ADMIN
3A
aENTL
A

Contrbutor 1711960 6:00:00 AM  1/2/1930 6:00:00 AM 0a4055c3524211e 3502 182F53 7b0

Qonbributer  1/1/1660 6:00:00 AM 1/2/1390 6:00:00 AM 228 1cf05%:2f1 12356 382440300000 12
Contrbutor  1/1/1950 6:00:00 AM 1/1/1990 6:00:00 AM 1a3b4e8a902f1103583334d030b9a0 12
Contrbutor 17171950 6:00:00 AM  1/1{1330 6:00:00 AM 4f00a5425d051 1a3ab4Ba4dbI0baa012

W Attriutes

¥ Eusness Rules

W Cakndars

W CW Answer

W& CW Ansvier User IO,
W CW Ohangesst

W CW Comment

¥ CW Diagram Designe
W CW Diegram Editor Dy...
P CW GS Filter

9 CW Meta Model Enlity
9 CWPage

W CW Qusstion

A CW Questcrnaire

W CW g

W CW Sites

= - o B

By default, all the user Categories will be shown as a Contributor.
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4. Double click on the user you wish to change to be a Diagrammer. e.g. ADMIN.

The CW User Properties window appears and under the tab General choose Diagrammer from the
drop-down list of Category and then click OK.

CW User properties: ADMIN

General Description Access Rights Status Version History

User Name:
ADMIN

Category:
Diagrammer v Edit ...
Undefined

Contributor
Diagrammer

Social
Static

Assodations

Now, when that user logs in, as they are now a Diagrammer, they will see the web modeler.
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Configuring Drafts and Publishing
Diagrams

This page explains how to configure Drafts and Publish diagrams in Web Modeler.

Add the Publish and Drafts tabs to your Object Page:

These instructions detail how to add the built-in tabs to control draft diagrams, to an Object
Page.

Unlike other elements in Evolve, these tabs are limited to Object Pages, and all diagrams must

be associated to an Object.
e.g. Process Object is associated to a Process Diagram. The diagram is describing graphically

the Process Object.

To add the tabs to an Object Page:

1. Logon to the site
2. Expand Site and Object Pages

23 Fvolve Designer (FA Foundation - Sample Mordel > FASAMP14] - v2020,1.0.356 - a x
Home | Dynamic Deployment  Static Deployment
| | &Y o'
Seve DynemicSite  Static Site Show/Hide Object Types Online Help
Publish Help

Layouts Options [cwWebDesignerTreeNadePagesSingle] - Object Pages

b 0
5-§Y Ste dmmm Node Name
#-( 1) Index Pages

w7 attribute
%71 businessrule
#-[J]) cw_user_favorites
w-[T]) datastore
w71 diagram

- 7]) document
@[ T] entity
&[] eventresutt
&[] fiow
(7] indicator

w-[ 7] itportfolio

3. Right-click on Object Pages, hover on Add eModeler Page for Object Type.
4. Select the object type you wish to create diagrams against, e.g. Application.
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E Evolve Designer (EA Foundation

Home | Dynamic

H | o &

- Sample Model > EASAMP14) - v2020.1.0.356

Deployment  Static Deployment

& (@

-Object Pages

t Pages

Save Dynamic Site Static Site : Show/Hide Ohisct T Qaolige Helg
Design Publish Business Hule
Layouts Options [cwWebDl Data Store
e @ Site ~ Nol Document
& @ Index Pages Entity
E
2 @E_ Add Object Page For Object Type » External Entity
| (E {j] appl Add Object Page Flow
o1 awif " Ada Page For ObjectType — —
@ E]D busi{ = Generate Object Pages Contents - Static Mode Only IT Portfolio
» ﬂ cw{a Expand Indicator
® [jj dats @ Collapse Esiie
@ [:m diagram Location
w Zm document Network
o) @ entity Organization
@[] eventresuit Picture
- flow Process
\ﬂ m indicator Beoduct
@ @ itportfolio Project
I == v = Requirement
Role
Service
Service Catalog
Technaloav

5. Scroll down to see <object-type>_cw_emodeler, e.g. application_cw_emodeler and click on it.

E Evolve Designer (EA Foundation

Home | Dynamic

H | & &

- Sample Model > EASAMP14) - v2020.1.0.356

Deployment  Static Deployment

o @

Save Dynamic Site  Static Site o Show/Hide Object Types Online Help
Design Publish Administration Help
Layouts Options [cwWebDesignerTreeNodePage] - application_cw_emodeler
oW network ~
i m . Page Name |appl\tancn‘cw_emndeler
@ m organization
- m process Page Display Name |App\|:a(mn
5 roject
#-( proi ‘ PageTitle |
{71 project_requirement
;3 [jj] requirement Page Type single
[ m role
(E m service Add Page Filter
- atal
' m i Customized Page
® m technology O
| m---m a Icon Library |E T
i @ Template Nodes
E‘"@ Menu keon Color | Default Theme Color
. Deployments
] @ Diagram Popouts Icon | No lcon

6. Change

o Page Disp

lay Name to Web Modeler

o Object Page Order to 2
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Options [cwWebDesignerTreeNodePage] - application_cw_emodeler

Page Name application_cw_emodeler
Page Display Name Web Modeler]
PageTitle
Page Type single
Icon
No Icon
Object Page Order 2
Display As Static Page
play 9 ]
Allow Refresh Disabled

7. Further, expand <object-type>_cw_emodeler, e.g. application_cw_emodeler, to display the Layout

eModeler Page and Tabs with sub-tabs.
8. Click Vector (HTML5)
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Layouts

- i | service Ce:

El’ﬁ] servicecatalogue
El’ﬁ] technology
S
El ----- 0 Application
EI ----- =0 Layout eModeler Page
i8] vector (HTMLs)
|é_| ..... _; Tabs
El ----- b |>BuiltinSite_ViewLabel_EModeler_Publis
2 Al Objects - Diagram (Detailed By)
P =51 Layout eModeler Diagrams
=) Jssa |>BuiltinSite_ViewLabel_EModeler_Drafts
&8 All Objects - Diagram Draft (is createc

3

..... =8 Layout eModeler Diagrams
R ’

\ Tarmnlata MAadare

< >

Configuring Diagram Popouts for Draft Diagrams:

In order to edit more object properties than the basic ones, you will need to configure a Diagram Popout.

See here, for Diagram Popout configuration. Then, to enable this Popout for Web Modeler:

1. Go to Diagram Popouts, choose Object type as the object type that represents this diagram,
e.g. Application, click on Category, if your Popout is defined correctly, it should fill out the fields
automatically as they are predefined by the Popout.
Check eModeler Editor.
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Options [CwWebDesignerTreeNodeBehaviourVectorDiagram] - Vector (HTML5)

Node Name

Object Type Category

Diagram Popout

|Vector (HTMLs) |
Full Screen
O
Default Zoom v |
Diagram Popouts

eModeler Editor

Application __|Undefined... v |application_di... v

v

Dynamic Templates

®

2. Scroll down to CM Templates.

-~ Enable eModeler diagramming.
i Serialize the site and the templates.
i~ Confiaure the dvnamic templates.

editable inside the Web Modeler application.

Check the templates you wish to associate with this Web Modeler page, e.g. — Application —

Services, Application — Technology Context and Application — Architecture

Options [CwWebDesignerTreeNodeBehaviourVectorDiagram] - Vector (HTMLg)

Note: Once the eModeler Editor is checked, it ensures that all these Popout properties are

CMTemplates

~[JTemplate : Process - Level 1

~Template : Process - Level 2

~[JTemplate : Process - Level 3

~[Template : Process - Level 4

~[JTemplate : Hierarchy

~[OTemplate : Project Portfolio

~[JTemplate : Conceptual Data Model
~[JTemplate : Application - Cartography
~[JTemplate : Service - Architecture
~[MTemplate - Application - Services
~[ATemplate - Application - Technology Context
=¥ Template : Application -
~[JTemplate : Impact Analysis
~[JTemplate : Menu Casewise
~[Template : Technology - Architecture

\rchitecture

Click on Save under the Home tab and then click on Dynamic Site to generate the site.
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E Evolve Designer (EA Foundation - Sample Model » EASAMP14) - v2020.1.0.356

Home = Dynamic Deployment  Static Deployment

I’:{@ &

Dynamic Site Static Site Show/Hide Object Types Online Help

Design Publish Administration Help

Drafts and Published Diagrams in Web Modeler:

Drafts and Published are the two tabs under the Web Modeler menu.

This section can be viewed only when the Web Modeler has been setup in Evolve Web
Platform.

To view Drafts and Published Diagrams in Web Modeler.

1. Open the browser and login to Evolve.

Select your Model, e.g. EA Foundation — Sample Model

ﬂ*rﬁ

My Sites ADMIN v

2. Go to the page you configured.
e.g. From the sample, Application from the left menu. Click Application List.
Choose the desired application from the list.

For instance, choose the first application from the list in the picture.
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4 EA Foundation - Sample Model X X 4+ = B

C @ localhost/evolve/sites/easamp14/i

pst/evolve/sites/easamp14/index htmi#/cwtype =indexBowview=index_applicationsédang=en&cwtabid=tab0 i e

E ) Application > Application List ADMIN v

& Bxport
Appication List Options Y| Category Y| Enterprise Standard
B 7 AciityMonitoing Legacy 2-Sundardizatoninprogress  ACT
I B (Z  Appication Portfolio Manager Software 2-Sundwdizatoninprogress  APM
B (@ BusinessObject ERP 3- Approved Standard 80
B (Z CasewiseSute R 3+ Approved Standard oM
B [ CompiaPhs P 1-Non Standard comp
B @ Dushbowd Legacy 1-Non Standard 80RD
B (@  ERwinData Modeler Software 3- Approved Standard CAER
: v
LR o L 50 v itemsper page 1:22022 tems

3. The new tab will be visible in your Object Page, e.g. Web Modeler.

B Activity Monitoring x 4 - - x
o C O locathost/evolve, asamp14/index html#/cwtype =single&cwview = application&lang - ensicwid =28 * » O
- g

b # > Applcation > Application List > Activity Monitoring ADMIN

L8 8 & 2+ oeeoe

Activity Monitoring
Legacy

Associations 2 Standardization in progress
act

2007

1- Low Criticality

M. Henri - thomas henn@entreprise.com

Published Januaty 1,2009
December 31,2016
Drafts Prey

3-Pla

Application Assessment

Permanent License per User
7500
1000

Under the drop-down menu Web Modeler,

o Drafts — Collection of saved diagrams are displayed under tab Drafts. Initially this will be
empty. Each time you press the Save button in Web Modeler, the draft will be updated in
Evolve. Note that this is not the same as Publishing; a draft is a diagram in a transitional
state. When a draft is published, it becomes a real Evolve diagram, and the objects it
contains are updated in the Evolve Model.
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Activity Monitoring

QO

Activity Monitoring

Each Draft has controls that allow you to Edit and to open the diagram in the Object Page.

o Published - Collection of all published diagrams are displayed under tab Published.

000

Activity Monitoring

Each published diagram has controls that allow to View, Edit, and open the diagram in the Object
Page.

Creating and Publishing a new Diagrams using Web Modeler:

1. To create and publish a new diagram, go to tab Published (initially the space under the tab shows as
empty).

Click on H

while configuring CM Templates.

icon from the top-right corner of the page that displays the list of templates chosen

Template : Application - Services

Template : Application - Technology Context

Template : Application - Architecture
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Choose the desired template to start creating the new diagram.

Evolve Web Modeler editor opens in the new tab with the predefined Shape Palette of the template
chosen.

B4 Activity Monitoring *x & erwin Web Modele x o+

& @ localhost/evolve/sites/easampl4/d agrammer/# diagram/4bi4a464-abdd-438e-abae-aefead035d30

#  Activity Monitoring
DB * %

Shape Palette

o % &

ke
2. To publish the diagram, press the button. You will be asked if you wish to publish. Press to
confirm.

Once the diagram is published in the Web Modeler, the same diagram can be accessed
from Modeler in the desktop application.

A Diagram and Palette properties can be modified if required from the desktop application.

To set the Parent object and object name in Evolve Web:

Before setting the Parent object and Parent object name in Erwin Evolve web, first, we need to

enable these options (Parent object and Parent object name) in Evolve Designer and publish
them on the site.

To enable the Parent Object in Evolve Designer:
1. Run the Evolve Designer.
2. Click on the model, e.g., EA Foundation — Sample Model.
3. Click Site.
4. Expand Site and Object Pages.
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https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/webmodeler/webmodeler-publish-button.png?width=86&height=96

5.

6.

|74 Evolve Designer (EA Foundation - Sample Model > EASAMP14) - v2022.0.0.470

Home | Dynamic Deployment  Static Deployment

L\) -
H d d ® &K @

Update Meta Model

Save Dynamic Site Static Site & Themes Show/Hide Object Types Online Help
Design Publish Administration Help
Layouts Options [cwWebDesignerTreeNodePage] - attribute
4 - _ A
E‘ o
\'j Sl;t~e Pagebame }attribute
@ Index Pages
E—J@ Object Pages {mmmmmmm Page Display Name ’Attribute
- licati
()l application PageTitle |
o)
@ Em businessrule Page Type single
ZJ Dj) cw_user_favorites
5 Eﬁ] datictore Add Page Filter
w7 di
+ [m e Customized Page
& Eﬁ] document O
a Eﬁ] ety Icon Library Evolve Icon Library
c3 Eﬁ] eventresult :
- ! Icon Color [
3] Dj] flow - H.Black
@11 indicator TI=t i
Right-click on the diagram and click Expand All.
Layouts Options [cw'Web
----- Gj] businessrule -
: Page N
| |jj:| cw_user_favorites
ﬁj] datastore t& Page Displ

: |j]13 Expand
----- |jj:| docum 1] Expand Al
B

Collapse
|jj:| eventres '~ Generate Content - Static Mode Only

|jj] flow |3 Delete
mindicata 1 Duplicate

=
3
E

Click General, check the Parent object and Parent object name box.
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Layouts
3 Y

Options [cwWebDesignerTreeNodePropertiesGroup] - General

J businessrule ~
j] cw_user_favorites

B

=

Property Group Name

General

. :ﬁ] datastore

®

Identifier

propertyGroup_1883134766

]

- jj] diagram

Custom Display String

E|O Diagram
'g,zﬁ Layout Object Page

| table \
=] .; Tabs ]
H View Display Full Width 0O
| —| .
~50 Layout Diagram ; T
E Corporate M Selected Properties = General ,
Properti ~[FIName
i Properties FIRule
i [ =]=]
EE - [ Category
- §§ Description -IAParent object
#-177] document J -MParent object name

Layout

7. Click Save and then, click Dynamic Site to generate the site.

Home

Dynamic Deployment

Static Deployment

t =
= ® X

Update Meta Model

Save Dynamic Site Static Site & Themes Show/Hide Object Types Online Help
Design Publish Administration Help
To set the Parent object and object name in Evolve Web
1. Open the browser and login to Evolve.
2. Click on the model, e.g., EA Foundation — Sample Model.
b Mhites X + v - 3
o C @ localhost/evolve/index.html Q 2 w O a
g My Sites ADMIN +
3. Click Diagram List from my menu.
my menu
> 78 *‘
Framework Service Application Technology Information Diagram List Page Picker
Architecturs Architacturs Architecture Architecture
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The Diagram list appears.

4. Search the diagram name in Filter the content of this page box.

000

5. Click Open related object page icon.

| Filter the content of this page

E || & @em Object in Evalve 1 Application - Architecture

The diagram will be visible on your object page.

6. Click Properties under Diagram dropdown.

WIWWwWW

Diagram P

View

Properties h |

7. Click Edit icon to edit the Parent object and Parent object name.

00O

8. Click Parent object dropdown and select required option.

9. Click Parent object name dropdown and select required option.

False
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General

Name* Parent Object in Evolve 1

Rule Generic

Category Application - Architecture v
Parent object Application ~
Parent object name SysCom v
Owner Administrator ~
Validated (O True @ False

Created by Administrator

Creation Date July 19, 2022

Updated by Administrator

Update Date July 21, 2022

10. Click Save changes icon.

6000

The Update summary pane appears on right-hand side.
11. Click Submit.

Updzte Summary

Property Changes
Paremt object

_

Metwork

Paremt object name

= S
LAN Mew-York

| Submit I
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To set Parent object and object name in Web Modeler

1. Click View under Diagram dropdown.
2. Click Edit Diagram In Web Modeler icon.

YT vy °ee°e

Diagram ~

— = +
Properties x
T - &)
) 1 { —_— ‘
IT Portfolio 25
3. Click Create new draft.
Available drafts for this diagram x

Parent Object in Evolve 1
Created by : Administrator

Last Saved : July 21, 2022 08:15:31

Parent Object in Evolve 1
Created by : Administrator

Last Saved : July 20, 2022 13:41:44

00 00 00

Parent Object in Evolve 1

Created by : Administrator

Last Saved : July 20, 2022 13:40:50
Count: 3 I Create new draft I

Evolve Web Modeler editor opens in the new tab with the predefined Shape Palette of the template
chosen.
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5.

Click on icon to see the diagram properties.

A Web Modeler

D F@ & = LA B
Shape Palette b L | AN = R —
+i !
¥
D IT Portlolio 25
toli
Click on icon.
> s

Parent Object in Evolve 1

Q Description of the diagram

o, NETWORK : LAN New-York F e

Parent Object Details popup opens.

6.

7
8.
9

Click Object Type dropdown and select the required option.

Click Category dropdown and select the required option.
Click Object dropdown and select the required option.
Click Save.

Parent Object Details

~

[o]

oo N ® B i

B

Cancel Save
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To publish the diagram:
1. Click Publish Diagram icon.

OD[rlB@ & = LA &

2. Click Confirm Publish.

Would you like to publish the diagram?

Cancel Confirm Publish

Once the diagram is published in the Web Modeler, it can be accessed from the Modeler in the
desktop application.

A Diagram and Palette properties can be modified if required from the desktop application.

Formatting Shapes In Web Modeler

Please check with your Administrator that firstly, your Server and Internet Browser meet the
necessary system requirements to use Web modeler. Secondly, check with your Administrator
that the Web Modeler feature is enabled.

This page explains how to format shapes in the Web Modeler online step by step.

Adding Shapes, Connecting Lines To The Diagram, and Changing Properties

To add shapes to the diagram,

1. Drag and drop the required shape from the Shape Palette.
2. Double-click on the object shape to edit the Title and its Properties.
3. Click Save.
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A SalesForce - Cart

ODb+*oB * @

Shape Palette 5 SalesForce - Cart

1. Double-click on .
shape to see the pop O e con

out on right-hand side
I = CHR
7] = [ s
@ | —

2. Edit the properties of
the shape

application  Middleware

Salesforce - Gartography - Copy

Description of the diagram

® &

o}

Save

You can use a Connector to link two Shapes, indicating that there is a connection between the two

shapes.

In-Place editing in the shape,
You can edit the name of a shape in the diagram editor using In-place editing.
To edit the name of the shape,

1. Select the shape you wish to edit.

2. Click again on the shape and then enter the text.

3. Either press Enter or click anywhere on the editor to finish editing.
f  Application Architecture

& @ Font

i
\,
| |

ODFBA & =~ @ O % =27

Shape Palette

Front Office

Partner Relationship Management Customer Relationship Managemitt

Application Middleware =)

Halestorcd
- Hlsalesforce)
® oo i

D earner acsiermtor

ERP Legacy

To add the connector between the shapes,

1. Select the first shape by clicking on it.

2. Click on one of the + symbols to add the connector and move your mouse pointer to the shape you
would like to connect to.

3. Click on the shape to end the selection.

4. If there are multiple connection types between these kinds of objects, you will get a menu to choose

the connection that is appropriate.
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To Clear or Delete Shapes from the Diagram
Object Shapes can be Cleared or Deleted from the diagram in two ways.
To Clear a Shape:

When you choose to Clear a shape, it removes the shape from the diagram, but it does not remove the
object it represents from the model.

1. Select the shape you wish to Clear.

2.Clickon * icon.

Name

0 Customer Update

Criticality
1 - High Criticality le .

Select the
SHET

o % &

Or

1. Select the shape you wish to Clear.
2. Press the Delete button on your computer's keyboard.
3. Confirm to Cleatr.

b
Would you like to clear or delete the selected shapes?

Clear Delete

To Delete a Shape:

When you choose to Delete a shape, it removes the shape from the diagram, and when published

will remove the object representing from the model too.

1. Select the shape you wish to Delete.
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2. Click on . icon.

Name
Customner Update

Criieslity

1 - High Criticality

® o

o}

Q Ssave

Or

1. Select the shape you wish to Delete.
2. Press the Delete button on your computer's keyboard.
3. Confirm to Delete.

Would you like to clear or delete the selected shapes?

Clear Delete

If a shape is deleted, any connector associated with the object shape also gets deleted.
When object shapes are deleted using the Delete option, it adds the item to the Trash can icon
called Deleted Objects on the right-hand pane.

Adding Background Colors and Borders to the Shapes
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Every Shape from the Palette has a definite background color, border size, and border color.

You can format the shape by

1. Background Color of the shape.
2. Border Size to the shape.
3. Border color to the shape.

.

,‘\v

Aligning Shapes

Object shapes in the Web Modeler editor can be aligned using Align Nodes placed on the toolbar.

D * B *

@ O

él

o

(.

Object shapes can be aligned to the Left, Right, and Center horizontally, and also Top,

Bottom, and Center vertically, which can also be evenly Distributed Horizontally or Vertically.

Horizontal Vertical Distribute

+|« Centre Align <+ Centre Align ¢+ Distribute horizontally
[« Left Align T TopAlign Distribute vertically
—| Right Align 1 Bottom Align

To Align shapes horizontally,
multi-select the shapes and
chaose the alignment.

To Align shapes vertically,
multi-select the shapes and
choose the alignment.

Multi-select the shapes to
distribute horizontally or
vertically with even spaces
between the shapes.
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Some shapes may have Region shapes and Region formatting which overrides these styles
such that the style options will not work.

Example: A shape may be set with color because of the “Category” of the object, i.e. the shape
may be Red because it is a critical object (as defined in one of its properties).
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Resizing Shapes to match others

In the Web Modeler Editor, the object shape can be adjusted to the height and width of the other shape
using Resize Nodes.

1]
N
H
T
e
0

D B8 ¥ @ N IR

Sizing

The Size of one shape can be
adjusted to the size of the other
object shape with respect to the
Height and Width.

Largest height

<>

~  Smallest height

<> Largest width

> < Smallest width

Move Shapes from Back and Front
In the diagram, if one shape is put on top of another, it may conceal the other.

Move To Back and Move To Front buttons help to show/Hide the object shape.

L i

Text Formatting and Fonts
The Title of Object shapes can be formatted according to:

1. Font and its Font Size
2. Text in Bold, and Italic
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3. Text alignment to Left, Center, and Right.
4. Vertical Alignment.
5. Text Color.

LA
f

[Monospace v 8 '] B [7

A
o @ 6 060

Some shapes may have Region shapes and Region formatting which overrides these styles

such that the style options will not work.

Example: A shape may use a different property for the Title, that is defined in a region. This

region’s style cannot be overridden by Web Modeler.

Gallery Manager In erwin Web
Modeler

In the Diagrammer, you can upload pictures to the shape palette of the diagram and publish them.
To upload the pictures:

1. Go to the diagram template or the existing diagram to which you wish to add pictures.

2. From the shape palette, drag and drop the picture template. Double-click on it to view the

properties pane on the right side.
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# Demo

O FA & = @ + O 4=/ n
Software T Portfolio
Level 1
IT Portfolio Data Store
Level 2
[Commm 0 F

Entity Issue

= [

Picture Title Bar

==

Version Control

Double-click on the picture template

[ERER | Font Settings ~
Picture
>
o Image not set
e
4]
Q

Save

3. Click on the 8 icon to open the gallery manager.

Gallery Manager displays all pictures available in the model with the most recent pictures at

the top.

4. To upload a picture, click on Upload at the top-right corner.

5. Select an image and click on Select.

Select Image 2 Search

©

EA_lssue_Logo_Bla ... EA_Technology_Web ... EA_Circle_Green_T ...

EA_Circle_Orange_ EA_Technology_DBS ... EA_Technology_Ser

t e 10w 1 > >l

The picture appears on the draft diagram.

6. Once the draft is ready, click Publish Diagram icon.
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I
N,
|

D|¥r|B@ & = “ A @ O %

7. After publishing the draft, picture can be viewed in erwin Evolve Web or erwin Evolve Suite.

4 Demo X erwin Web Modeler x| + =
<« C' @ localhost/evolve/sites/easamp4/indexhtml#/cwtype=single8tcwview=diagramailang=en&cwid=312 Q = f a
I Apps @ NewTab Reading list
E # > MyMenw > Diagramlist > Demo ADMIN w
SRS 00000

Properties =
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General Operations in Web Modeler

Options that are generally available for any diagram in the canvas are:

. Duplicate Draft
. Publish Diagram

. Save Diagram

. Undo and Redo

1
2
3
4. Download Diagram
5
6. Diagram Settings
Duplicate Draft

To duplicate the working draft of the diagram, click on Duplicate Draft on the toolbar.

?Bz

By doing this, a copy of the draft will be created, and you will be taken immediately to the draft diagram. It
will also be available in the Web Modeler Home.

The draft diagram will be associated with the originally published diagram, and on publishing will replace the

same published diagram.

To create a separate published diagram, you should duplicate the published diagram instead.

Publish Diagram

To publish the diagram, click on Publish Diagram icon on the toolbar.

D(¥]o *

Before proceeding to Publish the diagram, make sure you don’t have any incomplete items in To-Do list.
Once published, the draft diagram will be deleted, and the published diagram will be available on the Evolve

site and in Modeler.
Save Diagram

To save the diagram, click on Save Diagram on the toolbar.

0 ?1
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Although drafts are continuously saved to a secondary storage, saving your draft diagram ensures it is kept

in your Evolve database and can be backed up with your main database backup.
Download Diagram

To download the diagram in the form of an image to your machine, click on Download Diagram on the
toolbar.

0 = a[x)
Undo and Redo

You can Undo or Redo the changes made in the diagram editor.

To apply click on Undo/Redo options on the toolbar.

DF@L|[c~|a

Diagram Settings

To apply the settings related to the diagram Grid, Animation and Guiding lines in the editor, click on
Diagram Settings on the toolbar.

D Fa s na@

You will see a panel popped up on the right-side of the screen to work on settings.

A  Application Architecture

B FA & w ~ Click here for the Diagram
Settings
Shape Palette N Diagram Settings \
Front Office
anagement Customer Relationship Management oef Grid
® = (@ = ® =10
G Sypcamm @& Seisria @ ke Away Show Grid [ )
Application  Middleware @ © ©) _
= snaptoGrid »
s e * Grid Size
Back Office ®
ERP Legacy @
1ance & Accounting Business Intelligence Enterprise Architecture Human Resources Information Exchange
Mansgeman Animation
] fs :] o @ “ @ ./
ComptiPlus ()] fre— ® Enable Animations .
Software IT Portfolio 3]
Level 1 Guide
@ (.7—‘; w (r{-‘
l—‘ Fnince Sue B  ouioenonen (D ehwin ata odter }f\ Guiding Lines [
S @ @]
ITPortfolic  Data Store /

Level 2

"]
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Working with Connector Lines

The lines which associate the two objects in the diagram are called Connector Lines.

f Manage Sales

Do & @ H a g o0

[}
N,

Direct Route - L A ’

Shape Palette

= - ——

Organization Activity

O Q PR l
) v
Output XOR Input AND m E

=
O Q 17@ e
Output AND  Output OR B e 3B g =

On Selecting the line, options for connector lines are shown on the toolbar.

il

Direct Route L ~ /A

Avoid Route

Lines can be applied in two ways:

1. Direct Route - connects the objects using the shortest path.

2. Avoid Route — connects the objects avoiding the other objects in the diagram structure.

Lines are of three types are available to connect the objects:

1. Orthogonal Lines — Orthogonal Lines are when the line appears with right angles in order to
connect the two objects when it cannot be drawn horizontally or vertically.

This line is available only under Direct Route and will be disabled for Avoid Route.
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Orthogonal Off Orthogonal On

) - b 'e Direct Route L o>
2 & i

[\

2. Jump Lines - Jump Lines are when one connecting line passes over another, and it appears with an

arc over it.

This button are used in conjunction with the orthogonal lines button. If an orthogonal line is off for a

particular line then the jump line button is disabled.

Shared
Services & ]
Infrastructure Back Office

Jump is a property of an individual line, so if the lines cross and neither have the jump property then
they look like straight lines passing through one another. Jump lines will be seen if both lines have
jump property.

3. Lock/Unlock Link Port - Link Ports can be Locked or Unlocked. To lock them, either press the
button or move the connection point (port) of the line, around the shape. When you select a location
to port the line to the shape, it will become locked. If you want the diagrammer to automatically
reposition the port, select the line, and press the unlock button, to release the lock.

Locking the link ports helps to keep the specific connection point when the shapes are moved around
the canvas.
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Naming on Association Links
To show the flow between the shapes, Association Names can be placed on Association Links.
To place the name on the link,

1. Double-click on Link or Connector Line you wish to add on.

2. A property panel will be opened on the right-side of the screen.

3. Enter Name and then click on Save on the bottom of the screen.

M Manage the unloading process

O+FA@ * = S =E LW £ 10 - L 7

Mandatory @ X B8

b ]

Enter Name here

Shape Palette

§

™
By
(-

@
@ weenzw o
drives, s

p® Ot

(17

® &

| @ ommonommmtns ———&  owomomary

- . pEEm Lggmen.
flow ;
ak Extomal Event Click on Save

Q

4. The Association Name can be moved around the screen by Clicking and Dragging it to a new

location.

How to Add Missing Associations?

Associations between the shapes can be automatically displayed if a new object is added to the existing
diagram. This will render the associations between the existing objects and the newly added objects in the
existing diagram.

You can also place associations between any two or multiple objects using the button on the toolbar called

Add Missing Associations.

A Impact Analysis - Service

D B * ¢

Add Missing Associati
Shape Palette
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Associations can be applied in three ways:

¢ Upon Single Selection — Select any single object shape in the diagram and then click on Add
Missing Association button to display the associations related to the selected object shape and
the other shapes in the diagram.

¢ Upon Multi Selection — Selection of any two or more shapes will render the missing associations to
the objects that are already defined between them

¢ No Selection — This will render all possible associations between the shapes in the diagram.

erwin Evolve — User Help Guide |
Using Web Modeler |



Web Modeler Home Page

Web Modeler Home page also known as Draft Manager [from version 2020.2.0] allows more control over

your drafts. Providing significant features such as Search, Sort and Filters.

A new diagram can be created by choosing from the available templates in Web Modeler.

# Web Modeler

Showing 10 drafts Q, Sear = sort = Filter Name @) Title
Impact Analysis - Impact Analysis - Service testAA2 test_ass_lines_issue - Impact Analysis -
Application Copy Application
Template : Impact Analysis Template : Impact Analysis Template : Application - Template : Application - Template : Impact Analysis

Architecture Services
2 Created ! = t ! ) ) by: ADMIN 2 | i
O created: Jar 8 I B created: 1 (] B |
B update B upd " B update B upd " B upd

e Search - You can search for existing diagrams with the keywords in the Search Box.

[ Q search ] = Sort

e Sort- You can Sort the diagram drafts with several available options.

o Name or Title of the diagram

o Who it was last Modified by

o Who originally Created the draft

o Sort the list by Ascending and Descending order

erwin Evolve — User Help Guide
Using Web Modeler



Name

v Modified

Created

Ascending

~ Descending

e Filters — Diagrams in the draft manager can be filtered by,
o Diagram Type
o Creator of the diagram
o Modified Date — ‘From Date’ to ‘To Date’

Filters Reset
Diagram Type v
Creator
Modified Date m

To reset the applied filters, click on Reset.
e Toggle between Name and Title — List of diagrams will be displayed as per the toggle selection.

You can choose to display the diagrams as per the Name or Title of the diagram.
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e Create New Diagram — A new diagram can be created from the scratch by using the existing

template.

o

o

Click on + symbol from the bottom right of the screen.

i

Enter Name of the new diagram > Select Template > click on Create.

Qarvira Architertiira

Diagram Types

Name *
Test Diagram

@, Template

@\
o

222|222 BO, oH. o

Template : Process - Template : Process - Template : Process - Template : Process - Template : Hierarchy
Level 1 Level 2 Level 3 Level 4

CANCEL CREATE
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Parent object and Parent object name

The instructions on this page detail how to set a Parent object and object name in erwin Evolve Suite (CW

Suite), erwin Evolve Web, and erwin Web Modeler.

To set the Parent object and object name in erwin Evolve Suite:
1. Start the erwin Evolve Suite.

2. Click Modeler.
3. Select the Model and Template that you want use to create a diagram.

New

tode
&) EA Foundation - Sample Model

€ Dagrams @& GTOUp Dy Diagram Rule
Default
No Template
Rule: Generic
wn-a-cy Template : Appication - oo Template : Application -
Creeah Architecture Caelwe Cartography

wn-ap-c Template : Appication - Services  mm-a-c Template : Application -
Dy e Technology Context

w-am-ap Template : Impact Analysis wapap Template : Menu Casewise

O Creneh

e Template : Process - Level 1 a0 Template : Process - Level 2

e remeh p >
wn-ap-cp Template : Project Portfolo we-am-cp) Template : Service - Architecture

- Creeds ¢

o Template : Technology -
- -
Caumh Architecture

Rule: Entity
Template : Conceptual Data
Model

Rule: Hierarchy I
= Template : Hierarchy
LT T
Rule: Dynamics
i ™ Template : Process -Level 3
a e

Template : Process - Level 4

Create

4. Enter the name of the diagram in the Name box and then, click Create.

W) EA Foundation - Sample Model

ns | @] W] Group by

Default
No Template

Rule: Generic
-y Template : Appication - we-ap-c Template : Application -
Creleah Architecture reieey Cartography
wn-om-c Template : Applcation - Services mm-a-c Template : Application -
Dawea rsegh Technology Context
-1 Template : Impact Analysis oo Template : Menu Casewsse
- e

a1 Template : Process - Level 1 ) Template : Process - Level 2
D eve

=
e

- Template : Project Portfolo e Template : Service - Architecture
Y Craeeh

-y Template : Technology -

bweeh Architecture

Rule: Entity
=} Template : Conceptual Data
Model

Rule: Hierarchy I
B Template : Herarchy
LT

Rule: Dynamics

M ™ Template : Process - Level 3 hpky ™ Template : Process - Level 4
== ==
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8.

Drag and drop the required shapes from the palette onto the diagram surface.

Double click on the diagram surface or under the Home tab, click Properties.

The Diagram properties dialog box appears.

Sl oe | woon  roos

& Seectal | A e B3 specng - P@ #) Badkground Color
0 Frd - ) Version Control
(D) Copy Diagram Lk Pk i ObjectUink [ PrintFrames - | Unes |Propertes | View Assocations | 15 Retu toParent | Options
Edt Insert Disgram
§ New Objects © 2 % ||| Parent Object in Evolve 1 (AArch) - (EA Foundation - S...
pom— %
—d [’ W | Diagram properties: Parent Object in Evolve 1 o K3
Appication IT Portfolo Level
1 General Descrpton Tifle  AccessRights Status Verson  History
=2 :
IT Portfolo Level Data Store
2
Apphcation - IT Entity v Edit.
Pustiolen v Parent abject:

New Objects | Existing Objects Appication ~
i Application: Application 59 o8 x SysCom ¥,
~General ~ eveL:

Hame Application 59 lo
:::“"" RO [ Context Diacram
Version
Criticality Undefined
Enterprise Standard Undefined
~Detas
Go Live Date
£nd of Life v Assocatons [ ]| e Helo

Click the first drop-down list box under Parent object and select the required parent object.

Parent object:

| Appication g
Srcon 7
LEVEL:

o

D Context Diagram

Associations E Cancel Help

Click the second drop-down list box under Parent object and select the required parent object
name.
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Parent object:

Application ~
I‘ SysCom bt I
LEVEL:

o

[J context Diagram

Assodations Cancel Help
9. Click OK.
10. Click on the Refresh icon.

H e cla]n 2

You can see the same Parent object and Parent object name on the left pane.

! Diagram: Parent Object in Evolve 1 oR:
- General
Name Parent Object in Evolve 1
Rule Generic
Category Application - Architecture
Parent object Application
Parent object name SysCom
LEVEL 0
Context Diagram  No

Before setting the Parent object and Parent object name in erwin Evolve Web, first, we need to
enable these options (Parent object and Parent object name) in Evolve Designer and publish
them on the site.

To enable Parent object and Parent object name in Evolve Designer [Evolve 2022.0.0 and above]:
1. Start Evolve Designer.
2. Click on a model. For example: A Foundation — Sample Model.
3. Click Site.
4. Expand Site > Object Pages.
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|74 Evolve Designer (EA Foundation - Sample Model > EASAMP14) - v2022.0.0.470

Home | Dynamic Deployment  Static Deployment

L\) -
H d d ® &K @

Update Meta Model

Save Dynamic Site Static Site & Themes Show/Hide Object Types Online Help
Design Publish Administration Help

Layouts Options [cwWebDesignerTreeNodePage] - attribute

=& &) Si < A

- \'j Sl;t~e Pagebame }attribute

@ Index Pages
E—J@ Object Pages < Page Display Name ’Attribute

&- Dj] application -
] PageTitle ’
o)
Z] : Em businessrule Page Type single
c:] Dj) cw_user_favorites
5 Eﬁ] datictore Add Page Filter
EJ diagram :
[m ¢ Customized Page
& Eﬁ] document O
a = entity i :
! Eﬁ] epn Loy, |Evolve Icon Library
® Eﬁ] eventresult
3. ! Icon Color [
3] Dj] flow - H.Black
@11 indicator TI=t i

5. Right-click on diagram and click Expand All.

Layouts Options [cw'Web
L @ ﬁj] businessrule o~ Page N
----- |jj:| cw_user_favorites
|jj] datastore I::? Page Displ:
Expand
Expand All
2 Collapse

- Generate Content - Static Mode Only
: W Delete
----- |jj:| indicato| “§ Duplicate

6. Click General and under Selected Properties, select Parent object and Parent object name.
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5 Layouts Options [cwWebDesignerTreeNodePropertiesGroup] - General

J businessrule ~

B

Property Group Name |
j] cw_user_favorites Genera
@:ﬁ] datastore Identifier propertyGroup_1883134766
=58 diagram
jj] 9 Custom Display String
E|O Diagram
:_,:I Layout Object Page Layout table |
== Tabs ]
View Display Full Width 0O
| —| .
~50 Layout Diagram ; T
; Selected Properties -
- Fah Corporate M = @C;:f’a' #
~[Name
Properties FRule
EE = [ Category
55 Description -IAParent object
#-177] document . -- Parent object name

7. Click Save and then, click Dynamic Site to generate the site.

Home = Dynamic Deployment  Static Deployment

’ F’o Q
= Sean?
b @ | '® o
Update Meta Model

& Themes
Design Publish Administration Help

Save Dynamic Site Static Site ShowjHide Object Types Online Help

To set the Parent object and Parent object name in erwin Evolve Web:

1. Open the browser and login to erwin Evolve Web.

2. Click on model. For example: A Foundation — Sample Model.

E Mhnes X =+ ¥ - g S
“ C @ localhost/evolve/index.html Q » w 0O a
g My Sites ADMIN

3. Under my menu, click Diagram List.

my menu
Framework Service Application Technology Information Diagram List Page Picker
Architecturs Architecture Architecture Architecture

The Diagram List appears.
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4. Enter the diagram name in the Filter the content of this page box.

000

| Filter the content of this page ‘

5. Click on the "- icon.

The diagram opens on your object page.

6. Inthe Diagram drop-down list, click Properties.

WWWWW

Diagram P

Yiew

Properties @ |

7. Click the Edit icon to edit the Parent object and Parent object name.

00000

8. Click the Parent object drop-down list and select the required option.

9. Click the Parent object name drop-down list and select the required option.

General

Mame* Parent Object in Evolve 1

Rule Generic

Category Application - Architecture v
Parent object Application ~
Parent object name SysCom v
Owner Administrator A%
Validated () True @ False

Created by Administrator

Creation Date July 19, 2022

Updated by Administrator

Update Date July 21, 2022

10. Click the Save changes icon.
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6000

The Update Summary details appear on right pane.
11. Click Submit.

Updzte Summary

Property Changes

Paremt cbject

Metwork

Paremt object name

= o,
LAN Mew-York

| Submit I

To set Parent object and Parent object name in erwin Web Modeler:

1. Click View.
2. Click the Edit Diagram In Web Modeler icon.
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4,

WWWWW

Diagram ~

View

Properties

Click Create new draft.

Available drafts for this diagram x

Parent Object in Evolve 1
Created by : Administrator

Last Saved : July 21, 2022 08:15:31

»

Parent Object in Evolve 1
Created by : Administrator
t

t Saved - July 20, 2022 13:41:44
Parent Object in Evolve 1

reated by : Administrator
t

t Saved : July 20, 2022 13:40:50

The erwin Web Modeler editor opens in a new tab with the predefined Shape Palette of the

00 00

template chosen.

Click on the @ icon to view diagram properties.
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A Web Modeler

D Fa “— L A o]
Shape Palette I} 5 inms = A ) E(
- |
. o
,,,,,, : @
v
i —J .
- T Porttolio 25 . [}
I

5. Click on the © icon.
> '

Parent Object in Evolve 1

e Description of the diagram

0’ NETWORK : LAN New-York te s

Parent Object Details popup opens.

Click the Object Type drop-down list and select the required option.
Click the Category drop-down list and select the required option.
Click the Object drop-down list and select the required option.

Click Save.

© o N o

Parent Object Details

Cancel Save

To publish the diagram:
1. Click the Publish Diagram icon.
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2. Click Confirm Publish.

Would you like to publish the diagram?

Cancel Confirm Publish

Once the diagram is published in the erwin Web Modeler, it can be accessed from the Modeler in the
erwin Evolve Suite.

Diagram and Palette properties can be modified, if required, from the desktop application.

Using Explode Diagram in erwin Web
Modeler

The instructions on this page detail how to use the Explode Diagram feature to:
e Create links from parent to child diagrams
e Open existing child diagrams linked via the feature
e Return to the parent diagram

To use the explode diagram feature in erwin Evolve Suite:

1. Inthe diagram, right-click an object.
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id
T
T

e
Properties ...

Insert Mi iations
Foundation - Sa 4. Return to Parent
% Cut
2 2 Copy
™ Paste

Clear

Delete

Rename

Associate Objects ...

Datn Store 34

Format 3
Draw 2 e
Add Point

Rermove point

Relationship Sets 3

|_—D Copy Diagram Link

What's This?
ﬁ Diagrammed On 3
& Explode 3
©y  Explode New 3
L%-E Associations 3

Find and Replace...
EA Spell Check ltem ...

2. Hover over Explode New.

ﬁ Diagrammed On 3

2 Explode

“2  Explode New 3 | 3 Diagram
#2  Associations v Matrix

3. Click Diagram.
The New Diagram screen appears.
New Diagram E3

Model

Flease select the model you wish to create your new diagram in:
&t EA Foundation - Sample Model

Diagram

Mame:

|App|imﬁon &0 |

(®) Base the diagram on a template
|h.’.i' Template : Application - Architecture v|

(O Create a blank diagram (based on diagramming rules)
Data Flow

o Use Name to specify the name of the diagram.

o Use Base the diagram on a template to specify template of the diagram.
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o Use Create a blank diagram (based on diagramming rules) to create a new blank diagram

without any templates.

4. Click OK.
The selected object is linked to a new diagram. You can explode the object to view or open the

diagram.

To view an exploded diagram:
1. On alinked object that is represented on a diagram, click the indicator inside the shape.

The list of exploded diagrams appears.

Explode Diagram ==
Id Name Category Rules Modified Open
ko173 Salesforce - Cartography  Application -C...  Generic 01-01-1990 0
P8 157  Salesforce - Services Appication -Se... Generic 05-02-2020 1 Cancel
875  Salesforce - Technolog...  Appiication - Te... Generic 01-01-1990 0¥
< >

{ )

2. Select a diagram from the list.

3. Click Open.

The exploded diagram opens. You can view the parent object’s details in the properties of the

exploded diagram.

To view parent object or diagram of exploded diagram:

1. Under the Home tab, click Return to Parent.

| Return to parent ==
e comr
Applcation Architectire Adrch ~
Casentse Sutte - Cartographyl ACart ancel
mpact Analyss - Appication P
mpact Analyss - Service ™M
mpact Analyss - Task P
Impact Analyss - Technology P
Matrix - Applcation Landscape X
Matrix - Qualty of Service MY
Salesforce - Cartography ACart
Salesforce - Services ASery
Salesforce - Technology Context ATech
< >

2. Select a diagram and click Open.

The Parent diagram appears.

To create an exploded diagram in erwin Web Modeler [Evolve 2022.0 and above]:

1. Open the browser and login to erwin Evolve Web Platform.
The list of available model appears.
2. Click on the model, e.g., EA Foundation — Sample Model.

3. Under my menu, click Diagram List.
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my menu

Framework

The list of diagrams opens.

Service

4.  Click Diagram List available under my menu.

Technology Information Diagram List
Architecture Architecture

5. Enter the diagram name in the Filter the content of this page box.

( Filter the content of this page ] oeo

6. Click the Open related object page icon.

The diagram opens on your object page.

7. Click the Edit Diagram In Web Modeler icon.

Properties

IT Portfolio 25

Data Stoce 1

If this icon is not present, please check you have a license for Web Modeler, that Web Modeler

/s enabled, and you are allocated a Diagrammer license.

8. Click Create new draft.
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Available drafts for this diagram x

Parent Object in Evolve 1 e -
Created by : Admir :

Parent Object in Evolve 1 e

Parent Object in Evolve 1 e

Evolve Web Modeler editor opens in the new tab with the predefined Shape Palette of the template

chosen.
A Web Modeler B
¥R 2L = L4 B
Oarw Twwre ~ ¢
- > = » x —
o
f
)
-
. = . °
: @
v
i E3 ’
A Peh. - u
&
A

9. Select an object.

@
10. Click 5 .

The Diagram Types screen appears.

Diagram Types

Name

Q Template

CANCEL

11. Enter Name and select a Template.

A blank exploded diagram is created. Now, you can drag and drop objects from the shape palette.
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12. To publish the diagram, click the icon. You will be asked if you wish to publish. Click to
confirm.
Once the diagram is published in the Web Modeler, the same diagram can be accessed from the

Modeler in the desktop application.

Load Balancing with erwin Web
Modeler

Previously if you wanted to use Web Modeler you were restricted to a single server installation. We have

now extended the configuration to allow for multi-server (or load balanced) environments.

Configuring MongoDB Replication

This topic explains the process to configure MongoDB Replication. This process is only required if you are

serving Evolve Web Platform from more than one web server, in a load balanced array.

Configure MongoDB Replication

1. Press the Windows key and then click Start.
2. Search for Services.

The Services window appears.
3. Select MongoDB Server.

i Senvices - o %
File Action View Help
e mEc= Hm > onw

£ Services (Local) . Senices (Local)
MongoDB Server Name - Description Status Startup Type Log *
*11ongoDB Server MongoDB ... Running  Automatic
ﬁfﬂ‘:;‘i‘ﬁ& G Natural Authentication Signal aggr... Manual (Tig... Loci
G Net.Tep Port Sharing Service  Provides abi... Disabled Loc:
£ Netlogon Maintains a .. Manual Loci
Description: i Network Connected Device... Metwork Co.. Running  Manual (Trig.. Loci
MongoDB Database Server {8 Network Connection Broker  Brokers con... Running  Manual (Trig... Loci
€ Network Connections Manages o... Manual Loci
€2 Network Connectivity Assis... Provides Dir... Manual (Trig.. Loci
1€ Network List Service Identifies th.. Running  Manual Loci
G Network Location Awareness  Collectsan..  Running  Automatic et
£ Network Setup Service The Metwor... Manual (Trig.. Loc:
{5 Network Store Interface Ser...  This service .. Running  Automatic Loci
G} Offline Files The Offline ... Manual (Trig... Lec
). OpenSSH Authentication A...  Agent to ho... Disabled Loci
11, Optimize drives Helps the c... Manual Loci
i€ Parental Controls Enforces pa.. Manual Loc
{51 Payments and NFC/SE Man... Manages pa... Manual (Trig.. Loci
i Peer Name Resolution Prot... Enables serv... Manual Loci
i Peer Networking Grouping  Enables mul... Manual Loci
. Peer Networking Identity M... Provides ide... Manual Loci
ik Performance Counter DLL ... Enables rem... Manual Loci ¥

4. Click Stop.
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MongoDB Server service stopped.
5. Go to MongoDB bin folder available at C:\Program Files\ l\/longoDB\Server\A.Z\bin.
6. Open "mongod.cfg’ file in text editor (For example: Notepad).

7. Update replication property as follows:
replication:
replSetName: "rs0"
8. Bind your system IP address in the following format:
net:
port: 27017
bindlp: <enter system ipv4>, 127.0.0.1

9. Save the 'mongod.cfg" file.
10. Start MongoDB Service.
11. Goto C:\Program Files\l\/longoDB\Server\4.2\bin and open the command Prompt.
12. Run the mongo.exe command.
13. Run the following command:
rs.initiate({_id : "rs0",members: [{ _id: 0, host: "<enter system ipv4>:27017"}1})

The default MongoDB port number is 27017. If required, you can update it to a different port

numbetr.

14. Run the rs.status() command to check whether replication is configured successfully.

Successful MongoDB replication is indicated by a response where the members array has the name
and IP properties according to the values configured in step 13.

Configure Evolve Server

The instructions below explain Evolve Server Configuration to publish your sites on it.

On the main/master server:
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1. Start Evolve Designer.

2. On the Evolve Designer Models launcher dialog, click the Configure Evolve Server button.

PELe®O®

The Evolve Server Configuration dialog opens.

H ©® © ®

Save Configure IS nstall 115 Features Update Admin Made:

Server  Authentication Workdlow Features Security
Evolve IIS Site Name evolve -
Evolve Site Folder
CerwiniEvolvelSitel
Browse
Evolve Data Folder
Clerwin!Evolve| Datal
Browse
Senver Language = v
rver Thems
Server Theme boe ~
5 Application Path Defauit Web Sitejevalve
Evolve Suite Database s =
Evolve Suite User Name. ey 158
< >

Currently running with elevated privileges - IS configuration is enabled
Curment Version of IS is 10.0

3. Under Server, select Primary Server, Share Data Folder, and Share MongoDB.

[ Senver authentication Worklow Festures Security

Evolve Suite User Password ‘

Javascript Mode i

115 User Name DESKTOP-g6FDJOD\erwinxi ]

115 User's Password eesssssssnss ‘
Primary Server
Share Data Folder
Use the Shared Data Folder
Share MongoDB.

Use the Shared MongoDB

In the MongoDB URL option, the IPv4 address will be replaced with the host address, unless
you manually update the main machine IP address.

4. Click Save.
5. Click Configure IS and perform full deployment.

On the secondary server:

1. Start Evolve Designer.

2. On the Evolve Designer Models launcher dialog, click the Configure Evolve Server button.

PELed®oO®

The Evolve Server Configuration dialog opens.

erwin Evolve — User Help Guide
Using Web Modeler



W O

Save Configure IS

Evalve IS Site Name

Evolve Site Folder

Evalve Data Folder

Server Language
ServerTheme

IS Application Path

Evolve Suite User Name

Server  Authentication Worldlow Features Security

Cerwinl Evolve)Sitel

Browse

C\eswin| Evolve| Datal

Browse

Default Web Sitefevalve

Stand-slone v

ning with elevated privileges - IS configuration is enabled

ntly runn
Cument Version of II5 is 10.0

3. Under Server, select Share Data Folder, Use the Share Data Folder, and Use the Share MongoDB.
Authtﬁlitnllnﬁ Workflow Features Security

Evolve Suite User Password

Javascript Mode

115 User Name

IS User's Password

Primary Server

Concat
DESKTOP-56FDJOD\erwinx64 ]

sssssscssnee |

Share Data Folder

Use the Shared Data Folder

Share MongoDB

| Use the Shared MongoDB

If the Share Data Folder option is not selected by default select it.

4. Click Save.

5. Click Configure IS and perform full deployment.

Verify whether the database property is added to the environment variables.

6. Restart the secondary server.

7. Open erwin Web Modeler.

Verify whether it displays the main server’s erwin Web Modeler drafts and data. This indicates that both

machines are connected to the same MongoDB database.
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Automatic Diagrams (Diagram
Designer)

Create an Automatic / Visualization

Diagram

Diagram Designer allows the automatic creation of diagrams in erwin EA / BP.
You will be able to:

1. Enable a model
2. Create a new layout / auto diagram
3. Generate the diagram
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Enabling a Model

The first time you launch Diagram Designer, you may not have any models enabled. You need to enable a

model in order to use Diagram Designer.

5068
DD|agram

Ozu
S I G NER
powered by casewise

EA Foundation - Sample Elliat PF2013 Test

Madel

Diagrarm Designer w20180000 - erwin, Inc. «2018000

To enable a model,

1. Start Diagram Designer (You can find this in your Window's Start Menu)

. erwin CW Evolve

‘a :)Jla?ram Designer

EvolveDesigner

New

erwin CW Suite

2. Once it has loaded, and you have logged in, click on the “Enable a Model Icon
3. Select the model you want to enable for Diagram Designer from the drop down.

This operation take some time depending on your model’s size, when done your application will

restart. When the application has restarted you may then choose your model.
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4. Choose a Model by clicking on the "Model icon” with the name of your model.

Related Topics

Create a new Layout

Designing a Layout

Create a new Layout

Once your model is activated you are ready to add diagram layouts.

On first use, you will not have any diagram layouts created, so you need to create your first diagram layout.

To create a diagram layout, click on the “Add a Layout Icon” @ a popup will appear asking you to fill the

following information:

Option Description

Layout The name of your automatic diagram template (diagram layout). This name will help you to

Name find your template layout
The erwin EA/BP Desktop Modeler template which is used by the Diagram Designer to

. generate a diagram.

Diagram

Template The elements in the Palette of the diagram template are used for the default size of the
shapes. If the Object Type is not in the template palette, you will not be able to choose it in
the creation of your diagram layout.
There are 2 options for the output type of your diagram :
Group one or more objects on a diagram
This option allows you to put all the selected primary objects on the same diagram. This
option is used for heat map or big pictures diagrams.

Output type
Generate on diagram for each base object
This option allows you to create one diagram for each base object you will choose later. This
option is used for spider or flow diagrams.
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Related Items

Designing a Layout
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Designing a Layout

To configure your diagram layout, you need to be in the design mode, changing the mode is possible using

the Tabs below the options toolbar.

The design of your diagram layout is decomposed on the following steps:

1. Creation of the diagram layout
2. Definition of the object type(s) to select (Node)

3. Definition of output layout(s) to apply to the selected objects (Display)
4. Repeat step 2 as needed
That is, each time you choose a node (Set of Object Types) and a layout (Display), you can then if

required, add a sub level node using an Association Type.

In Diagram designer the selection of data is done using a graph structure. You will need to select the
Object Type(s) from which you want to start and then select Association Types from this object. A
selection of objects is called a “node”. For each node of objects you have to define which layout will

be used to display them in the diagram.
Three main layouts are available to apply to a Node:

1. Include layout : Have objects contained within a diagram or other object
2. Vertical layout : Have objects displayed to the right or left of the parent object

3. Spider layout : Have objects placed around the parent object

From each Node it is then possible to repeat the process of decomposing to sub nodes through

associations, to sub nodes.

Related Items

Working with Diagram Designer

Running a Layout
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Working with Diagram Designer

The Diagram Designer is designed to help you and propose you the next step depending on where you are in

the configuration of your automatic diagram template.

Each time a node has a red background, the meaning is that something is wrong or an action is required.
The Next step text is here to guide and help you. To see the message you need to hover with your mouse

over the element which has a red background.

Design
Layouts Options
=] test 1
N Node Name Application
~
© Next Step
Set your diagram name using the "Diagram Name" property.
Filter Properties ‘ ‘ )
Propert Operation
(AND) pery P

I =[ [~]

lcon |Node Name

’fy Design Layout, contain the design options

| |Object Node, either Object Type or Association Type

|ﬂ Node Layout, used to define the display type of the objects in the diagram

Design Mode

Once your configuration layout has been created you will be able to select objects and define a diagramming

layout.

Depending on the output type you have choose the diagram layout options vary.

Group Mode Output Type Options

Option Description

As you have choose the group mode, you will need to define the name of your diagram, as you
Diagram

Name will choose one or several objects to display on the diagram, the Diagram Designer can’t

define the name.
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Single Mode Output Type Options

The name of your diagram in the single mode will be the concatenation of the defined prefix + the name of

the primary object + the defined suffix.

Name Prefix

and the name of the primary object.

Option Description
This text will be used to prefix the name of the primary object to create the name of the
diagram. This option should be customized in order to avoid collision with existing
Diagram diagram.

Please include a space character after the prefix if you want a space between the prefix

Diagram
Name Suffix

the primary object.

The suffix will be used for the name of the diagram. It will be set just after the name of

To define the options for your diagram layout, left click on the root node and you will have the options at the

right side of the screen.

-
& Casewise Diagram Designer (APM)

Design

Options @ Help

Layouts Options
test1
Layout

Diagram Mode
Diagram Name
Diagram Template

Node UUID

test1

group v

‘ [Termlate: Application Hierarchy - ]

d08643f8e87011e1bfc0d4bed938b456
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Add Objects to the Diagram

Primary Object:
To add a primary object group you need to right click on the diagram layout node and choose the Object
Type you want to use.

Notice that only Object Types on the palette entry of your diagram template are displayed.

Notice also when you create the primary object node you have an include type layout which is
automatically added as a children of your object type node. This is because the first layout should
always be an Include Layout.

Association Types:
To continue adding objects, you need to right click on the parent node where you want to add an Association

Type, Objects Type associated to the selected Object Type are proposed in the context menu.

- .
¢ Casewise Diagram Designer (APM) =&
Options @ Help
Design | Run
Layouts Options
=4 test1 i
.5 [m— - [ Node Name Acgiication
lia) In | AddsssociationType  » || sppication  » || Application - Application (is Core System of)
o Expand Issue > Application - Application (is Customized Applictaion of)
@ Colapse o Name Application - Application (Receiver)
@ Detete rt Reverse [ | Application - Application (Sender)

Filter Properties (AND) Property Operation Value

[ L -

Notice that the Target Object Types should be present on the palette entry in order to have them
in the contextual menu.

Then from any association type node you can do the same operation.
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Notice that when you create an Association Type node, you will have to add the associated design

layout. Please refer to the "Add a Design Layout" section.

Object Node Options

The Object Selections node is used to specify the rules that determine which instances should be displayed
at the level you are working.

Here are the available options :

Option Description

Sort on Which property to sort the results by
Sort Reverse |Sortin reverse order

Filter Use this section to choose some rules for specifying exactly which objects you want
Properties returned — “where Category = A” etc

Notice that filters are using the “AND” operator when several filters are available.
If you put two filters like Category = A and Category = B, nothing will come out as it’s impossible

to have 2 categories at the same time.

Design Types
Add a design layout

To add a Design Layout, you need to right click on an object node without any Design Layout. On the context
menu you will have the option “Add Diagram Layout”, and then choose the diagram Layout you want to use
depending on your requirements.
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-
& Casewise Diagram Designer (APM) @Eﬂ

Options (@) Help
Design \
Layouts Options
=49 test1 "
- Node Name Application (is Core System of) ol
18] Include Layout | Association Type ToTarget |

Application - Application (is Core System of) v

W] Application (is Cora Sustam o

|im| Add Diagram Layout » ‘ [sm] Add Spider Layout
| Aad AssociationType  » [[i5]  Add Include Type Layout \

@  Expand [iml Add Horizontal Type Layout E
@ Colapse Wmm—'T,w' Operation Value
(O Dowte [ =] [+

Notice if your node has already a design layout attached, and you want to change it, you need first
to delete the existing design layout then you will be able to create a new one.

Available Design Types
The following design types are available:
Include Layout:

The include layout allows to include some objects in the diagram or in another object.

Option Description

When used at the top level, if the diagram has shapes already on it (the template may already
have some shapes) then a point is taken which is the bottom leftmost point of the bottom
leftmost shape — that is the zero point. Use the margin top and margin left to specify where the
first new shape should start.

Margin
On the first level, If you know there are no other shapes on the diagram, ignore all the margin
settings.

Space Use the Spacing settings to space the objects created at this level. This one is the X/Horizontal

Children X |axis.

Space Use the Spacing settings to space the objects created at this level. This one is the Y/Vertical
Children Y jaxis.
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Columns |Use the column setting to determine how many columns will be used to arrange the objects.

Reset If the include margins should be defined from the parent shape and not from the last rule’s

ese
c shape, check reset cursor. This is useful if only you have several include layout at the same
ursor
level.

Vertical Layout:

The vertical layout allows you to add an object at the right or left of the parent object.

Option Description
Sid Use the Side setting to choose whether the shape should be drawn to the left or right of the
ide
parent shape.
Horizontal ) ) ) ] ] ]
Use the Translate settings to specify the distance between this object and its parent.
translate
Vertical ) ) ] ] ) ]
Use the Space Children setting to specify the distance between instances at this level.
translate
¢ No: Do not connect the shapes in the diagram.
e Association Joiner: If the palette has an association type as a line for the association
Connect type being used here, then connect the child to its parent using that line.
shapes e Connector: If you do not use the set joiner’s option, you can instead use the set

connectors option to connect the child to its parent using a standard connector on
the palette.

Notice, if there is more than one instance of an object returned at this level, then the object will be

displayed multiple times on the diagram.
Spider Layout:
The spider layout allows putting the objects around the parent object.
Option Description

Distance from Allow defining the minimum distance between the parent and the children shapes, if a
parent bigger distance is required this distance will not be used.
e No: Do not connect the shapes in the diagram.

Connect

shapes e Association Joiner: If the palette has an association type as a line for the association

type being used here, then connect the child to its parent using that line.
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e Connector: If you do not use the set joiners option, you can instead use the set
connectors option to connect the child to its parent using a standard connector on

the palette.

Related Items

Designing a Layout

Running a Layout
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Running a Layout

The run mode allows you to generate the diagrams depending on the configurations you have selected.
When your diagram layout is correct, the run mode tab will appear next to the Design tab.

You can click on it in order to view the run mode.

% Casewise Diagram Designer (APM) -

- Application
~|sm| Include Layout
5 . Application (is Customized Applictaion of)
im Spider Layout

( '; \ Notice that depending on your design output type (single or group), the run mode varies.
s

The run mode objects which are displayed depend on the Primary object selected.

Run Mode for Single Output Type
In the single mode output, a diagram will be created for each primary object you will select.
You can select an object by checking the Generate column (1%t column).

When selected, the selected row’s state column will change, below the lists of the available states:

State Description

Waiting for

. The row has been correctly selected, when ready you can then start the generation
generation

Generation in _ _ )
The diagram is under generation
progress

Generated The diagram has been generated; it can be open using the “Open Diagram” column.
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Clearing joiners & [The diagram has been opened and is being cleared, this take time depending on the

shapes number of shapes and joiners you have on the diagram.

Once at least one object is selected, you will be able to use the “Start Generation” button and start the

generation of the diagram(s).

When a generation finishes, the name of the diagrams appears in the “Open Diagram” column, which should
be the last column. You may then click once (like a hypertext link in your browser) and the diagram will open

in Modeler.

Run Mode for Group Output Type

In the group mode for the group output type, all the objects you are going to select will be displayed on the
diagram.

You can select an object by checking the Generate column (1% column).

Once you have selected at least one object, you can then use the “Start Generation” button to create the
diagram.

When the generation starts, a new button appears labeled “Generation under progress”.

When the diagram is generated the button changes to “Open the Diagram”, if you click it, the diagram will

open in Modeler.

You can go back at any time to the Design mode, and return, and your selected items will remain checked.

Generae Copect wame Categary wren Creates wnen vpated
19r0aamz 32898 0w 1w
Loce |2r03/2012 153830 Er
o 207037002 5130531 23/002012 1683581
Local .11‘03.’1012 15:36c01 ‘um—-m-un;s-m
Lox
Loc
o

Core system B0 190107

Tacuca 21 e 0w 1mons
Local Based cn 8 Care System os/01/2011 1002320 230002012 17:1037

Related Items

Designing a Layout

Working with Diagram Designer
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Batch Generation of Automatic Diagrams

The diagram designer generation can be automated. You first need to create your diagram design layout,
make sure it's working correctly by running it manually. Once checked you will be able to prepare the

automatic execution.

To start configuring the batch mode:

1. Launch the “CMD” tool
2. Browse to your Diagram Designer installation directory

3. Launch the following command
DiagramDesigner.exe -h
The following usage will appear:

DiagramDesigner.exe -connection <connection_to_database> -model
<model filename>

-username <username> -password <password> -id <item_id>

Below details the arguments available:

Argument Key Description

-connection The name of your connection used to connect Corporate Exchange

-model The filename of the model you are going to use

-username The Username to connect Corporate Modeler Suite

-password The password associated with the username, leave “” if the password is empty

id The id of the design layout, accessible through the properties of the design layout
which is available in the Diagram Designer Object Type

Related Items

Running a Layout

Notice that you can use double quotes around your arguments if required.

Log Files
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Log Files

The Diagram Designer logs some information depending on the level of log requested.

This level can be configured in the DiagramDesigner.exe.config file which is located next to the

DiagramDesigner.exe application.

Values can be /INFOor DEBUG.

Related Items

Running a Layout

Batch Generation of Automatic Diagrams
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Additional Layouts

Jump and Merge Layout

As of the 2018 release of Evolve, Diagram Designer is now capable of performing a "Jump and Merge". This
popular add-on layout for Evolve Designer, has been brought to diagram designer, in order to make it

possible to build more complex diagrams.

With this layout the objects of the selected associations will not be put on the diagram. Instead, their parent
object(s) will be linked directly to their children. For example, if we have 3 levels and we switch the layout of
the 2nd one to “Jump & Merge” this is what we'll get:

Jump and merge can be added to your diagram, in the same way that other layout controls are applied.

The layout does not have any user defined properties other than the name. See below:
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Options @ Haip
Oesgn [Run |
Layouts ayout
=9 Test
&5 Process ety ]lumv Merge Layout
i Include Layout T

= < Process - Process (Contains)
-
=0 Process - Process (Contang)
8 Include Layout
=5 Al Objects - Dagram (Detalled By)
il Jump Merge Layout
= 3 Process Step (Showng)
il Include Layout
=5 Al Objects - Diagram (Detaied By)
i Jump Merge Layout
= Process Step (Showang)
al Include Layout
= ¥ Process - Process (Contains)
8 Hierarchy Layout

Options @ Help
Design |
u Options. ypel Layout
549 Test
W ® Peocess e [1ump Merge Layout
- Include Layout
89
&%) W AddDagnamLayout » |5 AddSpderLayout
W Include Layoy & NewAssociation » @ AddinciudeType Layout
=49 ANObjects -0 ©  Expand | @@ Add Horizontal Type Layout
i JumpMer¢ o Collapse | AddVertical Type Layout
89 ProcessSH@ Delete | @ AddHorizontal Merge Layout
¥ Include Layout 1@ AddHierrcyL
& f:MvM:(.Dﬂmly) [@ Ao ompwherge Type

& Process Step (Showing)
sl Include Layout
=55 Process - Process (Contains)
i Huerarchy Layout

Related Items

Designing a Layout
Running a Layout

Diagram Associations
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Diagram Association Layout

As of the 2018 release of Evolve, Diagram Designer is now capable of utilizing the diagram "detailed by" and

"diagrammed on" associations. This allows designers to create diagrams that take advantage of diagram
hierarchy/lineage.

Options @ Help
[Oesign [Run ]
Layouts Options [cwDiagramDesignerTreeNodeLayoutlumpMergeType] - Jump Merge Layout
=9 Test Node Name ]
=0 Process

Jump Merge Layout |
s Include Layout !

= (P Process - Process (Contains)
= Include Layout
=3 All Objects - Diagram (Detaded By)
i Jump Merge Layout
= {3 Process Step (Showing)
s Include Layout
=9 All Objects - Diagram (Detailed By)
= Jump Merge Layout
=) Process Step (Showing)
s Include Layout

=<3 Process - Py e AL antzine).
= H.mmn'y:— NewAssocaton » |  Diagram
°

» ) All Objects - Diagram (Detailed By) |
Expand Process » | AllObjects - Diagram (Diagrammed On)
o Collapse RootObject » T}
° 3 Py

The only available layout for a Diagram Association is the “Jump & Merge”.
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Options (@ Help

=

Layouts
=49 Test
=09 Process
sl Include Layout
=45 Process - Process (Contains)
-
= (3 Process - Process (Contains)
4l Include Layout
=5 All Objects - Diagram (Detailed By)
s Jump Merge Layout
= Process Step (Showing)
-4l Include Layout
=9 All Objects - Diagram (Detailed By)
48 Jump Merge Layout
=49 Process Step (Showing)
finl Include Layout

W AddJump Merge Type Layout 1

geType] - Jump Merge Layout

.IJumpMugewat

From that level the users can add any type of association used by the diagrams and show the linked objects.

Options @ Help
Design |Run

Layouts
=4 Test
=9 Process
8 Include Layout
=< Process - Process (Contains)
‘ Jump Merge Layout
=45 Process - Process (Contains)
s Include Layout
= All Objects - Diagram (Detailed By)
48 Jump Merge Layout
= (P Process Step (Showing)
8 Include Layout
=5 All Objects - Diagram (Detailed By)
s Jump Merge Layout
=49 Process Step (Showing)
s Include Layout
= Process - Process (Contains)
4% Mierarchy Layout

=5 All Objects - Diag|

- New Association »
sl Jump Merge

AllObjects

Expand
ollapse
Delete

0: ol
)

Diagram - CW Question (Showing)
Diagram - CW Questionnaire (Showing)
Diagram - CW Role (Showing)
Diagram - CW Site (Showing)
Diagram - CW Task (Showing)
Diagram - CW User (Showing)
Diagram - CW View (Showing)
Diagram - Connector (Showing)
Diagram - Connector Set (Showing)
Diagram - Control (Showing)
Diagram - Cost Centre (Showing)
Diagram - Data Store (Showing)
Diagram - Diagram (Showing)

Diagram - Person (Showing)

~ Phase (Showing)

- Picture (Showing)

« Process (Showing)

- Process Break (Showing)

- Process Step (Showing)

The node has been saved. in 00:00:02 44185045
The node has been saved. in 00:00:00.0200888s

- Process Version (Showing)
- Project (Showing)

« Relationship (Showing)

- Risk (Showing)

Diagram - Role (Showing)

i
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The combination of “Jump & Merge” and “Diagram Association” now allows designers to create very
complex diagrams without having to draw all intermediate objects or being limited by standard object types
and their basic/direct associations.

Single or consecutive “Jump & Merge” layouts and use of Diagram Associatons make Diagram Designer

even more powerful.

Related Items

Designing a Layout
Running a Layout

Jump and Merge
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Advance Filtering

Filter by Base Object 20180.1+

Use the base object for this diagram as a filter at a lower level in the diagram query.

On each Association node there is a checkbox. When checked, the only object that will appear on the

diagram at this level is the base object (if it is among the objects of this level).

In the following example, on the 3rd level (Transition State - Capability), if “Filter by Base Object” is
checked, only the Capability for which this diagram is generated (Base Object) will appear.

Options @ Help
Design |Run

Layouts Options TreeN iationType] - Capabilty - Application (Is supported
=4 Test —— -
&6 Capability NodeName ‘ [capabilty -Appication (is supported by)

il Include Layout
= £ Capability - Transition State ()
48l Include Layout

fal Include Layout

The node has been saved. in 00:00:00.04233045
Start serialize nodes.

INodes serialize in 00:00-00 32623475

Design done in 00.00.05 5074181 5

Full operation done in 00:00:05.77422545

Related Items

Designing a Layout
Running a Layout

Intersection Object Filter

Association Type To Target

Filter Properties (AND)

Capability - Application (Is supported by)

TargetObject Type s
=3 Transition State - Capability () Applcation
45/ Jump Merge Layout Mandatory Association
& Capability - Data Domain () L=
il Include Layout SortOn [
=% Data Domain - Capability () ‘ [Name
i@ Jump Merge Layout Sort Reverse 3
= Capability - Capabiity (contains) ]
il Include Layout Include Objects Only If Have Associations P
BYET Capabiiity - Application (Is supported by) O

Property

Operation | Value

I

v

© Filter by Base Object

Fiter by Base Object

Fiter by Base Objel

Intersection Object Filter

lo

|TRAN5ITIONSTATES LIKE "%{ACRONYM}%"
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Intersection Object Filter r2o1s.0.1+

As the name suggests, the Intersection Object Filter, allows filtering at the Intersection level.
Filters are provided against the Intersection Object's property values.

The syntax of the filter is SQL-like.
As can be seen in the following examples (be aware of the spaces):

+ TRANSITIONSTATES LIKE ‘TS%’
+ TRANSITIONSTATES NOT LIKE ‘%SEND’

TRANSITIONSTATES IN (‘TS1',TS2")

TRANSITIONSTATES NOT IN (‘TS3,'TS4")

TRANSITIONSTATES = ‘TST’
* TRANSITIONSTATES >= ‘TSI’

Additionally more complex scenarios can be provided using variables:

* TRANSITIONSTATES LIKE ‘%{ACRONYM}%’

In the following example, on the last level, we show Applications that are associated to Capabilities and the
Intersection Object’s property “TRANSITIONSTATES” (which is the property ScriptName) contains a specific
string. The variable value used is taken from the first object of the branch (starting from the top of the
diagram and moving down) that has the propertyname which is enclosed in curly braces (in this example,
ACRONYM). In this case, the value is taken from the second level where we have the "Transition States"
that have a property called “ACRONYM” (with values TS1, TS2 etc.).
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Options @ Help
[Design [Run |
Layouts Options [cwDiagramDesigner ypel - Capabilty - App (1s supported
=40 Test
& 5 Capability Node Name Capability - Application (1s supported by)
il Include Layout T
;@ Capabiity - Transition State ( Association Type To Target Capability - Application (Is supported by)
lisl Include Layout Target Object Ty
ype >
5 Transition State - Capabilty () e Application
|-l Jump Merge Layout Mandatory Association
£ Capability - Data Domain () o
48 Include Layout Sorton
5 Data Domain - Capability () Nomé i
il Jump Merge Layout Sort Reverse
=5 Capabilty - Capabilty (contains) o
Include Objects Only If Have Associations =
‘= Include Layout
Filter Properties (AND) ‘ T Oiaranon | Ve
[ M 0|
. . " )|
O Intersection Object Filter
jon Fiter by perty ~ SQLlike sy IKEINi... Sooack (A, B, C Z
Intersection ObjectNitter

‘TRANSIT‘ONSTATS LIKE “%{ACRONYM}%'

The node has been saved. in 00:00.00.04233045
Start serialize nodes

Nodes serialize in 00:00:00.32623475.

Design done in 00:00:05.5074181 5

Full operation done in 00:00:05.77422545

Related Items

Designing a Layout
Running a Layout

Filter by Base Object
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Navigating your Site

Overview

There are many ways in which you can navigate your Evolve site. However, since the 2018 release, two new

capabilities were added to help orient yourself while navigating.

e Smart Crumbs - a bread crumb trail with inbuilt recent lists, to help quick navigation between
frequently visited pages.
Helps you to see where you are in the Evolve site, and navigate more speedily.

o Diagram Navigator (or "Where Am 1?") - a diagram hierarchy viewpoint showing parent and child
lineage from the current diagram.
The tool can be used to navigate diagram hierarchies, showing previews of diagrams in the
immediate lineage, and allowing drill up and down from the current position.

Diagrams can be opened at any level, and activity is shown through the Smart Crumb trail.

Both Smart Crumbs and Diagram navigator are available without configuration. You just need to
be running version 2018 or above.

Related Topics

Smart Crumbs

Diagram Navigator
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Smart Crumbs

Introduced with Evolve 2018, Smart Crumbs brings a breadcrumb trail to the top of your site page.

Service Architecture @00

Service Delivery
Service Quality

rategy Managemens

premsion provitmy
j SR —
Shared Services Mamagement
T 1 o e
Wiragument
= = - oo
oy
- -
T, € ametton © i ]

e Smart Crumbs can be enabled in the Site Settings.
1. Select the Home tab.
2. Select the root Site node in the Layout's Tree.

3. See the option to Enable Smart Breadcrumbs in the options in the right hand pane.

© Evolve Designer (EA Foundation - Sample Model > EASAMP14) - v2018.0.0.0 - u] X

Home | Dynamic Deployment  Static Deployment

Update Meta Mode

namic Site tic Site
Dynemic Ste  Static Site & Themes

je Object Types Online Help

Publish Ad

on Help
Layouts Options [cwWebDesignerTreeNodeSite] - Site
2 &9 site
@-({) Index Pages
) Object Pages Link Extension MIME

Node Name Site

. html
Template Nodes ype
Site Language
en -
&~ A Deployments
A, Deployt Number Separator s .
) Diagram Popouts
JSON Extension eon
Less Theme T ~
Enable Cloud APIs
Export Diagram Images
=]
Display Dateflime In | _,
Local Time Zone
Restrict User Profle |
Access
Remember Diagram |
Zoom Level
Enable Smart =
Breadcrumbs
Node UUID 29b327466b2811e39838a4db3obgao12
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e The breadcrumb will expand as you navigate from the site menus, showing the menus and
objects you navigate through.
e The breadcrumb will offer a drop down list at each page node, showing recent objects/pages

of the same type.

@ # > Project » RequirementList » Working Time Turnover & > Unloading Process Optimization & Compliance

Deal with the urgent delivery

Enable Continuous Service Quality Improvement

q

X Mame | Unloading Process Optimization & Compliance

Properties
Category Undefined

Associations Project Code REGDECH
Criticality 3- Low Criticality

Mosisang Impact 2 - Medium Impact

. Director Ms Henri

Requirements

Manager Mr Ascenci
Requirement Status Documentation Jdocument/EN/_ENC4W_Final_Project pdf

Both Smart crumbs and Diagram navigator are available, provided you are running version
2018 or above.

Related Topics

Diagram Navigator

Site Configuration Reference
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Diagram Navigator

Prior to Evolve 2018, diagram hierarchy navigation was performed purely through the diagram drill downs,
and an in-page bread crumb trail. This trail was only integrated into the page, and could cause a little
confusion with regards to the outer page content. Since the 2018 release a new diagram navigation has been

added, that offers a much more visual experience.

As with Smart Crumbs, the Diagram Navigator feature is always enabled, and available to all users.

You will see this new feature as a simple icon above any diagram in your site. See below:

Strategic Planning Management

Quaiity Management Planning Management Finance Mansgement

= = =

Global Operations Management

Inbound Loghtics Operations Management Outbond Logitics
Management Management

tomer Relations
Management
- L ) [ Vendor intormanon
Stocs Managemert " ‘Managmiment
) L & Customer Detivery © Commumcation
i R oduct & Service Repo
S, - - B ot Catnog
St esammant Mansgrment Wanagement
| Re—
Shared Services Management
T Management Procurement Menagement Human Resources Sales Repasitory
Management
S, ] ] e = Cuntomer ntormatien
Management
- B hared ervces - = Onder inbormation
1 Promet Management : {mpoyes Management roohoracan

When viewing a diagram, pressing the new icon will launch the Diagram Navigator
The navigator will show the current diagram at the centre, with arrow-nodes representing each shape

on the diagram, that drills down to child diagrams.
Selecting one of these arrow-nodes will highlight the single/multiple child diagrams that 'explode'

from this shape.
Selecting the child diagram shapes, will display a diagram preview at the top left of the Navigator
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e Double-clicking on a child shape will drill down and re-center the Navigator around that diagram.

e Clicking on the "open" icon on any of the diagram shapes, will open the diagram fully.

Related Topics

Smart Crumbs

Both Smart crumbs and Diagram navigator are available, provided you are running version
2018 or above.
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Workflow Explained

Overview

Evolve includes a built-in Workflow capability which provides three useful processes:

1. A new Separate module for Workflow execution — new module, workflow is added to the
Erwin Evolve site, where you can create new applications, process, and business services.

E # Workflow New B

A New Application
& New Process

New Business Service

A Data
i}

& Support
I Configuration

‘Workflow

Ad r

2. A review and approval process for data changes - meaning that when
users create objects, delete objects or edit any data in Evolve, those changes are not submitted to
the repository until they have been approved.

3. An object validation request process - where users can request for an object to be validated
by a nominated set of users, and when all users approve the data, properties are set on the object
to record the validation.

4. A review process for Site pages - where you can share a page with a Role and every user in the

Role must confirm they have reviewed the content.
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Each of these processes are supported by Task and Notification mechanisms. Tasks are created for every
workflow that's initiated and users are alerted to them with notifications in the Site menu when they log in,

prompting them to take action.

In addition, users of your Site can Follow objects governed by workflows so they are notified of any

workflow-related activity affecting those objects.

Workflow can be configured to use SMTP, which enables alerts to be sent to users via email when Tasks are
created and completed. The emails, which are customizable, include details of the Task and the latest

activity, as well as direct links back to your Site for users to follow.

What do you want to do?

Enable Workflow for your Site

Set up the Review and Approval Workflow
Set up the Object Validation Workflow

Set up the Review Page Workflow

Work with Tasks

Review and approve, or reject, data changes
Confirm you have reviewed an Object Page

See who has reviewed a page you shared
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Enable Workflow for your Evolve

Server

Before you can use the Workflow feature you must configure your server to use it.

When you enable Workflow, it is at the server level - so any Sites you have can use it once it is enabled.

To enable Workflow

1. Start Evolve Designer.

2. On the Evolve Designer Models launcher dialog, click the Configure Evolve Server button.

Peed®O®

The Evolve Server Configuration dialog opens.

Home
t (@
Wio o @
Save Configure 15 Install IS Features Update Admin Mode!
Senver  Authentication Workiow Festures Security
Evolvs 15 Sia Nams e
Evelie Stz Folder ClerwinEvalve\Site)
Bromse
Evolve Data Folder ClerminlEvolve|Dats)
Browse
Senver Languzge = v
ServerTheme R v
115 Apslicstian Path Defoult Web Sitejevolve
Evolue Suite Database —— v
Evolve Suite User Nsme [rerm )~

ith elevated privleges - IS configuration is ensbled
oflS is200

Curre:
Curn

3. Under Workflow, select the Enable Workflow check box.
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Save Configure IIS Install IS Features Update Admin Model
Server Authentlcaﬁonl Worow reatutes Security
nable Wol
M
Workflow Due Date Interval (days) [3
Send Email Alerts
O
SMTP Server
SMTP Port
25

Enable Secure Sockets Layer (S5L) With
SMTP

SMTP User Name

SMTP Password

Email Display Name Evolve Web Platform

Nn-Renlvy Fmail Address
<

wrently runnina with alevated nrivileaes - IS ranfinuration iz enahled

4. Under Features, select the Enable Advance Workflow check box.

H©® © ®

Save Configure IS Install IIS Features Update Admin Model
Server  Authentication Woﬂd!owl Features kecuﬂty
Redis Cache
none
Instance

Enable Web Modeler Shape Styling

Enable Web Modeler Font Styling

Enable Advanced Workflow
(additional license required) %]

Ensure that you have Advanced Workflow license

view the Administration menu.

5. Click Save.
Save Configure 15 Install IS Features

6. Click Configure IS and perform full deployment.

and System Manager as a Power Level to

®

Update Admin Model
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Save Configure 15 Install IS Features Update Admin Model

Review and Approval Workflow

The Review and Approval workflow enables you to manage data quality by forcing changes to your model
to be approved before they are committed to the repository.

Task (3

The process covers all changes made to existing data, including the creation of new objects or
the deletion of existing objects, as well as changes to associations data.

The workflow does not cover the following:

e Questionnaires

e Social features - Comments, Ratings and Favorites
Who Approves What?

The Review and Approval Workflow has two levels, which can be combined in your Site:

e Page level

e Object Instance level
Page Level Review and Approval

Page Level Review and Approval works by linking a Role to Index Pages and Object Pages in your Site.
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Any changes to the data made via these pages, whether creating new objects, editing existing objects

or deleting objects, must be reviewed and approved by members of the Role before those changes are

applied.

Role members can approve or reject all, or merely some, of the proposed changes.

See how the Page level process works in detail

These steps assume there are no Object Instance level Approvers which would take precedence over the

Page level approval process.

The Page Level process works as follows:

1. A User (who is not a member of the Approver Role) uses one of the associated Pages to create, edit

or delete an object.

2. All members of the Approver Role linked to that Page are assigned a new Task informing them of

the changes and prompting them to review them.

o

If Evolve Workflow is configured to use SMTP, an email is sent to the Role members
notifying them of the Task, including a direct link to the Task in the Site.

The User is also able to view their change request - and can even delete it, discarding their

changes, as long as it has not already been approved.

If the change request relates to the deletion of an object, that object is highlighted with a
strike-through wherever it appears in the Site and the Ul makes it clear the object is 'marked

for deletion'. It cannot be edited while it is in this state.

3. Any one of the Approver Role members reviews the changes and either approves or rejects them.

o

o

The Approver can accept some of the changes and reject others.

The Task is cleared when one of the Approver Role members approves or rejects the

changes.

The Approver can enter comments explaining their decision which the User can see.

4. The approved changes are submitted to the repository and any rejected changes are discarded.

5. The Task is marked as 'Completed'.

6. A notification is sent to the person who made the changes informing them whether they have been

approved or rejected.

o

o

If Evolve Workflow is configured to use SMTP, the notification is sent via email as well.

The User can also see the outcome of the Task, including any comments, by viewing the
Task in the Site.
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Open | Completed

I SEP | New Application To Review
22 | 22sers0em

Review 1
Show assignees

AUG | New Application To Review

Show assignees
AUG | New Application To Review
24 | 24 406 121

Show assignees
AUG | New Application To Review

16 | 16 aug 22:0
Show assignees

AUG New Application To Review
16 | 1606 11310
Show assignees

ALG | New Application To Review

Show assignees
Object Instance Level Review and Approval

Object Instance Review and Approval works by linking a Role or User to a specific object instance in your
model. If another user edits or deletes the object, then it must be approved before the change is committed

to the repository.

See how the Object Instance level process works in detail:

1. A User (who is not an Approver for the object) edits or deletes a governed object.
2. All Approvers linked to that object, whether individual Users or in a Role, are assigned a new Task

informing them of the changes and prompting them to review them.

o If Evolve Workflow is configured to use SMTP, an email is sent to the Approvers notifying

them of the Task, including a direct link to the Task in the Site.

o The User who made the change is also able to view their change request - and can even

delete it, discarding their changes, as long as it has not already been approved.

o If the change request relates to the deletion of an object, that object is highlighted with a
strike-through wherever it appears in the Site and the Ul makes it clear the object is 'marked

for deletion'. It cannot be edited while it is in this state.
3. Any one of the Approvers reviews the changes and either approves or rejects them.
o The Approver can accept some of the changes and reject others.

o The Task is cleared when one of the Approver Role members approves or rejects the

changes.

o The Approver can enter comments explaining their decision which the User can see.

Reviewers can only download and view the attachment, which is attached by the user. They

cannot delete the attachment file.
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4. The approved changes are submitted to the repository and any rejected changes are discarded.
5. The Task is marked as 'Completed'.

6. A notification is sent to the person who made the changes informing them whether they have been
approved or rejected.

o If Evolve Workflow is configured to use SMTP, the notification is sent via email as well.

o The User can also see the outcome of the Task, including any comments, by viewing the
Task in the Site.

Precedence

If you combine Page level approval with Object Instance level approval, there is an order of precedence to

determine who must approve what.

The rules are detailed as follows:

e If an object has both levels of approval, then the Object Instance level takes precedence.
e If auserwhoisin a Page level approval Role edits an object on one of their governed pages, but the

object has Object Instance level approvers (Users or Roles) - then the Object Instance approvers
take precedence.

What do you want to do?

Set up Approver Roles and Users, and assign them to the pages or objects they must approve

Work with Tasks

Setup Approval Workflow Roles and
Users

This page explains how to set up approvers for the Page level and Object Instance level Review and
Approval workflows.

These instructions assume you have already enabled Workflow /in Evolve.

Set up Page level Approver Roles
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To ensure consistent data governance, you should ensure you assign Approval Roles to all pages on your
Site where the data you want to govern can be changed - for example on Object Pages, Index Pages using

Tables, and so on.

To specify which Roles approve which pages:

1. In your Evolve Site, browse to the Roles administration page.
IT Capability Catalogue
Interface Catalogue

Applications Landscape

Organisation Hierarchy

Server Application
Landscape

IT Capability Landscape

| & Roles

Zle Governance

© Questionnaires

Compliance Hierarchy

2. Click the Role you want to edit.
The Role page is displayed.

E L My Menu Roles 2nd Level Reviewer ADMIN w

HOBHS

4. In the page sub-menu, click Approve Views.
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Users

See pages

BIOIOI0)

Approve Views

Has Pages on Home

5. The page lists all the pages the Role is the Approver for.

6. Click the Associate button at the top-right of the CW View (approves) box.

Role

Users

See pages

Approve Views

2)B)2)E)

CW View (approves)

Has Pages on Home

7. Click inside the text box, or start typing the name of the page you want Role members to approve.

CW View (approves)

(2)(@)(2)(8)

application

application_audit
application_data_layer
application_details
application_diagram_popout
application_management

application_transition_state_mgmt

8. Select the page from the list.

The page appears in the box.

Role

Users

See pages

Approve Views

Has Pages on Home

DE®

CW View (approves)

ion_audit ion_details

9. Click the Save button.

@

2)(®)

erwin Evolve — User Help Guide 273
Workflow Explained



10. In the pop-out Changes window, click the Submit changes button.

The page is added to the list of pages Role members approve.
E G 2nd Level Reviewer

ADMIN

CW View (approves) % Association Changes
CW View (approves)

@ application_audit

x x % application_details

application_audit application_details

You can also configure Approver Roles using the grid on the built-in Governance
Administration Page.

To use this method, select a page, click the Edit button and then link the page to Roles using
the CW Role (is approved by) association.

Set up Object Instance level Approvers
Both Users and Roles can be assigned as Approvers at Object Instance level.
The simplest way to assign Users or Roles to object instances is using Object Explorer or Model Explorer.

You can do this by selecting an object and associating it to a CW User or CW Role, or by selecting a CW
User or CW Role and associating it to an object.

r/> B

'f\ || You must have opted to Show the Evolve Object Types using the Show,/Hide Object
Types function in Evolve Designer in order to be able to see the CW User and CW Role objects in
your model.

When assigning Object Instance Approvers:

Associate objects to Roles using 'Any Object (is approved by role) CW Role' or 'CW Role (role approves)
Any Object' depending on whether your focus is the object or the Role.

Associate objects to Users using 'Any Object (is approved by user) CW User' or 'CW User (user
approves) Any Object' depending on whether your focus is the object or the User.
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Object Validation Workflow

The Object Validation workflow enables users to request that an object be validated by one or more
nominated users (Reviewers).

Malification o

a VO A L VRO S bw e B AN Tl

{{{‘i

Each reviewer then receives a Task prompting them to review the object, and then either approve it for

validation or reject the request.

The workflow remains active until all reviewers have responded to their tasks. If all reviewers approve the

validation request, the object is marked as validated.

The validation is recorded using three Property Types of the object, one for recording if it is validated or not,
one to record the date/time of the validation, and one to record the names of the users who approved it. You
can use the standard Validated and Validated Date Property Types for the first two of these.

See how the Object Validation process works in detail

The Object Validation process works as follows:

1. A User views an Object Page on the Site and decides they would like to have that object approved for
validation.

2. The User clicks the Create Task button on the page and chooses one or more Users they would like
to validate the content. They can optionally enter a message or a comment about the object which
the nominated Users can view.

3. Each Reviewer is assigned a new Task asking them to review the object data and either Approve or

Reject it.

o The workflow remains open until all nominated Users have either Approved or Rejected the

object.

o When a nominated User responds to their Task, the User who requested the validation is

sent a notification informing them of the response.

o The objectis only considered validated if all Reviewers Approve it.
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o When the Task is completed, the User who requested the validation is sent a final summary

notification including all the response outcomes.

4. If all Reviewers Approve the validation request, the object is marked as validated, the date/time of
the approval is logged, and the names of all the Users who approved it are recorded. All this data is

captured on the object itself.

What do you want to do?

Set up the Object Validation workflow on your Site

Request an object be validated
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Set Up the Object Validation Workflow

This page explains how to configure your Site to use the Object Validation workflow.

These instructions assume you have already enabled Workflow in Evolve.

Required Metadata

In order to use the Object Validation workflow, you must choose which Object Types from your Model you

want the process to be applied to.

The workflow can work with the standard validation properties on objects, or with your own custom
properties you may want to use - but the meta data must be identical on each Object Type.

Users will not be able to request object validation on any Object Page where the Object Type is not

configured correctly.

The Object Validation workflow requires two Property Types on each Object Type, plus an optional
third property:

¢ A Check Box property - which is set to True when the object is approved for validation.

o A Date/Time property - which is set with the date/time when the Task is completed and the
validation request is approved.

o A Multi-Line Text property (optional)- which is used to list the names of the Users who were

requested to validate the object.

If you create custom Property Types to use, they must have matching Scriptnames for each
Object Type.

Configure Site to Enable Object Validation

To configure your Site to enable Object Validation:

1. In evolve designer, select the Deployments > Model node.
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Home
1 »
H | P
Save Dynamic Site
Design Publish
Layouts
=49 Erwin Demo
(1} Index Pages
") Object Pages
Template Nodes

Menu

E Deployments

P erwin-gw

= [ desktop-q6fdiod
@ Diagram Popouts

Messages

Dynamic Deployment

Static Site

Static Deployment

b D4
‘e

Show/Hide Object Types

®@

Online Help

Administration Help
Options [cwWebDesigner TreeNodeDeploymentModel] - EDGEWF

Deploy Custom 5Site

Default ||~
AD Mappin:
Pens ézup %:55” CWGroup  CWRole

v oo - - -
Social  |v - -
Diagram... |+ - -
Static ~ A A
None - - vl

Use Static Authentication

Display Model in the Evalve
Web Platfom
Validation Workflow Active
Object Types

All(10) Info(8) Success(2) Warning (o) Error(o) ClearAl

Start Reloading the meta model .

Meta Model reloaded in 00:00:00.32603655.
Operation Ends - Run for 00-00:02 7173668 secands

2. Complete each of the following settings:

Setting

Description

Validation Workflow
Active Object Types

Enter the Scriptnames of each Object Type you want to enable the Object
Validation workflow for. Separate using commas.

Use Default Validation
Property Types

Select this option if you want to use the standard Validated and Validated
Date properties for the Workflow Validated and Workflow Timestamp

properties below.

Choosing this option completes the next two fields automatically.

Validation Workflow
Validated Property Type

If you want to use a custom property to record if the object is validated or not,

enter the Scriptname of the Check Box Property Type you want to use.

Validation Workflow
Timestamp Property Type

If you want to use a custom property to record the validated date, enter the

Scriptname of the Date/Time Property Type you want to use.

Validation Workflow
Validated By Property
Type

Optional

If you want to record the names of the users who validated the object, enter
the Scriptname of the Multi-Line Text Property Type you want to use for

this purpose.

3. Save and Publish your Site.

To update meta model for models already configured for Advanced Workflow:

1. Start Evolve Designer.

2. Click a model. For example, EDGEWorkflow.
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l|. 1
|..11
tA Foundation - Sample EDGEWorkflow
Model

DN

3. Click Erwin Demo.

Erwin Demo

An Evolve Designer window opens.

You will receive the below error message when you click on 'Update Meta Model & Themes'. To fix this
error, you need to first update meta model.

Messages

All(14) Info(7) Success(4) Warning(o) Error(3) ClearAl
...... >

Start Updating the meta model
If you have Diagram Designer layouts or Visualizations make sure you Update The Meta Model for them also

Object Already Exists : <Cannot insert duplicate key row in object ‘dbo. CW_OBJECT" with unique index 'IX_GO_NAME'. The duplicate key value is (AcoKRKYX, 20053, cwworkflowitem) > on node Erwin Demo whichisa
cwWebDesignerTreeNodeSite

Upgrade meta model has been cancelled. Please restart evolve designer to complete the upgrade process. on node Erwin Demo which is a cwWebDesigner TreeNodeSite
Operation Ends - Run for 00.00:03 5506315 seconds.

To update meta model:

1. Expand Erwin Demo > Object Pages.
Layouts
S @ Erwin Demo <= ol
i @ Index Pages
E@ Object Pages 4mm
: [j] application
----- m application_audit
m application_data_layer
----- m application_details
[j] application_management
----- Eﬁ] application_transition_state_m
m architecctureenabler
----- [@ architecctureenabler_details
[jj] assessmentquestion

----- Eﬁ] assessmentquestion_details
r’ﬁ) benefit b
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2. Right-click cwworkflowitem and click Delete.

1] cwworkflowitem <¢um
= O CW Workflow Item
508 Layout Empty
572 Al Objects - CW Task (has task)
508 Layout Workflow
52 CW Task - CW User (is actioned by)
508 Layout Empty
- “ CW Action
OO LayoutEmpty
3. Click Update Meta Model & Themes.
4. Click Save.
5. Click Dynamic Site.

Deleting an index page without unlinking it from the menu leads to an error. To fix this error, follow below

steps:
To delete “z_custom_layout configuration” index page and unlink from menu:

1. Expand Erwin Demo > Index Pages.
= '{Q Erwin Demo
@--( 4 ) Index Pages
2. Right-click z_custom_layout_configuration and click Delete.

z_custom_layout_configuration

5D Cwsite

58 Layout Custom Layout Configuration

3. Expand Menu > Configuration.

4. Right-click Custom Layout Configuration and click Delete.
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Layouts

& Layout Custom Layout Configuraton -

# Coniguration
Node Name

(Custom Layout Canfiguration
LinkType o
2_custom_ayout_configuration
Font Awesome lcon Libeary
o Default Theme Color

Noicon

+ ™ Wordiow
Deployments

() Dagram Popouts

5. Click Save.
6. Click Dynamic Site.

Evolve Workflow Configuration

Workflow configuration is now a part of Administration, alongside Pool/Swimlane Configuration and it
enables you to create and customize workflows.

“ Workflow configuration is available to Subscribed users only. For access, contact Sales &
Support.

Q You must have Administrator rights to create or configure workflows.

To create a workflow:
1.

Open the browser and login to erwin Evolve Web.
2.

Click a model. For example, EDGEWorkflow.

<« C @ localhost/evolve/index.html 2w O &
E My Sites ADMIN w
EA Foundation - Sample Model EDGEWorkflow
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3. Click Administration.

©f Administration

4. Click Workflow.

Workflow

5. Click the Object Type drop-down list box and select the required object type.

Object Type : Architecture Enabler (architecctureenabler) v

Application (application) -
CwRole That Architecture Enabler (architecctureenabler)

: Architecture State (architecturestate)

Assessment Question (assessmentquestion)

Benefit (benefit)

Business Capability (capability)

Business Continuity Risk (businesscontinuityrisk)

Business Continuity Scenario (businesscontinuityscenario)
Business Rule (businessrule)

Business Service (businessservice)

Business Term (glossary)

Checklist (checklist)

Code Set (codeset)

Compliance Element (complianceelement)

Conceptual Architecture (conceptualarchitecture)

Connector (connector)

Connector Set (connectorset)

Control (control)

Custom Layout Configuration (cw_customlayoutconfiguration)

e CwRole is used by Workflow Engine, which can be triggered directly from the erwin Evolve
home page.

Add scenario

When you click add_scenario, a scenario is created and a request is sent for approvals.

e Users with Administrator rights can create multiple Scenarios.

To add Scenarios:

1. Click the add_scenario icon.
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[add_scenario]
2. Inthe Name box, specify the name of the Scenario.
Name : Scenario0

3. Inthe Order box, specify the order of the Scenario.

Order : [I =]

Use up or down arrow to change the order of the Scenario.

4. Click the Property for document list drop-down list box and select the required option.

Property for document list : v

-

> Graphical View Architecture priority
Average Rating
Category
Completion Date
Created By

Creation Date
Criticality

Date Validated
Delivery Date
Description

Diagram Order

Freeze Level

Id

Initiation Date

Name (Code Letter)
Owner

Retirement Date
Template

Total Comment v

Graphical View

You can view the workflow process in a graphical format in the Graphical View section.

To add step via the Graphical View:
1. Click the add_step icon.

add_step]
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2.

3.

In the Name box, specify the name of the step.

Name : | Step0

In the Order box, specify the order of the step.

Order : [I

Document Section in ReadOnly : [

Input Configuration

Use up or down arrow to change the order of the step.

To restrict the reviewer from unintentionally modifying the document, you can configure the
document to be read-only before sending it for review. Select the Document Section in
ReadOnly check box.

You can create custom approval form with fields, such as Name, Email and Description.

To add form_input:

1. Click the add_form_input icon.
~ Input Configuration
[ag:_f'orm_input]
2. Complete each of the following settings:
Section Property Description Additional Information
label Specifies the label
Input )
Configuration of input
Order Specifies the order
of input
Type Specifies the type of | property: Indicates an input type

input

objectType: Indicates a input's object
type
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Section Property Description Additional Information
association: Indicates a relationship
between two objects
message: Indicates a generic
message of input
request-name: Indicates the name of
workflow creator
Scriptname Specifies the script Available when Type is set to property.
name of the Click the Scriptname drop-down list
property box and select the required option.
Object Type Specifies the input Available when Type is set to

object type

objectType.
Click the Object Type drop-down list

box and select the required option.

Scriptname to use
in other property

value

Specifies the
scriptname of the
object Type or

request name

Available when Type is set to

objectType or request-name

Association Type

Specifies the

association type of

Available when Type is set to

association.

input Click the Association Type drop-down
list box and select the required option.
Informative Specifies an Available when Type is set to message
Message informative
message about
input
Read Only Specifies whether Available when type is set to property,
the input is read- objectType, association or request-
only name
Mandatory Specifies whether Available when Type is set to property,
the input is objectType, association or request-
mandatory name
Hidden Specifies whether Available when Type is set to property,
the input is hidden objectType, association or request-
name
Value Specifies a value of | Available when Type is set to property,

the input type

objectType, association or request-
name
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Section Property Description Additional Information
Filter Specifies the Filter 1. Click Add New
option to filter input | 2. Click the Property drop-down list
value box and select the required option
3. Click the Operator drop-down list
box and select the required option
4. Use Value or drop-down list to
specify the property value
Step Mapping Label Specifies the Iabél
Configuration of the step mapping
Order Specifies the order
of the step mapping
Step Name Specifies the name
of the step
Read Only Specifies whether
the step is read only
Hidden Specifies whether
the step is hidden
for all users
Mandatory Specifies whether
the step is
mandatory
CW User Specifies the

casewise user of

mapping

Mapped to the

creator of the

Specifies whether

the creator of the

workflow workflow is mapped
Cw Role Specifies the role of | Available only when Mapped to the
casewise user creator of the workflow is not
selected and while configuring Review
1 and Review 2
Filter Specifies the Filter 1. Click Add Filter
option to filter the 2. Click Property drop-down list box
value for custom and select the required option
form types 3. Click Operator drop-down list box

and select the required option
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Section Property Description Additional Information
4. Use Value or drop-down list to
specify the property value
Add Buttons and Label Specifies the name
Next Steps of buttons and
steps
Order Specifies the order
of buttons and
steps
Step Name Specifies the name

of the step

Enable Notification

Specifies the
notification of new
task

Create the Final
Object

Specifies whether
the created object is

final

To create the final object, user must

be contributor or diagrammer.

lgnore Mandatory
Fields

Specifies whether
the mandatory
fields can be

ignored

Filter

Specifies the Filter
option to filter the
value for custom

form types

1. Click Add Filter

2. Click Property drop-down list box
and select the required option

3. Click Operator drop-down list box
and select the required option

4. Use Value or drop-down list to

specify the property value

Notification Title &
Notification

message

Specifies the title
and message of

notification

Available only when you select the
Enable Notification check box or the
Create the Final Object check box

To save the workflow configuration, click the Save Configuration icon.
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The Save icon saves JSON configuration into erwin Evolve Web Platform.

To add an index page in erwin Evolve Web for the workflow

1. Start Evolve Designer.
2. Click a model. For example, EDGEWorkflow.

i.‘,| !i'.:f,'l
! Wan 1!
~ !l
‘l. 31 "h. 31
tA Foundation - Sample EDGEWorkflow
Model
M

3. Click Erwin Demo.r

Erwin Demo

An Evolve Designer window opens.

4. Expand Erwin Demo.

= '\»'7 Erwin Demo
¥ {7 Index Pages
#-{ () Object Pages
(g Template Nodes
©-(@m Menu
v Deployments

&6 Diagram Popouts

5. Right-click the Index Pages node and click Add Index Page For Object Type.

----- © [ | |

—~ o Expand
(j Object Pagg .

E‘t

=4 g ExpandAll

4, Template Ng 8l Colapse

_ s/ Menu - Static Mode Only

Eg" """ Deploymentl |Add Index Page For Object Type »

B @ Diagram Poj Add Index Page

6. Select the required object type for which you want to configure workflow. For example,
Architecture Enabler.
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| S
Application

Architecture Enabler
Architecture State

Assessment Question

l Benefit

Business Capability
Business Continuity Risk
Business Continuity Scenario
Business Rule

Business Service

Business Term
CWAPINETWORK

CW Answer

CW Answer User All Objects
CW Changeset

CW Comment

An index page (index_architecture_enablers) is added at the end of index pages.

o index_architecture_enablers

Click index_architecture_enablers.

In the Page Name box, change the page name if required. For example,
index_architecture_enablers_workflow.

Page Name ’index_architecture_enablers

Expand index_architecture_enablers_workflow > Architecture Enabler.

= index_architecture_enablers_workflow -

[

55 Layout Workflow

Right-click Layout List (Simple) and then, select Switch Layout > Casewise > Workflow.

index_technologies_pie_chart_os & N Custom Layout Configuration
index_technologies_servers_virtualisation_pie Workflow
index_technologies_table_complex Display AFM Application (Deprecated)
index_technologies_table_states D?ta Quality Chart
index_transition_states_strategic_alternative_tal Javasc Diagram

Diagram Draft (Private)

%v_create_business_service )
g | La Diagram Popout
z_diagram_template .
—41ag - P eModeler Diagrams

index_architecture_enablers_workflow L eModeler Page
O Architecture Enabler Empty
- Ew— Custon External Picture
ject Pages Ad.d Behaviours 3 : Grid (Simple)
nplate Nodes | % ';:I::; Layout ' | SEinEE b Image
qu List (Simple)
)Ilovments N w List Box
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The Layout List (Simple) nodes changes to Layout Workflow.

EI . D index_architecture_enablers_workflow

10. Click the Layout Workflow node.

11. In the ObjectType Scriptname box, specify the script name of the object type. For
example, application.

Ensure that ObjectType Scriptname is in lowercase.

Layouts Options [cwWebDesignerTreeNodeLayout] - Layout Workflow
% index_technologies_table_complex A
Node Name Layout Workflow
3! index_technologies_table_states
e} index_transition_states_strategic_alterna Display Object Hyperlink
2] w_create_business_service
| z_diagram_template Javascript Class Name cwWorkflow

2 index_architecture_enablers_workflow
E O Architecture Enabler

=8 Layout Workflow Layout ID

') Object Pages

Layout Name cw-workflow

:» Template Nodes Custom Display String fname]

-
S5/ Menu ObjectType Scriptname

Deployments |BDD“CBtIOﬂ I

/‘\\ Diagram Popouts Scenario Name

12. In the Scenario Name box, specify the name of the application that you use while

configuring workflow in your erwin Evolve site.
Display Object Hyperlink

Javascript Class Name

cwWorkflow
Layout Name cw-workflow
LayoutID
¥ I
Custom Display String |{name}
ObjectType Scriptname |app\|catmn

Scenario Name |

13. Right-click on the Menu node and click Add Menu Link.

T LR L

&

‘ Expand
[L\,-- Depl
] Expand All

""" @ Diagr Collapse

Add Menu Link

Add Index Page Link 3
AddCreate ObjectLink  »

B

E

XK

;5ages

14. Expand Menu node.

15. Right-click Menu Link and select Add Index Page Link > Custom Pages.
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Home

bl

Save

-

Layouts

P

@

Messages

Uynamic Deployment

d @

Dynamic Site Static Site

Publish

8 Layout Workflow
Object Pages
Template Nodes

@ Menu

o Strategy

Sl Bysiness Architecture
Sl Enterprise Architecture
@M Data Architecture

sl GRC Architecture

& Sypport

4l Configuration

W Workflow

: -.MC Add Menu Link -
*_ Deolovmel g Rgdindex Page Link __ »

Static Ueployment

@

Update Meta Model

9

&Themes

Options [cwWebDesignerTreeNo

Administration

Node Name

2

N/
LH

Show]Hide Ob)

INOeX_appiicatons_compiiance_stanaara_pie
index_applications_custom_report
index_applications_gdpr_compliance_pie
index_applications_lifecycle_gantt
index_applications_network
index_applications_pie_chart_criticality
index_applications_pie_chart_data_marking
index_applications_table_lifecycle_information
index_architecture_enablers_accordion_hierarchy

index_architecture_enablers_workflow

index_: _quesnons,bs'ifooo

®  Delete

@ AddCreateObjectLink  »

LinkType
Link
Icon Library

Icon Color

Icon

Standard Pages

Custom Pages.

1000006000000 6006600666

index_assessment_questions_is014001
index_assessment_questions_is020000
index_assessment_questions_is027001
index_assessment_guestions_isogoos.
index_assessment_questions_mifida
index_assessment_guestions_solvency2
index_benefits_accordion_hierarchy
index_benefits_req_table
index_benefits_table_complex
index_business_capabilities_maturity_boston
index_business_capabilities_table_complex
index_business_continuity_risks_register
index_business_continuity_scenarios_impact_accordion
index_business_continuity_scenarios_register
index_business_rules_catalogue

indav hiicinace rilae Asts srrardian

16. Select the index page that you created. For example,

index_architecture_enablers_workflow.

17. Click Save.

18. Click Dynamic Site.

To publish the workflow to the server, click the Publish icon.

®(@)
ey

e The publish icon publishes the workflow to the server.

To refresh the workflow configuration, click the Refresh Configuration icon.

@

Nt ’ .
| Refresh Configuration

The Refresh icon discards the workflow's saved changes and reloads it from the server.
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Page Review Workflow

The Page Review Workflow is part of the Share functionality in Evolve.
Share E

WLy e

e
If Workflow is enabled, a user can choose to share the page with a Role. All members of the Role are then

assigned Tasks prompting them to review the page - or object - and they must confirm they have reviewed it

before the Task is considered complete.

In addition, the user who shared the page is also assigned a Task - with the Task marked as 'My Requests' -

and this allows them to view which users have reviewed the page.

Only once all members of the Role have confirmed they have reviewed the page is the Task marked as
'Completed'.

What do you want to do?

Confirm you have reviewed an Object Page

See who has reviewed a page you shared
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Working with Tasks

Tasks are an integral part of Evolve Workflow and are assigned to users in the following two instances:

e When users are set as an Approver of Page or Object Instance as part of the Review and Approval

workflow, they will receive Tasks when users edit data that they must approve.

Users cannot delete or modify the attachment unless the status of the request is Resubmit.

e When users share a page with a Role, all members of the Role are assigned Tasks to prompt them to

review the page.

Depending on how a Workflow is configured, when Tasks are assigned, users may receive an Email

notification as well.

What do you want to do?

Create an approval request/task:

To create an approval request/task:

1. Open the browser and login to erwin Evolve Web.
2. Click a model. For example, EDGEWorkflow.

C @ localhost/evolve/index.html 2« O &

< :
E My Sites ADMIN w

EA Foundation - Sample Model EDGEWorkflow

3. Click Workflow.

4. Click New Application.
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¥ New Application

& New Process

New Business Service

An application form appears.

*Category : v
~Code :

Fiere you can éind ar imformstve messege
Lifecycle Status : ~
*Criticality : v
Tier : w

Business Owner :
*Person :

Contact Person/Mail (automatically filled) : ()

Attachment :
Submission : ADMIN
Review 1: 1st Level Reviewer >
Review 2 : 2nd Level Reviewer ~
===

5. Enter details in the required fields. Fields marked with asterisk are mandatory.

Property Description Additional Information

Name Specifies the name

of the new

application

Category Specifies the You can customize categories using

business category workflow configuration according to

of input your business usage.

i
Code Specifies an
informative

message about the

application

fios th
Lifecycle Status Specifies the status

of the lifecycle
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Property Description Additional Information

e Specifies the You can customize the criticality
Criticality
importance of the options using workflow configuration.
application
Tier Specifies the rank You can customize the tier options
of the application using workflow configuration.

ifies th
Business Owner Specifies the name

of the business

owner

Specifies the person | For example, Malcom Brooks
Person

who created the

application

Contact Specifies the name For example, Malcom Brooks

Person/Mail or email address of (person_email@company.com)

the person to be

contacted

Review 1 Specifies the first
level reviewer,
which is set in
workflow

configuration

Review 2 Specifies the
second level
reviewer, which is

set in workflow

configuration

6. Click Submit to submit the form or click Save For Later to save the form.

Save For Later enables you to save the information for later, and is stored under draft

Once the form is submitted, you will be notified that the form has been submitted and sent to the

reviewer for approval.

Your request was submitted successfully.

To view the approval request/task:
1. Under ADMIN, click My Profile.
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ADMIN A~
Mty Sites
| My Prefile |

The My Profile screen appears.

2. Under Application Request, click My Request.

Application Request
My Request
Reguest To Proceas

Request Sewved For Later

The My Request screen appears.

The My Request screen displays the status and history of all your requests.

Review

€

4+ Task created by Admin

|

Validated

+ gfe

4 Task by Admin

+ Test

4+ Test2

Rejected

+ 8 July

To review tasks raised by the requestor:

1. Login to erwin Evolve Web with reviewer.
2. Click Tasks.
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3. Select the application form that you want to review.

4. Click Assign to Me.

0 MNew Application Te Review

ADMIM, 17 OCT 3:20AM

@ Assign to Me

() Transfer Task

5. Click Take Action.
o —

An application form opens.
6. If you are a reviewer 1, enter the review comments in the First Review Comments box and
then, click Validate.

*First Review Comments : Approved
Attachment :

Submission : ADMIN

Review 1: 1st Level Reviewer
Review 2 : 2nd Level Reviewer
ReSubmit : ADMIN

AeSubmit ==

7.1f you are a reviewer 2, enter the review comments in the Second Review Comments box
and then, click Validate.

EFirst Review Comments : Approved
*Second Review Comments : Approved
Attachment :
Submission : ADMIN
Review 1: 1st Level Reviewer
Review 2 : 2nd Level Reviewer
ReSubmit : ADMIN
ReSubmit 2: ADMIN

—
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Once you click validate, you will be notified that “Your Action was successfully submitted. Requested User
will be Notified”.

Your Action was successfully submitted. Requested User will be Notified.

View your pending Tasks

To view your pending Tasks:

1. In your Evolve Site, click the Tasks menu.
The sub-menu lists up to five Tasks that are unread.

2. Click on a Task to go directly to it, or click See all tasks to view all your Tasks.
By default the My Tasks page is shown so the pending Tasks are displayed.

3. Select a Task to view its details.
Review and approve/reject data change requests by another user

If you are in an Approver Role for a Page or Object Instance, or you are a User assigned as an Object
Instance Approver, you are assigned Tasks to review the changes and then accept or reject changes made

by other users.

Reviewers can only download and view the attachment, which is attached by the user. They
cannot delete the attachment file.

To review and approve or reject data change requests:

1. View your Task from the Tasks menu or by following thelink in the notification email.
2. The page shows you all the changes made by the user, including the previous and new values.
3. Go through Review each change and choose whether to Accept or Reject it.
Alternatively, you can use the Accept All or Reject All buttons.
4. Once you have Approved or Rejected all the changes, click the Submit review button.

The changes are submitted, and your Task is marked as ‘completed’. A notification email with the

results of the review is sent to the user who made the changes.

Before you submit, you can enter comments in the comments text box. These will be visible to the

user so they can understand why you rejected or approved their change request.
Confirm you have reviewed a shared page

If a user has shared a page with a Role, all members of that Role must confirm they have reviewed the page.

To confirm you have reviewed a shared page:
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1. Navigate to the Task by using the Tasks menu in your Evolve Site, or by following the link provided in
the notification email.

2. Click on Take Action button to navigate to the page to be reviewed.

3. Once you have reviewed the page, click the Confirm you have reviewed this page button.

The Task is complete.
View pending Tasks you initiated

If you initiated a Task, either by a data change request, or by sharing a page for review, you can view the

details of the Task while it is still incomplete.

To view pending Tasks you initiated:

1. Use the Tasks menu to See all tasks.
2. Click the My Requests sub-menu.

All Tasks you initiated are displayed.
3. On the Task you want to check:

o Click Show Assignees on page sharing Tasks to see who has reviewed the page.

o Click Show Approvers on data change request Tasks to see the list of Approvers.

Cancel a pending Task you initiated

If you initiated a Task, you can cancel it at any time before the Task is completed.

To cancel a Task you initiated:

1. Use the Tasks menu to See all tasks.
2. Click the My Requests sub-menu.
All Tasks you initiated are displayed.

3. Click the Trashcan icon next to the Task that you want to cancel.

The Task is deleted and is removed from all Assignees’ and Approvers' Task lists.

View completed Tasks

To view your completed Tasks:

1. In your Evolve Site, click the Tasks menu.

2. On the sub-menu, click See all tasks to view all your Tasks.

3. Select My Tasks or My Requests in the sub-menu to see Tasks that have been assigned to you, or
ones that you initiated by sharing a page with a Role.
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My Tasks Open

n [T} Your Application Creation Request has been approuved
n [T} Your Application Creation Request has been approuved
2.3 106 32
n [Ie] New Application To Review
R1,2 AUG 2-559M
n [ITY New Application To Review
R, 2 AIG 202PM
n FITT] New Business Service
1,25 Jan sa2see

By default the My Tasks page is active so the pending Tasks are displayed.

Completed

3 My Requests

4. Click the Completed filter to view just completed Tasks.
Additionally filter the list by time (from now) using the 1 Month, 3 Months and 1 Year filters.
View Notifications

If you are involved in a Task, you receive notifications in your Evolve Site when the task related activity is
performed.

These notifications can be accessed using the Notifications link in the main Site menu.

If new notifications exist, they are highlighted in the menu.

To view your notifications:

1. Click the Notifications menu.

-~
e
-
e

-~
e

-~
ke

-~
ke

Draft created for Manage Incidents

15 OCTOBER 2020

Draft created for Manage Incidents

15 OCTOBER 2020

Draft created for Manage Incidents

15 OCTOBER 2020

Draft created for Application
Registration and Validation

& SEFTEMBER 2020

Draft created for Application
Registration and Validation

& SEFTEMBER 2020

Click Older and Newer to move through the pages of notifications.
Click 1 Month, 3 Months, 1 Year or All to specify the duration of notifications displayed.

Delete a Notification
To delete a notification:

1. Click the Notifications menu.
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Draft created for Manage Incidents

15 OCTOBER 2020

Draft created for Manage Incidents

15 OCTOBER 2020

L\ Notifications

Draft created for Manage Incidents

15 OCTOBER 2020

Draft created for Application
Registration and Validation

& SEFTEMBER 2020

Draft created for Application
Registration and Validation

8 SEFTEMBER 2020

2. Use the pagination and date filtering controls to locate the notification you want to delete.

1 Month 3 Months 1 Year All Mark All As Read Clear All

15 October 2020

15 October 2020

15 October 2020

8 September 2020

8 September 2020

22 July 2020

20 July 2020

22202220

3. Click the trashcan icon at the top-right of the notification.
Transfer a Task
When a task is assigned to you as 'My Tasks', you can either assign it to yourself, or transfer it to another
user.
To transfer a task:

By default the '"My Tasks' page is active and displays the pending Tasks.

The Action/Transfer options will display.

Your Application Creation Request has been approuved

R2, 24 AUG 1:16PM

(@ Assign fo Me

p—

() Transfer Task

A list of users to whom the task could be potentially delegated is displayed.

1. In your Evolve site, click on the Task menu.
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. From the sub-menu, click See All Tasks to view all tasks.
. Select My Tasks, to view the tasks assigned to you.

. Select and open the task you wish to transfer.

. Select the Transfer Task option.

o OB~ W N

. Select the user that you wish to transfer the task to, and you will be presented with the option to add
a brief message explaining the reason for the transfer.
7. Click on Submit button.

QR Ciary Carter daleg atesd asoiha Chandrakumarar

All references to the task are removed from the original user's profile and they are no longer

associated with it.
The task is added to the transferred user's My Tasks ' /ist.

The task's history is now updated to display the task transfer.

Once the transfer request has been submitted, it cannot be undone.

The Task Delegation function is enabled by default. To switch off this feature, open Evolve
Designer and deselect the Enable Task Delegation option on the Model node.
Enable Task Delegation

i

With the function disabled, commit the changes to your Site.

See: Publish your Site

Request an Object be validated

If your Site is configured to support Object Validation requests, you can make a request on any page
showing a supported Object Type.

To request an object be validated:

1. On a supported Object Page, click the Create Task button.
2. In the Validators section, select all the people you want to validate the object.
Use the Filter box to type people's names to find them in the list.
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3. In the Message field, optionally enter a message explaining why you want the object validated, or
note any information that may be of use to the validators.
4. Click Submit.

Comment on a Task requiring action

If you have a pending task to action, you can add a comment to your response.

To add a comment to a response:
A Comment field will display.

1. Navigate to the relevant Task using the Tasks menu in your Evolve Site, or by following a link in the
Task email.

2. Click on Add Comment (located next to the Submitbutton).

This task will be removed from your task list and reassigned to the selected user
for them to action.

Bl il | Add Comment v

3. Enter your comments or any information for the requester.

This task will be removed from your task list and reassigned to the selected user
for them to action.

s Add Comment A

Enter comments...|

P

4. Click Submit. Your comments will be attached to your response.
Comments sent from the Assigner will be stored in the Task's history and are only visible to the

original Requester and associated Assignees.
Change Calendar Due Date

If you have created a task that requires actioning, the Server Configuration automatically sets its Due Date

Interval to three days. This date can be changed using the Date Picker.

To customize a task's due date:

1. When creating a Task Request, click on the Change Due Date button (located next to
the Submit button).

2. A date field will display.

3. Click on the field or calendar icon and the Date Picker will display enabling you to select a custom
date from the calendar.

4. Review your change, and then click on Submit.

View Object Validation Status
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If an Object has a pending validation request, it is possible to view the status of this request on its Object
Page.
To view the status of an Object's validation requests:

1. In your Evolve site, open up the desired Object Page.

The status message will display at the top of the Page sub-menu.
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Follow an Object

Keep up to date with any workflow-related activity by following objects in your Site.

You can Follow any object that is governed by any of the available workflows. Following means, you

will receive notifications for any workflow activity related to the object.

If there is new workflow activity for any object you have followed, the Favorites link in the Site menu

highlights them, as well as the item itself on your home page.

To follow an object:

1. Navigate to an Object Page displaying the object you want to follow.
2. Favorite the object by clicking the Favorite button (the heart icon).
Favoriting the object adds it to your home page and Favorites menu.

L6 & SrBtd

Basic Details ~

Process Flow

Properties

Hierarchy

Business Ecosystem

[ MyMenu
3. On your home page, Iocéte the 6bject.
4. Click the Follow icon in the bottom right of item.

The icon changes color from gray to orange showing that it is now being followed.
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Social Interaction Features

Social Interaction Features Explained

There are several social interaction features available in Evolve Sites which encourage your users to
collaborate and share information.

Comments

The Comments feature is added automatically to every Object Page in a Dynamic Site. It allows up to two-

levels of comments by users discussing the data.

Ratings

Ratings are available on all pages by default and enable users to rate any page on a scale of one to five.
Favorites

Users can make any page they visit a Favorite by clicking the Add to Favorites icon which is displayed
on all Object Pages by default.

Users can view links to their Favorites directly on the Home page, or by using the Favorites link that

appears when you click the user picture in the top-right of the interface.

If there are new comments or discussions added to a page you have made a Favorite, then a highlight is

displayed next to the Favorites menu link.

Share

The Share button is displayed on all Index and Object Pages by default. When a user clicks the Share
button, a pop-out window allows them to share the page with another user by email, or - if Workflow is

enabled - share the page with a Role.

If the user chooses Share by email, they can optionally enter a Subject and Message, before a New Email
window is opened from the Email client installed on the local machine, containing a link to the page being

viewed.

In deployments with Workflow enabled, if the user chooses Share with roles, they are prompted to select a
Role to share the page with, and that starts a workflow process which means all members of the Role are

assigned Tasks to review the page, and must confirm that they have done so.

Disabling Social Features

Social features can be disabled on the Model node in Evolve Designer.
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Questionnaires

Questionnaires Explained

Questionnaires enable you to get feedback and opinion from your users. In Evolve you can create simple
questionnaires that gather users' answers, or you can weight questions and answers to determine business
values of responses.

There are two types of questionnaire available in Evolve:

1. Standalone questionnaires that gather the answers each user provides
2. Object questionnaires that are displayed as a Page View on all Object Pages for a specified Object

Type, such as Application, and can aggregate the responses from users and work out a Business

Value.

Whether a questionnaire is standalone or tied to an object is a simple setting in the questionnaire itself
which can be edited after it is created - so the process for creating a questionnaire is the same for both
types.

Object questionnaires require a specific property to be created on the Object Type itself to store
the aggregated Business Value against the object in question.

This should be a Decimal Number property.

What do you want to do?

Create a questionnaire
Edit a questionnaire
Delete a questionnaire

View questionnaire responses

erwin Evolve — User Help Guide 308
Questionnaires



Question Weights and Values

Using weights and values to determine an overall Business Value for an object is only really
applicable to Single or Multiple choice questions.

Object questionnaires allow you to gather information from your users about individual objects, such as an

application.

Evolve allows you to weight each question, and put value scores against the possible answers. When users
complete the questionnaire, Evolve works out a Business Value score for the object which is based on the

values assigned to the answers they provided, measured against the question weighting.

The Business Value is aggregated across all responses and is stored as a property of the object itself, for

example you could call it 'User Assessment Score' so you can display is on your Object Page.

As a best practice, we recommend aiming to capture a Business Value of between 0 and 100 - so you can

represent the value as a gauge on your Object Page.

Each question in the questionnaire can be given a weight of 0.0 to 1.0. The total of which must equal 1.0 in
order for it to work. In addition, each answer to each question is given a score — according to your scale. If

we are following the best practice guideline, this again would be between 0 and 100.

The formula for the Business Value is quite simple. The score for a given questionnaire response is

(Question Weight * Answer Value)+(Question Weight * Answer Value) + ...

Example
In this example we are using a questionnaire to ask users for their assessment of an application.

The application object has a numeric property called 'User Assessment Score' which will be used to store

the Business Value.

In the example, let's assume that the questionnaire has three questions and each question has five possible

responses.

Following the best practice of aiming to create a score of 0 to 100, and remembering we need to make the
combined weights add up to 1.0, | might set the weighting for Question 1 at .5, Question 2 at .3, and
Question 3 at .2.

This means | judge that Question 1 should have more impact on the result than Questions 2 and 3.

Each question has the same possible answers, we're asking users how they rate the application, so the
answers to all the questions are Very Poor (0), Below Average (25), Average (50), Above Average (75) and

Superior (100). Following our best practice, they can only have a maximum value of 100.
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Without weighting, or with equal weighting, scores of 100 for Question 1, 50 for Question 2, and 0 for
Question 3 would average out to 50 without weighting or with equal weighting. But with our weighting of .5,

.3 and .2, the weighted average score is 65 — a higher score because of the weighting.
The score is calculated using the formula (.5 * 100) + (.3 * 50) + (.2 * 0) = 65.

To determine the total score for that application, Evolve tracks the number of questionnaire responses for
that application and comes up with a straight average score of all user responses. So if only one other
person filled out the survey in our example and their weighted score was 75, the average score would be 70
((65+75)/2=70).
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Create a Questionnaire

The only way you can create a questionnaire is by using the Create Questionnaire built-

in administration page on your live Evolve Site.

To create a new questionnaire:
1. On your Evolve Site, follow the menu link to the Create a Questionnaire built-in administration page.
A new questionnaire is created.

2. Enter a Title for your questionnaire.
3. If you want to make this an Object Questionnaire - to link it to a specific Object Type - enter the

following:

o Use Property To Update to enter the scriptname of the Object Type you want to link to,
followed by the scriptname of the Property Type you will use to store the Business Value,

separated by a colon.
For example: ‘application:businessvalue’

o Use Cw Questionnaire Object Type Scriptname to enter the scriptname of the Object Type

you are linking to

This should be the same as the first part of the Property To Update value - for example:
application’

4. Add your questions
There are three types of question you can add, and you can add as many as you like.

o Use a single choice question to show one or more possible answers, but only allow the user

to select one.

o Use a multiple-choice question to show one or more possible answers and allow users to

choose more than one answer.

o Use a text question when you want the user to enter some text as the answer, such as a

comment or more qualitative answer.
How to add a single choice or multiple-choice question
i. Click the Add single choice or Add multiple choice button
ii. Enter a Question Title

iii. Enter a Question Weight - see Question Weights and Values
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iv. Click Add an answer

V. Enter the answer
vi. If you entered a Question Weight, enter a Value for the answer by editing the zero to the
right

How to add a text question
i. Click the Add text button
ii. Enter a Question Title

iii. Enter a Question Weight - see Question Weights and Values

iv. Click Add an answer

V. Enter any text in the answer - you must enter some text here, any text will do

vi. If you entered a Question Weight, enter a Value for the answer by editing the zero to the
right

5. Click the Save icon in the top-right of the page to Save your questionnaire.

Once saved, you can edit your questionnaire using the built-in Questionnaire Index Page.

If the Cw Questionnaire Object Type Scriptname value is changed when creating or editing a
questionnaire then you must Save & Deploy the Site.
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View Questionnaire Results

How you view questionnaire results depends on whether it is an Object Page questionnaire or a standalone

guestionnaire.

View the results of a standalone questionnaire

To view the results of a standalone questionnaire:

1. On your Evolve Site, follow the menu link to the built-in 'Questionnaires' Index Page
2. Select the questionnaire you want to view
3. Click the Results sub-menu item to view the results

The page displays a pie chart for each question, showing how many users chose each answer.
View the results of an Object Page questionnaire

When you view the results of an Object Page questionnaire, the results you see are for a specific object
instance.

If you want to view the Business Value for the object, you must configure the Object Page to display the
Business Value property.
To view the results of an Object Page questionnaire:

1. On your Evolve Site, browse to the object you want to view the questionnaire results for
2. Click the Questionnaire link in the page menu

3. Click the Results sub-menu item to view the results

The page displays a pie chart for each question, showing how many users chose each answer.
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Edit a Questionnaire

To edit an existing questionnaire:

1. On your Evolve Site, follow the menu link to the built-in 'Questionnaires' Index Page
2. Select the questionnaire you want to edit

3. Click the Edit button in the top-right of the page

4. Edit any of the questionnaire's details, questions and answers

5. Click the Save button to save your changes.
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Delete a Questionnaire

To delete an existing questionnaire:

1. On your Evolve Site, follow the menu link to the built-in 'Questionnaires' Index Page
2. Select the questionnaire you want to delete

3. Click the Edit button in the top-right of the page

4. Click the Delete button in the top-right of the page

The questionnaire is deleted.
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Reference

Site Configuration Reference

This page lists and explains all the configuration settings available for Evolve Sites.

Server-Level Settings

See the Server Configuration settings

Server

Setting Description
Specify the name of your IS Site as it appears in the URL, such as http://<server-
name>/<evolve-11S-site-name>/

Evolve IIS Site

Name We recommend you leave the IIS Site Name. If you do change it, it must be lower case
with no spaces, and you must make sure that the MVC Folder still points to
Casewise/Evolve/Site - or wherever your Evolve is installed.
Specify the path to your Evolve Site directory.

Evolve Site

Folder You can usually leave this as the default, unless you have installed to a different
directory.
Specify the path to your Evolve Data directory where your local resources will be

Evolve Data stored.

Folder You can usually leave this as the default, unless you have installed to a different
directory.

Server Choose the language of the top-level Evolve Site, including the Model Selector page, as

Language well as the login screen.

Server Theme

Choose the theme of the top-level Evolve Site, including the Model Selector page, as

well as the login screen.

IS Application
Path

Specify the path to your IS application.

You can usually leave this as the default.
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CW Database

Select the CW repository your Evolve deployment will use.

Evolve CM User
Name

Enter the Username of a CW Suite User with System Manager rights that can be used

to log on to the CW repository so the Evolve Site can access the Model data.

You could create a new user dedicated to Evolve use for this purpose.

Evolve CM User

Enter the password for the above user. Ensure you Encrypt the password after

Password entering it.

Javascript o ) ) _

Mod This is an advanced setting which can only be changed in developer debug mode.
ode

IIS User Name

Specify the name of a local user on the web server machine which has Administrator

rights on the machine.

This user is required for the Application Pool to run.

IIS User's
Password

Enter the password for the above user. Ensure you Encrypt the password after

entering it.

Authentication

Authentication
Mode

Choose how you want Users to be logged on to Evolve:
Use CorporateModelerAuthentication to only allow existing CW Users to sign in
Use ActiveDirectoryAuthentication to enable Active Directory authentication

For a basic site to start with, we recommend you use

CorporateModelerAuthentication.

Enable Automatic
Logon

If you choose ActiveDirectoryAuthentication, select Enable Windows Authentication
to ensure Evolve users are automatically logged in to Evolve when they access the
Site.

Domain Short

If CW Suite is set to use login via 'any valid Windows user and domain' (option 3),
use this setting to enter the short name of your domain. This is referenced before

(Active Directory)

Name "¥¥' when used as shortdomainname¥¥username. If you do not use login option 3,
leave this setting blank.

Use SSL

Connection Tick this box if you need to connect to Active Directory using LDAP SSL.
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AD Connection
Path

If you choose ActiveDirectoryAuthentication, use this setting to specify the path

Evolve can use to connect to your Active Directory server.
To do this:

Right-click onto the server/computer and go into Properties. The domain name

should be visible at the bottom.

For example, if your domain is '"MyDomain.local' the connection path would be:
LDAP://mydomain.local/DC=mydomain,DC=local

Note: for every parameter in the domain, you need to add a “DC=".

If you require a specific port for your Active Directory server, enter it here.

Selection Mode

AD Port
You can usually leave this as the default.
Leave as the default unless you have special Active Directory requirements.
Use GetAllGroupsForUser if your Active Directory has multiple domains and nested
groups. The method causes Evolve to fetch the user and then try to fetch all the
AD Group groups where this user belongs to.
Membership Use GetGroupMembers (default) if your Active Directory operates on a single

domain. Supports nested groups.

Use GetGroupDirectoryServices if your Active Directory has multiple domains and
nested groups, as in option 1 (GetAllGroupsForUser), but you want to use LDAP-

oriented protocol codes.

AD Connection

Username

This field is used to specify the property type on Active Directory used for the

connection.

This is an advanced setting that should only be used by someone who is an expertin

Active Directory.

Connect to Active
Directory Forest

This option is selected to browse and find users across the entire Active Directory

Forest.

If left unchecked, browsing is limited to the defined LDAP:// path, and will not

extend to all Forest domains.

Workflow

Enable Workflow

Select the check box to enable Workflow on your Evolve server.
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Workflow Due
Date Interval

Set the number of days you want to allow for task completion. Evolve uses this
interval to highlight tasks that are due for completion today, or alert you to ones that

are overdue.

Send Email
Alerts

Select the check box if you want alerts to be sent to users by Email. If you choose not

to use Email, there are notifications in the Evolve Site itself.

SMTP Server

If you choose to send Email alerts for Workflow, use this setting to enter the address
of your SMTP Server.

SMTP Port If your SMTP Server requires a port setting, enter it here.

Email Display Enter the name you would like to be displayed in the No-Reply email field for

Name Workflow emails.

No-Reply Email ] ) ]
Enter the No-Reply Email address you would like to use for Workflow emails.

Address

Site-Level Settings

Site node settings

Setting

Description

Node Name

Non-editable.

This is the name of the Site node.

Link Extension
MIME Type

Advanced only.

This is site page extension. You should leave this set to 'html' unless you have a

very specific reason not to.

Site Language

Choose the language of the Site if you want to override the global Evolve setting.

Number Separator

Select 'None' (default), 'Comma' or 'Space' to specify which number separator is

used when displaying numbers on your Evolve Site.

For example:
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None - 1000 or 1000000
Comma - 1,000 or 1,000,000
Space - 1 000 or 1 000 000

JSON Extension

Advanced only.

This is JSON file extension. You should leave this set to 'json' unless you have a

very specific reason not to.

Less Theme

Choose the theme of the Site if you want to override the global Evolve setting.

Enable Cloud APIs

Advanced only.

Use this setting to enable the Cloud APls.

Export Diagram

Static Sites only.

Use this option if you are publishing your Site in Static mode and you are
showing Diagrams created in CW Modeler using the CW Modeler

Diagram behavior.

Images
You can leave this option unselected if you are not displaying diagrams or are
only using the Vector (HTML5 ) behavior to prevent images of diagrams being
generated when you publish your Site - a process which can take some time.
Display . .
. When Set, ensures all dates and times are displayed locally for the end user.
Date/Time In

Local Time Zone

Otherwise, uses the server date and time.

Restrict User
Profile Access

When Set, prevents users from reading other user's profiles.

Remember
Diagram Zoom
Level

When Set, allows the end-user's browser to remember the zoom position for
diagrams they have viewed. This makes navigating back and forth between
diagrams, much easier. This can be disabled, if the site design is such that it is

preferred to default to showing the full diagram, each time a page is visited.
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Enable Smart
Breadcrumbs

When Set, the smart breadcrumb trail is shown for end-users, for this site.

Otherwise the display is, as it was pre-version 2018 (no breadcrumb trail).

Node UUID

Non-editable. This is the unique identifier for the Site node.

Deployment node settings

Setting Description
Model o ] ) ]
. Do not change this field. This setting represents the Scriptname of your Model.
Filename
Specify the name of this Site as it appears in the URL, such as:
http://<server-name>/<evolve-IIS-site-name>/[sites|statics]/<site-url-name>/
Site URL
Ensure the name is lower case, and has no spaces or special characters.
Name
To change the Site URL Name for an existing Site, see: Change the URL name of
your Site.
Site Display ) o ) )
N Enter the name of your Site. This is only displayed on the top-level Evolve Sites page.
ame
Deploy o : : : :
. This option is used if you have a custom site configuration.
Custom Site
Usage:
Only used in Dynamic sites if the Evolve Authentication Method is set to Active
Directory or SAML2.
The AD Mapping is used to map first time users to Evolve. This allows your
organization to select a Group, Role and License combination for users to be given,
AD Mapping the first time they connect to Evolve.

When they connect the product will check the group/s they are in, and create a user
in the administration model with the permissions defined. All subsequent access

rights changes can be managed from the product.

If a user is no longer in the necessary Active Directory group, or is without a required

SAML?2 claim, then they will be prevented access to Evolve.
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The Active Directory/SAML2 mapping gria

By default you will be provided 3 entries which correspond to the 3 license types your

users can be offered. Any entry without an AD Group name, is effectively not mapped.

For each row you wish to map, specify the name of the Active Directory group or the

SAML?2 Claim you want to use for that type of Evolve licensed users.

Members of multiple AD Groups will have their rights aggregated, such that they have
the super set of permissions acquired by the groups. The license they are provided
will be the highest level - e.g. Diagrammer trumps Contributor, which trumps Social

user.

Rows can be added to the bottom of the grid, to enable the addition of further groups

or claims.

AD Group

Specify the name of the Active Directory group or the SAML2 claim you want to use
for this row. This is the group the user will need to be a member of, or the claim the

user will need to have, in order to receive these rights.

A special built-in group called "Anonymous" can be used, to describe anyone who
logs in, without access to the other defined groups. Since version 2018, this
"Anonymous" group can have CW Group, CW User Type and CW Role defined, such
that they can have a default access. This may be desired if, for example, all
employees have read access, under a basic Role, but are not associated to any of the
EA/BP groups. Then, for example, a select few have Contributor access through a

specific Group.
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E.g.

Model FileMame

[EASAMP14
Site URL Name |easamp14
Site Display Name |EA Foundation - Sample Maodel
Deploy Custom Site Default
AD Mapping AD Group CW UserType  CW Group
Team-One Contributor |~
General Social e
4 Process-Team  |Diagrammer |+
Anonymous Static e
MNone “
1] et
Use Static Authentication

CW User Type

Specify the type of user license that will be provided for this group of users. The

highest level of license will be awarded if the user is in multiple groups.

CW Group

Specify the access rights group you wish the users of this group to belong to. This can
control the sites/models the user has access too, and also the object
types/categories available to them. CW Groups are managed in "Access Rights

Manager" or "Model Explorer"

CW Role

Specify the default Role that will be provided for this group of users. For details on

the use of roles in Evolve see here.

Use Static
Authenticatio
n

When checked this option will use the AD Mappings (or the CW_User Type) to enable
access to the static generated site. Users without at least 'Static' permissions, will be

denied access to the site.
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Display
Model in
Evolve

Use this option to specify if this Model Site is available or disabled in Evolve.
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Validate Repository for Global Search

Introduction

The Validate Repository tool has existed as part of erwin Evolve Suite for some time and helps in

maintaining the integrity of the erwin Evolve Suite database.

With the Evolve Web Platform also using this database, the Validate Repository tool has been extended in
this release (2020.2.1) to allow validation of the Global Search feature that exists in the web platform. This
validation of the global search ensures that the audit history and the global search history are kept fully

synchronized.

Running the Validation

To run the global search validation, additional options have been added to the command line. The Validate

Repository checks whether the erwin Web Modeler’s global search is installed before running these options.

If erwin Evolve Web Platform is not installed, the Validate Repository feature runs without Global Ssearch
checks. You will receive a warning if erwin Evolve Web Platform is not installed. However, this does not

affect any of the other tests.

Validate Repository cannot run the global search checks.
The Evolve search service is neither installed or running

Global Search validation is not part of the default checks. To run it, run the Validate Repository tool with the

“-gsmodelname:<modelname> option in following command format:
ValidateRepository.exe -username:admin -applyfixes:all -gsmodelname:<modelname>

For example: ValidateRepository.exe -username:admin -applyfixes:all -gsmodelname:EASAMP14

To run global search checks alone, run the Validate Reposiroty tool with the “-testonly” option in the

following format:
ValidateRepository.exe -username:admin -testonly:globalsearch -gsmodelname:<modelname>

For example: If you want to run the test on the erwin Evolve Suite’s default connection to test the EA

Sample Model, the following command in a command prompt
ValidateRepository.exe -username:admin -testonly:globalsearch -gsmodelname:EASAMP14.

If the checks do not find any changes, the result of the command is as shown:
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Ghost data in Global Search DB:
No data found.

Un-Synced data in Evolve DB:
No data found.

If the checks find any missing applications, the results of the command is as shown:

Ghost data in Global Search DB:
No data found.

Un-Synced data in Evolve DB:

In case where the command finds missing applications or out of sync data, you can run the same command

with “-applyfixes” instead of “-testonly”. You will be asked if you wish to correct the out of sync data.

Choosing yes syncs the data that was out of sync earlier and the results show that there is no out of sync
data.

You can run these tests at any time.

Verify and Fix Issues with the Repository

When upgrading from older versions of erwin Evolve Suit, or when the application behaves inconsistently, it
is advised to check that the repository is in a consistent state. This is done through the following steps:
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1. Ensure that you are an Administrator of the CW repository and have db_owner or administrator
permissions on the SQL/Oracle database.

2. Press Windows + R keys and type CMD. Then, click OK.

3. To navigate to the erwin Evolve Suite installation directory, in the Command Prompt run the following

commands:

1. C:
2. cd "program files (x86)¥casewise¥cm10¥bin"
4. Navigate to the CWSuite installation directory, usually:
C:¥Program Files (x86)¥Casewise¥CM10¥bin
Use the commands:
Type: C:
Type: cd "program files (x86)¥casewise¥cm10¥bin"
5. Run the Validate tool to check for errors:
Type: validaterepository -username: <your-admin-username> -password: <your-password> -
testonly
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You should be presented with something similar to the following response:

Program Files Casewise\CM18\binsvalida epository -username::

Other ValidateRepository commands can now be run from this point
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Validate Repository for Global Search
Re-indexing

Introduction

The Validate Repository tool has existed as part of erwin Evolve Suite for some time and helps in

maintaining the integrity of the erwin Evolve Suite database.

With the erwin Evolve Web Platform also using this database, Validate Repository tool has been extended in
this release (2022.0.0) to allow validation of the Global Search Re-indexing feature that exists in the erwin
Evolve Web Platform. This validation of the global search re-index helps delete the complete data from the
global search and re-index the entire erwin Evolve Suite database from scratch into a global search

database.

Running the Validation

To run the global search re-index validation, additional options have been added to the command line. The
Validate repository will check whether the erwin Evolve web platform’s global search re-indexing is installed

before running these options.
To run global search re-indexing:

1. Ensure that you are an Administrator of the CW repository and have db_owner or administrator
permissions on the SQL/Oracle database.

2. Press Windows + R keys and type CMD. Then, click OK.

3. Run the Validate Repository tool with the following command:
C:¥Program Files (x86)¥erwin¥CM10¥bin>ValidateRepository.exe -username:admin -
applyfixes:gsreindex
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The following screen appears.
BN CA\Windows\System32\cmd.exe *

NOTE:To perform the Global Search Re-index operation, the following services need to be stopped in Windows Services.
1. S Database Service
CWS Search Serwvic
The operation will DELETE ALL global search indexes for all models and recreate them. This will NOT impact audit history.
the operation s should be restarted.

4. Open Services.
5. Stop CWS Database Service and CWS Search Service.

Services - [m] X
File Action View Help
ez | FHEGEH

Services (Local)

Po|oanmn

Services (Local)

CWS Database Service Mame ° Description Status Startup Type Log *
i S5 COM+ Event System Supports 5y.. Running  Automatic Loci
%&T::hs:?::ice S\;‘;COM+ Systemn Application Manages th... Manual Loci
5k Connected Devices Platfor..  This service .. Running  Automatic (..  Loc
Lk Connected Devices Platfor...  This userser.. Running  Automatic Loci
Descriptinn: X Lk Connected User Experience.. The Connec.. Running  Automatic Loci
Casewise Database Senvice £ ConsentUX_43900 Allows Con... Manual Loci
% Contact Data_49%00 Indexes con...  Running  Manual Loc
‘L CoreMessaging Manages co... Running  Automatic Loci
&k Credential Manager Provides se..  Running  Manual Loci
&} CredentialEnrollmentMana..,  Credential E... Manual Loci
Sk Cryptographic Services Provides thr.. Running  Automatic Net

Automatic

Casewise Se..  Running  Automatic Aen

Casewise Running

25k CWS.DiagrammerService Service that ... Running  Automatic Loci
“EL CWS.elasticsearch-service-x.. CWS.elastic... Manual Loci
‘) Data Sharing Service Provides da...  Running  Manual (Trig.. Loc
£k Data Usage Network da...  Running  Automatic Loci
‘5L DCOM Server Process Laun... The DCOML.. Running  Automatic Loci
&) Delivery Optimization Performs co.. Running  Automatic (.. MNeb
&) Device Association Service Enables pair.. Running  Manual (Trig.. Loci
£ Device Install Service Enables a c... Manual (Trig...  Loci v
< >

\ Extended /(Standard/

6. Return to the already open Command Prompt and enter ‘Y’.

The following output appears.

Global Search Re-indexing is done.
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Global Search

Enabling Global Search

1. In CWSuite, ensure that the model’s auditing option is enabled. See image, on the right to find the
location of this setting.

If you do not see the option to 'Enable Object Revision History'in the Model Properties dialog.
Ensure you have turned auditing on in the Repository. See details here.

2. Before deploying a Dynamic Site from Evolve Designer, ensure Enable Global Search is selected by
navigating to Site -> Deployments -> [DeploymentMachine) -> Site Name and checking
the Enable Global Search checkbox.

3. Also check the location of the temporary search index delta files. This folder will buffer changes from
the database, to the search service. It is entirely temporary and should the content be erased, it will
automatically be recreated.

This directory should be server-local (a suitable location is selected by default, however if you need
more disc space, this can be placed anywhere else on the server).

If this server is Primary, the search content will appear at this location first, before being copied to a
"Shared Location", for use by the slave servers.

If this server is a Slave (not Primary), then this location will not be used, as the data is sourced from
the "Shared Location". Slave servers must have the "Shared Location" set to the same folder as the

Primary Server's "Shared Folder"
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New settings in Evolve 2018.1.0 and above. These control the temporary file location for search
index change.

Searching for Objects

Finding objects is as simple as entering text into the search field and clicking the search icon or pressing
enter.

Filtering Search Results

Filtering by Object Type

Search results can be filtered to only show objects that are a specific object type.

Filtering by Category

Search results can be filtered to only show objects that fall under a specific category.

Restricting Search
By default Global Searches are performed on object Names and Descriptions. If this is yielding too many

unwanted results you can specify to search based on object names or descriptions separately.
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Related Topics

Advanced Search

Using Favorites with Filters
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Global Search - Advanced Filters 1201s.0.2+]

Before you start
e Ensure Global Search is enabled.
Accessing the Advanced Filters

Access the search window by typing your search text in the left hand pane and clicking the search icon or
pressing enter.

This will give an initial result set using the current filter settings. Clicking the down twisty 'v' will show
the standard filters.

Just above the apply button there is an Advanced twisty 'v', this will give access to the advanced filters
section.

In order to add an advanced filter you must first select one or more object types.

b # > Organization Location List o
b ' Organization Lecation List
X
Search Results nameonyy & ¢ Search Results wameonly & =
Found 12 results for “app’ (0.01 seconds) S
Found 12 results for “app” (0.01 seconds)
Filter Results: * Filter Results: *
Object Type Object Ty
ject Type
All Object Types All Object Ty
All Object Types
Category Search In Category SearchIn
All Categories ¥ || Name Onk v = =
0 u Advanced v All Categories v || Name Only M Advanced A

Apply JEER

Youmust select an object type before you can set advanced filters

m Reset

SRV_APP_VM_UKO1

Technology (Application Server)

2 Jan 2019 - Deseription of the technology SRV_APP_VM_UKDT

Application Document Technology (Application Server)

Document (IT Document) 2 Jan 2019 - Description of the technology

2Jan 2019 - Document designed and generated ly with Casewise C

Aoolication Document

Fig. Advanced button Fig. Object Type Selection

Using the Advanced Filters

e Click the "Add" button to add a filter.
e Drop down a property (note: if multiple object types are selected, only the intersected set of
properties will be available).

Choose your condition from the second drop-down (e.g. Contains).

Type the text you wish to use with the condition.

Press 'Apply' to apply a filter and 'Reset’ to remove the filters.

Note that all filters are "AND"ed together, with the standard filter content.
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@ Q Application Portfolio Manager Location List

Search Results Filtered, advanced filter < X

Found 1 results for “app” (0.005 seconds)

Filter Results: *

Object Type
Application X
Category Search In
All Categories v | | Name Only v Advanced A

Advanced Filters (AND):

Criticality v | | Contains v |3

Add

Application Portfolio Manager
Application (Software)

28 Feb 2019 - Solution that managed the application portfolio of the enterprise abracadabra

Fig. Advanced Filters

Related Topics

Global Search

Using Favorites with Filters
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Global Search - Favorite Search Filters r201s.0.2+]

Before you start
e Ensure Global Search is enabled.
Using Favorite Filters
When viewing the filter options you will see a star symbol. Pressing this star will open the favorites options.
By default you will see a place to name a favorite, and the 'Save' button.

e Naming and saving a favorite will store it in your favorites.

It will appear in a list on the same page.
e Pressing a favorite name from the list, will switch to this saved filter.
e Pressing the X to the right of the favorite, will delete this favorite.

@ Q Application Portfolio Manager Location List

Search Results critical Applications

Found 1 results for "app” (0.005 seconds)

Filter Results:

iii
*

New Favorite:

|critical Applications| |m

Favorites: Save

Critical Applications x

o B

Application Portfolio Manager
Application (Software)

28 Feb 2019 - Solution that managed the application portfolio of the enterprise abracadabra

Fig. Your favorites, click one to use this filter
Viewing Preset Filters

e To the left of the favorites star icon is the presets icon. Pressing this icon, will show the preset filters.

e Preset filters are like favorites, but are available to all users with a given Role.
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e Preset filters are also available in Static evolve sites, where the Roles of the user generating the
Static site, will control which filters are available to ALL users.
Note: Static sites themselves do not have Roles, hence the preset's availability.

e Preset filters can only be added by an Administrator, and assigned to Roles

Search Resulis critical Applications < %

Found 1 results for "app” (0.033 seconds)

Filter Results: :
= % -

Presets:

Critical Applications

-

Application Portfolio Manager
Application (Software)
28 Feb 2019 - Solution that managed the application portfolio of the enterprise abracadabra

Fig. Choosing to view Preset Filters

Sharing Favorite filters as Presets (Administrator option only)

In order to configure Presets, it is necessary first to be an Administrator.

1. Create a filter in the usual way.
2. Make the filter a favorite.
3. From the 'Page Picker', choose the 'Filters' Page.
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[ # > PagePicker ADMIN v

O 0 TO O O 0 O

Application List Datafase List Diageam List Document List Entily & Atiributes Flow List
List

&I&o ‘%0 é0@0650@00

Governance Roles u

Indicator List Location List Orgarizations & Process List
Roles

Fig. Configure Preset Filters with this Page

# > MyMenu > Page Picker ADMIN w

CW GS Filter 5 Critical Applications False o Business Analyst Bz -

Filters

test test False SN

Fig. Select your favorite and assign it a Role

4. From the list of favorites displayed, choose the edit button
5. Search for a role and associate it to the favorite
6. Save the association.

7. This favorite will now display as a Preset, to all users who share this Role

Remove a Preset (Administrator option only)

In order to remove a Presets, it is necessary first to be an Administrator.

1. From the 'Page Picker', choose the 'Filters' Page.
2. Locate the Preset you wish to remove.
3. Disassociate the Roles from the Preset.

4. 1t will return to being a favorite and can be deleted in the same way as other favorites.

Related Topics

Global Search
Advanced Search
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File Structure

Overview of the folder structure of Evolve Web Platform

If you have configured your site to replicate content from one server to another, for example when

using a load balancer, you may need to adjust your ‘Copy’ scripts for 2020.0.2 onwards. See the

details below to determine what folders have moved.

Unlike many Windows applications, including 'Evolve Suite', 'Evolve Web Platform'is typically installed to the

root of your C: drive.

While most of the files that are installed are not intended for user serviceability, there are a few folders that

contain content, useful for administrators. Most significantly, folders containing customized content, search

indexes, and generated content. All of which may be replicated to other servers, when load balancing.

Up to and including Evolve Web Platform 2020.0.1 the folders followed this pattern:

Folder

Description

c:\erwin\evolve [or]
c:\casewise\evolve

Main installation folder

\CWSServices Global Search services

Global Search encrypted audit records, for indexing (and sharing to other
\CWSServices\Data .

servers in a load balanced group)
\Data\Common Shared web client content for all sites (javascript)

Specific content for the given dynamic site sitename
\Data\Sites\[sitename] This would include any temporarily generated content, such as gallery

content, images, user pictures, diagrams, hotspot maps etc.

\Data\Statics\[sitename]

Specific content for the given static site sitename
This would include all generated static site content.

The static content could also be used by a dynamic site, with static pages.

\Diagrammer

The new Web Modeler application service

\ElasticSearch

The elastic search runtimes to operate Global Search

\Elasticsearch\elasticsearch-
6.4.0\data\nodes

The elastic search database files. If upgrading within the same Major
release version, these files can be kept, to remove the need for a full
search re-index. In large installations this can save many hours of re-

indexing.
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Folder

Description

\JRE

The Java runtime to support ElasticSearch and other Java components

\node_modules

The node modules required to support Web Modeler

\Site\bin\sites The site configuration files that describe site settings
\Site\bin\webDesigner\custom The location for customization files for Evolve Web Platform

\Site\logs The Web Designer, Diagram Designer, and Live log files for the platform
NP The REST API that replaces Portal Web Services, and supports interaction

over a http interface

What has changed from 2020.0.2 onwards, is the location of the static generated content, and any data

related content for the dynamic site. The new structure is as follows:

Folder

Description

\Data\Sites\sitename]

Site structure and design for the given dynamic site sitename
This NO LONGER includes any site content / data.

\Data\Statics\[sitename]

Site structure and design for the given static site sitename
This NO LONGER includes any site content / data.
The generated JSON files are NOT put here.

\Data\Data\/sitename\live\

Content data for the site sitename
This includes images, gallery content, user pictures, temporary diagram images,

hotspot maps etc.

\Data\Data\/sitename\static\

Content data for the site sitename
This includes all generated static site content.

The static content could also be used by a dynamic site, with static pages.

Related Topics

Global Search

Customization Explained
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Required MIME Types

Your web server machine must be configured to understand some specific file formats used by Evolve.

The instructions below alter the settings for the Evolve application only. You can make these
settings at a higher level, such as the Default Web Site, that will then ensure they are available

to all applications below.

To specify the new MIME Types:

1. On the web server machine, run Internet Information Services (IIS) Manager

2. In 1IS Manager’s left-hand pane, select the node for the Evolve application
Ensure you have the central pane set to Features View, then double-click MIME Types in the /IS
section
The MIME Types settings are displayed

3. Check the list of extensions that are already configured and see if any of the following are missing:

o .eot
o .json
o .ttf

o .woff

4. For each extension that is not already configured, do the following:
i. Right-click in the central pane and select Add

ii. Enter the following details, depending on which you need to add

File name MIME Type
extension
application/octet-
.eot
stream
.json application/json
application/octet-
Atf PP
stream
.woff application/font-woff
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iii. Click OK

5. Close IS Manager.

Configuration and Administration

Server Configuration

Configure your Server

The instructions below explain how to configure your Evolve Server so that you can publish your sites on it.

This step must be performed after you have installed Evolve on the server machine, but before
you attempt to publish any sites.

To configure your Evolve server:

6. Run Evolve Designer.
7. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

De@®oe®

The Server Configuration dialog opens.

8. Configure the settings according to the table below:

Server

Setting Description
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Specify the name of your IS Site as it appears in the URL, such as http://<server-
name>/<evolve-11S-site-name>/

Evolve IIS Site

Name We recommend you leave the IIS Site Name. If you do change it, it must be lower case
with no spaces, and you must make sure that the MVC Folder still points to
Casewise/Evolve/Site - or wherever your Evolve is installed.
Specify the path to your Evolve Site directory.

Evolve Site

Folder You can usually leave this as the default, unless you have installed to a different
directory.
Specify the path to your Evolve Data directory where your local resources will be

Evolve Data stored.

Folder You can usually leave this as the default, unless you have installed to a different
directory.

Server Choose the language of the top-level Evolve Site, including the Model Selector page, as

Language well as the login screen.

Server Theme

Choose the theme of the top-level Evolve Site, including the Model Selector page, as

well as the login screen.

IS Application
Path

Specify the path to your IS application.

You can usually leave this as the default.

CW Database

Select the CW repository your Evolve deployment will use.

Evolve CM User
Name

Enter the Username of a CW Suite User with System Manager rights that can be used

to log on to the CW repository so the Evolve Site can access the Model data.

You could create a new user dedicated to Evolve use for this purpose.

Evolve CM User

Enter the password for the above user. Ensure you Encrypt the password after

Password entering it.

Javascript L . ) .

Mod This is an advanced setting which can only be changed in developer debug mode.
ode

IS User Name

Specify the name of a local user on the web server machine which has Administrator

rights on the machine.

This user is required for the Application Pool to run.
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NOTE: To prevent unwanted errors, the IS user must be different from the remote
desktop user.

IS User's Enter the password for the above user. Ensure you Encrypt the password after
Password entering it.

Authentication

Choose how you want Users to be logged on to Evolve:

Use CorporateModelerAuthentication to only allow existing CW Users to
sign in

Use ActiveDirectoryAuthentication to enable Active Directory

Authentication Mode authentication

Use SAML2 to enable a SAML2 authentication. Follow this guide to
complete the configuration of SAML2

For a basic site to start with, we recommend you use
CorporateModelerAuthentication.

If you choose ActiveDirectoryAuthentication, select Enable Windows
Enable Automatic Logon | Authentication to ensure Evolve users are automatically logged in to Evolve

when they access the Site.

If CW Suite is set to use login via 'any valid Windows user and domain'

. (option 3), use this setting to enter the short name of your domain. This is
Domain Short Name )
referenced before '"¥¥', when used as shortdomainname¥¥username. If you do

not use login option 3, leave this setting blank.

. Tick this box if dt t to Active Direct ing LDAPS. Not
Use SSL Connection ick this box if you need to connect to Active Directory using ote

. . the settings required in the AD Connection Path and AD Port, should match
(Active Directory)

this request.

If you choose ActiveDirectoryAuthentication, use this setting to specify the

path Evolve can use to connect to your Active Directory server.
To do this:

. Right-click onto the server/computer and go into Properties. The domain
AD Connection Path o
name should be visible at the bottom.

For example, if your domain is 'MyDomain.local' the connection path would
be: LDAP://mydomain.local/DC=mydomain,DC=local

Note: for every parameter in the domain, you need to add a “DC="
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Also, for SSL Active Directory, unsure the path begins:
LDAPS://

AD Port

If you require a specific port for your Active Directory server, enter it here.

You can usually leave this as the default. Unless you are using a SSL, in

which case the default port is: 636

AD Group Membership
Selection Mode

Leave as the default unless you have special Active Directory requirements.

Use GetAllGroupsForUser if your Active Directory has multiple domains and
nested groups. The method causes Evolve to fetch the user and then try to

fetch all the groups where this user belongs to.

Use GetGroupMembers (default) if your Active Directory operates on a
single domain. Supports nested groups.

Use GetGroupDirectoryServices if your Active Directory has multiple
domains and nested groups, as in option 1 (GetAllGroupsForUser), but you

want to use LDAP-oriented protocol codes.

AD
Connection Username

This field is used to specify the property type on Active Directory used for the

connection.

This is an advanced setting that should only be used by someone who is an

expert in Active Directory.

Connect to Active
Directory Forest

This option is selected to browse and find users across the entire Active

Directory Forest.

If left unchecked, browsing is limited to the defined LDAP:// path, and will

not extend to all Forest domains.

Domain Exclusion List

Connections will not be attempted for any domains in this list.

Workflow

Enable Workflow | Select the check box to enable Workflow on your Evolve server.

Workflow Due
Date Interval

Set the number of days you want to allow for task completion. Evolve uses this
interval to highlight tasks that are due for completion today, or alert you to ones that

are overdue.

Send Email Select the check box if you want alerts to be sent to users by Email. If you choose not

Alerts to use Email, there are notifications in the Evolve Site itself.
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SMTP Server

If you choose to send Email alerts for Workflow, use this setting to enter the address
of your SMTP Server.

SMTP Port If your SMTP Server requires a port setting, enter it here.

Email Display Enter the name you would like to be displayed in the No-Reply email field for

Name Workflow emails.

No-Reply Email . ) i
Enter the No-Reply Email address you would like to use for Workflow emails.

Address

9. Click Save to save your configuration.
10. Click Configure IIS.

The web server is configured and the top-level Evolve Site is created according to the settings you

specified

11. If running the Server Configuration tool for the first time, click Update Admin Model.

This adds new meta data to your CW user objects to store Evolve user details.

If you make any further changes to the server configuration in this dialog, you must Save again.

Authentication and SAML2

Configure SAML2 Authentication and SSO

SAML? is a commonly used, standardized approach of securing logon to web based systems, where the

authentication is delegated to another system or third party. The following section will describe both the

pre-requisites and the Evolve configuration required to enable SAML2 as your authentication provider. It is

largely assumed that you are knowledgeable about the configuration of your SAML2 authority.

For details on how SAML?2 is offered when Evolve is hosted and you wish to integrate your

corporate authentication with the platform, an overview document can be found here...

SAML?2 Configuration for Cloud Service Access (English) and

SAML2 Configuration for Cloud Service Access (French)

The instructions below explain how to configure your Evolve Server so that you can use SAML2 as an

authentication method to access your sites.
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Changes to these settings will require the re-publication of the site.

Pre-requisites for SAMLZ2 authentication:

Firstly it is a requirement to have a SAML2 authentication provider. This is the service that will provide both
authentication responses and offer users a means to logon. One common example is Microsoft Active

Directory, which can be configured natively, or through SAML2.
The authentication provider will be able to supply the following:

e Either a SAML2 metadata file, or a URL that links to a SAML?2 metadata file
e An EntitylD — this is the URL that points to the authentication provider (this may often be found in the
SAML2 metadata file)

The Evolve web site will need to be operated over a Secure HTTP protocol (HTTPS). This will mean you are

also in possession of:

e An SSL certificate to ensure both end-user clients and the authentication provider can trust Evolve.

Preparing the SSL certificate:

Since Evolve needs to be able to communicate securely with the SAML2 Auth provider, it will need to use an
SSL certificate. The certificate which is validating the Evolve site (SSL domain certificate) can be used,
however it is necessary to change the password on the certificate to make is usable by Evolve. In order to

achieve this:

1. If you have not done so already, import the domain SSL certificate into Windows

2. Export the certificate to a new *.PFX file

3. Use the following password to secure the certificate :
LQMrnsuLpVAZ9ePd
Note that it is not currently possible to choose an alternative password. However the certificate is
stored securely on your server, and is not made available externally, so this should not pose a
concern.

4. Save the filename: CasewiseAuth.pfx
in the folder: c:¥Casewise¥Evolve¥Site¥bin
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To configure SAMLZ2 on your Evolve server:

1. Run Evolve Designer.

Ste » bin »

2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

COO®

The Server Configuration dialog opens.

3. Configure the settings according to the table below:

Authentication
Authentication Choose how you want Users to be logged on to Evolve:
Mode Use Saml2 to make Evolve expect a SAML2 authentication
Enable

Automatic Logon

Leave un-checked

Domain Short
Name

Leave this setting blank.

erwin Evolve — User Help Guide

Configuration and Administration



https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/configure/Server%20Config%20Button.png

Use SSL
Connection
(Active
Directory)

Leave un-checked.

AD Connection
Path

Leave this setting blank.

AD Port Leave this setting blank.
AD Group
Membership Leave this setting blank.

Selection Mode

AD
Connection User
name

Leave this setting blank.

Connect to
Active Directory
Forest

Leave this setting blank.

Domain
Exclusion List

Leave this setting blank.

SAML2 Entity ID

This is often found in the metadata.xml file, and consists of the URL that Evolve needs to
check authentication.

SAML2 Meta Url

This could be a public URL, a private URL or a local file path. The meta data consists of an
XML file that contains the settings for the SAML2 configuration.

e.g. configured for a local file:

~/IDP-QA-Metadata.xml

where the metadata file should be stored in the Site folder
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Enter the URL to the Evolve home page - e.g.

Evolve's Url )
https://domain.company.com/evolve/

4. Click Save to save your configuration.

If you make any further changes to the server configuration in this dialog, you must Save again.

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the
permissions based on Claims configured on the Authentication Server, and their mapping to groups on the

Evolve server.

To configure Groups and Roles on your Evolve server:

Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a
look at this to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level

Settings" - "Deployment Node Settings".
Further instructions for specific Identity Providers:

See here for help on Integrating with Okta Identity Provider
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Configuring SAML2 Authentication and SSO with Google
Suite

If your organization uses Google (gsuite.google.com) as an ldentity provider, these instructions will help you

to configure Single Sign On, between Evolve and your IdP.

Create new Application in G Suite

1. Go to the homepage of your G Suite Admin Console

Choose Apps (top righticon in below screenshot)

= Google Admin Q,  Search for users, groups, and settings (.g. add user)

Admin console

Activities in last 7 days

wl - E l *
0 Active users A
i | ]

® 0 Files added N/A

Dashboard Users. Groups Device management Apps.
See relevant insights Add, rename, and Create groups and Secure corporate data Manage apps and their ./ VIEW REPORTS
about your domain manage users mailing lists on devices settings

Google admin on mobile

+ / : e Get the Admin console app for Android and
108 devices.

Security Reports Billing Company profile Admin roles Tools
Manage security Track usage of services View charges and Update information Add rew admins
features manage icenses about your company Get help from a partner

G Sulte Marketplace
G Sulte Status Dashboard
The G Sulte Referral Program

. Data Export
- Transfer 100l for unmanaged users
-

Domains Rules Data migration Support Common tasks
Add domains or domain Manage rules for your Import ema, calendar Telk with our support p R Lo
aliases domain and contacts

Review email quota
Add your logo

Recommended apps

MORE CONTROLS

2. Choose SAML Apps (top righticon in below screenshot)

= Google Admin Q,  search for users, groups, and settings (e.g. add user)
Apps H
APPS SETTINGS

Marketplace settings n G r 0
47

13 0 0

G Suite Additional Google services Marketplace apps SAML apps
Grmail, Calendar, Drive & more Blogging, photos, video, social tools More about Marketplace apps Manage S50 and User Provisioning
and more
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3. Press the Yellow (+) button at the bottom right of the window (see below)

This will create a new App in your G Suite.

= Goqgle Admin Q,  Search for users, groups, and settings (e.g. add user)
Apos » SAMIL Apps =
Sarvices Siwius - Cartificate

Mo services/Apps configured for SAML.

Add o servica' App to your domain
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4. Choose "SETUP MY OWN CUSTOM APP" at the bottom of the list (see below)

S1ep x

Enable SS0 for SAML Application

Sedect an services App for which you want to setup 550

Sarvices Provisioning supported

15Five ¥ »
4Me »
TGeese ¥
Accellion ¥
Adaptive Insights *
Adobe Sign ¥
Agileapps Cloud »
SETUP MY OWHN CUSTOM APP

SAML Meta Data - Part 1

1. Download the IDP metadata file, using the "DOWNLOAD" button in Option 2 (see below)
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Step2ofl 5 b

Google IdP Information

Choose frem either option to setup Googhe as your identity provider. Please add details in the 550
config for the service provider. Learm maore

Option 1
S50 URL https-eccounts.google.com/fo/sami2/idp Yidpid=C01 Igipin
Entity ID httpa=yaccounts. google. com/o/sami2 Midpid=C01 kgipin
Cartitcate Google_20:23-6-25-135529_SAMLZ.0
Expires Jun 25, 2023

4 DOWMNLOAD
Option 2
IDP metadata 4 DOWNLOAD
PREVIOUS CAMNCEL MEXT

Select this link and download it to your evolve server. (Saving the File as an XML file)
2. Press NEXT
Configure the Application

Provide App name, Description and provide a Picture to represent it.
Then press NEXT
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Step3of5
Basic information for your Custom App

Please provide the basic information needed to configure your Custom App. This information will be

viewed by end-users of the application.

Application Name * Evolve
Description erwin EA|
Upload logo ) CHOOSE FILE

app-id: evolve

This logo will be displayed for all users who have access to this application.

Please upload a .png or .gif image of size 256 x 256 pixels.

PREVIOUS

CANCEL NEXT

1. Configure the Settings

Step 4 of 5
Service Provider Details

Please provide service provider details to configure SSO for your Custom App. The ACS url and Entity

ID are mandatory.

ACS URL * https://evol in.host. /evolve/AuthServices/Acs

Entity ID * https:// host /evolve/AuthServices

Start URL https:// in.host. /evolve/

Signed Response O

Name ID Basic Information Primary Email

Name ID Format EMAIL

PREVIOUS CANCEL NEXT

Set the ACS URL to:

https://{your-domain}/evolve/AuthServices/Acs

e.g. https://evolvemain.host.casewise.com/evolve/AuthServices/Acs

Set the Entity ID to:

https://{your-domain}/evolve/AuthServices

e.g. https://evolvemain.host.casewise.com/evolve/AuthServices
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Set the Start URL to:
https://{your-domain}/evolve/

e.g. https://evolvemain.host.casewise.com/evolve/

Set Name ID Format to:
EMAIL

Press NEXT

2. Set the Attributes

Step 50f 5

Attribute Mapping

Provide mappings between service provider attributes to available user profile fields.

http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress Basic Information Primary Email
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname Basic Information Last Name
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname Basic Information First Name
http://schemas.xmlsoap.org/claims/Group Employee Details Department

ADD NEW MAPPING

PREVIOUS CANCEL FINISH

Using the "ADD NEW MAPPING" button add attribute mappings for the following 4 attributes
Add 4 new Attributes

Application
Attribute: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress

Category: Basic Information
User Field: Primary Email

Application Attribute: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname

Category: Basic Information
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http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress
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User Field: Last Name

Application Attribute: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname
Category: Basic Information

User Field: First Name

Application Attribute: http://schemas.xmlsoap.org/claims/Group
Category: Employee Details

User Field: Department

Accept all other defaults

SAML Meta Data - Part 2

1. Taking the file you downloaded in SAML Meta Data (Part 1)
2. Place your metadata file on the Evolve server in the following location
“C:¥Casewise¥Evolve¥Site” (ensure it's an XML file)

3. Now in Evolve Designer under server Configuration/Authentication tab

i Select Authentication mode to “Saml2”

me
17 © (@) )
ave Configure lIS Install IS Features Update Admin Model
] Authentication | Workflow | Features | Security | S ——
Authentication Mode
Samlz
Ensble Automatic Logon
Domain Short Name
Use S5 Connection (Active Directory)
ii. SAML2 Entity id = taken from your Metadata xml File
| 71 GooglelDPMetadita-erwingsuite.net - Notepad - o
| File Ede Formst View Hep
|<2xnl version="1.8" encoding="UTF-8" "no"2><md: criptor xmlns:md="urn:0asis:names:tc:SAML:2,8:metadata” entityl0-"]
| validUntil="2023-06-25712:55:29.0002"> <nd: Signed="false” pr tEnumeration="urn:oasis :name
|use="signing™> <ds:KeyTnfo xnlns:ds="http: //wa.n3.org/2000/09/xnlds 1g8"> <ds:X58%0ata>
|<ds: XSB?(er(xﬂute>HllD¢D((A1ygﬁuIBMIGAAQSKMHBG(SQGS&BDQEMMMsxFDASBgWBAoT(vaZﬂslsa 2 Q T00d:
|b2ds. EnnCHMT gl L2MTLINTISKn M Mol LIMTLINT 5K §B7MRQnE Ho JLJENBQGAIUEB N
| TW91bnRhakagVa1 20, ’le.'ﬁgn‘gm £ d 2A)BgNVBAYTAIVTMR 181 AQ8A
| MLIBCEKCAQEAS1UTTDIOGHOS 2 RTERLS ATPeTPFyzbxzaPtzfBFAC2IVOMY I aMnBbLKNGYL MY 3gFGy LYNRAKTy JSRXTFOBAQFbBLHCUeehHOACAZBL TODADS 21us h1Vm3XZLHO1 2En) 51 7pxcORTS 2QXNAZg T O TEVOs Xvg NéXa
QVKMNW(ZMAXM(VM!MSF%F)ImAquonyﬂg/lDay\‘quYAB JHVIRYCHL XOW1caXOVTvsL6nuq 3irwz/2QeCdOdH3LUGULMuaHRahGEAZRZwF t 7dafuSeYpVlp
SqGSIb3DQEBC RPVIHV72EJuGe FxEnZ' E1y0s IwE /s ZCBLqccZnRwnOBp1 7 5r 1pByg TRIS6. Nzkl 1nr2
| FTGONLOTOTV141pHe tHANM1gRT 1680 LNK]sHExnF tyDesnoPCxrEOPCACNZX W+  1aKa30pxullezK /12Y371Kg0S 2F FIXKtT w2KdRed8rd 1p3szoAaThie JF a9GHKV S Lak s cBCXFBRSOLv1pZ/CacGnZXDN Fedxr
| +T0CyBHosPxQrRRxbapIRSf /WVoR< /ds : X5@9Certi ficate> </ds:X509Data> </ds:KeyInfo>  </nd: criptors mat>urn:oasis:names:tc:SAML:1.1:nanedd-

| format:emailaddress</nd: NameIDFormat> <nd:SingleSignOnService Binding="urn:oasis:names:tc:SAML:2.9:bindings:HTTP-Redirect™ Location="https://accounts.google.com/o/saml2/1dp?
|1dp1d~CO11q1pln“/>  <nd:SingleSignOnService Binding="urn:0asis:names:tc:SAML:2.0:bindings:HTTP-POST" Location="https://accounts.google. con/o/sanl2/1dp?1dpid-Ce11q1pln" />
| </md: IDPSSODescriptor></md: EntityDescriptor>

iii. SAML2 Meta url = “~/NAME OF YOU METADATA FILE.xml"
e.g. ~/GooglelIDPMetadata-erwingsuite.net.xml
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4. Evolve's url = YOUR EVOLVE URL

Home
’
H ©
Save Configure IIS

®)

Install IIS Features

®

Update Admin Model

[

Server | Authentication | Workflow | Features | Security |

AL SUTIITLLIVE WISIHgINIE

|sAMAccountName

Connect To Active Directory Forest

O

Domain Exclusion List

SAML 2 Entity Id

|https:Haccounts.google.com!o,'sam|1?idpid=C01Iq|pIn |

SAMLz2 Metalrl

| ~/GooglelDPMetadata-erwingsuite net.xml

Evolve's url

| https://evolvemain. host.casewise.com/evolve/ |

5. Save and Configure IIS

Publishing Evolve Site

1. For each model you publish under the deployment of the model you must specify the

Department names in the “AD Group” Fields this must Match the G Suite Department Names you

have set up along with the Values you specified in the attribute statement

Static Deployment

Home | Dynamic Deployment

@ o o

Dynamic Site Static Site

Design Publish

Layouts
=-4® Site
#-(1) Index Pages
w--@ Ohbject Pages
(%) Template Nodes
[ @ Menu
B A Deployments
[ ﬂ Jp-pc
3] ’ dgrayapp
+ ’ dgrayenvey
=[P evolvemain
£ PRACTICE
B ’ evolvez

Global Files Generated in 00.00:03.92357455

D Done i 2
Operation Ends - Run for 00:00-53 1902840 seconds.

®

Update Meta Model

& Themes

s | @

Show|Hide Object Tynes Online Help
Administraticn Help
Options [cwWebDesigner PRACTICE
Model FileMame |PRM_'I1CE | L
Site URL Name: |°“=M. ]
L ]
Site Display Name |Prar:lice Model ]
Deploy Custom Site |Delauit ,| L
AD Mapping AD Group CW User Type W Group CW Role
EvolveContributor | Contril v |EvolveContribu... [v|Administratar |
- ial Social ~ |EvolveSocial ~ | Administrator v
Diagrammer hd hd hd
v

2. Once set you must save. Then deploy the full site
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HOW AD GROUP WORKS: In G Suite you already setup SAML Groups and mapped the value from
a User's "Department"” to be used as the Group in Evolve.
When the value returned by G Suite matches one of the values in "AD Group", Evolve creates the

user with the permissions specified on that line.

e.g. A User who has the "Department” = "EvolveContributor"”, will be created with a "Contributor"
Licence, in the Group "EvolveContributor". This will mean in Model Explorer you will see a new
User added, with a Category "Contributor”, and they will be associated with the group
"EvolveContributor", which will give them access to whatever models are available to that group. In
addition, we see that it will also give them a Role, "Administrator". This is an Evolve role, and will

dictate what views and pages they see in the Evolve site.

See below, where a User's department is set in the profile.

Google Admin Q, Search for users, groups, and settings (e.g. create users)

Users 2 lan Hancock 2 User information

ADMIN

lan Hancock

ianhierwingsuite net

{&) RESET PASSWORD
# RENAME USER

I MORE

User information

User details

Contact information

Email aliases

Employee information

Email (Home)
Add a secondary emil

Phone (Home)
Add a phone number

Address (Home)
Add address

Alias
Add an alias

Manager's ema

Department

EvolveCantributor

Naturally, other properties can be used to act as the Group, although we have not yet worked out

how to persuade G Suite to pass the ACTUAL Google Group information. If you are able to solve

this, please let us know, and we'd be happy to update the page, to let others know.

erwin Evolve — User Help Guide
Configuration and Administration



Configuring SAML2 Authentication and SSO with Okta

If your organization uses Okta (www.okta.com) as an Identity provider, these instructions will help you to
configure Single Sign On, between Evolve and your IdP.

Create new Application in Okta

1. Select Create new App
2. Platform = Web
3. Sign on Method = SAML2.0

Create a New Application Integration

Platform

Sign on method

4. Click create
Configure the Application

1. Provide app name

Web v

) Secure Web Authentication (SWA)

® SAML20

) OpeniD Connect

Cancel
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2% Create SAML Integration

© coreseoe
o General Setiings
App name Evoive SaML|
Appiogo o @
—
Upload Logo
Do not display application icon In the Olaa Mobile app

a. Single Sign on URL: Your Evolve URL followed by “/AuthServices/Acs”
Example https://EvolveTest/evolve/AuthServices/Acs

b. Ensure “Use this for Recipient URL and Destination UR” is checked

c. Audience URI (SP Entity ID): Your Evolve URL followed by “/AuthServices”
Example https://EvolveTest/evolve/AuthServices

d. Name ID format: EmailAddress

e. Application username: Email

o SAML Settings

GENERAL
Single sign on URL @ https:/fercignin_host.casewise.com/evolve/AuthSenvices/Acs
/| Use this for Reciplent URL and Destination URL
Allow this app to request other SSO URLs
Audience URI (SP Entity ID) @ https://ercignin.host.casewlise.com/evolve/AuthSenvices

Default RelayState €

Name ID format € EmallAddress v
Application username € Emaill A

Show Advanced Settings
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3. ATTRIBUTE STATEMENTS
Add 4 new Attributes
Name: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress
Name Format: URI Reference

Value: user.emailaddress

Name: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname
Name Format: URI Reference

Value: user.surname

Name: http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname
Name Format: URI Reference

Value: user.givenname

Name: http://schemas.xmlsoap.org/claims/Group
Name Format: URI Reference

Value: isMemberOfGroupName("Evolve Contributor") ? "Evolve Contributor" :
(isMemberOfGroupName("Evolve Social") ? "Evolve Social" : "NO")

IMPORTANT NOTE: /n the above value we have specified the name of the Okta Groups in this
case the group names are ‘Evolve Contributor ”and ‘Evolve Social ”. These are the Group names

you must specify in Evolve Designer.

This States that any user that in in the Okta group “Evolve Contributor” will be passed as a
Contributor user and any user in the Okta group “Evolve Social” will be passed as a Social user.
Finally any user that is not a member of either Okta groups will be passed as “No” and will gain no

access.
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ATTRIBUTE STATEMENTS (OPTIONAL) LEARN MORE

Name Name format (optiona Value
http://schemas.xmisoap.org/ = URI Reference user.email v Ly
http://schemas.xmisoap.orgf = URI Reference user lastName v &
http://schemas.xmisoap.orgf = URI Reference user firstName v o~
http://schemas xmisoap.org/ = URI Reference « IsMemberOfGroupName{"Evolve Contributor’ | = .
Add Another

Accept all other defaults

SAML Meta Data

1. In the Okta Admin Page under “Sign On” you will find the “Identity Provider metadata” link to

download you're the metadata.

Select this link and download it to your evolve server. (Saving the File as a XML file)

Sign On lobll t |

Settings Edit

SIGN ON METHODS

Default Relay State

SAML 2.0 Is not configured untll you complete the setup Instructions.
View Setup Instructions

Identity Provider metadata [f avallable If this application supports dynamic configuration.

2. Place your metadata file on the Evolve server in the following location
“C:¥Casewise¥Evolve¥Site” (ensure it's a XML file)
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3. Now in Evolve Designer under server Configuration/Authentication tab
a. Select Authentication mode to “Saml2”
b. SAML2 Entity id = taken from your Metadata xml File
c. SAML2 Meta url = “~/NAME OF YOU METADATA FILE.xml”

d. Evolve's url = YOUR EVOLVE URL

1 ©® © @

Configure IS Install IS Features Update Admin Model

[ Authentication | Warow | Features [ Securiy | —
Authentication Mods L [somiz |
Ensble Automatic Logon
O
Domain Short Name
Use SSL Connection (Active Directory) -
AD Connection Path
AD Port 389
‘AD Group Membership Selection Mode GetGrovpMembers
4D Connection Usermame AMAccountName
Connect To Active Directory Forest a
Domain Exclusion List
~
SAMLz Entity 14 T pe e
[
SAMLz Metald
Evolve's url https:/{EvolveTest/evolvel 2

.

4. Save and Configure IS

Publishing Evolve Site
1. For each model you publish under the deployment of the model you must specify the Okta group
names in the “AD Group” Fields this must Match the Okta group Names you have set up along with

the Values you specified in the attribute statement

[
AD Mapping AD Group CW User Type
Evolve Contributor Contributor v
Evolve Social Social i B
DiagrammerlUsers Diagrammer vl
b "

2. Once set you must save. Then deploy the full site.
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Authentication and Active Directory

Configure Active Directory Authentication and SSO

Active Directory is a commonly used Microsoft standard approach to securing logon to Windows and Web
systems. The following section will describe both the pre-requisites and the Evolve configuration required to
enable Active Directory (AD) as your authentication provider. It is largely assumed that you are

knowledgeable about the configuration of Active Directory.

The instructions below explain how to configure your Evolve Server so that you can use AD as an
authentication method to access your sites.

Changes to these settings will require the re-publication of the site.

Pre-requisites for AD authentication:

Before proceeding with the connection, there are some preparatory steps you need to complete, in Modeler,

Evolve and in the client’s Active Directory configuration in order for the synchronisation to work.

First let's setup the CW Roles:

1. Launch Model Explorer and create two (2) distinct objects within the CW Role object.

$ CW Role - Model Explorer
File Edit View Action Tools Help

V-l (BB i | = R < e =R S
Object | -| |[& Models 2T R |’
= -8 Avant Homes 7.0 W Administrators
"g! -8 Best Practice Process Model - Incident Management W Ediors
. -4y Casewise Framework 3.0 ! Read-Only Users
[z B8y Casewise Framework Example

[+-8} Enterprise Architecture Framework GS1
. -8} Enterprise Architecture Framework v3.0
-8 Enterprise Architecture Framework v3.5
B §¥ EPD Master Model 1.0
& ) EPO Master Model 2.0
H-8Y EPO Master Model 3.0
=8 EPO Master Model 4.0

¥ Activities

Report

¥ Applications

v Attributes

% Calendars

¥ Controls

3% OW Answer

&% CW Answer User all Objects
¥ CW Comment

& CW Diagram Designer
& CW Meta Model Enity
& CW Page

v CW Question

¥ CW Views
¥ Data Stores
v Diagrams
v Documents
% Domains

You can create as many roles as you want, but make sure that two of them can be used as generic

roles for all incoming users. For example, you can create a role named “Read-Only Users” (which
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will ultimately contain all Social Users) and another called “Administrators” (or “Contributors”)

(which will ultimately contain all Normal Users).
3. Connecting Roles to CW Views.

At this point, you should connect those default roles to the appropriate views to define which pages
each user group will be able to access once logged in. To do this please refer to the appropriate

section of the Evolve user guide (here).

If you choose not to connect any views to the roles, then both roles will be able to view the exact

same pages.

Next configure the Client Active Directory:

1. Creating new AD Groups:
You need to arrange with your customer’s system administrator to create two (2) distinct groups
within their Active Directory. They can choose to name them anything they want, but should keep
those names distinct and recognizable so they can then be connected to Evolve.

2. Adding users to the AD Groups:
The client system administrator should then, in conjunction with your main contact within the client,
ensure that the appropriate number of users is added in each group.

Configure the Active Directory Connection:

1. Change Authentication Mode:
Launch Evolve Designer (in Administrator mode) and choose "Server Configuration". Navigate to the
"Authentication" tab. In the Authentication Mode drop-down list, switch the default value

(CwAuthentication) to ActiveDirectoryAuthentication.
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& Evolve Designer (EA Foundation - Sam

Home

©®)

@ Diagram Popouts

Dynamic Deployment

Jii

ple Model > IW7TYULX) - v2018.0.0.0

Static Deployrment

.

&

Server Configuration Add/Remod B Evolve Server Configuration - 2012.0.0.0 — m] ped
Web Server Site Config Hame
Layouts (,
g 3
o H © © ®
@ Index Pages
() Object Pages Save Configure IS Install IS Features Update Admin Model
l"_w\ Template Nodes I
..... @5 Meny
@ Deol " Server  Authentication Workflow Features Security
----- eployments
..... P je-pc Avthentication Mode ActiveDirectoryAuthentication
ActiveDirectoryAuthentication
-7 desktop-nb2gg Enable Automatic Logen Cwhuthentication
£ wzrYuLx Semiz

Domain Shert Name

Use 55L Connection (Active Directory)

O

AD Connection Path ‘

AD Port ‘389

AD Group Membership Selection Mode [CetGroupMembers

AD Connection Username ‘SAMAEED\J"[NEME

Current Version of 1S is 10.0

Configuring the AD Connection Path:

2. Export the certificate to a new *.PFX file
3. Use the following password to secure the certificate :

LOMrnsuLpVAZ9ePd

Note that it is not currently possible to choose an alternative password. However the certificate is

1. If you have not done so already, import the domain SSL certificate into Windows

stored securely on your server, and is not made available externally, so this should not pose a

concern.

4. Save the filename: Ca

in the folder: c:¥Cas

sewiseAuth.pfx

ewise¥Evolve¥Site¥bin

To configure SAMLZ on your Evolve server:

1. Run Evolve Designer.

2. On the Evolve Designer Models launcher dialog, click the Server Configuration button.

CACOIC)

®
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The Server Configuration dialog opens.

3. Configure the settings according to the table below:

Authentication

Authentication
Mode

Choose how you want Users to be logged on to Evolve:

Use Saml2 to make Evolve expect a SAML2 authentication

Enable
Automatic Logon

Leave un-checked

Domain Short
Name

Leave this setting blank.

Use SSL
Connection
(Active
Directory)

Leave un-checked.

AD Connection
Path

Leave this setting blank.

Selection Mode

AD Port Leave this setting blank.
AD Group
Membership Leave this setting blank.

AD
Connection User
name

Leave this setting blank.

Connect to
Active Directory
Forest

Leave this setting blank.

Domain
Exclusion List

Leave this setting blank.
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SAML2 Entity ID This is often fgun(?i in the metadata.xml file, and consists of the URL that Evolve needs to
check authentication.

This could be a public URL, a private URL or a local file path. The meta data consists of an
XML file that contains the settings for the SAML2 configuration.

e.g. configured for a local file:

~/IDP-QA-Metadata.xml

where the metadata file should be stored in the Site folder

SAML2 Meta Url

# Downloads logs

4 Recent places Views

‘: Global ssax
1DP-QA-Metadataom

L9 packages.config

3 Web.config

Enter the URL to the Evolve home page - e.g.

Evolve's Url
vow https://domain.company.com/evolve/

4. Click Save to save your configuration.

If you make any further changes to the server configuration in this dialog, you must Save again.

At this point it will no longer be possible to logon to Evolve, as the final steps are to configure the
permissions based on Claims configured on the Authentication Server, and their mapping to groups on the
Evolve server.

To configure Groups and Roles on your Evolve server:

Groups and Roles for SAML2 are configured in exactly the same way as they are for Active Directory. Take a
look at this to see how they work. You will find this detail in the "AD Mapping" details of the "Site Level
Settings" - "Deployment Node Settings".

Further instructions for specific Identity Providers:

See here for help on Integrating with Okta Identity Provider.
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Sites Explained

There are two types of Evolve Site - Static Sites and Dynamic Sites. Which type of Site you can deploy
depends on the type of license you have for Evolve and what you want your users to be able to do on the
Site.

A Static Site is a read-only deployment which displays data from your repository taken at a fixed point in

time and is therefore is a great way to communicate your approved model data to a wide audience.

See more about Static Sites

Static Sites have the following features:

o Read-only data - users cannot edit any data they see.
o Fixed data taken at the time of publication - no live connection to the repository.
e Open access - no user login required.

o Portability - can be accessed via URL on a web server, or directly as files.

A Dynamic Site shows live data from the repository and requires users to log in to access it. It can be
configured to allow users to edit data, and you can control data visibility and permissions with Role-based

access.

See more about Dynamic Sites

Dynamic Sites can enjoy all the features offered by Evolve - such as Workflow, Comments, Questionnaires,

and Favorites.
In summary, Dynamic Sites offer the following features:

e Live data - the Site connects directly to your CW repository showing current data from your model.
¢ Restricted access - Users are required to log in to access the Site, with Active Directory and

Windows Authentication supported.

Access Rights - Roles and Access Rights can be used to restrict a User's view of the data and also
whether they can edit data using the Site.

Workflow - The Workflow component can be used to implement an Approval procedure for editing

data, as well as a Review procedure for validating data.

Social features - Dynamic Sites have the Evolve social features built-in as standard, enabling your
users to collaborate using Comments, provide feedback with Questionnaires, and create their own
quick links to important pages using Favorites.

For a table comparing the features of Static and Dynamic Sites, see the Site Comparison Chart.
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Creating a Site makes changes to your Model's meta model, resulting in new Object
Types and Associations being added to the Model.

If you are using Evolve for the first time and want to experiment with creating a Site, we
recommend that you create a copy of an existing Model and use that as the basis of

your Site.

Deployment

Evolve Sites should be deployed to a web server machine running Microsoft Internet Information Services
(ns).

What do you want to do?

Create a Site
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Site Comparison Chart

The following table shows the differences between Static and Dynamic Sites.

L. Stati | Dynami
Feature Description
c c
View data Users can view data from your repository in Evolve. [E [E
Home page
Display a diagram on the home page.
diagram [E
Show live data Evolve displays data directly from your live repository.
Edit data Users can edit data where permissions allow.
User login Users must log in to access the Site.

You can use Role-based access to specify which data users can

[x]

Access controls )
see and what they can edit.

The Workflow component can be used to implement Approval and
Workflow .
Review workflows.
Comments Users can collaborate using the in-page comment facility.

You can create and publish questionnaires to gather feedback from

(]

Questionnaires
your users.

Users can mark pages as Favorites, and then access those pages

N N M | @ |EHEHE

[x]

Favorites )
directly from the Site home page.
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Change the URL Name of your Site

This page explains how to change the Site URL Name for a model Site in Evolve.

The Site URL Name is the part of the URL which is specific to a particular site.

For Dynamic Sites this is:

http://<server-name>/<evolve-11S-site-name=>/sites/<site-url-name>/

For Static Sites, this is:

http://<server-name>/<evolve-11S-site-name=>/statics/<site-url-name>/

Change the Site URL Name for a Dynamic Site

To change the Site URL Name for a Dynamic Site:

1. In Evolve Designer, navigate to the Deployments > [server-name] > Model node

2. Change the Site URL Name to the new name you want to use, ensuring the text is lower case, and
has no spaces or special characters

3. Publish the Site

The Site is Published, is displayed on the Evolve Multi-Sites page, and can be accessed directly at
the new URL.

Change the Site URL Name for a Static Site

To change the Site URL Name for a Static Site:

1. In Evolve Designer, navigate to the Deployments > [server-name] > Model node

2. Change the Site URL Name to the new name you want to use, ensuring the text is lower case, and
has no spaces or special characters

3. Publish the Site

The Site is Published and can be accessed directly at the new URL.

When you publish the Site with a changed Site URL Name, the original Site still exists and can
still be accessed via the original URL.

To completely remove the original Site, you must:

1. On the Evolve server machine, browse to <your-evolve-install-path>¥Data¥Statics

2. Delete the folder named as your original Site URL Name.

erwin Evolve — User Help Guide |

Configuration and Administration |



Advanced Configuration

Configure TLS 1.2 (Transport Layer Security)

In line with industry security recommendations the erwin CW products now support Transport Layer Security
version 1.2. This security layer is a low level network encryption protocol which can optionally be used
between applications and MS SQL Server. Many large organizations have been disabling TLS1.0 and TLS1.1
in favor of the newer TLS1.2, as it has certain improvements that make it less susceptable to security

vulnerabilities.

In order to configure erwin EA/BP for TLS1.2 there are some steps required that go beyond a
simple install. This document will guide you through these steps.

1. Run the following Microsoft Installer “sqglncli.msi” which can be obtained from here

https://www.microsoft.com/en-us/download/details.aspx?id=50402

]

sqincli.msi

for either x64 (64bit) or x86 (32bit) - as is approriate to your environment.

2. Set the following Entries in the registry. These can be copied into a file that is given the extension
.reg and then run in windows, or downloaded with your erwin software.
Most of the entries are to disable TLS 1.0 and TLS1.1, then enable TLS1.2. The final entry is to
configure erwin EA/BP to use the correct SQL Server client.

6

ServerTLS.reg

Windows Registry Editor Version 5.00

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥ SCHANNELY¥Proto
cols]

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥SSL 2.0]

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥SSL 2.0¥Client]
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"DisabledByDefault"=dword:00000001

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥ SCHANNEL¥Proto
cols¥TLS 1.0]

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥TLS 1.0¥Server]

"Enabled"=dword:00000000

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥ SCHANNEL¥Proto
cols¥TLS 1.1]

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥TLS 1.1¥Client]

"DisabledByDefault"=dword:00000000

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥TLS 1.1¥Server]

"DisabledByDefault"=dword:00000000

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥TLS 1.2]

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥TLS 1.2¥Client]

"DisabledByDefault"=dword:00000000
"Enabled"=dword:00000001

[HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Control¥SecurityProviders¥SCHANNEL¥Proto
cols¥TLS 1.2¥Server]

"DisabledByDefault"=dword:00000000
"Enabled"=dword:00000001
[HKEY_LOCAL_MACHINE¥SOFTWARE¥Wow6432Node¥Casewise¥CorporateModeler¥11¥Tuning]

"UseSQLServerNativeClient"="true"

After changing the registry settings, it may be necessary to reboot your machine.
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3. Once this has completed, start "erwin EA/BP Modeler" and when the logon dialog appears click the
“Edit” button.
This will display all the available connections.

4. Click on the connection you want to use and "Edit" it.

5. Next to the server name there will be a check box to enable the use of TLS1.2.

Check this box and press "OK" to close the dialogs.

Configure Microsoft SQL Server “
’ @) Connection name:
Casewise
{ | Servername:* |
Name Col | [WiNg1X64 [¥] Use TLS 1.2 Add
Casewise Usi ttion =
Instance name: : Edt ...
Remove
Port number
Test
Database name:* Close
casewise
User name:
Password
)
p Default Database:
Confim password:
Casewise v Help
“Mandatory fields
OK Cancel Help
s — e

6. Having made these changes the erwin EA/BP applications should run as normal.

Troubleshooting:
On some operating systems this additional msi file may also be required to get the application to run
successfully

Run the following Microsoft Installer “msoledbsql_18.1.0.0_x64.msi” which can be obtained from here

https://www.microsoft.com/en-us/download/details.aspx?id=56730

iy
msoledbsql_18.1.0.0_
x64.msi
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Evolve REST API (2018.1.0.79 and above)

The Evolve REST APl was added to provide backwards compatibility support for the discontinued Web Portal

SOAP API.

Where it differs slightly is in the method of calling the API. This has been modified to use the more standard

RESTful http approach, using
POST, GET, PUT and DELETE protocols.

All of the calls return a json response, but can optionally return XML. The XML returned is equivalent to the

older Portal API, and so should

ensure it is relatively simple to integrate, in-place of the older service.

To configure the API, it is first necessary to enable it from within Evolve:

1. Having configured and ensured the Evolve server is functioning.

Start Evolve Designer with Administrator Permissions.

2. Goto your Evolve server settings
Check the box 'Enable Web REST API"

& Evolve Server Configuration - 2018.1.0.79 -

Save Configure IS Install lIS Features

Server  Authentication Workflow Features Security
Enable eModeler
Enable advanced matrix

Enable Web Rest API

[Currently running with elevated privileges - IIS configuration is enabled
[Current Version of IIS is 10.0

4. Save the configuration
5. Press "Configure IIS"

The default endpoint for the APl will be:

http://<your-server>/WebRESTAPI/api/<path to endpoint>

To use the REST API, please see the documentation, located here.
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When using the API, always remember to use the /auth endpoint to authenticate first, and
remember to include the returned token
in all subsequent calls to the API. This token should be encoded in the header of the http

request.
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Site Administration

Site Administration Pages

Evolve Dynamic offers a number of built-in pages for administering your site via the web front-end.

You can create new menu items which directly link to these pages, and using Roles you can restrict access

to them to prevent them being seen by normal users.

Administration pages are only available on Evolve Dynamic.

The table below details each type of page and how to create the menu link to it:

Name

Description

Menu

cw_appstore

This is the default page picker page.

Add Index Page Link > Standard

Pages >

index_cw_user_usag

e

Shows users of your Site arranged by type.

Add Index Page Link > Standard
Pages >

index_gov_roles

Used for managing Roles.

Add Index Page Link > Standard
Pages >

index_gov_users

Shows all the users of your Site.

Add Index Page Link > Standard

Pages >

index_governanance

Used for managing which roles can see which

pages.

Add Index Page Link > Standard

Pages >

index_questionnaires

Lists existing questionnaires and allows you to
edit them.

Add Index Page Link > Standard

Pages >

cw_questionnaire

This page is the only way you can create a new

questionnaire.

Add Create Page Link > Standard
Pages >

See here for help on Creating and Editing a Menu.
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Working with Roles

The instructions on this page explain all the activities relating to creating, editing and managing Roles.

For instructions on assigning Roles to Pages or objects for the Review and Approval workflows, see: Set

Approval Roles and Users.

Create a Role

7o create a Role:

1. In your Evolve Site, browse to the Roles administration page
2. In the page menu, click Grid

3. Click the Add CW Role button

4. In the pop-up dialog, enter the Name of the Role

5. Click Create

The Role is created.

Add Users to a Role

To add Users to a Role:

—_

. In your Evolve Site, browse to the Roles administration page

N

. Click the Role you want to add Users to
The Role page is displayed
. Click the Edit button
. In the page sub-menu, click Users
. Click the Associate button at the top-right of the Users (are in this role) box
. Click inside the text box, or start typing the name of the User you want to add

~N o o1 &~ W

. Select the User from the list
The User appears in the box

. Click the Save button.

. In the pop-out Changes window, click the Submit changes button.
The User is added to the Role.

O 0o

Specify which Site pages a members of a Role can view

N\

You can link Roles to any Index Page, Object Page, Object Page View or built-in Administration
Page in your Site.

Once you link a Role to a page, members of the Role are only able to view the pages they are
linked to.

If a Role is not linked to any pages, they can view all pages in the Site.
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To specify which Site pages members of a Role can see:

—_

. In your Evolve Site, browse to the Roles administration page
2. Click the Role you want to edit
The Role page is displayed
. Click the Edit button
. In the page sub-menu, click See Views
. The page lists all the pages in the Site members of the Role can view
. Click the Associate button at the top-right of the CW View (owner) box
. Click inside the text box, or start typing the name of the page you want Role members to be able to

~N O O B~ W

view
8. Select the page from the list
The page appears in the box
9. Click the Save button
10. In the pop-out Changes window, click the Submit changes button.

The page is added to the list of pages Role members can view.

You can also edit the links between pages and Roles using the grid on the built-in Governance
Administration Page.

To use this method, select a page, click the Edit button and then link the page to Roles using
the CW Role (is owned by) association.

IMPORTANT: After assigning pages to a role you must Save & Deploy your Evolve site.

Set which pages appear on Role members' home pages

You can specify which pages appear on the Evolve Site home page - and Home menu - for members of a

Role.

To specify the home page links for a Role:

1. In your Evolve Site, browse to the Roles administration page
2. Click the Role you want to edit
The Role page is displayed
3. Click the Edit button
4. In the page sub-menu, click Has Views on Home
5. The page lists all the pages which will appear on the Role members' home pages
6. Click the Associate button at the top-right of the CW View (has on a menu) box
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7. Click inside the text box, or start typing the name of the page you want to appear on the home page

8. Select the page from the list
The page appears in the box

9. Click the Save button
10. In the pop-out Changes window, click the Submit changes button.
A link to the page will now appear on all home pages for members of that Role, as well as a link in

the Home menu.

You can also configure home page links for a Role using the grid on the built-in Governance
Administration Page.

To use this method, select a page, click the Edit button and then link the page to Roles using

the CW Role (is on the menu of) association.
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Customizing Your Site

Customization Explained

This page explains how to do basic customization of your Evolve Site. It does not cover more
advanced topics such as how to create themes, or how to create custom layouts and behaviors.
If you are interested in bespoke customization, please speak with your Account Manager.

There are several ways you can customize Evolve.
You can:

e Change the logos of the top-level Evolve Site, or on your individual model Sites
¢ Use custom images for your Sites on the multi-sites page
¢ Use custom menu icons for pages in your Site.

In addition, some layouts or behaviors used in Evolve may also require some tasks that fall under the banner
of customization in order to work - for example using the External Picture layout requires uploading

images to a Custom Site folder.

Custom Sites

Most Evolve customizations, and some built-in layouts or behaviors, require that you publish your Site as a
Custom Site. What this means is that you create a Custom Site folder on your Evolve web server, where you
can store any CSS, images or other files you may need, and then ensure you reference this folder on

your Deployment node settings before publishing your Site.

Depending on the particular customization, or the specific layout or behavior you plan to use, there may be
special requirements for additional folders in this Custom Site folder structure. The help explaining those

elements will detail any such requirements.

To create and use a basic Custom Site folder:

1. On your Evolve server, browse to <your-evolve-install-path>/Site/bin/webDesigner/custom/
2. Create a new folder
The folder name must not have any special characters or spaces
3. In your new folder, create a sub-folder and name it 'images’
4. When you Publish your Site, ensure you select the folder in the Deploy Custom Site setting on
the Deployment node
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If Evolve Designer was already running when you created the new folders, close it and re-open
it again for it to be able to see the new folder exists.
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Basic Customization

Customizing Styles using LESS variables

LESS variables are used to change the properties of various elements within Evolve easily and
simultaneously. By changing the value of a single LESS variable, you can alter the appearance of multiple
HTML elements within the Evolve webpage. This enables simple customization through only a small subset
of variables.

The following sections detail what to be aware of when using LESS variables, particularly when upgrading

between product versions. The Appendix also covers an overview of the key variables and what they impact.

Upgrading Custom Themes with LESS variables

Since Evolve 2016.2.1 the Themes (LESS variables) are automatically upgraded when performing an 'Update
Meta Model & Themes' within Evolve Designer. However, if you find that the variables have not updated

correctly, the following instructions will help you to diagnose the issues.

Should a theme still be incompatible with the installed version of Evolve, the following error can appear in

Evolve Designer when you Deploy Dynamic/Static site:

Create Css file C:\Casewise\Evolve\Data\Commaon\css/casewise/grey theme evolve.css from theme
Create Css file C:\Casewise\Evolve\Data\Commonicssfcasewise/grey theme evolve min.css from theme
Input string was not in a correct format

Operation Ends - Run for oo:00:24 5B886ag seconds.

To upgrade the theme to be compatible with the installed version, follow these steps.

1. Ensure you know which default theme your custom theme was based on
e.g. Evolve7, Grey, Blue

2. Locate a copy of this theme in the new version of Evolve
nb: This can be found in <Evolve-Install-
Location>¥Casewise¥Evolve¥Site¥bin¥webDesigner¥themes¥

3. Using a comparison tool (e.g. WinMerge) compare your custom theme with the theme located in step
2

e This will highlight the new variables which have been added since your custom theme was
created.

e Each new variable will contain a comment (e.g. //v4.0.2) showing in which version it was
added.
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4. Copy over the new variables so that the custom theme contains the same number of variables as the

default theme.
5. Restart Evolve Designer and Deploy Dynamic/Static Site
Theme File Labelling Convention

Evolve’s LESS variables are named using camelCase whereby the first letter of each word is capitalized —
except for the first letter of the whole string. Evolve version numbers are commented out next to any

variables that relate to specific Evolve versions. l.e: //v4.0

Appendix - LESS: Global Variables

Click the groups below to see the LESS variables that are available and the elements that they will affect.
Note that for the sake of brevity, not all available variables are listed below - only the main variables that

alter colors and fonts have been included.

Primary Colors

. Exampl
LESS Variable Evolve Page Element(s)
e
@cwColorlShade | The primary color used for borders and shading. | -
@cwColorl The primary color used for various backgrounds | -
@cwColorlTint The primary color used as a highlight -
The secondary color used for borders and
@cwColor2Shade -
shading.
The secondary color used for various
@cwColor2 -
backgrounds
@cwColor2Tint The secondary color used as a highlight -
@cwShadowColo
The color used to add a shadow to elements -
r
Global Variables
LESS Variable Evolve Page Element(s) Example
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The font family used by a

@cwFont majority of text elementsin | p, span, li, a
Evolve
) The font family used by
@cwFontTitle h1, h2, h3, h4, h5, h6

various titles in Evolve

@cwFontTextColor

The color used by a majority

of text elements in Evolve

@cwGlobalLinkTextColor

The color of text links in

Evolve

@cwPageTitleColor

The color of various titles in

Evolve

@cwPageTitleBackGroundCol

or

The background color of the
page title at the top of the

screen.

@cwBodyBackgroundColor

The background color of the

main content area

@cwLoginBackgroundColor

The background color of the
login dialogue that appears

on the login page

@cwLoginTextColor

The color of the text on the
login dialogue that appears

on the login page

@cwLoginSubmitButtonTextC

olor

@cwLoginSubmitButtonBackg

roundColor
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Diagrams

LESS Variable

Evolve Page Element(s)

Example

@cwDiagramBreadCrumbBac
kgroundColor

The color of the area
surrounding the

breadcrumbs

@cwDiagramBreadCrumbBox
BackgroundColor

The background color of the

breadcrumbs themselves

@cwDiagramBreadCrumbBox
TextColor

The color of the text that
appears on the

breadcrumbs

@cwDiagramEditorlconColor

The color of the editor icons

within eModeler

@cwDiagramEditorMenuBack

groundColor

The background color of the
eModeler menu

@cwDiagramEditorMenuMain
HeaderBackgroundColor

The background color of the
eModeler menu's main

header

@cwDiagramEditorMenuSubH

eaderBackgroundColor

The background color of the
eModeler menu's

subheaders

@cwDiagramTileNameBackgr
ound

The background color of a
tile in eModeler

@cwDiagramTileNameBackgr

oundHover

The background color of a
tile in eModeler when you

hover over it

@cwDiagramTileNameTextCo

lor

The background color of a

tile in eModeler

600
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Left-Hand-Side Menu

LESS Variable

Evolve Page Element(s)

Example

@cwMenulLeftTabBackground
Color

This is the background color

of the pop-out tab

@cwMenulLeftTabTitleColor

This is the color of the title
that appears on the top of
the pop-out tab

@cwMenulLeftTabSelectedVie

wBackgroundColor

This is the background color
of items that are selected in

the pop-out tab

@cwMenulLeftMainNavigation
BackgroundColor

This is the background color

of the main navigation menu

@cwMenulLeftMainNavigation
TextColor

This is the color of the text

in the main navigation menu

@cwMenulLeftMainNavigation

BackgroundColorHover

This is the background color
of the menu item in the
main navigation menu when

the cursor is hovered over it

@cwMenuleftMainNavigation
TextColorHover

This is the color of the text
in the main navigation menu
when the cursor is hovered

over it

@cwMenulLeftMainNavigation
TextColorActive

This is the color of the text
in the main navigation menu
when the menu item or one

of its sub-menus is active

@cwMenulLeftMainNavigation

BackgroundColorActive

This is the background
colour of the menu item in
the main navigation menu
when the menu item or one

of its sub-menus is active

Opeors
s @
. @
s 7
s @
. 7
s @
e

@cwMenulLeftSubNavigation
BackgroundColor

This is the background color

of the navigation sub-menu
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@cwMenuleftSubNavigationT
extColor

This is the color of the text

in the navigation sub-menu

@cwMenulLeftSubNavigation
BackgroundColorHover

This is the background color
of the menu item in the
navigation sub-menu when

the cursor is hovered over it.

@cwMenuleftSubNavigationT

extColorHover

This is the color of the text
in the navigation sub-menu
when the cursor is hovered

over it.

[
s @
= @
- 7
s @
- @
- rs
» @

Drop-down Notifications

LESS Variable

Evolve Page Element(s)

Example

@cwNotificationMessageBack

groundColor

The background colour for
notifications

@cwNotificationMessageText

Color

The text colour for

notifications

00000

@cwNotificationErrorBackgro

undColor

The background colour for

Error notifications

@cwNotificationErrorTextColo

r

The text colour for Error

notifications

90004

extColor

header text

@cwListBoxPropertyValueBor
derColor

The color of the border
surrounding the list box's

content

List Boxes

LESS Variable Evolve Page Element(s) Example

@cwListBoxPropertyHeaderB | The background color of the

ackgroundColor list box header

@cwLlistBoxPropertyHeaderT | The color of the list box R T
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Properties Group

LESS Variable

Evolve Page Element(s)

Example

@cwPropertiesTableHeaderB

ackgroundColor

The background color of the
header on the Properties
table

@cwPropertiesTableHeaderT
extColor

The color of the text on the
header on the Properties
table

@cwPropertiesContainerBord

erColor

The color of the Properties

table's border

@cwEditPropertiesValueHove

rBackgroundColor

The color of a data row in
the properties table when

the cursor is hovered over it

@cwEditPropertiesValueHove

rTextColor

The color of text in a data
row in the properties table
when the cursor is hovered

over it

;lH’
i

[1HE]

00000

Buttons

LESS Variable

Evolve Page Element(s)

Example

@cwButtonSubmitBackground
Color

The background color of
the submit button.

@cwButtonSubmitTextColor

The color of the text on the

submit button.

@cwButtonSubmitBorderColor

The color of the submit

button's border

. Share by erad

@cwButtonTextColor

This isn't often used as the
text on the buttons is
hidden

@cwButtonBackgroundColor

The colour of the

background for icons that

1000
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appear in the top-right of

the Evolve page

@cwButtonlconColor

The colour of icons that
appear in the top-right of
the Evolve page

@cwButtonBorderColor

The colour of the border
for icons that appear in the

top-right of the Evolve
page

Accordions

LESS Variable

Evolve Page Element(s)

Example

@cwAccordionHeaderBackgro

undColor

The background colour of

accordion menu headers

@cwAccordionHeaderTextCol

or

The colour of the text on

accordion menu headers

@cwAccordionHeaderHoverB

ackgroundColor

The background colour of
accordion menu headers

when a cursor hovers over it

@cwAccordionHeaderHoverT

The colour of the text on

accordion menu headers

|- o]
o
I

extColor
when a cursor hovers over it
Discussions
LESS Variable Evolve Page Element(s) Example
@cwDiscussionsBackgroundC | The background color of the
olor Discussions panel header E
Discuss

@cwDiscussionsTextColor

The text color of the

Discussions panel header

Mew discussien
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World Map

LESS Variable Evolve Page Element(s) Example
@cwJVectorMapCircleBackg | The background color of circles
roundColor that appear on vector maps
@cwJVectorMapCircleBorde | The border color of circles that
rColor appear on vector maps

L X

@cwJVectorMapPathDefault
BackgroundColor

The default background color of

a map vector

@cwJVectorMapPathDefault

BorderColor

The default border color of a

map vector

@cwJVectorMapPathFilledB

ackgroundColor

The default background color of

a filled map vector

@cwJVectorMapPathFilledB

orderColor

The default border color of a

filled map vector

@cwJVectorMaplLabelTextC

olor

The color of the text on the map

labels

@cwJVectorMaplLabelBackg

roundColor

The background color of the

map labels

@cwJVectorMaplconlLinesC

olor

The color of the + and - signs

in the zoom icons

@cwJVectorMaplconBackgr

oundColor

The background color of the

zoom icons
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User Zone

LESS Variable Evolve Page Element(s) Example
Peter Muscat A
@cwProfileTextCol The color of the text in the
cwProfileTextColor User-area My Sites
My Profile
Pop-ups
LESS Variable Evolve Page Element(s) Example

@cwPopupBackgroundColor

The background color of the
left-hand-side pop-out

menu T
) The background color of the —

@cwPopupTitleBackground
title on the left-hand-side pexzes

Color
pop-out menu
The color of the title text on — e o

@cwPopupTitleTextColor the left-hand-side pop-out [ s |
menu

Badges

LESS Variable Evolve Page Element(s) Example

@cwBadgeBackgroundColor

The background color of
Badges

@cwBadgeTextColor

The color of the text that

appears on Badges

Tasks & Notifications

LESS Variable

Evolve Page Element(s)

Example

@cwWorkflowTaskListTask

ActionsColor

The background color of the
action panel associated with
pending tasks

Tasks Requested
002
(o] s

[ae—

- S
21
hew s
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@cwWorkflowTaskApproval
Approved

The color of the task's
approved tag

L L b Ty Py )
|

@cwWorkflowTaskApproval

The color of the task's

Reviewer's Comments

Rejected rejected tag B
Pl
=
Gl Gl
The color that highlights a - 7 ——
@cwWorkflowDelegatedTas o )
task to signify that it has
kColor
been delegated to you
=3
@cwWorflowTaskBackgroun | The background color of a - - i

dColor

task

@cwWorflowTaskTextColor

The text color of a task

@cwWorflowNotificationBac

kgroundColor

The background color of

workflow notifications

@cwWorflowNotificationTex
tColor

The text color of workflow

notifications

Notifications
o | ywce | ven [T ([ A o [[Conar |
@ Y siaat SASSSS I Wik S a5 Pt

@cwWorflowDueDateCalen
darBackgroundColor

The background colour for
calendars that appear next

to tasks

@cwWorflowDueDateCalen
darOverdueMonthTextColor

The colour of the month that
appears on the calendar for

tasks that are overdue

@cwWorflowDueDateCalen
darDueBackgroundColor

The background colour on
the calendar for tasks that

are due
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@cwWorflowDueDateCalen
darOverdueBackgroundColo

r

The background colour on
the calendar for tasks that

are overdue

Global Search

LESS Variable

Evolve Page Element(s)

Example

@cwGlobalSearchFocusColo

r

The color of the text in the
global search input field when

the cursor is focused on it

@cwGlobalSearchTextColor

The color of the text in the
global search input field

@cwGlobalSearchBackgrou
ndColor

The background color of the
global search input field

@cwGlobalSearchResultsTe

xtColor

The color of the search

results text

@cwGlobalSearchResultsBa

ckgroundColor

The background color of the

search results

@cwGlobalSearchResultSha

dowColor

The color of the shadow on

the search results box

Top Bar

LESS Variable

Evolve Page Element(s)

Example

@cwTopBarHeight

The height of the top bar

@cwTopBarBackgroundColo
r

The background color of the
top bar

@cwTopBarProfileLinkColor

The color of the profile links

within the top bar

@cwTopBarProfileLinkHove
rColor

The color of the profile links
within the top bar when you

hover over it

erwin Evolve — User Help Guide |

Customizing Your Site |



https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/customize/cwGlobalSearchResultShadowColor.png
https://dzf8vqv24eqhg.cloudfront.net/userfiles/1621/2466/ckfinder/images/evolve/customize/Evolve%204%20Top%20Bar.jpg

Home Page

LESS Variable

Evolve Page Element(s)

Example

@cwHomePageFavoritelcon

BackgroundColor

The color of the favorite icons
on the home page. Note that
a 'lighten' filter is applied to
each row of icons so it is
recommended to choose a
slightly darker color to begin
with.

@cwHomePageFavoriteText

Color

The color of the text that

appears on the favorite icons.

Casewise Suite Salesforce ITSM
B\ N B

@cwHomePageRolelconBac

kgroundColorHover

The color of the icon that

appears on the favorite icons.

Side Menu

LESS Variable

Evolve Page Element(s)

Example

@cwMenuleftSubNavigatio

nBackgroundColorHover

The background color a sub-
menu menu item when the

cursor is hovered over it

@cwMenulLeftTabSelectedV

iewTextColor

The text color of a selected

menu item

Service
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@cwMenulLeftTabSelectedV
iewTabSelectedTextColor

The text color of a selected
tabmenu item

Technclogy Let

@cwMenulLeftTabSelectedV
iewTabSelectedBackground

Color

The background color of a

selected tab menu item

Technucluyy et

@cwMenulLeftTabSelectedV
iewTabTextColorHover

The text color of a selected
tab menu item when the

cursor is hovered over it

@cwMenulLeftTabSelectedV
iewTabBackgroundColorHov

er

The background color of a
selected menu item when the

cursor is hovered over it

@cwMenulLeftBorderColor

The color of the border that
separates menu items on the

left hand menu
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@cwMenulLeftTabBorderCol

or

The background color of the

left-hand menu pop-out tab

@cwMenuleftToggleZoneB

ackgroundColor

The background color of the

'hamburger' menu-toggle icon

@cwSocialRatingStarBackgr
oundAndBorder

The background & border
color of the Social Ratings

section

gy

Azcact il it

Dlagrames

Grids

LESS Variable

Evolve Page Element(s)

Example

@cwGridButtonsColor

The color of the grid buttons

200

@cwGridPaginationBackgro
undColor

The background color of the
pagination section of the grid

]

P FFREE RERR R RN
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@cwGridColumnHeaderText

The color of the text in the

grid header

@cwGridColumnHeaderBac

kground

The color of the grid header's
background

Miscellaneous

LESS Variable

Evolve Page Element(s)

Example

@cwSiteSelectionTextColor

The color of the text that

displays the site name

EA Foundation - Sample Model

@cwButtonSelectedBackgro

undColor

@cwButtonBoxShadowColor

The color of the shadow on
the rounded buttons

Administrateur CW w

00000

@cwAccordionHeaderTextC

olor

The color of the title text on

accordion menus

Agplication List

1T Portfabio
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@cwDiscussionsBackground

ColorHover

The background color of the
discussions icon when you

hover the cursor over it

- Lelul~1-]
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Use Custom Site Logos

To make your Evolve Sites match your own corporate branding, you can change the default Evolve logos.

You can change the logos at a global level, so affecting the top-level Evolve Site which you see if you
have Dynamic Sites, as well as the logos used on individual Sites you publish.

In addition, you can override the global setting on an individual Site basis to create custom logos for one or
many of your Sites.

On the top-level Evolve Site, the logo is displayed on the login dialog and then in the top-left of the Site. A

second, smaller logo is displayed in the top-left for smaller screen sizes, such as mobile devices.

On your own Sites, the logo is only displayed in the top-left of each page, with a smaller version when the

site is viewed on a mobile device.

Create new logos

To replace either the global logos or create custom logos for your own Sites, you have to create two new

images. These images must have the following details:

Image 1 Image 2
Name logo.png Name logo-m.png
Dimensions 146 x 30 px Dimensions 112 x 30 px

There are different processes for changing the global logos and adding custom logos to an individual Site.

What do you want to do?

Change the global Evolve Site logos

To replace the logo on the top-level Site:

1. On the Evolve server machine, in Windows Explorer, navigate to:
<your-evolve-install-path>¥Site¥bin¥webDesigner¥images¥logos

2. Replace logo.png and logo-m.png with your new images.

Next time you Publish one of your Sites, the logos will be changed. You may need to delete
your browser cache in order to see the change reflected.
Alternatively, if you do not want to wait until you Publish one of your Sites, you can copy the

logo.png and logo-m.png files to the following location which will cause them to be changed
immediately:
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<your-evolve-install-path>¥Data¥Common¥images¥logos

Use a custom logo on an individual Site

To use a custom logo on an individual Site:

1. On the Evolve server machine, in Windows Explorer, navigate to:
<your-evolve-install-path>¥Site¥bin¥webDesigner¥custom

2. If you do not already use a custom folder for your Site, create one here and name it as you wish
If you already use custom content with your Site, open the folder you already use

3. In your custom folder, create an 'images' folder, then create a 'logos' folder within it
You should now have the following structure:
<your-custom-directory>¥images¥logos

4. Copy your custom logo.png and logo-m.png files to the 'logos' folder

5. Create a CSS file named 'main.css' and place it in

<your-custom-directory>¥css

If you already have a main.css file, do not create a new one, instead add the code detailed in
the next step.

6. Copy the following code and paste it directly into main.css

/* Change the logo on evolve site */
.logo
{

background: transparent url('../images/logos/logo.png') center
no-repeat;

}

/* Change the logo on the login page */
#cw-authentication-zone .cw-authentication-top

{

background: transparent url('../images/logos/logo.png') center
no-repeat;

}
/* Change the logo for smartphone and tablet devices */
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@media screen and (min-width: 240px) and (max-width: 1023px){
.logo
{

background: transparent url('../images/logos/logo-m.png")
center no-repeat;

}

7. Open your Site in Evolve Designer

8. On the Deployments > [server name] > [model] node, choose your new custom folder in
the Deploy Custom Site drop-down

9. Save and Publish the site by using the Dynamic Site or Static Site button on the Home menu.
If instead you use the Save & Deploy Site function, you must click Theme & Pictures first.
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Use Custom Site Images on the Multi-Sites
Page

If you publish Dynamic Sites, you can use the top-level Multi-Sites page which lists all the Model Sites you

have access to.

By default, these Sites are shown with an Evolve logo, but you can change it to an image of your choice.

To use your own custom image for a Site on the Multi-Sites page:

1. Create a new PNG image file
ldeally the dimensions should be 200 x 130 pixels, however if the image is larger, it will be scaled
down automatically in the page

2. Name the image file with the same name as the Site URL Name used for your Site
You can find this value on the Deployments > [server-name] > [model] node in Evolve Designer
For example: m48yxeuv.png

3. Place the image at the following location on your Evolve web server machine
<evolve-install-path>¥Data¥Common¥images¥sites
Usually <evolve-install-path> is: C:¥Casewise¥Evolve¥

4. Publish your Site, ensuring you choose the Theme & Pictures option if you do not do a full Dynamic
Site generation.
You may need to clear your browser cache in order to see the new image immediately.
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Use Custom Icons for Pages

When you create an Index Page or a Create Object Page in your Site, you can choose an image for that

page which is used as an icon in the menu.
While Evolve ships with a set of default images for this purpose, you can also use your own icons if you wish.

Any custom images you add are available to be used on any Site you create in Evolve.

Custom icons must be .png files and the recommended size is 128px x 128px.

The easiest way to create a custom image is to copy and edit an existing one. This ensures it is the correct

size and format and will fit neatly into your Evolve Site.

To use a custom icon:

1. In Windows Explorer, navigate to <your-evolve-install-
path>¥Site¥bin¥webDesigner¥images¥views¥sources¥custom
NB: If the custom folder does not exist, you can create a folder of this name in the sources folder
2. Create a copy of one of the existing images from the path
¥Site¥bin¥webDesigner¥images¥views¥sources¥CW
into the custom folder. Then rename the file - e.g. mytest.png
3. Open the image in an image editing application to change it
If you want to use color transformation with the image, you must make sure the parts you want to
change are kept in black, and you should keep the circle and only edit the middle of the graphic

4. Save the image.

Your icon will now be available in the Custom Image field on your pages.
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Style Development

Style information should always be contained in a file separate to the functioning code. In Evolve this can be

produced in one of two ways.

Each new visualization / layout should have its own stylesheet with the filename the same as it's matching

JavaSecript file, this file should be placed in the same folder as the JavaScript file.
CSS

Language: CSS

File Extension: .css

Reference: www.w3schools.com/css/

CSS is the most common format for producing stylesheets in web development, this method requires no
building of the code but does not give you access to the global style variables that are available through

Evolve.

For more information on CSS development see the reference linked above.
LESS

Language: LESS

File Extension: .less

Reference: lesscss.org

Tools: winless.org/

LESS lets you to be more flexible with the styles you write and allows the use of methods & variables
(amongst other things) when developing a style file. This LESS file is then compiled to a CSS output.

Through less you can gain access to global theme variables by adding the following to the top of your style

file. See LESS: Global Variables for a full list of variables available.
@import "../variables";

LESS files are automatically compiled by Evolve when they are placed in the correct location and ‘Apply

Themes’ is run through Evolve Designer. To compile LESS files outside of Evolve and learn more about LESS

and its development take a look at the tools and references above.
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Advanced Customization

Evolve
Advanced Customization Guide

Welcome to the CW Evolve Advanced Customization Guide.

Who is this guide for?

This guide is for CW consultants or advanced users of Evolve - those interested in extending the basic
capabilities of Evolve by creating custom layouts or visualizations, or changing the appearance of Evolve
Sites.

What do you want to do?

Getting Started

To prepare for customizing Evolve, see Get Ready For Development.
Layouts

To create custom layouts, see Creating Custom Layouts.
Visualizations

To create custom visualizations see Custom Visualizations.

CSS & JavaScript

To create custom CSS or JavaScript see Custom CSS & JavaScript.
Styles

To learn about style development, see Style Development.

erwin Evolve — User Help Guide

Customizing Your Site



Custom CSS & JavaScript

Evolve allows you to extend its functionality and styles by creating your own CSS classes and JavaScript
methods which can be used within the layouts and behaviors you create.

Creating a Custom File

Location: \webDesignerStatics\webDesigner\custom\{yourFolder}

1. Create a folder in the location above

2. Place the CSS and / or JavaScript files of the following files inside (See the CSS or JavaScript
sections below)

3. Open Evolve Designer for the site you're making the changes to

4. Expand down to the model node in the left hand tree

= Deployments
= j' machine_name

- g§ model_name

5. On the right hand side Select {yourFolder} name from the list of ‘Deploy Custom Site’
Deploy Lustom Site e "

6. From the ‘Advanced’ tab select the ‘Save & Deploy Site’ button
7. Hard refresh your browser by pressing Ctrl + F5 to pick up your changes

CSS
Language: CSS

File Extension: .css

Location: \webDesignerStatics\webDesigner\custom\{yourFolder}\css

Reference: www.w3schools.com/css/

The CSS file created should be named main.css, this file is added to the Evolve style list after the standard
Evolve styles, so will overwrite any existing classes of the same name. This allows you to tweak any Ul

styling to suit your specific needs by simply adding a class with the same name to the main.css file.
JavaScript
Language: JavaScript

File Extension: .js

Location: \webDesignerStatics\webDesigner\custom\{yourFolder}\js
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Reference: www.w3schools.com/js/

The JavaScript file created should be named main.js, any custom JavaScript you wish to be made available

within Evolve should be added to this file, which will be included when Evolve is run.

erwin Evolve — User Help Guide

Customizing Your Site


http://www.w3schools.com/js/

Using Custom Images

To use custom images in Evolve:

1. Go to Site/bin/webDesigner/custom (if it doesn’t exist, create it)
2. Create a folder inside there with the name of your customization
3.
4

. Inside 'images' you must add the new image files in the same position and the same name as the file

Inside the customization folder create a folder named 'images'

you want to replace in Content/images
If you want to replace Content/images/logos/logo.png you must name your file logo.png and put it
in Site/bin/webDesigner/custom/images/logo/logo.png

5. Run Evolve Designer and select the Model Deployment Node

. In the drop down next to Deploy Custom Site select the name you set in step 1

7. You must run Themes & Pictures then Save & Deploy for changes to take effect.
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Creating Custom Layouts

What Files Do You Need?

The setup of a new custom layout requires one of each of these files to be placed in the correct locations so
they are recognized by Evolve.

e Layout File
e Style File

e Layout Configuration File

Layout File
Language: HTML, JavaScript, JQuery

File Extension: .js

Location: C:\Casewise\evolve\Site\bin\webDesigner\custom\client\libs\cwLayouts\

Reference: www.w3schools.com/html/, www.w3schools.com/js/, www.w3schools.com/jquery/

The layout file contains the code that describes how the content on the page should be displayed. The
methods are called when the page is being drawn.

(function (cwApi) {

var myLayout = function (options) {
cwAPI.extend (this, cwAPI.cwLayouts.CwLayout, options):;
this.drawOneMethod = myLayout.drawOne.bind (this) ;
cwApi.registerLayoutForJSActions (this);

¥

myLayout.drawOne = function (output, item, callback,
nameOnly) {};
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cwApi.cwLayouts.myLayout = myLayout;

} (cwAPI)) ;

The file should be structured as followed:

The .drawOne Method

The drawOne method should contain all the code to describe how one object should be displayed on a page.
Parameters

output

This parameter contains an array of the HTML structure to be output. Each object that is to be displayed
should be added as a HTML list item (<li>) containing the information and / or HTML structure of how you

want that object to be displayed on the page.

myLayout.drawOne = function (output, item, callback, nameOnly)

{

output.push ("<1li class='cw-item'><div>",
this.getDisplayItem(item, nameOnly),
"</div></1i>") ;
i

Here is an example of how to display the information as a simple list.

item

This parameter is an object that contains all the information available to you for the object that is being
displayed including the current user’s rights to update and delete the object, for a more detailed look at the

information contains in this object. See Data Structure: item for an example of the data structure.
callback
This parameter is no longer used so will always be ‘undefined’.

nameOnly

This will be passed as true, false or undefined. If true the output should not contain a link to any other page,

if false or undefined, the output will usually link to the matching object page.
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Style File

Location: C:\Casewise\evolve\Site\bin\webDesigner\custom\client\libs\cwLayouts\

A style file should accompany the layout file in the same directory defining the styles used in the HTML
output. See Style Development for more information on how to produce this and the options available in

Evolve.
Layout Configuration File
Language: JSON

File Extension: .config.json

Location: C:\Casewise\evolve\Site\bin\webDesigner\custom\client\layouts\

Reference: www.w3schools.com/json/

{
"name"
"myLayout",
"display-name" : "My Layout",
"description" : "This is a new layout created by me",
"Js-class-name" : "myLayout"
}

The layout configuration file is a JSON file that sets properties for the layout. It is used by Evolve Designer to
make the layout available for selection when configuring Evolve, the display-name and description are
displayed when making a layout selection of a node. The js-class-name must match the name of your new

layout.
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Custom Visualizations

Custom visualizations currently require changes to be made to server side code, so an Evolve development
environment to develop a new visualization and a new build of Evolve are required.

What Do You Need?

The setup of a new custom visualization requires one of each of these files to be placed in the correct
locations so they are recognized by Evolve.

e Visualization File
e Style File

e Evolve Designer Configuration File
It also require the following file to be updated with a reference to the new visualization.

e Visualization List File

A rebuild of Evolve is required for a new custom visualization to be used in Evolve Designer.

Visualization File
Language: HTML / JavaScript / JQuery

File Extension: .js

Location: \webDesignerStatics\webDesigner\custom\client\libs\cwBehaviours\

Reference: www.w3schools.com/html/ / www.w3schools.com/js/ / www.w3schools.com/jquery/

The visualization file contains the code that describes how the visualization will be displayed on a page.
(function () {
var myVisualization = function () { };

myVisualization.setup = function (properties, allltems,
searching) { };

cwBehaviours.myVisualization = myVisualization;
PO

The file should be structured as followed:

The .setup Method
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S('div.' + properties.NodeID).html (YHTML String”);

The setup method is the first method that is called when the visualisation is loaded, it should contain any
code that will manipulate the data available and build up a HTML string the Ul for the visualisation you wish
to create. The HTML string should then be appended to the page’s DOM like so:

Parameters
properties

This parameter contains all the information for the visualisation you have created. You will need this
information in the next section to access the correct data list from the allltems parameter.

See DataStructure: properties for an example of the full data structure.

allltems

allltems|[properties.NodeID];

This parameter contains the list of object and their data for each page in Evolve, to access the data for the

page you're coding against use the link of code below.

The list will contain all the objects and it's information that should be displayed on the page, when searching
this list will be updated to show only objects that match the search criteria. See Data Structure:
allltems for an example of the full data structure.

searching

This is a Boolean parameter that tells you whether the page is currently being searched using Evolve’s in-
page searching capability. You do not need to do anything special to have your page be searchable, this is

provided as default by default.

Style File

Location: \webDesignerStatics\webDesigner\custom\client\libs\cwBehaviours\

A style file should accompany the visualisation file in the same directory defining the styles used in the
HTML output. See Style Development for more information on how to produce this and the options

available in Evolve.
EvolveDesigner Configuration File
Language: C#

File Extension: .cs

Location: \webDesigner\Sources\Nodes\Behaviours\
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class cwWebDesignerTreeNodeBehaviourMyVisualisation

cwiWebDesignerTreeNodeBehaviour

public cwWebDesignerTreeNodeBehaviourMyVisualisation (
cwiWebDesignerGUI cwWebIndexGui,
cwPSFTreeNode parent)
base (cwWebIndexGui, parent, "myVisualisation"

wWebDesignerTreeNodeBehaviour.CategoryBehaviourOtherCharts)

updateText ("My Visualisation");

public override bool checkNodeStructureCustom()

return true;

Reference: msdn.microsoft.com/en-gb/vstudio/hh341490.aspx

Visualisation List File

Language: C#

Location: \webDesigner\Sources\Libs\cwWebDesignerBehaviourManager.cs

Reference: msdn.microsoft.com/en-gh/vstudio/hh341490.aspx
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The Visualisation List File contains a list of the visualizations available in Evolve by linking to their
configuration file (described above), so any new visualisation should be added to this list so EvolveDesigner

can recognise it and make it available for use.

public cwWebDesignerBehaviourManager (cwWebDesignerGUI webDesignerGui,
cwiWebDesignerTreeNodelLayout parentLayout)

this.AddBehaviour (new
cwiWebDesignerTreeNodeBehaviourAccordion (webDesignerGui, parentLayout)) ;

this.AddBehaviour (new
cwiWebDesignerTreeNodeBehaviourGoogleMap (webDesignerGui, parentLayout));

this.AddBehaviour (new
cwiWebDesignerTreeNodeBehaviourMyVisualisation (webDesignerGui,
parentlLayout)) ;

this.SortBehaviours () ;

The line of code should be added as the example in red (below) shows.

Further Development

Layout Restriction

this.allowedLayouts.Add ("Layout Name") ;

You can restrict the layout your visualisation can be attached to in EvolveDesigner by adding an extra line of
code in the EvolveDesigner Configuration File. The following line of code should be added for each layout

you will allow your visualisation to be attached to.

Additional Properties

Object Properties

If you require extra properties for the objects that are being provided to you, this can be configured in Evolve

designer.

1. Load EvolveDesigner with the model and site you're configuring.
2. Expand the tree for the Index page you have attached your visualisation to and select the object type.

The example below shows this for a process object type.
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3. On the right hand side select the additional properties you require in your visualisation, these will
then be available in the allltems properties payload. See Data Structure: allltems for an example of
the data structure.

Selected Froperties A
[+ Average Rating
[+ Category
[ Complesxity
OConcurrency

erwin Evolve — User Help Guide 419

Customizing Your Site



Data Structure: allltems

projectl: Arrayl[4]

accessRights {
CanDelete: true

CanUpdate: true

associations { }

iName: null
iObjectAccessRights: Object
iObjectTypeScriptName: ""
iProperties: Object

label: "Object Name"
layoutName: "cwLayoutEmpty"
name: "Object Name"

nodeID: "projectl"
objectTypeScriptName: "project"
object id: 23

properties {

name: "Object Name"
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1: Object

2: Object
3: Object
4: Object

project2: Array[1l7]
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Data Structure: item

accessRights {
CanDelete: true

CanUpdate: true

Associations {

iName: null

i0ObjectAccessRights {

iObjectTypeScriptName: ""

iProperties {
label: "Object Label"
layoutName: "myLayout"
name: "Object Name"
nodeID: "diagram"
objectTypeScriptName: "diagram"
object id: 1234
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properties {

cwaveragerating: O

exportflag: O

name: "Object Name"
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Data Structure: properties

Behaviour {

AuthorizedLayouts: Array[0]
JSMethodName: "cwCostBenefit"
Name: "My Visualisation"

Options: Object

node name: "My Visualisation"

LayoutName: "empty"
LayoutOptions {
DisplayPropertyScriptName: ""

HasLink: true

LayoutID: ""

NodeID: "projectl"
ObjectTypeScriptName: "project"
PageName: "index projects cb"
PageType: O

ParentNodeID: null

TabID: null
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Get Ready For Development

Before you begin your new project you should take some time to setup an environment where you can easier
develop and debug your code. This will allow you to be able to view and insert breakpoints into source code
through your browser’s debugging window during development, it will also ensure that any saved changes

made are reflected in the browser by a simple refresh.

Set Evolve Debug Mode

1. Load Evolve designer and open the model & site you're currently using. Expand down to the
Deployments node and select your machine name.
2. In the list of properties on the right hand side, for the ‘JavaScript Mode’ select ‘debug’.

- Deployments Media Path

7 madhine_name|

& model_name Javascript Mode

debug

3. Specify the path of the server where the debug files are located

Debug Server Path

Deployments localhost-Bobo

) E' machine_name
Connect Debug Folders in IIS

This assumes a default Evolve installation, if you have made changes to the install location and IIS settings

for Evolve please adapt the steps to your installation.

1. Open Internet Information Services (IIS) manager from your windows programs
2. Expand ‘Sites’, right click on ‘Default Web Site’ and select ‘Add Virtual Directory---’

o Setthe ‘Alias’ to Libs-Debug
o Setthe ‘Physical path’ to C:¥Casewise¥evolve¥Site¥bin¥webDesigner
o Setthe ‘Connect as-' to Application User (pass-through authentication)

o Testyour settings to make sure they're correct
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Site name:  Default Web Site
Path: f

Alias:

Libs-Debug

-Eumple: images

Physical path:

-C:‘;Cam\nise‘kemhe‘ﬁite‘tbin\mhﬂesigner | ’_‘

Pass-through authentication

Connect as... Test Settings...

3. Repeat step 2 using the following:
o Set the Alias to Libs-Debug-External
o Setthe Physical path to C:¥Casewise¥evolve¥Site¥bin¥webDesigner

o Grant the ‘Users’ group the following permissions on the C:¥Casewise¥evolve¥Site folder

| Propeidtés de : Site - S -

Général | Fariage | Séorté | Versons précécemes | Fi dser |

Nom de lobjet ©  C\Lben'\Grondindermme\Documents’,_Clients ' SITEL-Evobve wvolve's

& GrondinJerome (JERDMEGRONDIN Grondinemme)
B2, Administrateurs (JERDMEGRONDIN' Administrateurs)

Pour modifier ks sutonsstions, chques sur Modifier.

Adoroadiong pour LAkateurs

Lischusre o exdcution
Affchags du comtenu du dosser
Lancfiamn

Ecriure

) ' i -

th.ummﬂuﬂlumlm_dmuu Aumnch

La 4

! I Ok ” Annuier | Applues Fj
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Troubleshooting

In the event you have issues setting up or using your Evolve Sites, please refer to the information here to

attempt to resolve any problems before contacting the erwin Support Team.

Issues

Issue

Resolution

Users cannot log on
using Internet Explorer -
screen just refreshes

Check that the server name (http://<server-name>/<evolve-11S-site-name>)
does not include any underscores.

There is an issue with Internet Explorer which results in this behavior if there
is an underscore in the server name.

Either change the server name, stop using Internet Explorer, or access the

Evolve Sites using the server IP address.

Unable to use Text
Editor in Internet
Explorer 11 or Evolve

It may be that the font setting is not enabled in Internet Explorer 11.

To enable the setting, please see: Enable Enhanced Multi-line Text Editor for
Internet Explorer

A Shape based on a
Style taken from an
older version of
Corporate Modeler only
displays in black in
HTML5 Diagrams

Open the Style in Model Explorer or from the Corporate Modeler Palette
Entries and Save the Style. Publish the change to your Dynamic or Static Site.
The Style will display correctly.

Users cannot create
Diagrams in eModeler

If Users are unable to create Diagrams, it is likely that an Index Page has
been used. Open Evolve Designer and check whether the Dynamic Template

Configuration was created using an Index Page or an Object Page.

The following table details the benefits associated with each Page Type:

Page Type Edit Create
Index Yes No
Object Yes Yes
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Once in Evolve Designer, adjust the Dynamic Template Configuration to use
an Object Page Type instead.

Duplicate associations do not usually cause issues, and are not a regular
occurrence. In fact for Evolve Workflows, they are necessary to support
Need to clean duplicate | workflow history data. But occasionally, they can be a problem and need
associations tidying. Validate Repository has a fix mode which can assist in this process,
but should be used with care, hence its semi-hidden status. To enable the fix

mode, please contact support for details
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Error messages

Use the table below to understand any error messages you may encounter:

Upgrade for grid failed because of the intersection node is missing inside the page

<attribute_associations> on node Table (Complex) which is a

cwWebDesignerTreeNodeBehaviourKendoGrid

This happens when the Intersection Grid option is selected in a Table (Complex) behavior, but there is no

intersection node for the table.

To resolve this error, use the Selected Properties to add the properties.
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Font Size Too Big on Diagrams

To change the palette version the user needs to be able to run SQL management studio .

1. Open SQL Management studio select the model and expand the tables

‘= SQLQuery3.sgl - GRAHAM-PC.CMIGG (CW\GrahamG (56))* - Microsoft SQL Se... — ©
File Edit Wiew Project Debug Tools Window Help

Pl - (S @ | I NewQuey [R5 4 a9 - - E-E e bl
Pl || cmiGe | ¥ Execute b Debug ® o 35 ol |37 dy gy 2

CEELS

4l

Object Explorer
Connect~ 3 3 m F 2] L5 —|SELECT TOP 1@ee [REVERSENAMiZE
- : OBJECTTYPENAME]

z el . [ .
= _ , [ASSOCTATIONTYPENAME  «
[ Database Diagrams [

= [ Tables .
3 Systemn Tables [ Resuts |13 Messages

sapadoly M

100% -

1 FileTables REVERSENAME  OBJECTTYPEMNA ~

E dbe ACCESS_RIGHT : Pe

= dbeoANY_COBJECT
rahamG (36) CMIGG = 00:00:00 | 27 rows

Qutput

=3 Find Results 1

2. Select the diagram table and chose edit top 200 rows
Lim GRAHAM-PC.Casewise?2 - dbo.DIAGRAM - Microsoft SQL Server Management Studio - Y mma
File Edit View Project Debug QueryDesigner Tools Window Help
P S e | D NewQuey [ ERPR | 4 2B 9 - -S-BE| e | (3 [cw_aupiT ]
i) ] o) = | ChangeType~ | | p | [ | 79 /8] -
Object Explorer ~ 1 % GRAHAM-PC.Casew...2 - dbo.DIAGRAM < [B
Connect~ 3 i m T z] 5 SELECT  TOP (200) MODEL_NAME, DI_ID, 3 BOLS, DI_TEMPLATE, DI_TITLE
=1 dbo.CW_REASON "

= dbo.CW_TECHNOLOGY
= dbo.CW_USER

3 dbo.DATA STORE MODEL_NAME  DI_ID ANO_ID AMO_TAENR DI_NAME DI_SYMBOLS DI_TEM

=1 dbo.DIAGRAM

=1 dbo.DISTRIBUTION
=1 dboENTITY + |NULL NULL NULL NULL NULL NULL NULL
=1 dbo.ENTITY_SYNONYM
=1 dboEVENT < 5
@ 1 Ahn FXTFRMAI FNTITV

HERE  (DIID = 2) AND (MODEL_NAME = 'CWFREX0S'

13 CWFREXD% 2 43 20003 Process Sales O... <diagraminfo>... False

Output

B Find Results 1

3. Change to the SQL view and replace the text with:

SELECT TOP (200) MODEL_NAME, DI_ID, ANO_ID, ANO_TABNR, DI_NAME, D|_SYMBOLS,
DI TEMPLATE, DI TITLE
FROM DIAGRAM
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WHERE (DI_ID = 2) AND (MODEL_NAME = 'CWFREX09')

Replace DI_ID with your diagram ID and replace CWFREX09 with the correct model file name

This must be upper case , if upgrading all diagrams, omit DI_ID and change (200) depending on
how many models you require

4. In the DI_SYMBOLS column click inside the cell to edit the palette XML.

5. Set the element <OriginalVersion OriginalVersion="2"> to <QOriginalVersion OriginalVersion="'4">

6. Close SQL Management studio when complete.

7. When all of these have been changed using one of the CM applications (Corporate Modeler, Model
Explorer or Object Explorer) the font size in styles that are referenced in the palette are reduced by
20%. Open every object on the palette, go to its style (if it has one) and reduce the font to the

nearest whole number that is 20% smaller (e.g a 10pt font becomes an 8pt font).
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Elastic/Global Search Using Too Much
Memory

Introduction

The latest release of the Evolve Web Platform has had the version of Elastic Search that it uses upgraded
to 7.16. If this version when installed with evolve is using too much memory, then it can be reduced by

changing some settings in the options file.

For these settings to take effect, the Elastic Search service needs to be uninstalled and reinstalled. While
this operation does not take too long, we recommend that it is done when the evolve application is not being

used or during a relatively quiet period.

Option File Changes

If the Evolve Web Platform has been installed using the default location, then you need to change the file.

e The file to be changed is in the folder:
“C:\erwin\Evolve\Elasticsearch\elasticsearch-7.16.2\config”

e The file required to change is called “jvm.options”
Edit this file with any text editor, but don’t set it as the default.
Locate these lines
HHHRHHH B RHH R R HH R RHH R R B R RHH R H RS R R H R RH R H R R
## IMPORTANT: JVM heap size
LR R s s s s s L g s s g g g g g s

After a short description you should find these lines
#i#

# -Xmsdg

# -Xmx4dg

##

Change them to the following

#H#
-Xms500M
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-Xmx1g
#i#t

So that whole section should look like this

HHBHHHH R RHH R R R H R R H RIS H R R R R R R
## IMPORTANT: JVM heap size

LR E s f s b s s s kg s b kg gt kg g gk F g
##

## The heap size is automatically configured by Elasticsearch

## based on the available memory in your system and the roles

## each node is configured to fulfill. If specifying heap is

## required, it should be done through a file in jym.options.d,

## and the min and max should be set to the same value. For

## example, to set the heap to 4 GB, create a new file in the

## jvm.options.d directory containing these lines:

#i#

-Xms500M

-Xmxlg

##

## See https://www.elastic.co/guide/en/elasticsearch/reference/7.16/heap-size.html
## for more information

##

Lk i g gt g gt g g g g g g g i

e Save the file.
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Updating the Service

1. Start the Windows Services (eg. by typing services in the windows search and clicking the application
that appears)
2. Locate the “CWS.elasticsearch-service-x64" and stop it, this will also stop the “CWS.Search” service
3. Open a command prompt and navigate to the folder “C:\erwin\Evolve\Elasticsearch” assuming the
default location.
In the command prompt type: UninstallService
When complete type: InstallService
4. When completed open the Windows Services application. If it did not open, refresh it, and start the

“CWS.elasticsearch-service-x64" service. Wait a minute or so and start the “CWS.Search” service.
DO NOT start the “CWS.Search” first as a small amount of time is required for the Elastic Search service to
initialize before search requests are made.

5. The memory usage for the service should now be at a reasonable level.
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Upgrading

Upgrading from Evolve Web Platform
2020.1.x

If you are upgrading to the latest Evolve 2020.1 from any 2020.1.x version.

When uninstalling any recent version of Evolve, it is also necessary to uninstall

"Evolve Services" - the service that operates the Global Search, and Web Modeler.

The Evolve Web Platform uninstaller does NOT remove Evolve Services when uninstalling.

The following steps also ensure compatibility between Evolve Web Platform and Evolve
Suite (CWSuite) when run on the same machine.

1. First BACKUP your SQL Database, to ensure any updates can be reverted should there be a problem.
2. Now uninstall Evolve Services.
To do this you may need to first stop the CWS Services from running
3. Then uninstall your previous version of Evolve Web Platform 2020
A restart may be required.
4. Now uninstall your previous version of Evolve Suite 2020 * only if previously installed *
A restart may be required.

5. Follow the steps below:

e Go to your previous Evolve Web Platform folder (defaults to C:\erwin\Evolve)
right-click on the 'Evolve' sub-folder, then choose

'Sent to >' - 'Compressed (zipped) folder'

e Let Windows compress the remnants of this folder to a backup file
This zip will contain any customizations made to Evolve Web Platform, various settings, and
your Global Search cache

This is a useful backup to keep, should you need to revert any changes.

e Finally delete all the contents of the Evolve folder EXCEPT these 2 folders (if you want to
preserve your Global Search cache):
* CWSServices - folder

* Elasticsearch - folder
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6. Install the latest Evolve Suite release (aka CWSuite) * /Fonly the Web Platform is required, this step
can be skipped. *
(The Suite should be installed first, if both Desktop and Web components are to co-exist on a single
machine)

7. Install Evolve Web Platform 2020
And copy any custom files back to their respective folders (nb: only copy files customized by your
organization)

8. ** ENSURE YOU HAVE BACKED UP YOUR DATABASE **

Follow the instructions to upgrade your database.

9. Any version upgrade can be performed from a previous version but the below is required when
updating to 2020.0.2 or later in the 2020 series
Continuing on from the database upgrade instructions, also run the following command
ValidateRepository.exe -connection: YourConnectionName -
username: YourUserName password: YourPassword -applyfixes
When prompted to apply fixes, review the changes (there may be other faults that need fixing,

check you are happy with them) then press 'a' for all.

10. Your upgrade is complete - continue to configure Evolve Web Platform and re-publish the sites.

When a version of Evolve Web Platform (Evolve) is installed on the same machine as Evolve Suite
(CWSuite), the version of Evolve Suite installed must be the same version (including revision, e.g.
2020.1.0) to ensure full compatibility.

Other machines on the network can continue to use Evolve Suite matching the same Major
Version, e.g. 2020.x if desired. Although upgrading to Evolve Suite (CWSuite) at the newer
version, may offer additional features / fixes.
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Upgrading from Evolve Web Platform
2020.0.x

If you are upgrading to the latest Evolve 2020.1 from any previous version of.

When uninstalling any recent version of Evolve, it is also necessary to uninstall

"Evolve Services" - the service that operates the Global Search, and Web Modeler.

The Evolve Web Platform uninstaller does NOT remove Evolve Services when uninstalling.

The following steps also ensure compatibility between Evolve Web Platform and Evolve
Suite (CW Suite) when run on the same machine.

1. First BACKUP your SQL Database, to ensure any updates can be reverted should there be a problem.
2. Now uninstall Evolve Services
To do this you my need to first stop the CWS Services from running
3. Then uninstall your previous version of Evolve Web Platform 2020
A restart may be required.
4. Now uninstall your previous version of Evolve Suite 2020 * only if previously installed *
A restart may be required.

5. Follow the below steps:

e Go to your previous Evolve Web Platform folder (defaults to C:\erwin\Evolve)
Inside you will find a folder called 'Data’
Delete this folder - it contains generated content from your sites, that will be recreated

when you republish your sites in Evolve Web Platform 2020.
Due to the changes to several folder structures, the above step is important.

e Go back up a folder, to your previous Evolve Web Platform root directory (defaults to
C:erwin\)
right-click on the 'Evolve' sub-folder, then choose

'Sent to >' - 'Compressed (zipped) folder'

e Let Windows compress the remnants of this folder to a backup file
This zip will contain any customizations made to Evolve Web Platform, various settings, and
your Global Search cache

This is a useful backup to keep, should you need to revert any changes.

e Finally delete all the contents of the Evolve folder EXCEPT these 2 folders (if you want to
preserve your Global Search cache):
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* CWSServices - folder

* Elasticsearch - folder

6. Install the latest Evolve Suite release (aka CWSuite) * /f only the Web Platform is required, this step
can be skipped. *
(The Suite should be installed first, if both Desktop and Web components are to co-exist on a single
machine)

7. Install Evolve Web Platform 2020
And copy any custom files back to their respective folders (nb: only copy files customized by your
organization)

8. * ENSURE YOU HAVE BACKED UP YOUR DATABASE **
Follow the instructions to upgrade your database.

9. Continuing on from the database upgrade instructions, also run the following command
ValidateRepository.exe -connection: YourConnectionName -
username: YourUserName password: YourPassword -applyfixes
When prompted to apply fixes, review the changes (there may be other faults that need fixing,

check you are happy with them) then press 'a' for all.

10. Your upgrade is complete - continue to configure Evolve Web Platform and re-publish the sites.

When a version of Evolve Web Platform (Evolve) is installed on the same machine as Evolve Suite
(CWSuite), the version of Evolve Suite installed must be the same version (including revision, e.g.
2020.1.0) to ensure full compatibility.

Other machines on the network can continue to use Evolve Suite matching the same Major
Version, e.g. 2020.x if desired. Although upgrading to Evolve Suite (CWSuite) at the newer
version, may offer additional features / fixes.
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Upgrading from Evolve Web Platform
2018 or older

If you are upgrading to the latest Evolve 2020 from any previous version 2018 or older and you have CWSuite

installed on the same machine.

When uninstalling any version of Evolve from 4.0 upwards, it is also necessary to uninstall "Evolve
Services" / "CWS Services" - the service that operates the Global Search, and Web Modeler.

The Evolve Web Platform uninstaller does NOT remove Evolve Services (or CWS Services)
when uninstalling.

The following steps ensure compatibility between Evolve Web Platform and Evolve Suite

(CW Suite) when run on the same machine.

1.
2.

First BACKUP your SQL Database, to ensure any updates can be reverted should there be a problem.
Now uninstall CWS Services for 2018 and older

To do this you my need to first stop the CWS Services from running

. Then uninstall your previous version of Evolve 2018 or Evolve 2016

A restart may be required.

. Now uninstall your previous version of CWSuite 2018 or CWSuite 2016 * only if previously installed *

A restart may be required.

. Go to your previous Evolve installation folder (defaults to C:\Casewise\Evolve) and rename it to

"Evolve_OLD")
This folder is not removed by the installer, as it contains files that were not part of the installation.
Keeping this folder can be useful, if you have customizations that you need to copy across.

Once you are sure you have all you need from this directory, it can be removed.

. Install the latest Evolve Suite release (aka CWSuite) * /f only the Web Platform is required, this step

can be skipped. *
(The Suite should be installed first, if both Desktop and Web components are to co-exist on a single

machine)

. Install Evolve Web Platform 2020

And copy any custom files back to their respective folders (nb: only copy files customized by your

organization)

. ** ENSURE YOU HAVE BACKED UP YOUR DATABASE **

Follow the instructions to upgrade your database.
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9. Continuing on from the database upgrade instructions, also run the following command
ValidateRepository.exe -connection: YourConnectionName -
username: YourUserName password: YourPassword -applyfixes
When prompted to apply fixes, review the changes (there may be other faults that need fixing,

check you are happy with them) then press 'a' for all.

10. Your upgrade is complete - continue to configure Evolve Web Platform and re-publish the sites.
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Upgrading from Evolve 3.x

If you are upgrading from a version earlier than Evolve 4.0, please first ensure you have completed the steps
in the Database Migration Guide, and then follow the appropriate steps listed below in order to complete

the migration process and have your Sites running the new version.

If you have any custom themes, you must copy all of the lines below and paste it in all theme files
for every Evolve site that you are deploying.

@cwDiagramEditorlconColor: #b7b7b7; //v4.0
@cwDiagramEditorMenuBackgroundColor: #f1f1f1; //v4.0
@cwDiagramEditorMenuMainHeaderBackgroundColor: #2372a7; //v4.0
@cwDiagramEditorMenuSubHeaderBackgroundColor:#2881bd; //v4.0

Adding this text to the end of the theme files will upgrade the theme files for the new version

If you are using a custom logo, it is important to note that the new dimensions for the top left logo are
146px x 30px.

Upgrading Custom Themes / Less Variables

This section applies to users that have customised their Evolve theme. You can skip this section if you are

using the default Evolve theme and have not made any changes of your own.

Failure to Update — Theme Errors

Failure to update your custom theme with Evolve 4’s new LESS variables will result in an error.
Merging Changes Into Custom Theme

To ensure that Evolve 4.0's pages appear as they should, you must copy the new variables into your custom

theme files. These variables are listed on the next page.

New Variables in 4.0

The following variables are new to Evolve 4.0:

Global search

Variable Default Value

@cwMenulLeftMainNavigationBackgroundColorActi
@cwGlobalSearchFocusColor

ve
@cwGlobalSearchTextColor @cwMenulLeftMainNavigationTextColor
@cwGlobalSearchBackgroundColor @cwMenuleftMainNavigationBackgroundColor
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@cwGlobalSearchResultsTextColor @cwFontTextColor

@cwGlobalSearchResultsBackgroundColo
whitesmoke
r

Top Bar

Variable Default Value
@cwTopBarHeight 40px
@cwTopBarBackgroundColor #ECEFF1
@cwTopBarProfileLinkColor @cwColor2

@cwTopBarProfileLinkHoverCol

or

@cwColor2Shade

Login Page

Variable

Default Value

@cwlLoginTextColor

@cwTextColor

@cwLoginLabelColor @cwColor2
@cwLoginTextBoxBorderColor #CFD8DC
@cwLoginTextBoxFocusBorderColo

@cwColor2
r
@cwSiteSelectionTextBackground ||@cwColor2

@cwAccentColo
@cwLoadinglconColor
r

Theme File Labelling Convention

Evolve’s LESS variables are named using camelCase whereby the first letter of each word is capitalized —
except for the first letter of the whole string. Evolve version numbers are commented out next to any

variables that relate to specific Evolve versions. l.e: //v4.0

Custom Logos

The dimensions of custom logos have been changed, they are now:

Image 1
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logo.png
146 x 30 px

Image 2
logo-m.png
112 x 30px

Upgrading from Evolve 2.2, 2.3, 2.3.1, 3.0 or
3.1

There are no changed configuration options required for your upgrade, but you must still do the following:

¢ Run the Server Configurator to complete the upgrade.
e Upgrade Your Database so it works with the new version.
e Update each of your Sites so they work with the new version.

Evolve eModeler

Evolve 3.1 introduces eModeler. To ensure that this new feature is enabled for use across your Sites,

see Enable BP modeler.

Upgrading from Evolve 2.1

If you are upgrading from Evolve 2.1, quite a lot has changed in terms of Site configuration and setup.
As such, there are a series of steps you should follow in order to complete the upgrade process.

Instructions for upgrading from Evolve 2.1

7

& These instructions assume you have already upgraded the Evolve application on the web server in

accordance with the Installation Guide.
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Upgrading your database to support
CW Suite / Evolve 2016 and above

These instructions explain how to update your database for new releases of CWSuite and Evolve.

IMPORTANT: Before beginning the upgrade process you must make sure that your database user
has DBA permissions.
It is also STRONGLY advised that you backup your SQL database prior to upgrade, as any failures

during upgrade may not be reversable.
Step 1 - Backup and Preparation
e |tis recommended that you back up your database prior to following these steps.
Step 2 - Ensure you have installed your new version of CW Suite
e Follow the install guide for CW Suite until the step to upgrade your database.

Step 3 - Upgrade the Database

1. Run Command Prompt as an administrator and navigate to the 'bin' directory where CW Suite is
installed.

o] Administrator: Command Prompt |;|£l-

icrosoft Windows [Uersion 6.3.9680]
(c)> 2013 Microsoft Corporation. All rights reserved.

>:\Users\Administrator>cd \

3:N\>cd “Program Files (x86>"

>:N\Program Files (x86)>cd Casewise \
>:\Program Files (x86>\Casewise>cd CM16

>:\Program Files (x86)\Casewise\CM1B>cd bin

>:\Program Files (x86>\Casewise\CM168\bhin>_

2. Type the following: ValidateRepository.exe -connection: YourConnectionName -
username: YourUserName password: YourPassword -upgradedb
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3. The Validate Repository tool will do various checks and will display the results of these checks as

well as a prompt to commence the upgrade.

DD D DD D D D T D I 2 D D D D DD I DI DT DI D 2 2 DD DI DD TP DE D DI MDD DI PP MM

e NB: THIS OPERATION WILL CHANGE DATA WITHIN YOUR DATABASE. seoe

BEOOOOOHOOEOHOOOOEOHODOOEPOOEOOOOEOOOOOMOOOONHOEOOOOHOOOOOROOOROOOOOE

re you sure that you wish to proceed with the upgrade? (¥des/A>11/(Ndo: y

If your user does not have DBA permissions, you will see the following message:
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If you see this message, you should not proceed with the database upgrade.

Step 4 - Continue with you install instructions for Evolve as required

e Install Evolve following the information detailed in the installation guide.
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Upgrading to Evolve 2.3 from Evolve
2.1

If you are upgrading from Evolve 2.1 there are several steps you must follow to ensure your Sites are

updated to run with the new version.

There are also some changes to file paths and the URLs your Sites can be accessed via that you should

understand.

If you previously used Workflow in Evolve, please read this important message:

Important message for Workflow users
The mechanism for providing workflow capabilities within Evolve has changed completely in this release.

While any workflows you may have previously configured will still work in Evolve 2.3, all existing Tasks and
Notifications will be lost.

If you need assistance preserving existing Tasks and Notifications, please contact the erwin Support Team.

Steps for Updating Sites

These instructions assume you have already upgraded the Evolve application on the web server

machine in accordance with the Installation Guide.

To ensure a smooth transition to the new version, follow the steps below:
1. Understand multiple Sites, the new URLs, file paths and directories
Learn about the URLs, file paths and directories used in Evolve 2.3.
2. Run the Server Configuration utility
Use the Server Configuration utility to ensure your Evolve IIS Site is configured correctly.
3. Update and publish existing Sites

For each existing Site you want to use in Evolve 2.3, ensure you follow the instructions for Updating

an existing Site.
4. Learn how to create and configure a new Site

Now Evolve supports multiple Sites, learn how to Create a Site.
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Update an Existing Site

These instructions explain how to update an existing Site and configure the settings so it can be published
in the latest version. These steps should be followed for each existing Site you want to publish in the new

version of Evolve.

These instructions assume you have already upgraded the Evolve application on your server, and used
the Server Configuration tool to configure it.

As long as the model containing your Site is in your repository, when you launch Evolve Designer the Model
and its Site should be listed so you can open the Site in the designer application.
There is a new warning message displayed when publishing a Site if your model has more than

one template diagram for a Rule and Category combination.
We strongly recommend that if you see this message you revisit your model to eliminate
duplicate diagram templates for the same Rule and Category, otherwise you could have issues
displaying diagrams in your Site.

Step 1 - Check existing custom data and files

Custom Site content

Check that any custom Site content you may have is in the correct location in the Evolve/Site directory.

This is in your Site¥bin¥webDesigner¥custom¥<customization-name> directory.

See URLs, file paths and directory structures.

Custom logos

If you use custom logos in your Evolve Site or Sites, the configuration required to use them has changed.
Please read these instructions on how to use custom logos on your Site to ensure they continue to work

after upgrading.
Custom Workflow Emails

If you have customized the default Email templates for Workflow, ensure they are copied to the
Site\bin\SMTP\Email Templates directory.

Step 2 - Update the Site's Meta Model

To update the meta model:

1. In Evolve Designer open your Site
2. Click the Update Meta Model button
The Model is updated with the latest required meta data.
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3. Save your Site, the close and re-open Evolve Designer when prompted.
Step 3 - Update Diagram Designer layouts

1. Ensure Evolve Object Types are displayed in Object Explorer by using the Show/Hide Object
Typesbutton in Evolve Designer

2. In Object Explorer, view the CW Diagram Designer objects in your model

3. Edit the properties of each object and set the Freeze Level to ‘Unfrozen’

4. In Diagram Designer, open each layout and click the Run tab.

Step 4 - Update the Site settings

To update the Site settings:

1. Open the Site in Evolve Designer
2. Select the top-level Site node

3. Check the following settings and edit where necessary:

Setting Description
Server Choose the language of the Site if you want to override the global Evolve
Language setting.

Choose the theme of the Site if you want to override the global Evolve
Server Theme ]
setting.

Note: These are the basic settings required to publish your Site. For the full configuration reference,

see: Configuration Reference.
4. Select the Deployments > [server name] > Model node (showing the Scriptname of the Model your
Site is in)
5. Complete the following fields:

Setting Description

Specify the name of this Model Site as it appears in the URL, such as
Site URL Name http://<server-name>/<evolve-11S-site-name>/[sites|statics]/<site-url-

name>/

. . Enter the name of your site. This is only displayed on the top-level Evolve
Site Display Name )
Sites page.

. If you publish using custom content, select the custom site reference
Deploy Custom Site N
ere.
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Only used if the Evolve Authentication Method is set to Active Directory.

Contributor Users

AD Group for Social
Users Specify the name of the Active Directory group you want to use for Evolve
Social users.
Only used if the Evolve Authentication Method is set to Active Directory.
AD Group for

Specify the name of the Active Directory group you want to use for Evolve

Contributor users.

AD Default Social
Role Name

Only used if the Evolve Authentication Method is set to Active Directory.

Specify the default Role you want newly-created Evolve Social users to
be given.

AD Default
Contributor Role
Name

Only used if the Evolve Authentication Method is set to Active Directory.

Specify the default Role you want newly-created Evolve Contributor users

to be given.

Display Model in
Evolve

Applies to Dynamic Sites only.

Use this option to specify if this Model Site is available or disabled in

Evolve.

Note: These are the basic settings required to publish your Site. For the full configuration reference,

see: Configuration Reference.

6. Save the Site.

The settings are updated.

Step 6 - Publish your Site

Now the Site and IIS are configured, you must publish your site so that all the required files are generated

and placed in the correct location on the web server.

To publish your Site:

In Evolve Designer, click Dynamic Site or Static Site in the Publish area on the Home menu.

Accessing a Dynamic Site

Dynamic Sites are published at the following URL:

http://<server-name>/<evolve-IIS-site-name>/sites/<site-url-name>/

Accessing a Static Site

Static Sites are published at the following URL:

http://<server-name>/<evolve-IIS-site-name>/statics/<site-url-name>/
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Evolve Suite Addendum

Map Imported Associations to Existing
Source and Target Objects

When importing data into an existing model using the XML file import format, the user can now [2020.1.1]
choose to map associations by the source and target object for an existing user-defined association, as

opposed to by the Unique Identifier.

NB: Traditional associations such as Reason for involvement, Data Model Usage, and Entity Synonym are not
affected.

This means that when a user imports an association from another model, if an association of the same type
exists between the same source and target objects (having the same source and target, Unique ldentifiers)
in the target model, the importer will consider it to be the same association, even if the Association's Unique
Identifier is different. Without this option, duplicates are created if for example, the same association
between the same two objects is created separately in two models, and then the data is merged. This is
because they were created separately, so will have different Unique Identifiers and when one is imported

into the other, they will be treated as separate Associations and thus be duplicated.

This option, when it has identified an Association that matches by Source, Target and Association Type,
irrespective of Association ldentifier, will then proceed to update the Target Association, rather than duplicate
it.

For the user to be able to do this, there is a new check box in the import options called "Map associations to

existing source and target object" (it only applies to the import wizard for XML), as shown on the image below.
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Import data into existing model (XML Format) - Import Options X

Select the options for this import

(O Import new objects only
(O Import existing objects only

Update Conflicts

(®) Keep Newest
(O Keep Oldest

(O Keep object from import file
(O Keep object from target model

General
[ [IMap association to exsting source and target object |
[[] set current date/time for all new objects
Text to add on name confiicts
Prefix v [Copyof ]

Help Cancel <Back Finish

Note: Choosing this option does not change the original XML in any way.

For example, a user creates a new model, say "Master." Within that model, the user creates their own
Association Type between Application and Process. They create one instance of Process and one instance of
the Application and then Associate the two items using the this new Association Type.

The model is exported to another model, say "Working", and some work is done on it. In this "Working" model,
they remove the user-defined Association between the original Process and Application. Do some further
work, including making changes to the actual Process and Application, and then decide they need the
Association between the original Process and Application back, so recreate it. As it has been recreated, it will
now have a different unique identifier. This working model now needs importing into the "Master" model. If
the "Working" model is imported using any standard options, the user will now have two Associations between
the original Process and Application.

Ticking the check box will stop this and map any changes made to the Association in the "Working" model to
the Association in the "Master" model.
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Communicator for Word Filtering

Communicator for Word is an application that allows users to export the data from the Evolve Suite to a Word
document. As part of this process, the data is initially exported in XML format using the application
CMXMLApp

Depending on the model's size, this export can potentially produce a huge XML file, which may take a long

time to load or may even exceed memory limits.

To reduce the XML files' size, the user can select the specific objects and the properties to export. In addition,
the ability to filter objects based on a property value is also available. These filter options are saved with the
filter configuration [2020.1.1 onwards].

How to apply filter

e Start the application CMXMLApp from the erwin bin folder, usually "C:¥Program Files
(x86)¥erwin¥CM10¥bin".
e Run through the wizard until you get to the "Filter by Properties" page.

Filter By Properties
Selected Object Types: Select Property Types: Show Fiter

OTName PTName Condition o)
Application Average Rating

' [ Created by
Creation Date
Criticality
Description
: Documentation

End of Life

Enterprise Standard

Freeze Level

Go Live Date

Id

License Type

Maintenance Anniversary v

A IRRRRRRRRRE

< >

File Name / Location: [Hter_fu_EA Foundation - Sample Model ] Save As ...

Help < Back Next > Cancel

e Click on "Show Filter" in the top right, then the filter options will appear on the right side as shown in

the picture below.
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Filter By Properties

OTName PTName
"","“““‘ Category
Object Type
Process Condition
(in v
Value
ERP
Crticalty %Leoaw )
Description [] Middieware v
[ Documentation
[ End of Life l Add HMI
Enterprise Standard
Freeze Level
[ Go Live Date
M
[ License Type
Maintenance Anniversary
< >|| ¢ >
Fle Name / Location: | Fiter_for_EA Foundation - Samg| | Save As .. |

| <Back |

 Net>

erwin Evolve — User Help Guide

Evolve Suite Addendum

454



The type of filter shown and the data entered will depend on the property. In the example above, itis a
category property with know values and the user can choose one or more. The application will then only
output results where the category matches this selection. If the user chooses to save this file by clicking the
"Save As" button, opening the file again will show the user's original selection.
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About Us

Quest creates software solutions that make the benefits of new technology real in an increasingly complex
IT landscape. From database and systems management to Active Directory and Office 365 management, and
cyber security resilience, Quest helps customers solve their next IT challenge now. Around the globe, more
than 130,000 companies and 95% of the Fortune 500 count on Quest to deliver proactive management and
monitoring for the next enterprise initiative, find the next solution for complex Microsoft challenges and stay
ahead of the next threat. Quest Software. Where next meets now. For more information, visit

www.quest.com.

Technical support resources

Technical support is available to Quest customers with a valid maintenance contract and customers who

have trial versions. You can access the Quest Support Portal at https://support.quest.com.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24

hours a day, 365 days a year. The Support Portal enables you to:
e Submit and manage a Service Request
e View Knowledge Base articles
e Sign up for product notifications
e Download software and technical documentation
e View how-to-videos
e Engage in community discussions
e Chat with support engineers online

e View services to assist you with your product.

erwin Evolve — User Help Guide |
About Us |


https://www.quest.com/
https://support.quest.com/

	Getting Started
	About CW Evolve
	Key Concepts
	Meta Model Considerations
	Displaying Diagrams in Evolve Sites
	Users, Roles and Access Rights
	Running Evolve Designer
	Product Licensing
	URLs, File Paths and Directory Structures
	Creating your First Evolve Site

	Creating Sites and Pages
	Create a Site
	Layouts and Behaviors Explained
	Working with Index Pages
	Index Pages Explained
	Create an Object List Index Page
	Create an Empty Index Page
	Create a Diagram Index Page
	Create a Graphical Index Page
	Create Multiple Index Pages for an Object Type

	Working with Object Pages
	Object Pages Explained
	Create an Object Page
	Creating Objects from an Object Grid Using Object Pages (4.0.2 onwards)
	Object Page Views

	Working with Menus
	Create and Edit a Menu
	Menu levels


	Publishing
	Publish your Site
	Command Line Publishing

	Use Tabs to Present your Data
	Use Custom Display Strings
	Static Pages in a Dynamic Site [2018.0.2+]
	In-Page Static Content Refresh


	Data Layout Options
	Working with List (Simple)
	Working with Accordions
	Working with Tables (Simple)
	Working with Tables (Complex)
	Working with a Simple Matrix
	Working with an Advanced Matrix
	Working with Tabs based on Lookup Values

	Filtering Data
	Page Queries and Filters

	Property Groups
	Working with Property Groups
	Property Group Layouts

	Data Visualizations
	Visualizing Data in Evolve
	Working with Pie Charts based on Lookup Values
	Working with Recursive Pie Charts
	Working with Roadmap Gantt Charts
	Working with Lifecycle Roadmaps
	Working with Cost/Benefit Charts
	Working with Vector Maps
	Working with Bar Charts (Simple)
	Working with Multi-Axis Bar Charts
	Working with Simple Bubble Charts
	Working with Cluster Bubble Charts
	Working with Radar Layout
	Working with the Visual Identity Layout
	Working with Visual Indicators
	Working with External Pictures
	Working with the Image Layout
	Working with View Box Layout
	Working with the Custom URL Layout [2018.0.2+]
	Working with Text Editor

	Displaying Diagrams
	Display a CW Modeler Diagram
	Display a Visualization Diagram
	Display Object Data with Diagram Pop-outs
	Display a Diagram on the Home Page of your Static Site
	Displaying Vector (HTML5) for Displaying Diagrams
	Editing Business Process Diagrams

	Using Web Modeler
	Overview of Web Modeler - Editing Diagrams Online
	Enable Web Modeler
	Configuring Drafts and Publishing Diagrams
	Formatting Shapes In Web Modeler
	Gallery Manager In erwin Web Modeler
	General Operations in Web Modeler
	Working with Connector Lines
	Web Modeler Home Page
	Parent object and Parent object name
	Using Explode Diagram in erwin Web Modeler
	Load Balancing with erwin Web Modeler
	Configuring MongoDB Replication
	Configure Evolve Server


	Automatic Diagrams (Diagram Designer)
	Create an Automatic / Visualization Diagram
	Enabling a Model
	Designing a Layout
	Create a new Layout
	Designing a Layout
	Working with Diagram Designer
	Running a Layout
	Batch Generation of Automatic Diagrams
	Log Files

	Additional Layouts
	Jump and Merge Layout
	Diagram Association Layout

	Advance Filtering
	Filter by Base Object [2018.0.1+]
	Intersection Object Filter [2018.0.1+]


	Navigating your Site
	Overview
	Smart Crumbs
	Diagram Navigator

	Workflow Explained
	Overview
	Enable Workflow for your Evolve Server
	Review and Approval Workflow
	Setup Approval Workflow Roles and Users
	Object Validation Workflow
	Set Up the Object Validation Workflow
	Required Metadata
	Configure Site to Enable Object Validation

	Evolve Workflow Configuration
	Page Review Workflow
	Working with Tasks
	Follow an Object

	Social Interaction Features
	Social Interaction Features Explained

	Questionnaires
	Questionnaires Explained
	Question Weights and Values
	Create a Questionnaire
	View Questionnaire Results
	Edit a Questionnaire
	Delete a Questionnaire

	Reference
	Site Configuration Reference
	Validate Repository for Global Search
	Introduction
	Running the Validation
	Verify and Fix Issues with the Repository

	Validate Repository for Global Search Re-indexing
	Introduction
	Running the Validation

	Global Search
	Global Search - Advanced Filters [2018.0.2+]
	Global Search - Favorite Search Filters [2018.0.2+]

	File Structure
	Required MIME Types

	Configuration and Administration
	Server Configuration
	Configure your Server
	Authentication and SAML2
	Configure SAML2 Authentication and SSO
	Configuring SAML2 Authentication and SSO with Google Suite
	Configuring SAML2 Authentication and SSO with Okta

	Authentication and Active Directory
	Configure Active Directory Authentication and SSO

	Sites Explained
	Site Comparison Chart
	Change the URL Name of your Site
	Advanced Configuration
	Configure TLS 1.2 (Transport Layer Security)
	Evolve REST API (2018.1.0.79 and above)


	Site Administration
	Site Administration Pages
	Working with Roles


	Customizing Your Site
	Customization Explained
	Basic Customization
	Customizing Styles using LESS variables
	Use Custom Site Logos
	Use Custom Site Images on the Multi-Sites Page
	Use Custom Icons for Pages
	Style Development

	Advanced Customization
	Evolve  Advanced Customization Guide
	Custom CSS & JavaScript
	Using Custom Images
	Creating Custom Layouts
	Custom Visualizations
	Data Structure: allItems
	Data Structure: item
	Data Structure: properties
	Get Ready For Development


	Troubleshooting
	Issues
	Error messages
	Font Size Too Big on Diagrams
	Elastic/Global Search Using Too Much Memory
	Introduction
	Option File Changes
	Updating the Service


	Upgrading
	Upgrading from Evolve Web Platform 2020.1.x
	Upgrading from Evolve Web Platform 2020.0.x
	Upgrading from Evolve Web Platform 2018 or older
	Upgrading from Evolve 3.x
	Upgrading Custom Themes / Less Variables
	Upgrading from Evolve 2.2, 2.3, 2.3.1, 3.0 or 3.1

	Upgrading your database to support CW Suite / Evolve 2016 and above
	Upgrading to Evolve 2.3 from Evolve 2.1
	Update an Existing Site

	Evolve Suite Addendum
	Map Imported Associations to Existing Source and Target Objects
	Communicator for Word Filtering

	About Us

